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Chapter 1 
Introduction and Overview 

 

This chapter provides a general overview of the TotalChrom software and how it is 
typically used in a laboratory. It also describes the contents of the TotalChrom User’s 
Guide, discusses conventions used throughout the manual, and describes the 
TotalChrom online help. 

To learn about: Go to page: 

TotalChrom.......................................................................................................1-2  

TotalChrom Functions ......................................................................................1-3 

Using This Guide ..............................................................................................1-8 

The Help System.............................................................................................1-12 
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TotalChrom 
TotalChrom is a hardware and software system developed by PerkinElmer to perform 
the following tasks: 

• Control supported chromatographs through serial communications 

• Acquire analog or digital chromatography data from chromatographs 

• Analyze raw data and report results 

• Control the acquisition and analysis of data from large batches of samples 

• Work interactively with instruments to change instrument or interface settings 
before, during, or after a run 

• Store raw data and the calculated results 

• Create methods that define acquisition and analysis parameters 

• Optimize analysis parameters graphically and use the improved parameters to 
reprocess raw data 

• Compare chromatograms; subtract, add, and calculate the ratio of 
chromatograms; and, manipulate calibration curves 

• Interface with other software applications  
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TotalChrom Functions 
The following sections provide a brief overview of the major functions in 
TotalChrom. 

Acquiring Data  
You use the TotalChrom Navigator to collect, store, and analyze chromatographic 
data from analog or digital interfaces. The Status function in the Navigator displays a 
summary screen that shows the status of all 900 Series Interfaces and any 
chromatographs controlled through LINK Interfaces currently connected to and 
accessible by the system. You can download an acquisition sequence through the 
Setup function to prepare an interface or instrument for collecting data. You can also 
view one or more real-time chromatograms or analyze the information for any 
attached interface or instrument. 

You can also use the QuickStart option through the Setup function to create a 
control/acquisition method you can use to collect data quickly. You can use these 
chromatograms to optimize the new method. 

The TotalChrom Navigator is described in Chapter 4, “Using the Navigator.” 

The QuickStart option, the Status function, and the Setup function are described in 
Chapter 12, “Acquiring and Viewing Data.” 

Analyzing Data 
TotalChrom stores raw data in a raw data file on your disk. At the end of a data 
acquisition run, it analyzes the data according to the data acquisition method you 
used, it detects peaks and establishes baselines, it determines peak beginnings and 
endings, and it determines the separation of adjacent peaks. Finally, it generates a 
report and plot and stores the results in a separate file. 

If you are using the TotalChrom default method or default sequence, or if you have 
used the QuickStart option to create a method or sequence, TotalChrom will use the 
default parameters, store your raw and result data, and generate an area-percent report 
with a single-page plot at the end of the run. 

The QuickStart option is described in Chapter 12, “Acquiring and Viewing Data.” 
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Creating Data Acquisition Methods  
You create and modify control and acquisition methods by using the Method Editor in 
TotalChrom. A method consists of three sections that specify how you want to handle 
the control, acquisition, storage, analysis, quantitation, calibration, and reporting of 
data.  

Instrument 
The instrument section of the method contains parameters for all tasks associated 
with real-time data collection and display. 

Processing 
The processing section of the method contains parameters for all tasks associated 
with post-run analysis of the data. 

Calibration 
The calibration section of the method contains a list of components with associated 
identification and calibration information. Each component in the method can have 
unique calibration tables, reference peaks, internal standard peaks, calibration curve 
fits, number of calibration levels, and search windows. 

The Method Editor is described in Chapters 5, 6, 7, and 8. 

Setting up a Sequence 
In TotalChrom, you create a sequence file to designate the method you want to use 
for each injection. A sequence also specifies where TotalChrom stores data, and 
indicates whether or not an injection is to be used as a calibration standard. A 
sequence can also be used for dual channel acquisition, and it allows you to set up 
totally independent sample IDs, storage, integration, calibration, and reporting for 
each channel. 

You must have a sequence file in order to perform dual-tower and random-access 
injections with a LINK-controlled instrument, to change methods, and to perform 
other functions in TotalChrom. The Setup function in the Navigator lets you use a 
single method for any operation that does not require a sequence. 

The Sequence Editor is described in Chapter 11, “Building a Sequence.” 
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Reprocessing Data 
Because TotalChrom stores your raw data on disk, you can re-integrate and reprocess 
the data in two different ways: 

• By reviewing the chromatogram on screen and re-integrating it graphically 
(using the Reprocess Results function) 

• By reprocessing a series of data files using a new method or methods (using the 
Batch Reprocessing application) 

The Reprocess Results function lets you change such parameters as integration 
thresholds or enter new integration timed events. After each change, TotalChrom 
replots the chromatogram on the screen and draws the new baselines. When you are 
satisfied with the integration, you can generate a new report and plot based on the 
changes and store a new result file if you wish. It is also possible to draw manual 
baselines and generate a report with the adjusted results. 

The Reprocess Results function is described in Chapter 10, “Editing Methods and 
Results Graphically.” 

The Batch Reprocessing application lets you select a series of stored raw 
chromatograms and re-integrate and reprocess them in a batch mode using new 
processing methods if you wish. Batch can also read the data file names and method 
files to be used for reprocessing from a sequence. Alternatively, you can specify 
individual data files by name.  

Batch Reprocessing also gives you five options for starting and ending processing. 
For example, you can choose to start reprocessing with peak detection and end with 
storage of new result files without generating a report or plot. Or, you can generate a 
duplicate set of reports without changing the integration. This could be used to 
generate all the reports from a series of runs at a later time. 

Batch Reprocessing is described in Chapter 15, “Reprocessing Files in Batch.” 

Viewing Chromatographic Data 
TotalChrom provides two post-run graphics functions, Chromatograms and Fit 
Analysis, which allow you to view your chromatographic data graphically and 
perform certain operations on the chromatogram itself. 

The Chromatograms function lets you select multiple raw data files and display them 
in separate windows or overlaid in the same window. You can also change the 
scaling, expand and contract, align and label the chromatograms, and generate printed 
plots. 

Chromatograms also lets you perform ratios and differences or add two raw 
chromatograms and store the result as a new raw data file. This function is convenient 
for subtracting baseline bleed profiles from a stored raw chromatogram. You can then 
re-integrate the baseline-subtracted raw data and generate new reports. 
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The Chromatograms function is described in Chapter 14, “Displaying 
Chromatograms.” 

You access the Fit Analysis function through the Method Editor. It lets you examine 
calibration curves, change fit types, and overlay the fits to determine visually which 
fit is the best for your data. This function also allows you to add custom labels and 
generate high-quality plots of the calibration curves. 

Fit Analysis is described in Chapter 17, “Performing a Fit Analysis.” 

Generating Summary Reports 
The Summary function in TotalChrom lets you generate a single report that includes a 
tabular listing of the results for multiple components from a series of runs. You can 
select result files to be summarized from a sequence file, by specifying a common 
base file name, or by choosing from a list of result files on your disk. Summary also 
includes a report editor that lets you select the information you want to include in 
your summary report. This program also lets you store the summary report in a 
comma-delimited ASCII file, which you can then import directly into a spreadsheet 
program such as Microsoft Excel. 

The Summary function is described in Chapter 16, “Summarizing Component Data.” 

Review and Approve 
The Review and Approve process requires one or more people, other than the analyst 
generating the data, to review and sign the work done by that analyst. Once data have 
been reviewed and the reviewer s signature applied, that data is then available for one 
or more levels of approval signatures. After final approval has been applied to the 
reporting of a particular set of data, the status and security of that data must be 
changed to prevent any further modification. 

The United States FDA regulations for the review and approval of electronic records 
are described in the general GLP and GMP regulations, the “Predicate Rules”, upon 
which 21 CFR Part 11 is based. These regulations require that any relevant records or 
data, in paper form or electronic, are reviewed by one or more authorized individuals 
other than the one who was responsible for the generation of those records, and that 
the reviewer(s) sign and date that record with an indication of the meaning of that 
signature (for example, Reviewed By). Once data have been reviewed, it can be 
submitted for final review by another individual, or submitted for approval and/or 
final approval, by a similar process of signings including a date and meaning of the 
signature. Such review and approval e-signatures are applied to TCR (TotalChrom 
Report) files. 
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The function of Review and Approve is associated with the review and approval of 
the reporting of data, rather than the data itself. This consists of a combination of 
information from the existing TotalChrom file types listed below: 

• The Raw data for the sample (necessary to redraw plot images required for 
the report). 

• The Result data used for the report. 

• The Method used to generate that result file (as embedded in the 
TotalChrom RST file).  

• The Report Format files used for all reports generated during processing (as 
specified in the Sequence, as Optional Reports in the Method, or as selected 
during processing in Batch or Graphic Editing).  

In addition to the above, the TCR contains a Signatures Table associated with each 
report (effectively the same as each RPT file) defined within the TCR file. The 
signatures are applied to each report independently within the TCR file. 
The Review and Approve function is described in Chapter 20, “Review and 
Approve.” 
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Using this Guide 
This TotalChrom User's Guide is a step-by-step guide for using the TotalChrom 
Chromatography System. It explains how to create a chromatographic method, 
acquire data, format and print reports, build a sequence file, and how to reprocess data 
using interactive graphics or a batch mode. It also guides you through the post-run 
capabilities of TotalChrom, which include comparing chromatograms, calculating 
ratios and differences, and creating peak summary reports. 

Chapter Topics 
Chapters in the TotalChrom User's Guide cover the following topics: 

Chapter 1 Introduction and Overview of TotalChrom  
Describes the major features of the TotalChrom system and the conventions and 
terminology that appear in the documentation. 

Chapter 2 TotalChrom Basics 
Explains the common elements of TotalChrom applications.  

Chapter 3 Configuring TotalChrom  
Describes how to set up your initial system configuration and change an existing 
configuration. 

Chapter 4 Using the Navigator 
Explains each of the features that appear in the Navigator. 

Chapter 5 Building a Method 
Provides an overview of the TotalChrom Method Editor and how to create and 
modify a method. A method consists of instrument, processing, and calibration 
parameters, which are described in subsequent chapters. 

Chapter 6 Developing Instrument Parameters in the Method 
Describes how to set and change instrument parameters in a method. These 
parameters affect how TotalChrom acquires and analyzes data by controlling settings 
for the chromatographic instruments configured on your system. 

Chapter 7 Developing Processing Parameters in the Method 
Describes how to set and change processing parameters in the method. Processing 
parameters control how peaks are detected and integrated, how reports and plots are 
printed, and which user programs will run at what point in the data analysis process. 
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Chapter 8 Developing Calibration Parameters in the Method 
Describes how to set and change calibration parameters in a method. Calibration 
parameters identify and calibrate the components being analyzed. 

Chapter 9 Building a Report Format 
Explains how to use the Report Format Editor to create customized report formats. 
These control which parameters are included in the reports that are printed following 
data analysis. 

Chapter 10 Editing Methods and Results Graphically 
Explains how to create an optimal method, or modify an existing method, by 
manipulating the chromatographic display in the Graphic Method Editor. It also 
explains how to optimize the results for a single analysis by using the Reprocess 
Results function. 

Chapter 11 Building a Sequence 
Describes how to develop a sequence using the Sequence Editor. A sequence controls 
data acquisition and analysis. 

Chapter 12 Acquiring and Viewing Data 
Explains how to set up your instruments and interfaces to acquire data from 
chromatographic instruments. It also describes how to control a run, view the real-
time plot as data is being collected, and how to view detailed information about the 
instruments and interfaces. 

Chapter 13 Working with Instruments Interactively 
Explains how to use the Hands On and Modify functions in TotalChrom to work 
interactively with instruments before, during, or after a run.  

Chapter 14 Displaying Chromatograms 
Describes how to use the Chromatograms function to examine raw data files 
graphically, how to compare two or more data files, and how to perform 
mathematical operations on two files. 

Chapter 15 Reprocessing Files In Batch 
Describes how to use the Batch Reprocessing function to reprocess the data from 
multiple files. 
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Chapter 16 Summarizing and Reporting Component Data 
Describes how to use the Summary function to generate reports based on multiple 
result files. 

Chapter 17 Performing a Fit Analysis 
Explains how to use the Fit Analysis function to plot calibration curves for 
components identified in the calibration section of the method. 

Chapter 18 Discussion of Data Analysis 
Explains how TotalChrom uses the parameters defined in the method to produce an 
analysis of the raw data. 

Chapter 19 Converting Files to Other Formats 
Explains how to use the Convert program that comes with TotalChrom to convert 
files to different formats. 

Chapter 20 Review and Approve 
Explains how the Review and Approve environment provides a single interface to 
examine chromatographic data, results, and reports.  If electronic signoff and routing 
of the data is required – the environment supports the use of electronic signatures and 
multiple levels of authority. 

Appendix A How Interfaces Collect Data 
Explains how the 600 Series LINK Interface and 900 Series Interface collect and 
store data. 

Appendix B System Suitability Testing 
Describes how to use the System Suitability program to assess the performance of a 
chromatographic system. 

Appendix C Interface Validation  
Explains how to use the Interface Validation Module software, which is an add-on 
program to TotalChrom. You use this module to characterize the performance of 900 
Series Interfaces.  

Appendix D Serial Dilution 
Explains how to use Serial Dilution, which is a separate application for use with the 
Series 200 Autosampler. This application lets you create a Serial Dilution method 
which can be used to perform multiple vial-to-vial transfer and mixing operations. 
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Conventions Used in This User’s Guide 

NOTE:  TotalChrom is the updated version of the software previously marketed as 
Turbochrom. 

This guide, designed for Windows users, assumes that you will be using a mouse or 
similar device to perform your TotalChrom operations. Many shortcut keys are listed 
on the TotalChrom menus, and the documentation for your operating system can 
provide information about equivalent keyboard procedures. This section discusses 
capitalization, terminology, and the way that references are used in this guide. 

Capitalization 
All menus, commands, and dialog box option names appear with initial capital letters 
whether or not they are completely capitalized in the user interface. The names of 
keyboard items, such as the Enter key, are capitalized. This will help you to 
distinguish these items from narrative or procedural text. 

Terminology 
Throughout the TotalChrom documentation, the following terms are used to refer to 
program elements and the actions that you perform to carry out tasks: 

Chromatogram, Plot, and Replot ⎯ A chromatogram, plot, or replot, is the 
graphical representation of chromatographic data in TotalChrom. The terms 
“chromatogram,” “plot,” and “replot” are used interchangeably in this guide. 

Choose ⎯ The terms choose and select indicate actions that you perform. Choose 
represents carrying out an action associated with a command or command button. 
When you are likely to use the mouse to choose an action, mouse-specific terms are 
used, such as “click,” “right-click,” and “double-click.” When you are likely to use 
the keyboard to choose an action, the specific key is mentioned, such as Enter or Tab. 

Select ⎯ The term select refers to highlighting an object or item or moving the 
cursor focus. Selecting an item prepares it for an action: for example, when you select 
text, it appears in reverse video. When you select a dialog box option, you activate 
the option but the function is not carried out until you choose the OK button, which 
closes the dialog box and sometimes completes another operation. 

“Enter or select” ⎯ When you use the File Select or File Open dialog box to open a 
file, the phrase “enter or select” is used to refer to the actions you can take to open 
that file. When you enter a filename, you type it in the File Name text box exactly as 
it exists. When you select a file, you browse for it on your computer or your network. 
When you select a file, you will not introduce typographical errors. 

“Locate and select” ⎯ When you must browse for a file or other entity, the term 
“locate and select” is used. For example, in the Sequence Editor, certain spreadsheet 
columns contain cells that you edit by selecting a file name from the File Select 
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dialog box. After you display this dialog box, you must locate and select the file 
name that you want to use by browsing for that file on your computer or network. 

Illustrations 
Unless otherwise indicated, the values in the illustrations of this manual are examples 
only. They are not intended to indicate the exact values you will see or to suggest the 
values you should use. 

The Help System 
The TotalChrom help system is a collection of help files, one for each TotalChrom 
application. You access help in several ways:  

Context sensitive help — When you press F1, TotalChrom displays information 
related to the dialog box or window you are currently using. Press Escape to close the 
help.  

Help menu — When you choose Help Topics from the Help menu, TotalChrom 
displays the list of help topics for the current application. 

From within help, TotalChrom offers two additional sources of information: 

• Other Help — Displays a list of help files for other TotalChrom applications. 

• Glossary — Lets you access a list of terms and definitions. 



 2-1 

Chapter 2 
TotalChrom Basics 

 

TotalChrom is a collection of applications, such as the Sequence Editor and the 
Method Editor, rather than a single program. These applications have many elements 
in common: how files and instruments are accessed, dialog boxes, and user interface 
features. 

To learn about: Go to page: 

Using Common Dialog Boxes ..........................................................................2-2 

Entering Descriptive Information About a File ................................................2-8 

Using Audit Trail ............................................................................................2-10 

Using Electronic Signature .............................................................................2-13 

Selecting an Instrument...................................................................................2-15 

Using TotalChrom Toolbars and Status Bars..................................................2-16 
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Using Common Dialog Boxes 
Many TotalChrom applications have the following dialog boxes in common: 
• Startup 
• File Select/File Open 
• Path Select 
• Program Selection 
• Tokenized File Names 
This section describes these dialog boxes and includes instructions for using them. 

Startup Dialog Box 
Some TotalChrom applications, such as the Sequence Editor, display a Startup dialog 
box when you enter the application. This dialog box allows you to choose the way in 
which you begin your work with the application. Your application manager can set 
whether or not the Startup dialog box appears. 

 

When you select a Startup option, TotalChrom does one of the following: 

• Create New File ⎯ Opens appropriate dialog boxes that you complete to create 
a new file. 

• Load File Stored On Disk ⎯ Displays the File Open dialog box, where you can 
locate and select an existing file. 

• Load Recently Edited File ⎯ Activates the selection box where you can select 
and open a file with which you recently worked. 

• Clear MRU List ⎯ Clear the list of the most recently used files. 
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File Open and File Select Dialog Boxes 
The File Open dialog box allows you to open an existing file in order to edit it, 
rename it, or use it as a template to create a new file similar to the existing file. This 
dialog box opens when you choose Open from the File menu. 

In many TotalChrom dialog boxes, there is a folder icon next to an edit box that 
requires a filename or path. Clicking the icon opens a File Select, Path Select, or 
Program Selection dialog box. 

 

The File Select dialog box allows you to select a file, such as a method file, that 
TotalChrom will use during its operation (for later use). This dialog box opens when 
you click the folder icon next to an edit box that requires a filename. 

 

The File Open and File Select dialog boxes contain the same elements. TotalChrom 
will open the appropriate dialog box depending on the task you are performing. 

 To open or select an existing file: 

1. In the File Name text box, either enter or select the name of the file. 



Using Common Dialog Boxes 

2-4  

The Multiple File Open dialog lets you open more than one file at a time by 
using the Shift and Control keys when selecting files. 

Use the Quick Paths selection box to quickly select an often-used path. You 
set up these paths in the Configuration application — see “Quick Paths” in 
Chapter 3 for information. 

2. To select a different type of file, scroll to the file type you want in the Files 
Of Type list. 

The list of file types includes all of the available file types that the current 
application can recognize. For example, the Sequence Editor allows you to 
open .SEQ and .IDX files. 

3. Toggle the Header button to view file header information. 

4. Choose Open or Select. 

Path-Select Dialog Box 
The Path-Select dialog box opens when you click the folder icon next to an edit box 
that requires a path. This allows you to select an existing folder and file. 

 

Use the Quick Paths selection box to quickly select an often-used path. You set up 
these paths in the Configuration application — see “Quick Paths” in Chapter 3 for 
information. 
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Program Selection Dialog Box 
The Program Selection dialog box opens when you click the folder icon next to an 
edit box that requires a user program filename. Some TotalChrom applications let you 
specify a user program to run in conjunction with data analysis. Your application 
manager sets up your access to these programs. If you have access to user programs, 
you will have a choice of entering a program name in the edit box or clicking the 
folder icon to open the Program Selection dialog box. 

 

• If a list of programs appears in the Program Selection dialog box, select the 
program from the list. These are the only programs to which you have access. 

• If no list appears, click the Browse button and select a program. 
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Tokenized File Names  
The system manager is able to define default raw, result, and modified base file 
names in the Default Base Names dialog box, for each user, based on the use of 
tokens to represent key data values. This is accomplished through the Default 
Paths/Base Names button on the Users tab of the System Configuration screen.  This 
procedure is described in the Application Manager’s Guide. 

For example, the token <Inst> is replaced by the instrument name, <User> 
by the operator’s name and <Name> by the sample name. An option is 
provided to prevent the user from changing these file names (i.e., those 
columns will be set read-only in SeqEdit for that user). Another option 
(active by default) is the appending of a file number suffix to the file name. 

 

Clicking on a displayed token in the Tokens list box adds it to the Raw Data File 
string. 

The Tokens list box displays a list of allowed tokens: 

<Calib>  Calibration level (null if the run is not a calibration) 
<Chan> Channel (A or B) 
<Inst> Instrument name 
<Rack> Rack number  
<Name> Sample name 
<Num> Sample number 
<User> User logon name 
<DOM> Day of the month at start of run  
<DOY> Day of year at start of run  
<Mon> Month at start of run  
<Year> Year at start of run  
<SDOM> Day of month at setup (does not change for overnight runs) 
<SDOY> Day of year at set up ((does not change for overnight runs) 
<SMon> Month of setup (does not change for overnight runs) 
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The format of the date-related items when resolved is numeric, with the year given as 
four digits. 

The Separator selection defines what character is to be inserted between tokens 
added to the token string. Note that the separator is only added when another token is 
chosen. This is in case the user wants to add some literal text to the string. The 
separators the user may select from are ‘_’ (underscore) — the default—, ‘ ‘ (space), 
‘- ‘ hyphen), ‘+’ (plus), ‘=’ (equals) and (none). 

The Clear button erases the current token string.  

The Raw Data File name is shown in its tokenized form as it is constructed. The 
label on that field is changed appropriately with the file type being defined.  

After adding a token, the cursor remains at the end of the field. This is done to make 
it easy to add literal text to the name, if you wish to do so. For this reason, the file 
number suffix will not be shown in this dialog. The suffix token is appended only 
after clicking OK and return to the Default Paths/Base Names. 
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Entering Descriptive Information About a File 
You may enter descriptive information about a file on the Description tab in the 
Documentation dialog box and in the Audit Trail dialog box. One or the other will 
appear automatically when you save a file according to the following rules: 

• The Description tab in the Documentation dialog box always appears when you 
save a new file. If auditing has not been started for a file, then the Description tab 
also appears when you use Save As to save an existing file with a new name. 

 Your application manager may set up the Description tab to appear every time 
you save a non-audited file. 

• If auditing has been started for a file, the Audit Trail dialog box appears every 
time you save that file with either Save or Save As. 

Auditing is automatically enabled for a result file if any of the methods used to 
create it have auditing enabled. Therefore, the Audit Trail dialog box is also 
displayed when you save a result file (in the Graphic Method Editor or in 
Reprocess Results) that contains an audited method. 

You enable auditing by selecting Start Audit Trail on the Description tab. Once an 
audit trail is started, the Description dialog box will not appear automatically if you 
choose Save As. However, you can display it at any time by choosing Description 
from the File menu. 

Description 
The Description tab in the Documentation dialog box opens when you save a new 
file, and (if auditing is not enabled) when you choose Save As to save an existing file 
with a new name. It also opens when you choose Description from the File menu. 

The Description tab also has the options for starting audit trail and electronic 
signature. Your application manager may have set up these options so that they are 
always selected and unavailable. 
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 To enter information on the Description tab: 

1. Enter any descriptive information about the file that you want to store with it. 

 

2. If you want to start tracking changes to the file, select the Start Audit Trail 
check box. 

This will cause the Audit Trail dialog box to appear every time this file is 
saved in the future. 

3. If auditing is enabled and you want to enable electronic signature, select the 
Start Electronic Signature check box. 

This will cause the Electronic Signature dialog box to appear every time this 
file is saved in the future. 

4. Choose OK. 
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Using Audit Trail 
The audit trail feature creates a record of the changes made to a file. Entries in the 
audit trail are created: 

• interactively by the user when saving a file. 

• non-interactively by TotalChrom when an audited file is updated as a result of 
background processing (such as when a method is updated with a new set of 
calibration replicates as a result of batch reprocessing). 

You enable auditing on the Description tab in the Documentation dialog box. 
Auditing for a result file is automatically enabled if any of the methods used to create 
it have auditing enabled. 

Entering Audit Trail Information 
If you previously enabled auditing for a file, the Audit Trail dialog box appears every 
time you save the file or select Save As to save it under a new name. The Audit Trail 
dialog box also appears when you switch between the Method Editor and the Graphic 
Method Editor even though you may not be saving a file. This dialog box cannot be 
opened manually by any menu command or button. 

Your application manager may have set up the system so that you must select a 
reason in the Audit Trail dialog box before you can continue. 

 



 Using Audit Trail 

TotalChrom Basics 2-11 

 To enter information in the Audit Trail dialog box: 

1. Select a reason for the change(s) from the Reason list. 

There is a global list plus a supplementary list for each job type. A 
composite list appears for a each user based on their job type. 

2. Enter any information about the change(s) you made to the file in the 
Comment text box. 

3. If you are saving the existing file as a new file (Save As), select Retain 
Audit Trail Information if you want to copy the Audit Trail information 
from the existing file to the new file and have auditing enabled in the new 
file. 

4. If you are saving the existing file as a new file (Save As), select Retain 
Electronic Signature if you want to have this feature enabled in the new file. 

5. Choose OK. 

The information you enter in the Audit Trail dialog box is saved with the file 
that you are auditing. 

Viewing the Audit Trail 
The Audit Trail tab in the Documentation dialog box displays a history of changes 
made to the audited file, including an indication that electronic signature was verified 
(if it is enabled). It appears when you choose Audit Trail from the File menu. You 
cannot edit the information in this tab. 

 To view the Audit Trail: 

1. Choose Audit Trail from the File menu. 
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2. Select an audit trail record from the list on the left, and review its details on 
the right. 

3. When you are finished viewing the information, choose OK. 

Printing the Audit Trail 
TotalChrom applications display a print options dialog box when you choose Print 
from the File menu. This dialog box includes an option to print the Audit Trail for the 
current file. 
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Using Electronic Signature 
The electronic signature feature forces a user who saves a file to enter the 
TotalChrom password that corresponds to the logged on user. The electronic 
signature feature of TotalChrom is provided to assist in satisfying the requirements of 
FDA Final Rule in 21 CFR 11. 

Electronic signature works in conjunction with audit trail; you can enable electronic 
signature only on files for which audit trail has been enabled. Once electronic 
signature has been enabled for a file, it cannot be turned off. 

Electronic signature makes the following entries in the audit trail: 

• When electronic signature is enabled for an file, an entry is made in the audit trail 
to record the fact that signature requirement has been started. 

• When a user enters the correct password for a file that has electronic signature 
enabled, the audit trail entry for the transaction will show that the electronic 
signature was verified. 

Starting Electronic Signature 
You start electronic signature on the Description tab in the Documentation dialog 
box. You can do this either at the time you create a file or later. Your application 
manager may have set up this option so that the Start Electronic Signature check box 
is always selected and unavailable. 

 To start electronic signature: 

1. On the Description tab in the Documentation dialog box, enable Start Audit 
Trail if necessary. 

2. Select the Start Electronic Signature check box. 
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Entering Your Electronic Signature 
When you save a file that has electronic signature enabled, you must enter your 
TotalChrom password after you complete the Audit Trail dialog box in order to save 
the file. 

 To enter your electronic signature: 

1. In the Electronic Signature dialog box, enter your TotalChrom password. 

The entry in the User Name field is the name of the current user. The 
password must correspond to this name. 

2. Choose OK. 

Retaining the Requirement for Electronic Signature on a New File 
When you use Save As to create a new file from a file that has electronic signature 
enabled, you have the option to retain the requirement for electronic signature for the 
new file. 

 To retain electronic signature: 

• In the Audit Trail dialog box, leave Retain Electronic Signature selected. 
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Selecting an Instrument 
Use the Instrument Selection panel in the Navigator to select an instrument. The 
panel also appears in other applications whenever you have to select an instrument. 

In the Method Editor, access the panel by choosing Name from the Instrument menu. 
In the Sequence Editor, choose Global Parameters from the Change menu. Then click 
the … button to the right of the Instrument list. 

The Instruments That You Can Select 
You have access to instruments for which you have rights as assigned by your 
application manager. To change your access level to different instruments, see your 
application manager. 

Using the Instrument Selection Panel 
The Instrument Selection panel shows up to eight configured instruments to which 
you have access. 

 

Selecting an instrument in the Navigator sets the entire Navigator to reflect the status 
of that instrument. The Status button shows current data for the instrument, and if you 
start a TotalChrom application, it will open with that instrument as the focus. For 
example, if you click the Real-Time Plot button, any plots that appear will reflect 
activity at the selected instrument. 
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Using TotalChrom Toolbars and Status Bars 
Many TotalChrom applications have a toolbar with buttons that give you quick access 
to commonly used commands. When you point to a toolbar button, a tool tip will 
appear beneath the button as well as a definition in the status bar at the lower edge of 
the window. 

A status bar appears at the bottom of many TotalChrom windows and dialog boxes. 
The status bar displays a short Help message explaining the function of the command 
you highlight in a menu or the button that the mouse is positioned over. In dialog 
boxes, it displays field lengths and allowable values that you can enter for the 
selected field. 

The status bar is displayed in dialog boxes and is displayed by default in application 
windows. Some applications let you hide the main status bar by choosing the Status 
Bar command on the View menu. 
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Chapter 3 
Configuring TotalChrom 

 

This chapter explains how to use the Configuration program to set up your 
instruments and set user options such as which screen colors to use and what 
information to include in the screen display. 

Throughout this chapter, and in other parts of the manual, the name AutoSystem refers 
to both the AutoSystem GC and the AutoSystem XL GC. Also, 900 Series refers to                          
the NCI 901/902, the 900 Series, and the 900A Series Intelligent Interfaces.  

To learn about: Go to page: 

The Configuration Editor ..................................................................................3-2 

Configuring Instruments ...................................................................................3-4 

Configuring a 900 Series Interface ...................................................................3-4 

Configuring a 600 Series LINK Interface and Attached Instruments ...............3-9 

Configuring User Options...............................................................................3-17 

Printing Configuration Information ................................................................3-25 
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The Configuration Editor 
The Configuration Editor lets you edit configuration data for those instruments and 
interfaces to which your application manager has given you access. 

 To open the Configuration Editor: 

• In the Navigator, choose Configuration from the Build menu. 

The Configuration Editor appears. 

 

Summary List 
The Configuration Editor Summary list shows all instruments defined in the System 
Configuration program and includes the following data: 

Name ⎯ Your name for this particular instrument. 

Location — Where the instrument is installed. 

Type ⎯ The instrument model or type. 

Acq. Port — The physical data acquisition port to which the interface is connected. 

LINK Port ⎯ The physical port to which the instrument is connected. This applies 
only to instruments that are connected through a 600 Series LINK interface. 

Configured ⎯ Displays YES if you have provided all the information TotalChrom 
needs to configure the instrument. Otherwise, the status is NO. 
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IPM ⎯ Shows whether or not the Instrument Personality Module (IPM) for this 
device has been downloaded. This applies only to instruments connected through a 
600 Series LINK interface. 

The area below the list displays key information about the currently selected 
instrument.  

On the left is information about the interface (900 Series or LINK) including the type 
(model number), EPROM version number, memory size assigned to the instrument 
(in bytes), and serial number. On the right (for LINK-controlled instruments) is a 
summary of the chromatograph's configuration and any attached autosampler. 

Menus 
The Configuration Editor includes the following menus: 

File Menu 
Lets you set up and print the current instrument configuration file; refresh the view of 
the system configuration, preview a print job, and exit the Configuration Editor to 
return to the Navigator. 

Instrument Menu 
Lets you configure all instruments connected to your computer for which you have 
permission, disconnect instruments, and reset channel run counters. 

Interface Menu 
Lets you configure a physical LINK. 

User Menu 

Lets you define the font style and size for plot labels; set colors; define plot 
preferences such as whether or not to display the reference chromatogram in the 
Graphic Method Editor; define “quick paths” to locations for storing data; and set a 
Project Directory. 

Options set here apply only to the local TotalChrom workstation. 
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Configuring Instruments 
You can configure instruments for which you have access as set up by your 
application manager. The instruments must be turned on and physically connected to 
a valid data acquisition port.  

This section includes the following topics: 

• Configuring a 900 Series Interface 

• Configuring a 600 Series LINK Interface and Attached Instruments 

• Resetting a LINK Configuration 

• Disconnecting Instruments 

• Using Run counters. 

Configuring a 900 Series Interface 
The 900 Series Interface is an analog-to-digital converter: it converts the analog 
signal (voltage) from a chromatographic detector into digital values that TotalChrom 
can then store, analyze, and plot. 

You define how TotalChrom acquires data from detectors connected to a 900 Series 
interface in the instrument section of the method. These parameters include the 
sampling rate, run time, channel, and relay-timed events you want to occur during a 
run. (Timed events cause relays in the interface to switch, triggering an outside event, 
such as a valve switch on a chromatograph.) For more detailed information, refer to 
Chapter 12. 

There are five steps to configuring a 900 Series interface: 

• Choose a data acquisition port. 

• Set A/D configuration options. 

• If necessary, configure an autosampler. 

• Save the configuration. 

Each step is described in a separate procedure. 

 To choose a data acquisition port: 

1. In the Navigator, choose Configuration from the Build menu to open the 
Configuration Editor. 

2.  Select the 900 Series Interface you want to configure and choose Configure 
from the Instrument menu. 
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3.  If the interface is not configured, the Acquisition Port dialog box opens. 

 

4.  Click the + marks to expand the tree and select the data acquisition port to 
which the interface is physically connected. 

When a port is highlighted, you can click Query Port For Type to see which 
type of interface is connected to it.  

 To set A/D configuration options: 

1. Choose Continue. 

The A/D (Analog-to-Digital) Configuration dialog box appears and shows 
the selected instrument name. 

 

2. Enter a new name in the Instrument Name text box if you want this 
instrument to have a name other than its default name.  
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3. If you have an autosampler, follow the procedure, “To configure an 
autosampler.”  

 Otherwise, go to the final procedure, “To save the configuration.”  

 To configure an autosampler: 

Some autosamplers are equipped to communicate the rack and/or vial 
numbers of each injection. TotalChrom can store this information in the raw 
data file with the chromatographic data from the injection and include it in 
the header of each report that is printed after data analysis. 

TotalChrom can interpret the coded rack and/or vial numbers from a long 
list of autosamplers. However, if the autosampler you are using does not 
appear in the A/D Configuration dialog box, you can choose Other Type and 
manually enter the information needed to interpret rack and vial codes. To 
read the rack and/or vial numbers, you must have the correct cable for the 
make and model of autosampler connected to your 900 Series Interface. 

1. From the Autosamplers list in the A/D Configuration dialog box, select the 
type of autosampler that is connected to the 900 Series interface. 

 

Selecting the autosampler name changes the information in the Rack/Vial 
Mask Info area of the dialog box. These values are preset and cannot be 
changed. The Autosampler Code shows which device is selected. 

2.  If your autosampler was listed, skip steps 3 through 6 and go to the 
following “To save the configuration” procedure. 

 OR 

 If the autosampler was not listed, choose Other Type from the top of the 
Autosamplers list. 
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All of the options in the A/D Configuration dialog box become available. 
You may need to refer to the manual that came with your autosampler to 
complete this information. 

3. Select Positive or Negative as the appropriate Logic Sign. 

4. Select Binary or BCD (binary coded decimal) as the Logic Type. 

5. Specify the Number Of Vial Bits by entering the number or clicking on the 
up or down arrows. 

This is the number of binary digits, or signal lines, that are sent to represent 
a vial number. The options are 1 through 8, indicating how many of pins 1 
through 8 on the 900 Series Interface will receive vial information. 

6. Specify the Number Of Rack Bits. 

This is the number of binary digits, or signal lines, that are sent to represent 
a rack number. The options are 0 through 6, indicating how many of pins 9 
through 14 on the 900 Series Interface will receive rack information. 

For more details, refer to the 900 Series Intelligent Interface Operator's 
Manual. 

As you enter the rack and vial information, you will see the Autosampler 
Code change. These codes have the format “abnnmm” where: 

a    = N or P, designating negative (N) or positive (P) logic 

b    =  B or D, designating binary (B) or BCD (D) coded logic 

nn  = 1 through 8, designating the number of vial bits in base-4 format 

mm = 0 through 6, designating the number of rack bits in base-4 format 

You can revert to the original settings in the dialog box at any time by 
choosing Reset. 

 To save the configuration: 

• Choose Finish. 

TotalChrom creates a configuration file (.CFG) for the instrument. In the 
Configuration Editor Summary list, YES appears in the Configured column. 
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 To set Post-Sequence Options: 

1. Select Post Sequence from the Instrument menu in the Configuration Editor. 

 

Post Sequence Options appears: 

 

2. Select a Post Sequence Action and choose OK. 

• Selecting Clear Setup will leave the instrument uninitialized at the end 
of the sequence. No other options in the Post Sequence Options tab will 
be available. This is the only action available for a bracketed sequence. 

• Selecting Use Last Active Method From The Sequence will leave the 
instrument set up with the last-used method. No other options in the 
Post Sequence Options tab will be available. 

• Selecting Set Up With Specified Parameters will enable other options in 
the Post Sequence Options tab. 

For additional information, refer to Setting Post Sequence Options in  
Chapter 12. 
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Configuring a 600 Series LINK Interface and Attached Instruments 
The 600 Series LINK interface lets you control instruments as well as acquire data. A 
LINK interface can support one LC or up to a maximum of three GCs. LINK 
Interfaces have no analog-to-digital conversion function.  

Note the following exceptions: 

• You cannot configure an AutoSystem with Headspace and a different type of GC 
on the same LINK.  

• An LC pump module must connect to Port A and the data source (either a 
detector with digital output or a 900 Series interface) must connect to Port B. If 
used, an ISS-200 or Series 200 autosampler must connect to Port C.  

• A Model 7673 autosampler connected to an HP5890 Series II GC must appear on 
the port immediately following the HP5890. 

The following procedures explain how to configure LINK-controlled GC and LC 
instruments. These procedures assume that the instrument has not previously been 
configured.  

Configuring a LINK-controlled Instrument 
There are four steps to configuring a LINK-controlled instrument for the first time: 

• Choose a data acquisition port. 

• Set LINK configuration options. 

• Set GC or LC configuration options. 

• Save the configuration. 

Each step is described in a separate procedure. 

 To choose a data acquisition port: 

1. In the Navigator, choose Configuration from the Build menu. 

The Configuration Editor opens, which shows the instruments that are 
connected and turned on. 

2.  Select the instrument you want to configure. 
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3.  Choose Configure from the Instrument menu.  

 The Acquisition Port dialog box opens. 

 

4. Click the + marks to expand the tree and select the data acquisition port to 
which the interface is physically connected. 

When a port is highlighted, you can click Query Port For Type to see which 
type of interface is connected to it.  

5. Choose Continue.  

The LINK Configuration dialog box opens. 
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 To set LINK configuration options: 

1. Select a LINK port for the instrument. 

2. Select the Instrument Module that is physically connected to this port in the 
Instrument Module list and a Detector Module and Autosampler Module if 
applicable. 

The LINK port becomes unselectable and any detector and autosampler 
selected will occupy the subsequent available LINK ports.  

3. Select the instrument names to configure additional instruments on 
remaining LINK ports. 

If you make a mistake, choose < Back to return to the Acquisition Port 
dialog box. Choosing Restart disconnects any configured instruments and 
clears all ports on the LINK.  

 Choosing Reset clears all the changes to this dialog box and returns it to the 
state it was in before it opened. 

 To set GC configuration options: 

1. In the LINK Configuration dialog box, choose the Configure button next to 
the port selection. 

The GC Configuration dialog box appears. The settings available for each 
option vary depending on the instrument you are using.  

 

2. To rename the instrument to something other than its default name, enter the 
new name in the Name text box. 
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3.  You can configure GCs three different ways: 

• Choose Query Inst For Config to let TotalChrom configure the 
instrument automatically. This method avoids problems which may arise 
because of the complexity of the AutoSystem and HP 6890 
configurations. You can use this option if the instrument's IPM has 
already been downloaded to the LINK. 

• Choose Copy Inst Config to use the configuration data from a similar 
instrument. A dialog box will appear that lists configured instruments 
from which you can copy configuration data. You can then edit the 
configuration as needed. 

• Configure the instrument manually by following steps 4 through 14. 

After configuration, TotalChrom will download the Instrument Personality 
Module (IPM) for the instrument. 

4. Under Options, select whether or not you have PPC (Programmable 
Pneumatic Control) installed. 

Selecting YES makes available the other PPC options in the dialog box. 
Select Gas Leak Alarm if you want to be alerted of a gas leak within an 
instrument under PPC control. 

5. Under Inlets, select the Injector setting that matches your instrument for 
Channel A and/or B. 

6. If the instrument has valves, select the valve type for each valve. 

(The PPC split vents will be configured automatically.) 

7. Under Detectors, select PPC for detector A and/or B (if PPC is installed), 
then select the Detector, Mode, and Output settings that match your 
instrument for Channel A and/or B. 

8. Under Carrier Pneumatics, select the Pressure Units and other options. 

9. Select a setting for Carrier A. The available settings depend on which type 
of instrument you have. 

PVel — denotes programmable linear velocity operation. This option is 
only available for CAP and PSSx injectors in Cap Control Mode. (You enter 
the average values for capillary column linear velocity in the method, as well 
as values for column dimensions and vacuum compensation.) 

CFlow — denotes operation at a constant flow rate. (Enter pressure values 
in the method.) The pressure is varied by the GC to maintain a constant mass 
flow rate through the column as the oven temperature changes. This mode 
does not require you to enter column dimensions in the method. 
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PFlow —denotes programmable flow operation. (Enter flow values in the 
method.) 

Press — indicates direct pressure programmable control in the pressure 
units you select. 

IFlow — denotes constant flow operation. (Enter flow values in the 
method.) 

10. If appropriate, repeat the process for Carrier B. 

11. Under Auxiliary Pneumatics, select PPC for any auxiliary zone that has a 
PPC controller installed. 

12. Select the settings to control pressure or flow of the auxiliary zone(s). 

13. Choose OK. 

A check mark in the LINK Configuration dialog box indicates that the 
instrument has been configured. 

 To set LC configuration options: 

1. In the LINK Configuration dialog box, choose the Configure button next to 
the port selection. 

The LC Configuration dialog box appears. The settings available for each 
option vary depending on the instrument you are using.  

 

2. To rename the instrument to something other than its default name, enter the 
new name in the Instrument Name text box. 

3.  Select a setting for each option that is active for your instrument. 
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4.  If you are configuring an LC and you are using a 900 Series interface to 
communicate with an autosampler, choose R/V Decode (rack/vial decode) to 
set autosampler options. See the To Set A/D Configuration Options 
procedure in Configuring a 900 Series Interface on page 3-4. 

5. Choose OK to return to the LINK Configuration dialog box. 

 To save the configuration: 

1. Choose Finish in the LINK Configuration dialog box. 

TotalChrom creates a configuration file (.CFG) for each instrument and 
downloads the IPM. All IPMs available to you are installed during the 
TotalChrom installation process. If TotalChrom cannot find an appropriate 
IPM, consult your application manager. 

When you first configure a LINK-controlled instrument, a dialog box similar 
to the following appears asking if you want to check communication for the 
instrument. 

 
2. If the named instrument is connected and turned on, choose Yes. 

TotalChrom will attempt to check the physical connection with the 
instrument by taking, and then releasing, control of the instrument.  

The Confirm Configuration message box appears with AutoSystem and  
HP 6890 devices. 

3. Choose Yes to compare the configuration options you selected with those 
that are being reported by the instrument. 

If the two do not match, a message box appears.  

4. Choose Yes to modify the configuration settings in TotalChrom so that they 
match those of the instrument. 

When TotalChrom is finished, the Configuration Editor appears.  

YES appears in the Configured column if an instrument is adequately configured. If 
NO appears, you need to complete the configuration options for the instrument before 
you can acquire data. 
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Resetting a LINK Configuration 
A severe incompatibility between a LINK’s physical configuration and the logical 
configuration as defined by the Configuration program may result from moving the 
LINK or other reasons. The Reset LINK command from the Interface menu lets you 
clear the LINK of all IPM and instrument and port configuration data. 

 To clear a LINK of all configuration data: 

1. Select the LINK interface in the Configuration Editor. 

2.  Choose Reset LINK from the Interface menu. 

Any existing configuration data in the LINK will be erased and you must reconfigure 
the LINK. 

Disconnecting an Instrument 
Before you make any physical changes to an instrument, you should disconnect it 
from the system by choosing Disconnect from the Instrument menu. 

Using Run Counters 
Run counters count the number of runs made on each channel of an instrument.The 
current number of runs for each instrument is displayed in the Interface group box on 
the Configuration Editor screen. The configuration printout includes these values in 
the instrument table. 

 

 To reset a run counter: 

1. Select the Reset Run Counter or Reset All Run Counters command on the 
Instrument menu. 
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The following dialog box opens. 

 
2. Select the channel counter you wish to reset, then choose Reset. 

The following appears. 

 

3.  Choose Yes to reset the counter. 
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Configuring User Options 
The User menu in the Configuration Editor lets you define the font style and size for 
plot labels; set colors; define plot preferences such as whether or not to display the 
reference chromatogram in the Graphic Method Editor; define a set of often-used 
paths for quick access to files; select the reporting program to review your data; and 
set a Project Directory. 

User options apply only to the local TotalChrom workstation. 

Fonts 
The Fonts dialog box lets you choose the typeface, style, and size of text that will 
appear in different TotalChrom functions such as reports, the user interface, and 
displayed and printed plots. The different TotalChrom functions are listed in the 
Select Font For selection box.  

Typefaces, font styles, and font sizes are limited by the capability of the target printer 
or plotter. For example, only printers and plotters that can scale fonts produce labels 
that match non-default requested sizes. Wherever possible, TotalChrom uses default 
printer fonts. 

 To select a font: 

1. Choose Fonts from the User menu. 

 

2. Select where you want to use the font in the Select Font For selection box. 

3. Select a font, style, and size of text. 

4.  Choose OK. 

Choose Apply to make the changes and select other fonts without closing the 
dialog box. 
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Colors 
The Colors dialog box controls which colors appear in the chromatogram display, on 
calibration plots, and in the screens that display summaries of configuration and 
method information.  

 To define the colors that appear on screen and on printed plots: 

1. Choose Colors in the Configuration Editor to open the Colors dialog box. 

 

2.  Select the feature in TotalChrom for which you want to change colors. 

 

• Chromatogram Colors ⎯ Defines the colors of the chromatogram 
display in the Graphic Method Editor, Reprocess Results, and Real-
Time Plot windows; the background and annotation colors in the 
Chromatograms window; and the output colors (if you are using a color 
printer). 

• Multiplot Colors ⎯ Defines the colors that appear in one or more 
chromatograms in the Chromatograms window, which allows you to 
compare multiple plots. It also defines the color of the reference chro-
matogram in the Graphic Method Editor and Reprocess Results 
windows. 
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• Calibration Plot Colors ⎯ Defines the colors used in calibration 
curves, which appear in the calibration section of the method and in the 
Fit Analysis window. 

• Summary Screen Colors ⎯ Defines which colors appear in the 
Method Editor screen. 

3.  Select the specific display element whose color you want to change. 

 

The list of items in the Color Selection list box changes depending on the 
option you select above it. To change the color of a particular item, you 
select it and then adjust the Hue, Saturation, and/or Luminosity. 

4. Change the hue, saturation, and/or luminosity by dragging the scroll box or 
clicking on one of the scroll arrows until the screen element is the desired 
color. 

 

• Hue — Represents the item's basic color, such as red, orange, or blue. 

• Saturation — Determines how dark or light the hue is. A saturation 
level of zero (scroll box positioned at the extreme left) means that none 
of the selected hue will be used, thus leaving the color white. When the 
scroll box is at the extreme right, the hue is at its maximum saturation. 

• Luminosity — Affects how bright the color is by adding more or less 
black. When the scroll box is at the extreme left, the color is black. 
When the scroll box is at the extreme right, the color is at its brightest 
with no black. 

5. Change the color of each item in the list, as needed, until you are satisfied 
with the overall effect. 

Choosing Reset returns the colors to what they were when you first opened 
the dialog box. 

6. Select the next element whose colors you want to change and repeat steps 4 
and 5. 

7. Choose OK to save the color configuration. 
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Plot Options 
The Plot command in the Options menu controls a variety of features related to how 
TotalChrom displays and prints chromatograms. Plot settings include: 

• Whether or not to autoscale the chromatogram. 

• To include or exclude header information on the printed output. 

• Whether or not to display the reference chromatogram in the Graphic Method 
Editor and Reprocess Results windows, and if so, its size. 

• The default plotting style you want to use. 

You define which labels you want to appear on the plot in the processing section of 
the method. Refer to Chapter 7, “Developing Processing Parameters in the Method.” 

 To configure plot options: 

1. In the Configuration Editor, choose Plot from the Options menu. 

 

2. Deselect Autoscale Plots By Default to disable this feature. 

Autoscaling automatically scales the chromatogram so that the tallest peak 
extends from the bottom of the window to the top. Other peaks are scaled in 
proportion to the tallest peak. 

If you deselect autoscaling, a dialog box appears each time you load a new 
file in the Graphic Method Editor and Reprocess Results windows. The 
dialog box allows you to scale the chromatogram manually by entering 
minimum and maximum values for each axis. 

3. Select Header On All Replot Pages to print the header on all pages, or leave 
it unselected to print the header on the first page only. 

The header appears at the top of the printed plot. This applies to replots 
generated automatically at the end of a run. 
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4. Leave Show Reference Chromatogram selected if you want to display both 
the reference and working chromatograms in the Graphic Method Editor and 
Reprocess Results windows. 

The Reference Chromatogram Size text box becomes active. 

5 Use the scroll arrows to change the reference chromatogram size. 

The percentage of the screen the reference chromatogram occupies can be 
between 5% and 50%.  

6. Under Plotting Style, select whether you want the chromatogram to appear 
by default as Line Segments, Data Points, or Bunched Points in the Graphic 
Method Editor and Reprocess Results windows. 

You can also change the plotting style from within these windows. Note that 
these are display modes only and have no effect on data analysis or printed 
chromatograms. 

Line Segments — Displays chromatograms as a series of line segments 
connecting each raw data point.  

Data Points — Displays chromatograms as a series of unconnected raw data 
points. 

Bunched Points — Displays chromatograms as a series of raw data points 
and includes bunched points. Bunched points are calculated points 
representing the average of every n raw data point, where n is the bunching 
factor. Displaying bunched points allows you to see the actual data values 
TotalChrom used when detecting peaks in the chromatogram. 

7. Choose OK to close the Plot dialog box. 

Quick Paths 
You can configure TotalChrom so that file open, file selection, and file save dialog 
boxes display a preset list of up to 20 commonly used paths. This feature lets you 
quickly choose a path instead of scrolling and clicking through a complicated file 
hierarchy with the default Windows file-selection method. 

 To add a path to the Quick Paths list: 

1. In the Configuration Editor, choose Quick Paths from the User menu. 
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The Quick Paths dialog box opens and displays the current quick paths. 

 

2. Choose Add. 

The TotalChrom Path-Select dialog box opens. 

 

3. Select a path and choose OK. 

TotalChrom will add the path as a quick path and list it in the Quick Paths 
dialog. 

 To insert a path in the Quick Paths list: 

1. In the Configuration Editor, choose Quick Paths from the User menu. 

2. In the Quick Paths dialog, highlight the path above which you want to insert 
a new quick path. 

3. Choose Insert. 
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The TotalChrom Path Select dialog box appears. 

4. Select a path and choose Select. 

TotalChrom will add the path as a quick path and list it in the Quick Paths 
dialog. 

 To remove all paths from the Quick Paths list: 

1. In the Configuration Editor, choose Quick Paths from the User menu. 

2. In the Quick Paths dialog, choose Clear. 

3.  TotalChrom will remove all paths from the Quick Paths list. If you change 
your mind, choose Reset to replace the original paths. 

Reporting 
This command opens a dialog box for you to select either TotalChrom Review and 
Approve or TcPublisher as the reporting program to review your data. 

 To select a Reporting Option: 

1. In the Configuration Editor, choose Reporting from the User menu. 

The Reporting Options dialog box opens. 

 

2. Select the Reporting program and choose OK. 

The change will be seen the next time you start TC Navigator. 

Project Directory 
This command opens a dialog box for you to type in (or select via a Path-Select 
dialog) a Project Directory setting. The Project Directory path (the default is blank), 
is used by all applications in place of all default path settings for all file types.  This 
includes all editors and Setup.  

The specified project directory is saved with other user settings and will continue to 
be used for all TotalChrom sessions of that user until a further change is made. 
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 To set a Project Directory: 

1. In the Configuration Editor, choose Project Directory from the User menu. 

The Project Directory Setup dialog box opens. 

 
2. In the Project Directory Setup dialog, click on the file folder 

The TotalChrom Path-Select dialog box appears. 

  
3. Select a path and choose OK. 

The Project Directory path displays. 
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4. Choose OK. 

Printing Configuration Information 
The Print command in the File menu lets you print a copy of the configuration 
information for each interface and instrument. Configuration information includes 
plot, compare, curve, and edit colors; font choices; options; quick paths; and, 
instrument and interface data. 
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Chapter 4 
Using the Navigator 

 

The Navigator window that appears when you start TotalChrom lets you 
perform most TotalChrom functions in a graphic, easy-to-use environment. 
Large, recognizable buttons duplicate many menu commands, and functions 
are depicted in a logical, flow-chart style. 

To learn about: Go to page: 

Starting TotalChrom .........................................................................................4-2 

The Navigator Window.....................................................................................4-3 

Navigator Buttons and Commands ...................................................................4-4 

Navigator Tasks and Other Application Tasks .................................................4-7 
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Starting TotalChrom 
Start TotalChrom and open the Navigator window by double-clicking the Navigator 
icon in the TotalChrom program group. 

 To start TotalChrom and open the Navigator window: 

1. Click the Start button, choose Programs, and open the TotalChrom folder. 

2. Double-click the TCNav icon. 

 

The TotalChrom Logon dialog box appears, unless your application manager 
has configured your system to bypass it. 

 

3. Enter or select your user name, then enter your password. 

You can change your password with the Change Password command in the 
Admin menu. 

4. Choose OK. 

The Navigator window opens after the program initializes. 
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The Navigator Window 
The Navigator window contains a graphical representation of the major functions in 
TotalChrom. This window has a panel that shows instruments configured for your 
system, groups of function buttons that give you access to TotalChrom applications, 
and a box that shows the status of instruments. 

The names on the Navigator buttons are the names of commands, and the text above 
the buttons shows the menu on which you can find each command. 

 

Like toolbar buttons, Navigator buttons represent the functions that you are likely to 
perform frequently in TotalChrom. Most buttons have a corresponding menu 
command. Some infrequently used functions have menu commands only. 

Choose a TotalChrom function by clicking a button or by choosing a command from 
a menu. When you choose a menu command, you can subsequently select which 
instrument the command will apply to. When you click a button, the command is 
carried out for the instrument that is selected in the Instrument panel. 
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Navigator Buttons and Commands 
This section describes Navigator buttons and commands in more detail. 

Instrument Panel  
This panel has two tabs: Primary, a list of up to eight instruments that you use most 
often; and All, a list of all configured instruments on your network to which your 
computer has access rights. 

When you select an instrument on either tab on this panel, other TotalChrom 
operations that you subsequently perform from the Navigator will pertain to that 
instrument. 

 

Status Box and Command 
The Status box displays the status of the instrument that is currently selected in the 
Instrument Panel. You can choose the Status command in the Status box or from the 
View menu to open the Instrument Status Window, which contains additional 
instrument status information. 
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Build Buttons and Menu 
The Sequence, Report Format, Method, and Graphic Edit buttons have corresponding 
commands on the Build menu. Use these buttons to open the Sequence Editor, TC 
Publisher, Method Editor, and Graphic Method Editor. 

        

Other commands on the Build menu open the Report Format Editor and the 
(instrument) Configuration Editor. 

Instrument Buttons and Menu 
The Setup, Hands On, and Modify buttons have corresponding commands on the 
Instrument menu. Use these buttons to set up instruments for data collection, to 
change instrument settings, and to modify an active method or sequence. Hands On 
and Modify do not become active until you set up and bind an instrument. 

     

The icon that appears on the Hands On button changes depending on the type of 
instrument that is active. 

Other commands on the Instrument menu allow you to bind and unbind instruments, 
to perform a wavelength calibration for a 785 detector, and select instruments for 
display on the primary tab in the Instrument panel. 

Run Button and Menu 
The Run button lets you control a data acquisition run. It opens the Run pop-up 
menu, which is the same as the Run menu. The Run commands also let you control 
single or multiple runs from within TotalChrom and take actions that affect LINK-
controlled instruments. 
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View Buttons and Menu 
The Details and Real-Time Plot buttons have corresponding commands on the View 
menu. Use these buttons to view detailed information about an instrument during a 
run and to display a real-time plot as an instrument is collecting data. 

   

The Status and Error Messages commands on the View menu display instrument 
status and error information. 

Reprocess Buttons and Menu 
The Results, Batch, and Summary buttons have corresponding commands on the 
Reprocess menu. Use these buttons to access the Results, Batch, and Summary 
Report applications, which pertain to data reprocessing functions. 

     

Display Buttons and Menu 
The Chromatograms, Spectra, Review or Publish buttons have corresponding 
commands on the Display menu. Use these buttons to access the Chromatograms 
application, the optional LC spectral analysis application, and the TC Publisher 
application. These applications pertain to post-run display features in TotalChrom. 

     or  

Apps Menu 
Provides access to additional applications you have installed on your system. The 
commands that appear on the Apps menu will vary depending on your system 
configuration. No Navigator buttons correspond to the Apps menu. 
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Admin Menu 
Lets you change passwords and access system configuration and administration 
functions. See the Application Manager's Guide for information about commands in 
this menu. No Navigator buttons correspond to the Admin menu. 

Navigator Tasks and Other Application Tasks 
The Navigator is both an application itself and the main point from which you start 
other TotalChrom applications. Some of the buttons and commands in the Navigator 
window perform Navigator tasks; others start other TotalChrom applications. 

This section differentiates these two aspects of the Navigator, providing a table for 
each. Each table visually maps a task to the command that invokes it and directs you 
to the area of the documentation that describes the task. 

Performing Navigator Tasks 

To perform this task: Use this button or 
command: 

For more information, 
see: 

Select an instrument 

 
Instruments 

Chapter 2 

Set up instruments for 
data analysis 

 
Instrument/Setup 

Chapter 12 

View instrument status 

 
View/Status 

Chapter 12 
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To perform this task: Use this button or 
command: 

For more information, 
see: 

View a real-time plot 

Note: Although this is a 
separate application, it 
cannot run unless the 
Navigator is running. 

 
View/Real-Time Plot 

Chapter 12 

Produce customizable, 
high quality summary and 
single-injection reports 

 
Build/Develop 

Reports 

TC Publisher Help File 

View instrument details 

Note: Although this is a 
separate application, it 
cannot run unless the 
Navigator is running. 

 
View/Details 

Chapter 12 

Control a run and affect 
instrument status 

 
Run button or menu 

Chapter 12 

Work with instruments 
interactively 

 
Instrument/Hands On 

Chapter 13 

Modify a downloaded 
method or the active 
sequence 

 
Instrument/Modify 

Chapter 13 

Change password Admin menu/Change 
Password 

Chapter 4 
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Opening Applications from the Navigator 

To open an application 
that lets you: 

Use this button or 
command: 

For more 
information, see: 

Configure instruments on 
your system 

Build/Configuration Chapter 3 

Build a chromatographic 
method 

 
Build/Method 

Chapters 5, 6, 7, and 8 

Build a report format file 

 
Build/Report Format 

Chapter 9 

Edit the method 
graphically 

 
Build/Graphic Edit 

Chapter 10 

Reprocess data graphically 

 
Reprocess/Results 

Chapter 10 

Build or edit a sequence 
file 

 
Build/Sequence 

Chapter 11 

Display and compare 
chromatograms 

 
Display/Chromatograms 

Chapter 14 
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To open an application 
that lets you: 

Use this button or 
command: 

For more 
information, see: 

Reprocess data from 
multiple runs 

 
Reprocess/Batch 

Chapter 15 

Summarize component 
data 

 
Reprocess/Summary 

Chapter 16 

View and manipulate 
spectral data with the 
optional LC spectral 
analysis application  

Spectra button 

IRIS (TurboScan) 
documents 

Start the Review and 
Approve application 

or 

 
 

Chapter 20 

Display the TC Publisher 
Report Console to enable 
you to generate reports 

 
Display/Reports 

TC Publisher Help file 

There are other applications that you access from the Apps menu. Some of these 
applications are documented in this manual; use the table of contents and index to 
locate this material. Other applications such as Results Review are documented in 
separate manuals. 

There are various administrative functions that you access from the Admin menu. 
These are documented in the Application Manager’s Guide. 
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Chapter 5 
Building a Method 

 

This chapter explains what a method is, shows how to use the Method Editor, and 
provides the general steps to build a method that meets your analytical needs. 

To learn about: Go to page: 

What is a Chromatographic Method? ...............................................................5-2 

Working with Methods .....................................................................................5-2 

Using the Method Editor...................................................................................5-3 

Reviewing Method Parameters .........................................................................5-7 

Printing Method Parameters..............................................................................5-8 

Importing Method Parameters...........................................................................5-9 
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What is a Chromatographic Method? 

A method is a collection of parameters that determine how TotalChrom acquires and 
analyzes data from your chromatography equipment, based on the specific 
requirements of your instrument and your sample. 

Every method consists of three sets of parameters: 

• Instrument Parameters — These control data acquisition. Settings include data 
channels, oven temperatures, instrument parameters, and detector settings. 

• Processing Parameters — These control data analysis. Settings include peak 
detection and integration of raw data, how reports are printed, and how replots 
are formatted. 

• Calibration Parameters — These control component information. Settings 
include component names, calibration levels, and calibration data. 

Working with Methods 
Depending on your needs, you can use the following tools and functions when 
working with methods: 

Method Editor — Allows you to access all the settings for each section of a method 
so that you can build a comprehensive method. 

This chapter provides general information about the global Method Editor tasks. For 
specific information on using the Method Editor to complete the instrument, 
processing, and calibration parameters, refer to Chapters 6, 7, and 8 respectively. 

Graphic Method Editor — Allows you to change a method and view the effect on a 
stored chromatogram instantaneously. Graphic method editing lets you optimize the 
method for an individual run. 

For information about the Graphic Method Editor, refer to Chapter 10, “Editing 
Methods and Results Graphically.” 

Quick Method —Allows you to collect data before developing a comprehensive 
method. 

For information about creating Quick Methods, refer to Chapter 12, “Acquiring and 
Viewing Data.” 
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Using the Method Editor 
Use the Method Editor for all method operations. This section describes the windows 
and menus in the Method Editor and also explains the general procedure for creating 
a method.  

Method Editor Windows 
There are two windows in the Method Editor: 

Method Summary Window —Shows the instrument, processing, and calibration 
parameter settings for the open method. The information that is displayed in the 
Method Summary window changes depending on the type of instrument you are 
using. 

Component List Window — Shows the list of components in the method, the 
component calibration information, and the calibration curve for the selected 
component. 

Method Summary Window 
There are three sections in the Method Summary window: 

Data Acquisition and Instrument Control —Shows the instrument name; run-time 
information; type of injection; and control options such as the sampling rate and the 
oven temperature or solvent gradient program depending on whether you are using an 
GC or a LC. 

The figures that follow show the instrument parameters for an AutoSystem GC and a 
LC 410 pump. 

 

 

Data Processing and Reporting —Shows the number of pages over which you want 
the replot to appear; scaling and offset values; the bunching factor, noise threshold, 



Using the Method Editor 

5-4 

and area threshold; how many timed events and user programs are included in the 
method; and how many report formats are used. 

 

Component List and Calibration —Shows the number of components that are 
identified in a sample using this method; the number of named and timed groups; the 
type of calibration you are using; and global calibration parameters. 

 

Component List Window 
There are three panes in the Component List window. The left pane shows the 
component list for the method, the middle pane shows the calibration parameters for 
the selected component, and the right pane shows the calibration curve for the 
selected component. You can change the relative size of the panes by dragging the 
dividers. 
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Method Editor Commands 

 

The Method Editor contains the following menus and commands: 

File Menu 
Lets you create, open, save, and print method files; import the method parameters 
saved in other files; enter and review documentation about a method; review method 
parameters; and exit the Method Editor. 

Instrument Menu 
Lets you define and edit various instrument parameters for a method; enter file header 
information; set the scale for the real-time plot; and define control options for the 
chosen instrument. 

Process Menu 
Lets you define and edit processing parameters such as peak detection and 
integration; identify different report formats to use; set up replot characteristics; and 
set up user programs. 

Components Menu 
Lets you set default parameters; perform various tasks with components; and load and 
merge the components from text, result, or other method files. 

Setup Command 
Lets you switch to the Setup dialog box in the Navigator. 

Other Menu 
Lets you switch to other TotalChrom applications such as the Graphic Method Editor 
or the Sequence Editor without returning to the Navigator. 

In addition to showing Help text for each command and field that you select, the 
status bar at the bottom of the window displays the word “MODIFIED” if you change 
any part of the open method. 
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General Procedure for Creating a Method 
This section contains the general procedure for creating a new method. You can also 
create a new method by editing an existing method file and renaming it with the Save 
As command. Another option for building a method is to import parameters from a 
result file or from methods created with older versions of TotalChrom (prior to 
Version 4.0). For information, refer to “Importing Method Parameters” on page 5-9. 

When you create a new method, TotalChrom opens a series of dialog boxes in 
succession. These dialog boxes contain instrument, processing, and calibration 
parameters, respectively. You can stop this automated display of dialog boxes by 
choosing Cancel in any of the dialog boxes. 

 To create a new method: 

1. Do one of the following: 

• In the Navigator, choose Method from the Build menu or click the Method 
button, select Create New Method in the Startup dialog box, and choose 
OK. (Your application manager may have disabled the display of the 
Startup dialog box.) 

 

• If the Method Editor is already open, choose New from the File menu. 

2. Complete each dialog box that is displayed, choosing OK to go to the next 
one. Refer to Chapters 6, 7, and 8 for procedures. 

3. When you are finished developing the method, choose Save from the  
File menu. 

The Documentation dialog box opens. 

4. Complete the Description tab in the Documentation dialog box and choose OK. 

For a discussion about entering descriptive information about a file, refer to 
Chapter 2, “TotalChrom Basics.” 

The TotalChrom File Save As dialog box opens. 

5. Enter a name for the method in the File Name text box and choose Save. 

The dialog box closes, and the new method name appears in the title bar. 
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6. When you are finished working in the Method Editor, choose Exit from the 
File menu. 

Alternatively, you can choose from the Other menu to go directly to another 
application. 

Opening a Method Referenced in a Sequence File 
You can open an existing method directly, or you can open it through a sequence in 
which it is used. 

 To open a method referenced in a sequence file: 

1. In the Method Editor, choose Open from the File menu. 

2. In the TotalChrom File-Open dialog box, select Sequence Files (*.seq) from 
the Files Of Type list and select a sequence. 

3. Under Method Source, enter the number of the cycle that specifies the 
method you want to open. 

If that cycle includes different methods for instrument, processing, and/or 
component parameters, TotalChrom loads the instrument method. 

Reviewing Method Parameters 
You can review the parameters in the instrument, processing, and calibration sections 
of the method sequentially by using the Review command in the File menu. This 
command opens each of the method dialog boxes in succession, allowing you to 
easily review and edit parameters. 

 To review all of the parameters in a method: 

1. Choose Review from the File menu. 

2. For all dialogs boxes other than the Instrument Name dialog, after reviewing 
or making any changes in each dialog box, choose Next to go to the next 
dialog box in the series or Back to go to the previous one. 
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Printing Method Parameters 
You can print either the specific parameters from a method file or the summary 
information for a method by using the File menu Print, Print Preview, or Print 
Summary commands. Two print-related dialog boxes will appear when you select 
Print: one for method parameter options and one for standard Windows printing 
options. 

 To print the parameters from the method: 

1. Choose Print from the File menu to open the Print Options dialog box. 

  

2. Select the data you want to print and choose OK. 

3. Make any changes in the Print dialog box and choose OK. 

 To print summary information for a method: 

1. Choose Print Summary from the File menu to open the Print dialog box. 

2. Make any changes in the Print dialog box and choose OK. 



 Importing Method Parameters 

Building a Method 5-9 

Importing Method Parameters 
When TotalChrom collects and processes data and creates a result file, the method 
parameters used to create the results are stored with the result file. Because a 
sequence can specify different methods for instrument, processing, and calibration, 
the method parameters stored in a result file can represent sections from different 
methods. 

You can use the Import command in the File menu to import the method parameters 
stored in a result file. You may also import parameters from instrument, process, and 
sample files created in older versions of TotalChrom (prior to Version 4.0). 

When a method that is embedded in an imported result file has auditing enabled, then 
auditing is also enabled for the method into which you import the file. 

 To import method parameters from other files: 

1. Choose Import from the File menu. 

2. In the TotalChrom File Open dialog box, select the file type that you are 
looking for: .RST for result, .INS for instrument, .PRC for processing, or 
.SMP for calibration files. 

3. Locate and select the file whose parameters you want to use and choose 
Open. 

TotalChrom replaces the values in the method with those from the imported 
file. 
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Chapter 6 
Developing Instrument Parameters 

in the Method 
 

This chapter explains how to use the Method Editor to set instrument parameters in 
the method. For general information about using the Method Editor, refer to 
Chapter 5, “Building a Method.” 

To learn about: Go to page: 

Introduction to Instrument Parameters..............................................................6-2 

Selecting the Instrument....................................................................................6-3 

Creating Instrument Notes ................................................................................6-4 

Setting Data Channels.......................................................................................6-6 

Setting the Real-Time Plot Scale ....................................................................6-10 

Setting Control Options ..................................................................................6-11 

Creating Derivatization and Dilution Programs 
(Series 200 Autosamplers Only) .....................................................................6-38 
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Introduction to Instrument Parameters 
Instrument parameters affect how TotalChrom acquires and analyzes data by 
controlling settings for the chromatographic instruments that you can access from 
your system. These parameters include data channel, oven temperature, valve settings 
and carrier pressure, solvent composition, pump flow rate, detector settings, and 
others. The values that you set pertain only to the selected instrument and method. 

During data acquisition, TotalChrom uses the values in the instrument section of the 
method to control data sampling, the plotting of real-time data, and the creation of 
raw data files. 

Set instrument parameters using the commands in the Instrument menu in the Method 
Editor. The specific parameters that you can access depend on the instrument that you 
select. 

 

Name command ⎯ Displays a list of all instruments you can access. The instrument 
that you select for each method determines which commands and dialog box options 
are available. 

Notes command ⎯ Lets you describe the instrument type and model, the column 
type and length, and other settings. You can enter your own text or use predefined 
templates that match different instrument types. This information has no effect on 
data analysis; it only appears in the header of printed reports. 

Data Channels command ⎯ Controls how TotalChrom acquires analog and digital 
data by letting you set the channel and sampling rate for data collection. 

Real-Time Plot Scale command ⎯ Lets you define plot offset and scaling values as 
well as graphic display characteristics for the real-time plot. 

Control Options command ⎯ Opens a submenu that lets you set a wide range of 
parameters for the current instrument including autosampler, valves, carrier, 
oven/inlets, solvent, pump, detector, and instrument timed-event options. 

The following sections describe the dialog boxes and procedures for each command. 

The options, parameters, defaults, and ranges in the dialog boxes for the instrument 
section of the method all depend on the specific instrument that you choose for the 
method. Some of the parameters described in the following tasks and figures might be 
unavailable on your system. 
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Selecting the Instrument 

The Name command in the Instrument menu displays a list of all instruments you can 
access. The instrument that you select affects which options are available through the 
other commands in the Instrument menu. 

 To select an instrument: 

1. Choose Name from the Instrument menu to open the Instrument Selection 
dialog box. 

2. From the list of configured instruments, select the instrument that you want 
to use with this method and choose OK. 

 

The Method Summary window changes to reflect the parameters associated 
with this instrument. 
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Creating Instrument Notes 

The Notes command in the Instrument menu lets you create original text or use a 
preset template to record information for the instrument section of the method. The 
information you enter has no effect on data analysis. The maximum number of 
characters allowed in the Instrument Notes field is 1641. 

To print these notes as part of the header in the analysis report, select the Instrument 
Control Parameters option in the Report Format Options dialog box. You access this 
dialog box in the Report Format Editor. 

 To create or edit header information: 

1. Choose Notes from the Instrument menu to open the Instrument Notes 
dialog box. 

 

2. Do one of the following:  

• Enter the header text that you want to appear in the printed reports for 
this method. To start a new line, press Enter. To erase the contents of 
the text box, choose Reset. 

• Select a template for the instrument from the Template list. 

3. If you are working with a template, edit the information as necessary. 

4. Choose OK to save your changes. 



 Creating Instrument Notes 

Developing Instrument Parameters in the Method 6-5 

 To change the template: 

1. Choose Instrument Notes from the Instrument menu. 

The Instrument Notes dialog box appears and shows any current header 
information in the text box.  

2. Select the new template type from the Template list. 

A confirmation box appears and asks if you want to erase the current header 
information. 

3. Choose OK. 

4. Edit the information or create new header text and choose OK. 
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Setting Data Channels 

The Data Channels command in the Instrument menu controls how TotalChrom 
acquires analog and digital data by letting you set the channel or channels for data 
collection, the data sampling rate, and the analysis run time. The options available on 
the Data Channels tab depend on the type of instrument that you are using. 

 To set channel options for a LINK-controlled instrument: 

1. Choose Data Channels from the Instrument menu to open the Data 
Acquisition dialog box with the Data Channels tab selected. 

 

Series 200 DAD: The Data Channels dialog has a slightly different configuration 
for a Series 200 DAD detector, but the name and function of the available controls 
is the same as those described in this procedure. 

Series 200 UV/VIS: The Data Acquisition dialog screen for the Series 200 
UV/VIS uses the standard LINK instrument layout. Since only a single channel is 
available with the Series 200 UV/VIS, Channel A is always selected and Channel 
B and the Dual radio buttons are disabled. The Source setting will always be 
Series 200 UV/VIS (the only selection available). 

2. Under Data Channel, select channel A, B, or Dual. 

3. Under Source, select a data source for one or both channels from the list of 
choices supported by this instrument. 
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4. Under Set Data Rate, do one of the following to set the rate at which the 
instrument will sample its detectors: 

• Select By Peak Width At Base, and then enter the number of seconds in 
the text box. 

• With this option, TotalChrom acquires data in terms of the width (at its 
base) of the narrowest peak that you expect to occur in the run. If you 
enter a peak width, TotalChrom calculates the optimum sampling rate 
for that peak width, collecting at least 20 data points across the peak. 

• Select By Sampling Rate, and then enter or select a rate. 

 With this option, TotalChrom acquires data from the instrument using 
the number of data points per second that you explicitly set (or the 
nearest available rate to that value). 

5. Under Data Storage, do one of the following: 

• Select Store All Data From Run to store all the data from a run. 

 TotalChrom collects and stores data for a run based on your instrument 
conditions. This option is useful if you don't know the run time because 
you haven't entered the GC oven program or LC solvent program. 

• Deselect Store All Data From Run to store only the data collected in a 
given time window.  

 You must specify the relevant times. In the Delay Time text box, enter 
the number of minutes that you want to elapse between the start of the 
run and when data analysis starts. A value entered here does not affect 
the measurement of peak retention time. In the Run Time text box enter 
the number of minutes for which you want the interface to collect data. 
Note that TotalChrom will not allow the delay time to be greater than 
the run time. 

 The number of data points value is calculated as follows: 
Data Points = RT  x SR x 60 
where RT is the run time and SR is the sampling rate. 

6. If your instrument supports the uploading of run logs, you can select Store 
Run Log to upload the run log at the end of each run.  

When you select this option, TotalChrom prints the run log as part of the 
report. 

7. Do any of the following: 

• To save your work and close the dialog box, choose OK. 

• To save your work without closing the dialog box, choose Apply. 
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• To close the dialog box and discard your changes since the last time you 
chose Apply, choose Cancel. 

 To set channel options for a 900 Series Interface: 

1. Choose Data Channels from the Instrument menu to open the Data 
Acquisition dialog box with the Data Channels tab selected. 

 

2. Under Data Channel, select channel A, B, or Dual. 

3. Select the required Voltage Range. 

The required Voltage Range depends on the magnitude of the output signal 
from the chromatograph detector. 

4. Under Set Data Rate, do one of the following to set the rate at which the 
instrument samples its detectors: 

• Select By Peak Width At Base, and then enter the number of seconds in 
the text box. 

 With this option, TotalChrom acquires data in terms of the width (at its 
base) of the narrowest peak that you expect to occur in the run. If you 
enter a peak width, TotalChrom calculates the optimum sampling rate 
for that peak width, collecting at least 20 data points across the peak. 

• Select By Sampling Rate and enter a rate in the text box. 

 With this option, TotalChrom acquires data from the instrument using 
the number of data points per second that you explicitly set (or the 
nearest available rate to that value). 
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If your power line frequency is 60 Hz, you must enter a sampling rate as follows: 

• for single- and dual-channel acquisition, a rate that is evenly divisible  
into 100. 

 For example: 10 pts/s is acceptable as entered; however, TotalChrom 
changes 12 pts/s to 12.5 pts/s. 

If your power line frequency is 50 Hz, you must enter a sampling rate as follows: 

• for single-channel acquisition, a rate that is evenly divisible into 50. 
• for dual-channel acquisition, a rate that is evenly divisible into 25. 

If necessary, TotalChrom will change your entry for sampling rate to conform to 
this requirement. This is done to prevent the excessive baseline noise that may be 
produced with certain detector grounding configurations with older, generic 
interfaces. 

5. In the Delay Time text box, enter the number of minutes that you want to 
elapse between the start of the run and when peak detection starts. 

6. In the Run Time text box, enter the number of minutes that you want the 
interface to collect data. 

Note that TotalChrom will not allow the delay time to be greater than the run 
time. 

7. Choose OK. 
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Setting the Real-Time Plot Scale 

The Real-Time Plot Scale command in the Instrument menu lets you set the scaling 
parameters that appear in the Real Time Plot window. When you acquire raw data, 
TotalChrom uses the scaling parameters in the instrument section to draw the real-
time plot. To view this plot during data acquisition, click the Real-Time Plot button in 
the Navigator. 

 To set real-time plot parameters: 

1. Choose Real-Time Plot Scale from the Instrument menu to open the Data 
Acquisition dialog box with the Real-Time Plot tab selected. 

 

The Real-Time Plot Scale tab shows the settings for Channels A and B. 
Depending on the type of instrument that you have chosen, the units for the 
plots will be either millivolts (mV) or milli-absorbance units (mAU). 

2. In the Offset text box, enter a value for the first channel being used. 

This value specifies the voltage corresponding to the bottom of the plot 
window. 

3. In the Full Scale value text box, enter a value to specify the height of the 
real-time plot. 

4. In the Number Of Pages text box, enter the number of pages (screen widths) 
over which you want to display the plot. 

5. If you are using both channels, repeat Steps 2 through 4 to set the options for 
Channel B. 
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6. Do any of the following: 

• To save your work and close the dialog box, choose OK. 
• To save your work without closing the dialog box, choose Apply. 
• To close the dialog box and discard your changes since the last time you 

chose Apply, choose Cancel. 

Setting Control Options 

The Control Options command in the Instrument menu opens a submenu that has 
additional commands for controlling your instruments. When you select a command 
from this submenu, TotalChrom opens the Instrument Control dialog box, which 
contains tabs for each major control command. 

 To set control options parameters: 

1. Choose Control Options from the Instrument menu and choose a command 
from the cascaded menu. 

The Instrument Control dialog box opens to the tab corresponding to the 
command that you selected.  

2. Select the tab for each control option that you want to complete or edit. 

3. Make any changes to the values in the dialog box and do any of the 
following: 

• To save your work and close the dialog box, choose OK. 

• To save your work without closing the dialog box, choose Apply. 

• To close the dialog box and discard your changes since the last time you 
chose Apply, choose Cancel. 

The following sections describe how to complete each of the tabs in the Instrument 
Control dialog box. The tasks for GCs and LCs are grouped in separate sections. 
However, because instrument timed events are similar for all instruments, these 
procedures are combined in “Setting Instrument Timed Events” on page 6-36. 

Setting Control Options for GCs 
If you are using a LINK-controlled GC, the possible tabs in the Instrument Control 
dialog box are:  

• Autosampler 

• Oven/Inlets 

• Carrier 

• Detectors  
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• Instrument Timed Events 

For a complete definition of each GC parameter, refer to the operating manual that 
came with the specific instrument. 

Setting GC Autosampler Parameters 

 To set autosampler parameters for gas chromatographs: 

1.  Select the Autosampler tab of the Instrument Control dialog box. 

 

2. If you are using Manual injection, select Manual or a TurboMatrix select 
TurboMatrix. 

When you select Manual or TurboMatrix all other controls are disabled. If you select 
Autosampler, the other controls are enabled or disabled according to the instrument 
type (for example, Clarus, AutoSystem, HP 6890, etc). 

 If you are using an Autosampler, continue with Steps 3 through 9. 

3. Select the Syringe Capacity for the syringe in the autosampler. 

4. Select an Injection Volume and an Injection Speed. 

The actual injection volume is set here. The sample volume that you enter in the 
sequence file is an optional mathematical correction used in quantitation.  

5. Select the number of Sample Pumps that you want to use. 
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This value specifies the number of times the syringe is filled and emptied 
before the final load. 

6. If you are injecting a viscous sample, set the Viscosity Delay. 

7. If you are using an AutoSystem GC, select the Wash/Waste Vial Set that 
you want to use. 

Wash/Waste Vial Set 1 uses vials 1 and 2. Wash/Waste Vial Set 2 uses 
Wash/Waste vials 3 and 4. 

8. If you are using an AutoSystem, select the number of Pre-Injection Solvent 
Washes that you want to have. 

This value determines how many times the syringe is washed with solvent 
before each injection. 

9. Select how many Pre-Injection Sample Washes and Post-Injection Solvent 
Washes that you want to have. 

If you are using an HP5890A, HP 5890 Series II, or an HP 6890, you can 
specify two sets of Post-Injection Washes (with solvents A and B). 

Setting GC Oven/Inlets Parameters 
The Oven/Inlets tab of the Instrument Control dialog box controls the oven 
temperature of your gas chromatograph, the rate at which the temperature increases, 
the type of coolant that you are using, and the zone setpoints for injectors and 
detectors. 

The Ovens/Inlets tab also includes a temperature curve that corresponds to the values 
that you enter in the table beneath it. The table has the following columns: 

Rate column —Represents the rate at which the oven is heated. You can create up to 
three ramps, which are periods during which the temperature increases. Ramps are in 
degrees per minute. 

Temp column —Gives the temperature to which the oven is being raised during the 
ramp. The initial setting is the temperature of the oven at the start of the run, or 
throughout the run for an isothermal analysis. 

Hold column —Represents the period for which the temperature is held before 
starting the next ramp. 

The Initial Rate field is always 0.0 and you cannot edit this field. To edit the other 
fields, click in the field and then enter a value. The Temperature and Hold fields are 
disabled until you set the Rate. You can also adjust the Temperature and Hold values 
by dragging the corresponding points on the curve to the desired position. 
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 To set oven temperature and zone parameters: 

1. Select the Oven/Inlets tab of the Instrument Control dialog box.  

 

2. From the available program tabs under the table, choose the tab for the 
temperature program that you want to edit. 

The curve for the program that you select appears as a solid line. The curves 
for all other programs appear as dashed lines. 

3. In the Initial Temp field of the table, set the temperature for the start of the 
run. 

4. In the Initial Hold field, enter the amount of time that you want to hold the 
initial temperature. 

To hold the temperature indefinitely for most instruments, enter 999. 

5. Set the Rate, Temp, and Hold values for the other ramp levels. 

The time value under Program Time changes to reflect the time that is 
required to complete the temperature program. 

6. You can also change the values directly on the curve by dragging the points 
associated with each ramp level. When you release the points after dragging, 
the new values appear in the table. 

• To change the rate of a level, select the point that represents the 
temperature and drag it horizontally. 



 Setting Control Options 

Developing Instrument Parameters in the Method 6-15 

• To change the temperature value of a level, select the point that 
represents the temperature and drag it vertically.  

• To change the hold time duration of a level, select the point that 
represents the time and drag it horizontally. 

7. Under Cryo, select the type of subambient cooling that you want to use, or 
set Coolant to Off. 

8. If you are using sub-ambient cooling, enter the values for the cryogenic 
cut-in temperature and the oven timeout in the respective text boxes. 

9. Under Oven, enter the maximum oven temperature allowed. 

TotalChrom will not allow any temperature in the table to be greater than 
this value. 

10. In the Equil Time text box, enter the number of minutes that you want the 
oven to equilibrate at the initial temperature before it becomes READY. 

11. Under Heated Zone Setpoints, if you have non-programmable inlets, enter 
the temperature for injectors A and B. 

If you have programmable inlet type (POC or PSS) configured in either inlet 
program mode or oven tracking mode (POCI, PSSI, POCO, or PSSO), select 
either ON or OFF for Injectors A and B. 

POCO and PSSO track the oven program temperature +5°C. 

12. If the option is available, enter an Auxiliary zone temperature. 

Setting GC Carrier Parameters 
You can use the Carrier tab of the Instrument Control dialog box to set carrier 
parameters such as the inlet pressure or flow rate for carrier gas. 

The options that are available in the Carrier dialog box depend on whether the 
instrument has a carrier or auxiliary zone configured as a PPC (Programmable 
Pneumatic Control) zone. 

Configured for PPC 
If the instrument has either carrier or any auxiliary zones as a PPC zones, you can 
enter information about the column, program, inlet split controls, and auxiliary 
pneumatics setpoints.  

The Carrier tab also includes a pressure/flow/velocity curve that reflects the values 
that you enter in the table beneath it. You can switch among different carrier 
programs by selecting the program tabs at the bottom of the table. The table has the 
following columns: 
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Rate column — Represents the rate at which the carrier pressure/flow/velocity 
changes. You can create up to three ramps, which are periods during which the 
pressure/flow/velocity changes. Ramps are shown on the vertical axis of the curve. 

Setpoint/Temp column — Gives the pressure/flow/velocity to which the carrier is 
being changed. The initial setting is the pressure/flow/velocity of the carrier at the 
start of the run, or throughout the run. When the Oven program tab is selected, this 
column displays the temperature for the oven. 

Hold column — Represents the period for which the pressure/flow/velocity is held 
before starting the next ramp. 

The Initial Rate field is always 0.0 and you cannot edit this field. To edit the other 
fields, click in the field and then enter a value. The Setpoint and Hold fields in a ramp 
are disabled until you set the Rate. You can also adjust the Setpoint/Temp and Hold 
fields by dragging the corresponding points on the curve to the desired position. 

 To set parameters for carriers configured as a PPC zone: 

1. Select the Carrier tab of the Instrument Control dialog box. 

 

If PPC is disabled for the channel selected in the grid, then the Carrier 
Control drop-down list is disabled,  but the control displays the setting  
(i.e. Pressure or Flow) for that channel (from Configuration). 

When PPC is enabled for the selected channel, the Carrier Control drop-
down list is enabled.  The contents of the list depends on the Inlet type and 
the Capillary Mode settings from Configuration. 
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2. From the available program tabs under the table (e.g., Carrier A, Carrier B, 
Aux 1, or Oven), choose the tab for the program that you want to display. 

The curve and the table change to reflect the program that you select. The 
curve for the program that you select appears as a solid line. The curves for 
all other programs appear as dashed lines. 

The information under Program Time also changes to reflect the selected 
carrier values. The color-coded carrier time fields show how much time is 
required to complete the pressure/flow/velocity program. Aux Time appears 
instead of the carrier time for certain instruments. Oven Time shows how 
much time is required to complete the oven program. 

3. In the Initial Setpoint field of the table, set the flow/pressure/velocity for the 
start of the run.  

If the program you are editing is a constant flow/pressure/velocity program, 
then you can only enter an initial Setpoint value in the table. 

4. In the Initial Hold field, enter the length of time to hold at the final 
flow/pressure/velocity for this program step. 

To hold the flow/pressure/velocity until the end of the temperature program 
for most instruments, enter 999. For the HP5890, enter 650. 

5. Set the Rate, Setpoint, and Hold values for the other ramp levels. 

6. You can also change the values directly on the curve by dragging the points 
associated with each ramp level. When you release the points after dragging, 
the new values appear in the table. 
• To change the rate (flow/pressure/velocity) of a level, select the point 

that represents the setpoint and drag it horizontally. 
• To change the setpoint value of a level, select the point that represents 

the setpoint and drag it vertically.  
• To change the hold time duration of a level, select the point that 

represents the time and drag it horizontally. 
7. If you selected capillary mode during instrument configuration, set the 

length and diameter of the column under Column, and select whether or not 
you want vacuum compensation for the column. 

Select On if the detector is at vacuum. Select Off if the detector is at 
atmospheric pressure. 

8. If the instrument is configured with auxiliary pneumatics, enter the Aux 
Pneumatics Setpoints for any auxiliary zones. 

9. Under Split Control, select a split control mode, and then do one of the 
following: 
• If you select Ratio, enter a split ratio in the Ratio text box.  
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• If you select Flow, enter a split flow in the Flow text box. 

Not Configured for PPC 
If the instrument has neither carrier nor auxiliary zone configured as a PPC Zone, you 
can enter only the pressure and flow values for inclusion in the instrument’s Ready 
logic. You must set the actual pressure and flow rate on the instrument itself. 

 To set parameters for carriers: 

1. Select the Carrier tab of the Instrument Control dialog box. 

2. Enter the pressure or flow rate for carrier A and B in the corresponding 
initial setpoint cell. 

Enter 0.0 if you do not want the actual pressure or flow setting to prevent the 
instrument from becoming ready. 

Setting GC Valves 
You can use the Instrument Timed Events tab of the Instrument Control dialog box to 
enter the initial settings for any valves installed on the instrument. 

 To set the valves: 

1. Select the Instrument Timed Events tab of the Instrument Control dialog 
box. 

The Valves group box reflects your system configuration. 
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2. Under Valves, set the Initial Setting buttons to On or Off for each valve. 

You can set split control by Timed Event.  For example, you can set the split flow 
to 0 by Timed Events rather than by the SPL1 and SPL2 settings. 

Setting GC Detector Parameters 
You can use the Detectors tab of the Instrument Control dialog box to control the 
temperature of the detector, the sensitivity of detection, and the magnitude of any 
optional analog output from the GC.  

 To set detector parameters for a LINK-controlled GC: 

1. Select the Detectors tab of the Instrument Control dialog box. 

 

2. In the Temp text box, enter a temperature value for the detector.  

3. Select a sensitivity setting for the detector in the Range list.  

This value is the gain level of the detector output. The values depend on the 
instrument and detector type. For example, if you are using an AutoSystem 
with an FID, the lower the Range setting, the greater the detector sensitivity. 
For a TCD, the lower the Range setting, the lower the detector sensitivity. 

4. Select a value in the Time Constant list. 
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This value sets the detector filter width in milliseconds, which smoothes out 
the detector signal. Higher values improve the signal-to-noise ratio but 
attenuate narrow peaks. 

5. Depending on the detector type, either set the PMT percentage (FPD 
detector only) or enter a gain adjustment value. 

The PMT percentage is the percentage of the maximum photo-multiplier 
tube voltage and sensitivity. 

6. To make the detector autozero at the start of each run, select the On check 
box for the Autozero option. If the Value text box is available, enter a value 
to specify an offset. 

7. If the Polarity option is available, select Positive or Negative. 

8. If the Filament option is available, select On or Off. 

9. Under Gases, specify the gas flow rates for the detector. 

10. If the instrument configuration includes either REC (Recorder) or INT 
(Integrator) settings for analog output, set the following options under REC 
or INT: 

• Select an Attenuation value for analog output in the Attenuation list. 

• In the Offset text box, enter the amount by which to offset the analog 
output for an external recorder. 

11. Repeat Steps 2 through 10 for the second detector. 

Setting Control Options for LCs 
If you are using an LC, the possible tabs in the Instrument Control dialog box are: 

• Autosampler 

• Pump Config 

• Pump Program 

• Detectors 

• Instrument Timed Events 

This section describes how to complete each tab. Because instrument timed events are 
similar for both GCs and LCs, the procedures are combined under “Setting 
Instrument Timed Events” on page 6-36. 

For a complete definition of each LC parameter, refer to the manual that came with 
the specific instrument module. 
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Setting LC Autosampler Parameters 

 To set autosampler parameters for liquid chromatographs: 

1. Select the Autosampler tab of the Instrument Control dialog box. 

 

2. If you are using manual injection, select Manual. If you are using an 
autosampler, continue with Steps 3 through 19. 

3. In the Injection Volume text box, enter the amount of sample that you want 
to inject. 

Ensure that this value is less than 50% of the Loop Size that you specify in 
the next step. 

4. From the Loop Size list, select the size of the injection loop fitted to your 
autosampler. 

To enable the Fixed Mode option, where the injection volume is equal to the 
loop volume, select a Loop Size value less than 50 µL. 

5. To operate in Fixed Mode, set the value of the Fixed Mode list to On. 

This option forces the Injection volume to be equal to the loop volume. 
Fixed mode is useful if you are working with small sample sizes or 
applications that require high precision. You can only use Fixed Mode when 
the Loop Size value is less than 50 µL. 
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6. In the Excess Volume text box, enter the amount of sample that you want 
withdrawn from the vial in addition to the injection volume. 

This option prevents evaporation and contamination by isolating the actual 
plug of sample to be injected as it is transported to the injection loop. This 
option is only available if Fixed Mode is set to Off. 

7. In the Air Cushion text box, enter the amount of air that you want to insert 
between the sample and flush solutions to prevent the two solutions from 
mixing. 

8. From the Sample Syringe Size list, select a syringe volume. 

9. From the Sample Speed list, select the speed at which you want the sample 
pump to fill the injection loop. 

Slower speeds provide more reproducible injection volumes, particularly for 
viscous samples. 

10. From the Needle Level, select the appropriate percentage. 

This value sets the height at which the sampling needle extracts the sample. 
It is set as a percentage of the vial height, measured from the bottom of the 
vial. 

11. In the Inject Delay Time text box, enter the number of minutes that you want 
between the pump's run start signal and when the sample injection occurs. 

12. If you are using a Series 200 Autosampler, refer to “Creating Derivatization 
and Dilution Programs” on page 6-38 for information on the Derivatization 
and Dilution options. 

When using Serial Dilution with a Peltier Tray, when you Setup the autosampler 
it goes Not Ready and starts to cool the Peltier Tray to 4 °C. 

13. In the Flush Volume text box, enter the amount of flush solution that you 
want pumped through the sampling system for each flush cycle. 

14. From the Flush Speed list, select the speed at which you want the pump to 
flush the system. 

15. In the Flush Cycles text box, enter the number of flush cycles that you want 
to have between injections when the method changes in a sequence. 

 This value also specifies the number of flushes the autosampler performs 
when you choose Flush Autosampler in the Hands On dialog box. 

16. In the Pre-Injection Cycles text box, enter the number of flush cycles that 
you want before each sample injection or before each vial-to-vial transfer in 
sample processing modes. 
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17. In the Post-Injection Cycles text box, enter the number of flush cycles that 
you want after each sample injection or before each vial-to-vial transfer in 
sample processing modes. 

18. In the Post-Method Cycles text box, enter the number of flush cycles that 
you want after each method is completed in a sequence. 

19. Under Peltier Tray Control, set the Temperature of the tray. 

20. In the +/- list, select a tolerance percentage to control when the system 
Peltier Tray becomes ready. 

The autosampler will not come ready unless the Peltier tray temperature is 
within the range of the temperature that you set, plus or minus the value in 
the tolerance section. 

Configuring Pump Information 
The Pump Config tab of the Instrument Control dialog box lets you enter labels for 
solvents and set other pump configuration parameters, such as the Ready Time and 
the pressure units. The solvent labels you create appear in the Method Summary 
window and on the Pump Program tab. 

 To set pump configuration parameters: 

1. Select the Pump Config tab of the Instrument Control dialog box. 
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2. In the Ready Time text box, enter the number of minutes that the pump 
remains in a READY state, after which you want the pump to shut down. 
A Ready Time of 999 means that the pump will continue in the READY 
state indefinitely. 

3. In the Standby Time text box, enter the number of minutes that the pump 
remains in a READY state, after which you want the pump to change to the 
standby flow rate. 
A Ready Time of 999 means that the pump will continue to use the flow rate 
set in the grid as long as the pump remains READY. 

4. In the Standby Flow text box, enter the pump flow rate during standby 
mode. 

5. From the Pressure Units list, select either PSI or BAR as the units for inlet 
pressure, depending on the instrument that you are using. 

6. In the Max Pressure text box, enter the upper pressure limit, above which the 
pump will shut off. 

7. In the Min Pressure text box, enter the lower pressure limit, below which the 
pump will shut off. 
A typical value for the lower pressure limit is 100 PSI or 6 BAR. 

8. Under Solvents Names, enter the labels you want to use in the available 
Solvent text boxes. 

Creating Pump Programs 
To create a pump solvent gradient program, or pump program, you use the Pump 
Program tab of the Instrument Control dialog box. This tab contains a table and a 
gradient curve, which let you define the composition of the solvent(s) at each step in 
the run. You can change the table parameters and the curve either by editing the 
values in the table or by dragging points on the curve with the mouse. 

You can enter 10 rows, or steps, in the pump program. Step 0 is always the pre-run 
equilibration, for which you enter Time, Flow, and Solvent values. The table has the 
following columns: 

Time — The duration of each program step. 

Flow — The flow rate during each program step. 

A, B, C (Solvents) — The percentage of each solvent at the end of each program 
step. 

D (Solvent) — The percentage of this solvent at the end of each program step. 
TotalChrom ensures that the sum of all solvents used is 100. 
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Curve — The type of gradient curve to use for this program step. The types of curve 
are step (0), linear (1), convex (-1.1 to -9.9), and concave (1.1 to 9.9), for increasing 
solvent percentage. The magnitude of the number determines the degree of curvature. 
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 To set pump-control parameters: 

1. Select the Pump Program tab of the Instrument Control dialog box. 

 

The Program Time field displays the sum of the values in the Time column 
for all the steps that you create. The Detector Time field displays the data 
acquisition time of the analysis. 

2. In Step 0 of the table, click in the Time, Flow, and solvent fields, and then 
enter amounts for the equilibration step. 

3. Enter the Time, Flow rate, solvent composition, and Curve type for each 
additional program step. 

The Time field activates the other fields in each row, and the curve changes 
as you enter each set of values. Depending on the specific pump that you are 
using, TotalChrom completes the solvent percentage either for solvent B or 
for solvent D so that the total solvent composition is 100 percent. Also, if 
you change the value of solvent B or the value of solvent D, the value of 
solvent A adjusts so that the total remains 100 percent. 
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For the Model 250 LC Pump, the resolution at which you can enter time and 
flow values changes across the allowed range. You can enter times between 0 
and 9.9 minutes to the nearest 0.1 minute, but times between 10 and 999 minutes 
must be to the nearest minute. Flow rates between 0 and 0.99 mL/min can be to 
the nearest 0.01 mL/min, but flows between 1.0 and 10.0 mL/min can only be to 
the nearest 0.1 mL/min. TotalChrom will beep if your entry causes a switch from 
one resolution range to another. 

4. To reduce the amount of equilibration time after the first run, select Enable 
Solvent Saver, and then enter the new amount of equilibration time to use 
after the first run in the text box.  

5. To turn the pump off at the end of the run without recycling to initial 
conditions, select Shutdown In Final Conditions. 

Only set this option for a “shutdown method,” which is run as the last cycle 
in a sequence. 

Changing LC Pump Parameters Graphically 
As you enter values in the table, the gradient curve changes to reflect the new values. 
You can also change the values by dragging the point associated with each step. In 
addition, you can add and delete steps from the program by using the Duplicate and 
Delete buttons in a pop-up menu. 

In this section, solvents A, B, and C represent the solvent names that you enter in the 
Pump Config tab. 

 To change pump parameters using the gradient curve: 

1. From the group of available solvents, select the solvent whose parameters 
you want to change.  

The corresponding curve appears for the solvent that you select. The curve 
that you select has small square selection points at the ending time of each 
program step. 
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2. Select the point that represents the end of the step that you want to change, 
and then do either of the following: 

• To change the time duration of the step, drag the point horizontally. 

• To change the percentage of the total solvent composition drag the point 
vertically. 

As you drag the point, TotalChrom displays a dotted boundary line, which 
restricts you from exceeding 100 percent in the % axis and preceding the 
time for the previous step.  

 

3. Release the mouse button when the solvent percentage and time period are 
correct. 

 

TotalChrom updates the values in the table and revises the numbers for the 
other solvents so that the total remains at 100 percent. 
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Duplicating and Deleting Program Steps 
You can duplicate and delete steps in the pump program by using the Duplicate and 
Delete choices in a pop-up menu. 

 To duplicate a step in the pump program: 

1. From the group of available solvents, select the solvent you want to work 
with. 

The corresponding curve appears for the solvent that you select. 

2. With the right mouse button, click the point on the gradient curve that you 
want to duplicate. 

The Delete/Duplicate pop-up menu appears. 

3. Choose Duplicate. 

TotalChrom adds another program step to the curve using the same 
parameters as the step you selected. For example, if the step you select has a 
time duration of 15 minutes, the new step will have the same duration and 
will appear after the original step. 

TotalChrom also inserts the new step in the table, using the same values as 
the original step that you selected. 

4. Drag the new step point(s) anywhere within the allowable boundaries to 
change the parameters and solvent percentages for each step. 

After you release the mouse, TotalChrom updates the table and the gradient 
curve. 
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 To delete steps from the gradient curve: 

1. With the right mouse button, click on the point on the gradient curve that 
represents the step that you want to delete. 

The Delete/Duplicate pop-up menu appears. 

2. Choose Delete. 

TotalChrom deletes the step from the curve, removes the corresponding row 
from the table, and shifts all remaining rows up one place. 

 

3. To reverse the last change that you made, choose Cancel to close the dialog 
box. The gradient program reverts to the previously saved version. 

You can also delete steps using the solvent table by entering a zero in the Time 
column. However, this approach deletes all subsequent steps in the table as well. 

Setting LC Detector Parameters 
The Detectors tab of the Instrument Control dialog box for LCs varies depending on 
the type of detector you are using: LC 235, Series 200, or 785. Each is described in a 
separate procedure below. 

Setting LC 235 Detector Parameters 
The Detectors tab for an LC 235 detector includes a table you can use to create a 
detector program. The detector program can have up to nine rows, or steps, with the 
following parameters: 

Time — The duration of the current step. 

Wavelength A(nm) and B(nm) — The wavelength selected to monitor Channels A 
and B. 

Bandwidth BW-A and BW-B — The bandwidth, or total wavelength range, around 
the nominal selected wavelength for Channels A and B.  
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 To set LC 235 detector parameters: 

1. Select the Detectors tab of the Instrument Control dialog box. 

The Program Time displays the duration of the pump solvent gradient 
program, which you set in the Pump Program tab. The Detector Time 
displays the current duration of the detector program. 

 

2. In the Min Wavelength text box, enter the starting wavelength for peak 
purity measurements. 

Peak Purity is available as a report option in the Report Format Editor. 

3. From the Spectral Threshold list, select the peak size required to trigger a 
spectral scan in Auto or Apex spectral acquisition modes. 

4. In the Time column of the detector program, enter the amount of time that 
you want the step to last. 

5. In the Wavelength columns for Channels A and B, enter the wavelength that 
you want to use. 

The valid range is from 195 nm to 365 nm, in 1- or 5-nm increments. If you 
enter a value, set in the configuration program, that is not a multiple of 5, 
TotalChrom rounds upward to create a correct value. 

6. In the Bandwidth columns for Channels A and B, enter the total wavelength 
range around the nominal selected wavelength. 
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7. Under Spectral Acquisition, select the Mode that you want to use. The 
options are: 

Off — Collects no spectral data. 

Apex — Collects a spectrum at the apex of each detected peak. 

Auto — Collects a spectrum at the upslope, apex, and downslope of each 
detected peak. 

Time — Collects a spectrum at regular time intervals, and at the apex of 
each peak detected. 

8.  If you selected Time as the Mode option, select the interval at which you 
want to collect spectra from the Sampling Period(s) list. 

The available rates depend on the data sampling rate that you set in the Data 
Channels dialog box. For higher sampling rates, more time intervals are 
available. This frequency of spectral acquisition occurs between the Start 
and End Times. 

9. In the Start Time text box, enter the time into the run at which you want to 
begin collecting spectra. 

The Start and End Time options apply to Auto and Time modes. TotalChrom 
collects apex spectra for the entire run. 

10. In the End Time text box, enter the time at which you want to stop collecting 
spectra. 

If you later edit the detector program so that the total Detector Time is less 
than the end time for spectral acquisition, TotalChrom reduces the amount 
for spectral acquisition. However, if you lengthen the detector program, 
TotalChrom does not increase the spectral acquisition end time. 

11. To turn the lamp off at the end of the run, select Lamp OFF At End Of Run. 

To have the system shutdown at the end of a sequence, select this option, 
and then use this method in the last row of the sequence. You must also 
select Shutdown In Final Conditions in the Pump Program tab. 
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Setting 785 Detector Parameters 
You should periodically perform a wavelength calibration procedure before you set 
up this type of detector for data acquisition. 

 To set 785 detector parameters: 

1. Select the Detectors tab of the Instrument Control dialog box. 

 

2. Enter a value, in whole numbers, in the Wavelength box. 

3. Choose a Rise Time from the list.  

This is the length of time it takes for a step change. 

4. Enter a value in the Zero Offset box. 

This is the amount the recorder pen is offset from zero. 

5. Set the duration of the detector program in the Detector Time box. 

The Program Time displays the duration of the pump solvent gradient 
program, which you set on the Pump Program tab. 
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Setting Series 200 UV/VIS Detector Parameters 
Support for control and data acquisition for the LC Series 200 UV/VIS detector 
includes wavelength programming and digital data acquisition from the detector.  
Series 200 UV/VIS configuration is analogous to that of the 785A, except that no 
A/D is included in the module options.  

There are no instrument timed events for the Series 200 UV/VIS. 

 To set Series 200 UV/VIS detector parameters: 

1. Select the Detectors tab of the Instrument Control dialog box. 

 

2. If necessary, you can change a wavelength value in the wavelength table 
during the run. The wavelength program is downloaded to the detector, 
which executes the changes in exactly the same manner as the LC235C 
detector.  

Time entries have a range of 0 to 999min with a precision 0.01min. 

Wavelength (nm) entries have a range of 190 to 700nm for the deuterium 
lamp and 360 to 700nm for tungsten. For each lamp type the precision is 
1nm. If the wavelength is greater than 375nm, and the deuterium lamp is 
configured, then a warning about possible second order interference will be 
issued. This will be the same warning message as used for the 785A. A zero 
entry for the wavelength indicates an autozero command.  

3. If necessary, select Lamp OFF at end of run by clicking the check box. 
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Setting Series 200 DAD Parameters 
With this detector, spectra are collected for the full (data) run time. 

 To set the Series 200 DAD detector parameters: 

1. Select the Detectors tab of the Instrument Control dialog box. 

 

2. Under Chromatogram Acquisition, edit the default monitoring wavelength, 
bandwidth, and reference wavelength for each channel as necessary. 

The bandwidth is the spectral window around the wavelength setpoint. 

3. Under Spectral Acquisition, select the mode you want to use for collecting 
spectra. 

Select Time if you want to collect spectra at regular time intervals. 

4. If you selected Time above, select the interval from the Spectra/Period list. 

This interval for spectral acquisition is independent of the sampling rate for 
chromatogram acquisition. 
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Setting Instrument Timed Events 
Use the Instrument Timed Events tab of the Instrument Control dialog box to select 
one or more timed events from a predefined list, and enter the time at which you want 
the event to take place. The events available depend on which instrument you have 
selected. 

For a 900 Series Interface, you can choose events to set relays 1 through 7 on or off. 
Another event, RVPRT, instructs the interface to read rack and vial information from 
the attached autosampler at a specified time. For information about the instrument 
timed events for other supported instruments, refer to the documentation that came 
with the instrument. 

In the Graphic Method Editor, you can insert instrument timed events directly on the 
chromatogram at a specified time. For more information, refer to Chapter 10, 
“Editing a Method and Results Graphically.” 

 To add or edit timed events: 

1. Select the Instrument Timed Events tab of the Instrument Control dialog 
box. 

 

2. In the Time text box, enter the time at which you want this event to occur 
during the run. 

3. From the Event list, select the event that you want to add. 
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If the event requires a value or setting, the Value text box or list becomes 
enabled. 

4. Depending on the event, use the Value text box or list to specify a value for 
the event. 

5. Choose Add to add this event to the Defined Events list. 

6. Repeat Steps 2 through 5 to add other events. 

TotalChrom lists the events in the order of the time at which they occur. 

 To change the time or value of a timed event: 

1. Under Defined Events, select the event that you want to change. 

2. Do one of the following: 

• To change the time, enter a new number in the Time text box. 

• To change the value, either select one from the list or enter a value in 
the text box. 

3. Choose Replace. 

 To delete a timed event: 

1. Under Defined Events, select the event that you want to delete. 

2. Choose Delete. 

 To delete all timed events: 

• Choose Clear List. 
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Creating Derivatization and Dilution Programs (Series 200 
Autosamplers Only) 

If you are using the Series 200 Autosampler, you can access the following additional 
features from the Autosampler dialog box: 

Derivatization —transfers and mixes specific volumes of derivatizing reagents from 
source vials to sample vials. You can transfer, mix, and react specific volumes of up 
to five reagents with liquid in every sample specified in a sequence. 

Dilution —performs dilutions by adding diluent to sample vials. You can also 
perform up to four optional additions on every vial in a sequence. 

You can only perform dilution operations if your Autosampler has the dilution sample 
tray installed.  

TotalChrom saves the derivatizing and dilution programs that you set up as part of the 
method you are working with. When you run a sequence that specifies this method, 
TotalChrom applies the program to each sample and vial identified in the sequence. 

Setting up a Derivatization 
Use the Derivatization dialog box to program the derivatization operation. The 
options in this dialog box change slightly depending on whether you choose air or 
liquid as the mixing mode. 

In addition to selecting the mixing mode, you also need to use the Entry Table to set 
values for each reagent you want to transfer to the sample vials. For each reagent, 
complete the corresponding row in the Entry Table, specifying the location of the 
reagent vial, the volume to transfer, and so on. When you run the sequence specifying 
this instrument method, the Autosampler transfers, mixes, and reacts the volumes in 
every sample vial identified in the sequence. 
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 To create a derivatization program: 

1. Select Deriv under Derivatization/Dilution and choose the Program 
command button to open the Derivatization dialog box.  

 

2. Select Liquid or Air as the Mixing Mode. 

3. In the Sample Volume text box, enter the volume of liquid in the sample 
vials. 

This volume is the amount of liquid present before the Autosampler transfers 
any reagent or liquid to the sample vial. If the sample vials contain different 
volumes, enter the smallest volume of the vial series. 

4. If you are using air mix mode, select from the Air Mix Volume list the 
volume of air you want delivered through the flush syringe for each mixing 
cycle. 

5. Enter the number of reagents that you want to use for the derivatization. 

The same number of rows are enabled in the Entry Table. 

6. Select a speed from the Mix Speed In list. 

For liquid mixing, this setting controls how fast the syringe draws up a 
sample from the vial for mixing. For air mixing, this setting controls how 
fast the syringe draws up air. 

7. Select a speed from the Mix Speed Out list. 

For liquid mixing, this setting controls how fast the syringe dispenses the 
sample back into the vial for mixing. For air mixing, this setting controls 
how fast the syringe injects air into the sample vial. 
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8. In the Reagent Vial column, enter the vial position of the reagent that you 
want to use in the derivatization. 

9. In the Volume column, enter the volume of the reagent that you want the 
Autosampler to transfer to each target vial. 

10. In the Mix Cycles column, enter the number of mixing cycles you want. 

This value represents the number of times you want the Autosampler to mix 
the sample and the reagent after the reagent transfer. 

11. In the Reaction Time column, enter the reaction time for the mixture. 

This time specifies how long the Autosampler waits after the transfer before 
it injects the sample or proceeds to the next vial. The timing begins after the 
addition and mixing operations complete. 

12. Repeat steps 8 through 11 for each reagent in the series. 

13. Choose OK. 

Setting up a Dilution 
Use the Dilution dialog box to program dilution operations. The options in this dialog 
box change slightly depending on whether you choose air or liquid as the mixing 
mode. 

The Dilution operation allows you to dilute a consecutive range of target vials in the 
tray and make additions of liquid from another range of vials to the same group of 
target vials 

Dilution Example 
Use the Entry Table in the dialog box to program each separate step of the operation. 
For example, suppose you configure your tray so that the first 20 positions contain 
sample vials, the next 20 contain internal standard, and the last 20 positions contain 
the target vials.  

Set the vial numbers for the target vials (vials 41 through 60 in this example) in the 
Sequence Editor. 

You then want to program the Autosampler to: 

• Add 100 µL of diluent from the tank to each of the 20 target vials 

• Add 50 µL of liquid from each of the 20 sample source vials into the 
corresponding target vials 

• Add 25 µL of internal standard from each of the 20 internal standard vials into 
the corresponding target vials 
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The Entry Table to program this operation looks like this: 

 First Vial Volume Mix Cycles Equil Time 

Diluent 1 Tank 100 0 0 

Diluent 2 1  50 0 0 

Diluent 3 21 25 2 0 

The following table shows what the Autosampler does in each cycle when you run 
the sequence containing this method: 

Sequence Cycle Autosampler Actions 

Vial 41 Transfers 100 µL from the diluent tank to 
target vial 41 

Transfers 50 µL of sample to target vial 41 

Transfers 25 µL of internal standard to target 
vial 41 

Injects vial 41 

Vial 42 Transfers 100 µL from the diluent tank to 
target vial 42 

Transfers 50 µL of sample to target vial 42 

Transfers 25 µL of internal standard to target 
vial 42 

Injects vial 42 

Vial 60 Transfers 100 µL from the diluent tank to 
target vial 60 

Transfers 50 µL of sample to target vial 60 

Transfers 25 µL of internal standard to target 
vial 60 

Injects vial 60 
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 To create a dilution program: 

1. Select Dilution under Derivatization/Dilution and choose the Program 
command button to open the Dilution dialog box. 

 

2. Select Liquid or Air as the Mixing Mode. 

3. In the Sample Volume text box, enter the volume of liquid in the sample 
vials. 

This volume is the amount of liquid present before the Autosampler transfers 
any liquid to the sample vial. If the sample vials contain different volumes, 
enter the smallest volume of the vial series. 

4. If you are using air mix mode, select from the Air Mix Volume list the 
volume of air you want delivered through the flush syringe for each mixing 
cycle. 

5. Select a speed from the Mix Speed In list. 

For liquid mixing, this setting controls how fast the syringe draws up a 
sample from the vial for mixing. For air mixing, this setting controls how 
fast the syringe draws up air. 

6. Select a speed from the Mix Speed Out list. 

For liquid mixing, this setting controls how fast the syringe dispenses the 
sample back into the vial for mixing. For air mixing, this setting controls 
how fast the syringe injects air into the sample vial. 
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7. In the First Vial column, enter the vial position of the first source vial in the 
series that you want to use in the dilution.  

For the dilution operation, the Autosampler always dispenses diluent from 
the diluent tank.  

8. In the Volume column, enter the volume of the liquid you want the 
Autosampler to transfer from the source vial (or tank) to the target vial. 

The dilution tank is always the first line in the table. The value you set for 
the tank is transferred from the tank to every dilution-active vial in the 
sequence. 

9. In the Mix Cycles column, enter the number of times you want the 
Autosampler to mix the mixture in the target vials. 

For best results, set this value to 2. 

10. In the Equil Time column, enter the amount of time you want the mixture in 
the target vial to equilibrate between vial-to-vial transfers of liquid, or before 
injection in the case of the last step. 

11. Repeat Steps 7 through 10 for each dilution operation. 

12.  Choose OK. 
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Chapter 7 
Developing Processing Parameters 

in the Method 
 

This chapter explains how to use the Method Editor to set processing parameters in a 
method. For general information about using the Method Editor, refer to Chapter 5, 
“Building a Method.” 

To learn about: Go to page: 

Introduction to Processing Parameters.....................................................................7-2 

Entering Peak Detection and Integration Parameters...............................................7-4 

Entering Baseline Timed Events ..............................................................................7-6 

Selecting Optional Reports ......................................................................................7-9 

Editing Replot Parameters......................................................................................7-12 

Running User Programs.........................................................................................7-16 
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Introduction to Processing Parameters 
The processing section of the method contains parameters that control the following 
steps in data analysis:  

• How peaks are detected and integrated 

• How reports and replots are printed 

• Which user programs are run at which point in the data analysis process 

Use the Process menu in the Method Editor to set and edit processing parameters in a 
method. 

If you are using a single-channel instrument, you need to develop only one set of 
processing parameters. If you are acquiring data using a dual-channel instrument, you 
can either use the same processing parameters for both channels or you can create 
two separate methods, each method with different processing parameters: one for 
analyzing Channel A and one for Channel B. 

 To enter processing parameters in the method: 

1. In the Method Editor, choose a command in the Process menu to open the 
Process dialog box. 

The dialog box opens to the tab corresponding to the command you selected. 
The following figure assumes you chose Baseline Timed Events. 
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There are five tabs in the Process dialog box: 

Integration — Select this tab to set integration and peak detection 
parameters. Peak detection parameters include bunching factor, noise 
threshold, and area threshold. Integration parameters include peak separation 
criteria and exponential skim criteria. 

Baseline Timed Events — Select this tab to set baseline timed events that 
determine how TotalChrom processes data. 

Optional Reports — Select this tab to specify up to six different types of 
reports that will be printed, in addition to the main report that you specify in 
the sequence. 

Replot — Select this tab to set the characteristics of the chromatogram 
TotalChrom produces after analyzing a raw data file. Replot parameters 
include scaling factors, offsets, plot title, and X/Y axis labeling information. 

User Programs — Select this tab to specify the file names of the programs 
you want to run during or after data analysis. 

2. Select the tab for each processing function that you want to complete or edit. 

3. Make any changes to the values in the dialog box, and then do any of the 
following: 

• To save your work and close the dialog box, choose OK. 

• To save your work without closing the dialog box, choose Apply. 

• To close the dialog box and discard your changes since the last time you 
chose Apply, choose Cancel. 

The following sections describe how to complete each of the tabs in the Process 
dialog box. 
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Entering Peak Detection and Integration Parameters 
The Integration command in the Process menu lets you enter the parameters that 
affect peak detection and integration.  

Peak detection — The process by which TotalChrom examines raw data points to 
determine where peaks exist. Your entries for basic integration parameters are used in 
this process. 

Peak integration — The process of determining peak area. Your entries for 
advanced integration parameters are used in this process. 

For technical information about peak detection and peak integration and how baseline 
timed events affect them, refer to Chapter 18, “Discussion of Data Analysis.” 

You seldom need to modify the advanced parameters because their values have been 
optimized for normal chromatographic situations. Modify these values with caution. 
If you change these parameters without fully understanding the potential 
consequences, you might obtain invalid results. 

 To edit peak detection and integration parameters: 

1. Choose Integration from the Process menu to open the Process dialog box 
with the Integration tab selected. 

 

2. In the Bunching Factor text box, enter the number of successive raw data 
points you want to average to establish a single bunched data point. 
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3. In the Noise Threshold text box, enter a value that helps determine the 
difference between baseline noise and the start of a peak. 

4. In the Area Threshold text box, enter a value that helps discriminate between 
noise spikes and peaks. 

As a general rule, set the area threshold to approximately five times the noise 
threshold. However, the optimal ratio depends on the actual peak size and 
signal-to-noise ratio. 

5. Under Peak Separation Criteria, enter a value for Width Ratio and Valley-
To-Peak Ratio. 

6. To restore the peak separation criteria to the system defaults, choose 
Defaults. 

7. Under Exponential Skim Criteria, enter a Peak Height Ratio, Adjusted 
Height Ratio, and Valley Height Ratio. For additional information refer to 
Chapter 10, “Changing Peak Separation and Exponential Skim Criteria.” 
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Entering Baseline Timed Events 
Baseline timed events alter the way TotalChrom detects and integrates peaks during 
the run. You can use baseline timed events to help maintain consistent results when 
peak characteristics and baseline characteristics change. 

Although you can set timed events in the processing section of the method, you can 
also add them directly to the chromatogram by using the Graphic Method Editor. 
Using the Graphic Method Editor helps you see how adding one or more baseline 
timed events affects the run. For more information about the Graphic Method Editor, 
refer to Chapter 10, “Editing Methods and Results Graphically.” 

You select events in TotalChrom by choosing the Baseline Timed Events command 
in the Process menu. You then select different events by clicking on a graphical 
representation of the event on the Baseline Timed Events tab. 

The following table provides a brief description of each timed event. The code 
column indicates the corresponding baseline timed event code that appears on the 
chromatogram in the Graphic Method Editor. For technical information about these 
events, refer to the sections “How Timed Events Affect Peak Detection,” and “How 
Timed Events Affect Integration” in Chapter 18, “Discussion of Data Analysis.” 

Event Value Code 

Set bunch factor to value 1 – 99 BF 

Set noise threshold to value 1 – 999999 NT 

Set area threshold to value 5 – 1015 AT 

Enable peak detection  +P 

Disable peak detection  −P 

Enable negative peak detection  +N 

Disable negative peak detection  −N 

Inhibit end of peak detection  +I 

Allow end of peak detection  −I 

Turn on non-forced common baseline  +CB 

Turn off non-forced common baseline  −CB 

Force the end of current peak  E 

Force start of new peak  S 

Force baseline to current point  BL 
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Event Value Code 

Force horizontal forward baseline  +HF 

Stop horizontal forward baseline  −HF 

Force horizontal backward baseline  HR 

Start manual integration window  +M 

End manual integration window  −M 

Turn on valley-to-valley baselines  +V 

Turn off valley-to-valley baselines  −V 

Force an exponential skim  +X 

Prevent an exponential skim  −X 

Force a tangential skim  T 

Smooth Peak Ends On  +SM 

Smooth Peak Ends Off  -SM 

Force retention time of current peak to be 
the event time 

 RT 

Locate peak retention time at the 
maximum data point 

 LM 

Force a baseline at any point in data file   UF 
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 To add timed events: 

1. Choose Baseline Timed Events from the Process menu to open the Process 
dialog box with the Baseline Timed Events tab selected. 

 

2. In the Time text box, enter the time at which you want this event to occur. 

3. From the Event list, select a timed event. 

4. In the Value text box, enter a value if required. 

5. Select Correct Actual Times Of All Baseline Events Based On Actual RT Of 
Nearest Reference Peak if you want your baseline timed events to shift in 
proportion to the shift of the retention time of the nearest reference peak. 

6. Choose Add to add this event to the Defined Events list. 

You can also edit or delete the timed events once you have added them. 

 To edit a timed event: 

1. In the Defined Events list, select an event to edit. 

2. Enter the new time or value in the Time or Value text boxes. 

3. Choose Replace. 

 To delete a timed event: 

1. In the Defined Events list, select the event you want to delete. 

2. Choose Delete, or choose Clear List if you want to delete all timed events. 
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Selecting Optional Reports 
The Optional Reports command in the Process menu lets you generate up to six 
reports in addition to the report specified in the sequence. 

These reports can be formatted according to TotalChrom report format files or 
according to TC Publisher methods that define the layout of the report. For 
information on how to create a report format file or template, refer to Chapter 9. 

 To generate and print additional reports: 

1. Choose Optional Reports from the Process menu to open the Process dialog 
box with the Optional Reports tab selected. 

 

2. Locate and select the file that you want to use. 

You can choose the Select from List button to display a list of reports 
associated with the current job type or Browse all available file types (for 
example, a TC Publisher method is *.tpm).  TotalChrom inserts the path and 
filename of the file that you selected in the report format field.  

3. To remove files from the list, use the Delete or Delete All command. 

4. If you want to generate a plot, to include in a TC Publisher report, choose 
the Plot Settings Command and select the settings for it in the Plot Settings 
dialog box. The Plot settings do not apply to RPT file reports. (This is 
described in the following procedure.) 

To include plots in a TC Publisher report you must also select the Keep 
Temporary Files check box. 
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5. Under Options For Selected Report, select the form of output you want and 
complete the Output Selection dialog box: 

• To print a report, click the Printer icon and select an output printer. 

Contact your application manager for information about default and 
other printers. 

OR 

• To save a report to a file, click the Folder icon to open the Output 
Selection dialog box. 

Select the type of output file you want. 

$RST — creates a .RD file (TC Publisher report file) with the same 
name as the result file. 

File — creates a file where the report will be written. 

 

When specifying printers for TC Publisher, always use the UNC printer name. 

When you choose OK in the Output Selection dialog box, TotalChrom inserts the 
output information that you selected in the Output field on the Optional Reports 
tab. 
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 To specify plot settings: 

1. Click the Plot Settings button to open the Plot Settings dialog box.  

 

2. From the Plot Number list, select the plot to which you want the current 
settings to apply. 

3. To generate the plot selected above using the options set in this dialog, select 
Generate This Plot. 

4. To plot all data that TotalChrom collects during the run, Select Set Plot 
Limits To Full Run. 

If you clear this option, TotalChrom only plots the data in the range that you 
define in the Start Time and End Time text boxes. 

5. Under Scaling Type, select whether to use Vertical, Autozero, or Absolute 
Scaling. 

These options and the necessary Scale Factors are defined in “Editing Replot 
Parameters.” 

6. In the Scale Factor text box, enter the corresponding factor for the Scaling 
Type you chose in the previous step. 

7. Choose OK to save the settings and return to the Optional Reports tab. 
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Editing Replot Parameters 
The Replot command in the Process menu lets you specify how the replot appears 
when you print it. The settings include paper orientation, what portion of the plot you 
want to print, labeling information, and scaling parameters. 

You can produce replots in two different ways: 

• You can print one or two chromatograms on one or more pages in portrait or 
landscape format.  

• You can embed a portrait-formatted replot within a report where both appear on 
a single page.  

Although you select the embedded replot option in the Report Format Editor (See 
Chapter 9, “Building a Report Format.”), TotalChrom uses the parameters as they are 
defined in this section of the method. 

 To edit replot parameters: 

1. Choose Replot from the Process menu to open the Process dialog box with 
the Replot tab selected. 

.  

2. To suppress printing of a full-page plot after data analysis, deselect the 
Generate A Separate Replot check box and skip to Step 8. 

If you deselect this option, you can still enter parameter values that will 
affect a replot embedded in the report. 
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3. In the Number of Pages text box, enter the number of pages on which you 
want the replot(s) to appear. 

This option enables you to display more detail than if you print the replot on 
a single page. This option is only available if you select Generate A Separate 
Replot. 

4. To print two plots with different scale factors on the same page, select 
Generate Second Plot, and then enter a Scale Factor for the second plot. 

All other replot parameters are shared between the two plots. 

5. Under Orientation, select Portrait or Landscape. 

 Portrait — Prints the plots so that the X-axis spans the width of the page.  

 Landscape — Prints the plots so that the X-axis spans the length of the page.  

6. Under Retention Labels, select a label position option. 

Labels do not overlap if you place them at the top of the plot. If they are 
close enough to overlap, some labels will be omitted. All labels at the tops of 
peaks are shown, even if they overlap. 

7. Under Component Labels, select an option to specify how you want 
component names to appear on the replot.  

 None — Suppresses all component names on the replot. 

 Expected Time — Includes the names of all expected components on the 
replot, whether or not a corresponding peak is present. The component name 
appears at the expected retention time for the component. 

 Actual Time — Positions component names under the corresponding peak 
at its actual retention time. If no peak corresponds to an expected 
component, the component name does not appear on the replot. 

8. Under Miscellaneous, do one of the following:  

• To print the whole chromatogram, select Set Plot Limits To Data 
Limits.  

• To specify a particular time period for the replot, deselect Set Plot 
Limits To Data Limits, and then enter the Start Time and End Time to 
designate which portion of the plot you want to print. 

9. In the Plot Title text box, enter the name you want to appear on the replot(s). 

This option is not available for a replot that is embedded in a report. 

10. In the X-Axis Label text box, enter the label you want to use for the time 
axis of the replot(s). 
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11. In the Y-Axis Label text box, enter the label you want to use for the 
response axis of the replot(s). 

12. Select Draw Baselines if you want to print baselines for each peak. 

13. Select Timed Events if you want each timed event to appear on the printed 
replot(s). 

14. Under Scaling Type, select the scaling option you want to use for the 
replot(s). 

 Vertical Scaling — Scales the plot so that the largest peak prints at full 
scale. 

 Autozero Offset — Scales the plot so that the Y-axis minimum data point 
value is at 5 percent of full scale. TotalChrom determines the Y-axis 
maximum based on the value you enter in the Full Scale text box. 

 Absolute Scaling — Lets you enter precise full-scale and offset values. In 
this case, the Y-axis minimum is equal to the Offset value and the range of 
the Y-axis is equal to the Full Scale value. 

15. Based on your choice in Step 14, do one of the following:  

• If you selected Vertical Scaling, enter a value in the Scale Factor text 
box. 

• If you selected Absolute Scaling, enter a value in the Offset text box. 

• If you selected Autozero Offset or Absolute Scaling, enter a value in the 
Full Scale text box. 

About Scaling Types 
The Vertical Scaling, Autozero Offset, and Absolute Scaling parameters all determine 
the scaling of the voltage axis. This section provides additional information on these 
parameters. 

Vertical Scaling 
If you choose this option, the voltage scale will be relative — it will be based on the 
maximum and minimum points in the chromatogram. With relative scaling, you enter 
a scale factor that determines the relationship between the data limits and the voltage 
scale. For example, if the scale factor is 1, the maximum data value minus the 
minimum data value will set the raw scale. If the scale factor is 2, the initial scale will 
be equal to the difference divided by 2. The plot or final scale is set by the plot offset, 
which adjusts the initial scale by five percent to keep the chromatogram on the page.  

The relationship between the plot scale, plot offset, reported high point and reported 
low point is shown below: 
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Scaleinitial
Maximum Minimum

Scale Factor

Scale Scaleinitial Scaleinitial

Offset Minimum Scaleinitial

High PtPlot Scale Offset

Low PtPlot Offset

=
−

= + ×

= − ×

= +

=

0.05

0.05  

If the data maximum is 100 mV, the minimum is 5 mV, and the scale factor is 2, then 
the initial scale will be 47.5 mV. The plot scale will be 49.875 mV (rounded to 49.9 
mV in the plot header). The plot offset will be 2.625 mV, rounded to 3 mV. The high 
point reported on the plot header will be 52.5 mV. The low point reported on the plot 
header will be 2.625 mV, rounded to 2.63 mV. 

Auto-Zero Plot Offset  
If you choose this option, enter the absolute plot scale. The lowest point will be 
calculated from the minimum data value as follows. 

Scale User entered Scale
Offset Minimum Scale
High Ptplot Scale Offset

Low Ptplot Offset

= −
= − ×

= +

=

0.05
 

If you enter 100 mV as the scale, and the minimum data value is 5 mV, the plot scale 
will be 100 mV and the plot offset will be 2.625 mV (rounded to 3 mV in the header). 
The high point will be reported as 102.625 mV (rounded to 102.63 mV). The low 
point will be reported as 2.625 mV (rounded to 2.63 mV). 
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Absolute Scaling 
If you choose this option, you then enter an absolute plot scale and offset. 
TotalChrom makes no adjustments to the bottom of the plot. 

Scale User entered Scale

Offset User entered Offset

High Pt plot Scale Offset

Low Pt plot Offset

= −

= −

= +

=

 

Running User Programs 
The User Programs command in the Process menu lets you run up to five other 
programs during data analysis. The entry points for the programs can be: 

• After baseline subtraction 

• After peak detection or integration 

• After component identification 

• After calibration 

• After quantitation 

• After report generation 

• After replot generation 

You can also synchronize these programs in TotalChrom with the Analyze program, 
which is the program responsible for data analysis. Synchronization lets you prevent 
Analyze from continuing the stages of analysis until your user program has 
completed running. For specific information on running System Suitability, Fit 
Analysis, or Summary as a user program, see the corresponding chapter in this 
manual. 
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 To run user programs in conjunction with analysis: 

1. Choose User Programs from the Process menu to open the Process dialog 
box with the User Programs tab selected. 

 

2. Select the name of the program to run during data analysis. 

See your application manager for information about access to programs. 

3. To remove files from the list, use the Delete or Delete All command. 

4. In the Command Line text box, enter the information you want to pass to the 
user program.  

To pass the names of files that TotalChrom uses or generates during the run, 
use the variables shown below. When Analyze runs a user program, it adds 
the command line by taking the specified information and providing file 
name substitution for the variables as follows: 

$RAW — Full path and file name of the raw data file. 

$RST — Full path and file name of the result data file. 

$MET — Full path and file name of the method file. 

$SEQ — Full path and file name of the sequence file. 

$IDX — Full path and file name of the index file. 

$AIA  — Full path and file name of the AIA metafile file. 
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The names of the sequence and method can be obtained from either of the 
data files, so you need not specify all of them. 

If you must include the name of an explicit file rather than one of the tokens listed 
above, and the file name contains a space, you must enclose the name in quotation 
marks. 

If TotalChrom is running in a networked environment and the command line must 
include the name of an explicit file, use the UNC name instead of a mapped share 
name. 

When you run TotalChrom user programs (calplot.exe, suit.exe, and summary.exe) 
from the command line, they run in the quiet mode ( /q ) by default.  TotalChrom 
automatically enters the /q to the command line. User programs that run in the 
quiet mode run in the background and do not display a window on your screen. 

5. In the Execute After list box, select the point during data analysis at which 
you want to run the program. 

6. Select Synchronize With Data Analysis to pause data analysis until the user 
program causes it to resume. 

In the following example, data analysis pauses after quantitation while the 
user program MYAPPLIC.EXE runs. Analysis resumes with report 
generation when the program stops. 
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Chapter 8 
Developing Calibration Parameters 

in the Method 
 

This chapter explains how to use the Method Editor to set calibration parameters 
in a method. For general information about using the Method Editor, refer to 
Chapter 5, “Building a Method.” 
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Introduction to Calibration Parameters 
Calibration parameters identify and calibrate the components that TotalChrom 
analyzes. Calibration parameters are divided into two groups: 

• Global parameters, which apply to the method as a whole 

• Component parameters, which define the specific calibration treatment for 
each peak in the analysis 

The calibration section of the method includes a component list and parameters 
that determine how TotalChrom matches peaks with named components. 
Calibration parameters, which apply only to components being analyzed by the 
method, include component names, expected retention times, and calibration data 
(the responses produced by different component amounts). The calibration section 
also includes parameters TotalChrom uses to calculate each component’s 
calibration curve. 

Every cycle in a sequence identifies the method whose calibration parameters 
TotalChrom uses for that particular run. If the method calls for dual-channel data 
acquisition, each channel can either use the same method and calibration values or 
use a different method. If the method calls for single-channel data acquisition, 
you only need one set of calibration parameters. 

Always use the same data acquisition mode for your calibrations and analyses. 
For example, for dual-channel analyses, only use calibration values determined 
in dual-channel calibrations. Similarly, for single-channel analyses, only use 
calibration values determined in single-channel calibrations. 

You develop and modify calibration parameters using the commands in the 
Components menu in the Method Editor. 

Global Information command — Lets you define global component values for 
all components or unidentified peaks in the method. Also gives you access to 
functions needed for use with Connect. 

Defaults command — Lets you set the default values that TotalChrom provides 
when you add new components to a method. 

New Component command — Lets you add a new component to the method. 
This includes entering component identification information and setting the 
calibration parameters you want to use. Also gives you access to functions needed 
for use with Connect. 

Edit Component command — Lets you edit the currently selected component. 

Calibrate command — Lets you update the calibration information in the 
method using response values from result files. 
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Change Component Info command — Lets you change component 
identification parameters for a range of components. 

Change Calibration Info command — Lets you change calibration/quantitation 
parameters for a range of components. 

Delete Component command — From the Component List window, lets you 
delete an individual component from the component list. 

Delete All Components command — From the Component List window, lets 
you delete all components, levels, and replicates from the method. 

Load command — Lets you load a new component list from another file. 

Merge command — Lets you add components from another file. 
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Understanding Global Calibration Parameters 
The settings in the Global Information dialog box apply to the method as a whole, 
including how TotalChrom calibrates peaks that are unidentified in the run. 

 

Every new method contains a set of default parameters, which appear in the 
Global Information and Component Defaults dialog boxes. You only need to 
change the defaults if you are creating a component list. 

This section explains the parameters in the Global Information dialog box. The 
procedures for completing the dialog box follow. 

Volume Units 
Specifies the units you want to use for sample volume in the analysis. These units 
are for reference only in the method and in reports, and do not affect the 
calculations that TotalChrom performs. 

Quantitation Units 
Specifies the units used for amounts or concentrations for calibration standards 
and sample quantitations. These units are for reference only in the method and in 
reports and do not affect the calculations that TotalChrom performs. 
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Sample Volume 

Specifies the normal sample volume for the calibration standards. If the actual 
sample volume you enter for the calibration cycles in the sequence differs from 
this value, TotalChrom corrects the calibration amount values prior to calibration. 

The term sample volume is used to distinguish this parameter from injection 
volume, which is used for a LINK-controlled autosampler. Injection volume 
controls the volume of sample injected into the chromatograph, whereas sample 
volume is simply a correction factor applied to the quantitative results. 

Void Time 

Specifies the elution time of an unretained peak. TotalChrom uses this value to 
calculate k′ and relative retention values as follows: 

k peak retention time - void time
void time

′ =  

relative retention =  
peak retention time -  void time

reference peak retention time -  void time  
The Void Time also corrects the retention times of reference peaks when 
TotalChrom calculates the expected component retention times. For more 
information, refer to “Reference Components” on page 8-13. 

Calibration 

Specifies the calibration setting. The options are: 

External standard — Uses component amounts and response values to compute 
either an average calibration factor or a calibration curve.  

Internal standard — Uses amount ratios and response ratios to compute the 
average calibration factor or calibration curve.  

The amount ratio is the amount of component in a standard sample divided by the 
amount of the designated internal standard in the same sample. The response ratio 
is the area or height of the component peak divided by that of the internal 
standard peak. For information on external and internal standards, refer to 
Chapter 18, “Discussion of Data Analysis.” 

Reject Outliers During Calibration 

Checks the response for each component from a calibration run against the 
current average. If the response falls outside the percentage deviation from the 
average you specify, TotalChrom rejects the results (does not include them as a 
replicate). 



Understanding Global Calibration Parameters 

8-6  

Sample Amount Options 

Correct Amounts For Calibration Standards — Adjusts the calibrated amounts 
of the components during auto or manual calibration. TotalChrom bases the 
adjustment on the difference between the total component amounts from the 
component list (excluding internal standards) and the actual sample amount 
in the sequence file. TotalChrom only makes this correction if you change the 
sample amount in the sequence from the default value. For more information, 
refer to Chapter 11. 

Convert Unknown Samples To Concentration Units — Uses sample amount as 
a divisor for sample cycle types. 

Unidentified Peak Quantitation 

Specifies how TotalChrom calculates unidentified peak amounts in the analysis. 
The options are: 

• Always Use Calibration Factor ⎯ Calculates component amounts based on 
the constant calibration factor you enter in the dialog box. 

• Use Nearest Component ⎯ Calculates each unidentified peak using the 
same options as the nearest component. The amounts are calculated as if the 
unidentified peak is the same as the component. 

• Use Nearest Reference ⎯ Calculates each unidentified peak using the same 
options as the nearest reference peak. TotalChrom calculates the amounts as 
if the unidentified peak is the same as the reference peak. 

For more information on the quantitation of unidentified peaks, refer to 
Chapter 18, “Discussion of Data Analysis.” 

RRT Calculation 
Specifies the way that TotalChrom calculates relative retention time. The 
calculated value is available for reporting purposes; it has no effect on the use of 
reference peaks for component identification. 

• Use First Peak In Run As RRT Reference — Use the first integrated peak 
to calculate relative retention values for all other peaks in the run. 

• Use This Component As RRT Reference — Use the peak selected from the 
list below to calculate relative retention values for all other peaks in the run. 
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Editing Global Calibration Information 
 To edit global calibration parameters: 

1. Choose Global Information from the Component menu to open the 
Global Information dialog box. 

 

There are two tabs in the Global Information dialog box: 

 Global Information ⎯ Use this tab to set parameters that apply to all 
components in the method or to all unidentified peaks. 

 LIMS Results ⎯ If you have Connect, use this tab to specify which 
results to send to SQL*LIMS. 

2. In the Volume Units text box, enter the units you want to use for sample 
volume. 

3. In the Quantitation Units text box, enter the units you want to use for 
amounts or concentrations. 

4. In the Sample Volume text box, enter the value that represents the 
normal sample volume for the calibration standards you are using. 

You only need to alter the default value if you plan to use different 
volumes for different samples. 

5. In the Void Time text box, enter a time value that represents the elution 
time of an unretained peak. 
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6. Under Calibration, select External or Internal Standard as the calibration 
type. 

7. To exclude replicates that are outside a chosen limit, select Reject 
Outliers During Calibration and enter the Allowed Deviation percentage 
you want to use. 

8. To proportionally correct all calibration levels, select Correct Amounts 
For Calibration Standards. 

TotalChrom uses the amount you specify in the sequence file to adjust 
the calibration level. 

9. Select Convert Unknown Samples To Concentration Units if you want 
TotalChrom to perform that function. 

TotalChrom uses the amount you specify in the sequence file as a divisor 
for sample cycle types. 

10. Under Unidentified Peak Quantitation, enter a value in the Calibration 
Factor text box and, if necessary, select a calibration option. 

11. Under RRT Calculation, select the way you want TotalChrom to 
calculate relative retention time. 

The second option is not available until you add a component to the 
method. If you select this option, also select the specific component from 
the list below. 

Your selection here is reflected in the Components dialog box, where 
you can also control this setting as you identify individual components. 
Conversely, if you change the RRT reference there, that change will be 
reflected in the state of the options in this dialog box. 

12. If you have Connect, complete the LIMS Results tab according to the 
Connect documentation. 

13. Make any other changes to the values in the Global Information dialog 
box, and then do any of the following: 

• To save your work and close the dialog box, choose OK. 

• To save your work without closing the dialog box, choose Apply. 

• To discard your changes since the last time you chose Apply and 
close the dialog box, choose Cancel. 
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Understanding Component Parameters 
The Component List window displays the components in the method. The 
component parameters in the middle section of the window show how you want 
the components to be quantitated.  

 
You provide this information through the parameters in the Component Defaults 
and the Components dialog boxes. These dialog boxes contain essentially the 
same parameters: parameters that specify how TotalChrom matches components 
to a peak or peaks (on the Identification tab), and parameters that affect 
calibration (on the Calibration tab). The default parameter values apply to every 
new component added to the list. You can change the values associated with each 
component individually by choosing the Edit or Add Component command in the 
Components menu. 

This section describes some of the parameters and concepts you need to know 
when completing the parameters in the components dialog boxes. The procedures 
for completing the information follow the descriptions starting with “Setting 
Component Defaults” on page 8-20. 
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Component Types 
You can define three types of components in the method: peak (single peak 
components), named groups, and timed groups. 

Single Peak Components 
The single peak component is the simplest and most common component type. 
This setting identifies a component as a single peak in the run. TotalChrom 
performs a calibration by relating an amount to a single peak response at each 
level except when you calibrate by reference or a constant calibration factor. 
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Named Groups 
A named group consists of two or more single peak components. You must first 
identify a peak as a component before you can include it in a named group. The 
group area and height are the sum of the individual peak areas and heights. 
TotalChrom calculates the components as a group, independent of its members’ 
calibrations. TotalChrom reports the results as if the group is a single component. 
You can calibrate the components in a named group individually and report the 
results for individual components. Members of a named group can appear 
anywhere in the chromatogram, and a single peak component can be a member of 
more than one named group. 
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Timed Groups 
A timed group consists of a group of peaks whose retention times fall within a 
group time window that you define. The time window consists of a start time and 
an end time, so a timed group is comprised of a series of contiguous peaks. Each 
peak is detected and integrated individually. The group area and height are the 
sum of the individual peak areas and heights. The group is calibrated 
independently of its members' calibrations if they are identified as components. 
Peaks need not be identified to be included in a timed group. 

 
A variant of the timed-group component type groups all unidentified peaks in a 
specified time zone of the run and quantitates them as a single component. This is 
set up by selecting the check box labeled, Include only unidentified peaks. When 
this is checked, any identified components that fall within the group time limits 
will be excluded from the group. 

When this option is set for a timed group component that fact will be included in 
the method printout for that component. 
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Setting Up Search Windows 
When setting up peak components, you need to define a search window to enable 
TotalChrom to match components with the correct peaks in a run. A search 
window is a time tolerance before and after the expected retention time of the 
component. This window allows TotalChrom to identify components despite 
small variations in retention time from run to run.  

TotalChrom must find a peak within a component's search window to identify it 
as that component. If the component's search window contains no peaks, 
TotalChrom will not be able to find the component in the sample. If more than 
one peak occurs within the search window, you can designate the largest peak in 
the window, or the peak closest to the expected retention time, as the component. 

The search window has two parts:  

Absolute window — Defined by an amount of time, in seconds. 

Relative window — Defined by a percentage of the component’s expected 
retention time. 

Because the relative search window is a percentage of the expected retention time, 
the window increases as retention time increases. This increase helps compensate 
for the greater uncertainty that occurs in peaks eluting later in the run.  

The calculation for the total size of the search window, W (in seconds), centered 
at the expected retention time of the component, RTexp  (in minutes), is: 

W  2 absolute window  
RT    relative window  60

100
exp= +

× ×⎛
⎝⎜

⎞
⎠⎟

 

For example, consider a peak with an expected retention time of 15 minutes, an 
absolute search window of 10 seconds, and a relative search window of 5%. The 
window size on each side of the expected retention time is then 55 seconds ⎯ 10 
seconds plus 5% of 15 minutes (or 45 seconds). The total width of the window is 
then 110 seconds. 

Reference Components 
Retention times for components can vary greatly from run to run. If you create an 
excessively wide search window to find these peaks, you can cause windows to 
overlap. Overlapping windows complicate the peak identification process because 
it then becomes difficult for you to predict the component assignments 
TotalChrom will make. For more information about how TotalChrom handles 
overlapping windows during component identification, refer to “Overlapping 
Windows” in Chapter 18, “Discussion of Data Analysis.” 

To compensate for these shifts in peak retention times, you can use reference 
components. As with any other peak component, a reference component has an 
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expected retention time and a search window. However, a reference component is 
usually readily identifiable either because it is well separated from other peaks or 
because it is always the largest peak in that region of the chromatogram. 

When you establish a reference component, TotalChrom uses the ratio of the 
actual retention time of the reference peak to the expected time in order to 
calculate adjusted expected retention times for the components associated with the 
reference component. The complete equation for the adjustment calculation is 

T   
T   T
T   T

 Tadj comp
act ref void

exp ref void
exp comp=

−
−

⎛

⎝
⎜

⎞

⎠
⎟  

where 

Tadj comp is the adjusted expected retention time for a component 

Tact ref is the actual retention time of the reference component from the run 

Texp ref is the expected retention time of the reference component as defined in 
the method 

Tvoid is the Void Time (if you have entered one in the Global Information 
dialog box) 

Texp comp  is the expected retention time of the component as defined in the 
method 

You can define one or more components as reference peaks in the component list. 
However, you cannot use named or timed group components as reference peaks. 
For information about optimizing component identification, refer to Chapter 18, 
“Discussion of Data Analysis.” 

Internal Standard Components 
If you select Internal Standard as the method of Calibration in the Global 
Information dialog box, you must associate each component (that is not itself an 
internal standard) with a designated internal standard component. You can define 
one or more components as internal standards in the component list. However, 
you cannot use named or timed group components as internal standards. 

When you use an internal standard, TotalChrom relates amount ratios to response 
ratios in order to compute the calibration curve or average calibration factor. The 
amount ratio is the amount of component in the calibration standard divided by 
the amount of the internal standard component in the same sample. The response 
ratio is the area or height of the component peak divided by that of the internal 
standard peak. For more information about the internal standard method, refer to 
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“External Standard Versus Internal Standard Calibration” in Chapter 18, 
“Discussion of Data Analysis.” 

Calibration Type 

 

You can use a different calibration type for each component in a method. The 
calibration types are: 

Use Calibration Factor ⎯ Calculates component amounts based on the constant 
calibration factor you enter for the individual component. Note that this is 
different from the calibration factor you enter in the Global Information dialog 
box, which is used for all unidentified peaks. The calibration factor is divided into 
the peak response to obtain an amount during quantitation. 

Average Calibration Factor ⎯ Averages the response-to-amount values (or 
response ratio-to-amount ratio for internal standard calibration) at each calibration 
standard level. It applies to multi-level calibrations but does not construct a 
calibration curve from the data. 

Calibrate By Reference ⎯ Quantitates the component using the calibration type 
of a designated reference component. TotalChrom calculates the amounts as if the 
peak were the same as the calibration reference component. The designated 
calibration reference component can be any component in the method (other than 
an internal standard), and it is distinct from any time reference peak specified for 
identification purposes. 
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Use Curve ⎯ Creates a calibration curve based on the data collected from 
standard samples. The actual curve for each component depends on the values in 
a number of parameters. If you specify an external standard calibration, the curve 
then shows the relationship between amount and response (area or height) values. 
If you specify an internal standard calibration, the curve then shows the 
relationship between amount ratios and response ratios (between the component 
and its designated internal standard component). 

Response 
The Area and Height Response options on the Calibration tab specify whether 
TotalChrom calibrates and quantitates each component using peak area or peak 
height values. You can change the option if you want to use a different response 
mode for different components. 

Selecting Fit Parameters 
If you select Use curve as the Calibration Type in one of the components dialog 
boxes, the Curve fit type, Scaling, Weighting, and Purity (%) parameters become 
active. These parameters determine exactly how the software constructs the curve 
from the data points. 

 

Curve Fit Type 
The Curve Fit Type options are: 

Point To Point — Averages all replicate amount and response data at each 
calibration level to derive a point. Each pair of points is connected by a straight 
line segment. You can use this fit type with one or more calibration levels. 

1st Order Polynomial — Calculates a first-order polynomial (linear) fit using the 
coefficients of the curve (the intercept and slope). A component must have at least 
two calibration levels to use this type of fit. 

2nd Order Polynomial — Calculates a second-order polynomial (quadratic) fit 
using the curve coefficients. A component must have at least three calibration 
levels to use this type of fit. 

3rd Order Polynomial — Calculates a third-order polynomial (cubic) fit using 
the curve coefficients. A component must have at least four calibration levels to 
use this type of fit. 
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For more information about how TotalChrom solves the various calibration curve 
types, refer to “Calibration of Initial Component Amounts” in Chapter 18, 
“Discussion of Data Analysis.” 

Scaling Factor 
Instead of using response versus amount (or response ratios versus amount ratios 
for internal standard) for the calibration curve, you can use alternative functions 
of the amounts. The Scaling options are: 

None Does not add a scaling factor. 

1/X Plots response as a function of the reciprocal of the amount. 

1/(X*X) Plots response as a function of the reciprocal of the square of the 
amount. 

log[X] Plots response as a function of the base-10 log of the amount. 

1/log[X] Plots response as a function of the reciprocal of the base-10 log of the 
amount. 

If you are using internal standard calibrations, X represents the amount ratio. 

If you use one of these scaling alternatives, some values will not be valid. For 
example, you cannot use 0.0 with l/X or l/(X*X), and you cannot use an amount 
less than 1.0 with a logarithmic option. 

Weighting Factor 
By default, the software weights each data point equally when it calculates the 
calibration curve equation. However, you can use different weighting options to 
affect how the curve is fit to the data. The Weighting options are: 

None Applies no weighting. 

1/X Uses the reciprocal of a point’s amount value. 

1/Y Uses the reciprocal of a point’s response value. 

1/(X*X) Uses the reciprocal of the square of a point’s amount value. 

1/(Y*Y) Uses the reciprocal of the square of a point’s response value. 

Purity (%) Value for Components 
Enter a Purity % number that represents the percent purity of the standard 
material for the component. The amount at each calibration level is multiplied by 
the purity value before being used to calculate the calibration curve. The range of 
permitted values will be 0.0001 to 100.0000%. The default value will be 
100.0000%. 
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The Purity field is enabled whenever the grid is enabled; that is, when the 
calibration type is Use curve or Avg calibration factor. 

The Purity field is disabled and will not be visible when the Calibration Type is 
Use calibration factor or Calibrate by reference. In both of these cases the internal 
value stored for the component will be reset to 100%. 

You cannot set a purity value for an Internal Standard component since it is 
always 100%. 

Calibrate by Reference 
This is for use only with components that are calibrated by reference. 

 

When you select Calibrate by reference, the Cal Reference Factor entry field 
replaces the Purity field shown when the calibration type is Use curve or Avg 
calibration factor.  

The Cal reference factor value is the factor that is modified to act AFTER the raw 
adjusted amount has been calculated in the usual way.  In other words, Cal 
Reference Factor acts as an additional multiplier on the raw amount. The factor 
can only be used if the calibration reference component's calibration type is Use 
Calibration Factor or a first order curve FORCED THRU THE ORIGIN. The 
permitted range will be the standard TotalChrom floating point range (positive 
numbers only). The default value will be 1.0000. 
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Origin 
TotalChrom provides three alternatives for defining how you want to treat the 
origin in calculating a calibration curve. The origin is the point (0,0). The options 
under Origin Treatment are 

Force — The intercept is always zero in the calculation. With this option, the 
curve is forced to pass through the origin.  

Include — The origin is added to the calculation but does not appear in the 
calibration level list. 

(None) — If you deselect both of these options, the software does not factor the 
origin into the calibration.  

User Values/LIMS 
The User Values/LIMS tab provides additional settings you can use when setting 
up and editing components. 

User Values — You can define up to five numeric constants for each component. 
You can then include these values in custom expressions within the Report 
Format Editor. Setting up these values enables TotalChrom to perform such 
calculations as molar concentration, percentage recovery, or BTU content. 

LIMS —If you have Connect, you can send results for a particular component to 
SQL*LIMS. For information, refer to the Connect documentation. 
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Setting Component Defaults  
This section describes the Component Defaults dialog box and the procedures for 
setting up defaults. For detailed information on the specific parameters in the 
Component Defaults dialog box, refer to “Understanding Component Parameters” 
on page 8-9. 

The Defaults command in the Components menu lets you set the default values 
that the software provides when you add new components to a method. 
Customizing component defaults is useful in the following situations: 

• You want to add to a method or series of methods a large number of 
components whose parameters are the same. 

• You want to add to a method a large number of components that share an 
internal standard or retention reference. 

You generally use the component defaults function in conjunction with the 
Components dialog box, which you use for adding new components. For 
example, if you want to add 100 components that have the same calibration 
settings, set the common parameters in the Default Components dialog box. Then, 
when you add each component using the Components dialog box, you only need 
to specify the unique parameters such as the component names and retention 
times. For information on adding new components, refer to “Adding and Editing 
Components” on page 8-28. 
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Entering Default Component Information 
The following is the general procedure for entering component default 
information. 

 To enter default component information: 

1. Choose Defaults from the Components menu to open the Component 
Defaults dialog box.  

 

There are three tabs in the Component Defaults dialog box: 

 Identification ⎯ Select this tab to establish parameters for component 
identification. The options on this tab change depending on the 
component type you select. 

 Calibration ⎯ Select this tab to set the calibration defaults you want to 
use. 

 User Values/LIMS ⎯ Select this tab to specify default constants to use 
in calculations. You also use this tab to set the default for tagging 
components for SQL*LIMS (if you have Connect). 
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2. Make any changes to the values in the Component Defaults dialog box, 
and then do any of the following: 

• To save your changes and close the dialog box, choose OK.  

• To save your changes without closing the dialog box, choose Apply. 

• To discard your changes since the last time you chose Apply and 
close the dialog box, choose Cancel. 

The following sections describe how to complete each tab of the Component 
Defaults dialog box. 

Entering Component Identification Defaults 
You can specify that TotalChrom identifies new components as peak, named 
group, or timed group components. This section describes the procedures for 
setting defaults for each type. Generally, you set up component identification 
defaults for peak components. 

If you are setting up default internal standards or reference peaks, the components 
you want to designate must appear in the component list for the open method. For 
example, if you want to set Methane as an internal standard for new peak 
components, you must first add it to the method and then specify that it is an 
internal standard in the Components dialog box. 

 To set a single peak component as the default type: 

1. Select the Identification tab of the Component Defaults dialog box. 

2. Select Peak under Component Type. 

3. In the Absolute Window text box, enter the time you want to use for the 
default absolute search window. 

4. In the Relative Window text box, enter the percentage you want to use 
for the default relative search window. 

5. Select Find Largest Peak In Window if you want the default to be to 
identify peaks by size (based on height, not area). 

When you deselect this option, TotalChrom identifies the peak closest to 
the expected time as the component. 

6. To designate a component as the default reference peak, select it from 
the Reference list. 

7. To designate a component as the default internal standard, select it from 
the Internal Standard list.  
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 To set defaults for new named and timed group components: 

• The procedures for setting identification defaults for named group and 
timed group components are very similar to that for peak components, 
except that many parameters are not available.  

• For named group components, select the component that you want 
to designate as the default internal standard for the open method.  

• For timed groups, select the default retention reference and/or the 
default internal standard for the open method. 

Setting the Calibration Defaults 
Calibration values affect how the software calculates component amounts. You 
can choose among the following types of calibration for components:  

• Using a constant calibration factor 

• Calculating an average calibration factor 

• Using the calibration curve of another component (calibration reference) 

• Solving the component's calibration curve 

The procedures for setting up each calibration type follow. This section also 
provides instructions for working with calibration levels. 

 To calibrate using a constant calibration factor: 

1. Select the Calibration tab of the Component Defaults dialog box 

2. Select Use Calibration Factor as the Calibration Type. 

 

3. Enter a calibration factor value in the Cal Factor text box. 

4. Under Response, select whether to use Area or Height. 
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 To calibrate using an average calibration factor: 

1. Select the Calibration tab of the Component Defaults dialog box. 

2. Select Avg Calibration Factor as the Calibration Type. 

 

The table in which you specify the calibration levels becomes active. 

3. Under Response, select whether to use Area or Height. 

The last column of the table changes to Area or Height, depending on the 
option you choose. 

4. Edit the Level, Amt, and Area or Height values. 

For more information on levels, refer to “Adding Default Calibration 
Levels” on page 8-26. 

 To calibrate using a reference component: 

1. Select the Calibration tab of the Component Defaults dialog box.  

2. Select Calibrate By Reference as the Calibration Type. 

 

3. Select a component from the open method in the Cal Reference list. 

You do not have to select a specific component to use Calibrate By 
Reference as the default calibration type. However, you must pick one 
when you add new components. 

 The Cal reference factor value is the factor that is modified to act 
AFTER the raw adjusted amount has been calculated in the usual way.  
In other words, Cal Reference Factor acts as an additional multiplier on 
the raw amount. The factor can only be used if the calibration reference 
component's calibration type is Use Calibration Factor or a first order 
curve FORCED THRU THE ORIGIN. The permitted range will be the 
standard TotalChrom floating point range (positive numbers only). The 
default value will be 1.0000. 
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 To calibrate using calibration curve parameters: 

1. Select the Calibration tab of the Component Defaults dialog box. 

2. Select Use Curve as the Calibration Type. 

 

3. Under Response, select Area or Height. 

The last column of the table changes to Area or Height depending on the 
option you choose. 

4. From the Curve Fit Type list, select a curve type. 

When you set defaults, you must enter an appropriate number of levels 
for the curve type you have selected. However, you do not have to 
change amounts from 0.0000. Based on the calibration curve type, the 
minimum number of levels required are: 

• Point-To-Point:  1 

• 1st Order Polynomial:  2 (or 1 if you include the origin) 

• 2nd Order Polynomial: 3 (or 2 if you include the origin) 

• 3rd Order Polynomial: 4 (or 3 if you include the origin) 

5. From the Scaling list, select a factor you want to use. 

For definitions of the choices, refer to “Selecting Fit Parameters” on 
page 8-16. 

6. From the Weighting list, select a factor you want to use. 

For definitions of the choices, refer to “Selecting Fit Parameters” on 
page 8-16. 

7. Under Origin Treatment, select Include or Force as the origin option, if 
required. 

Leave both options deselected to omit the origin from the calibration. 

8. Edit the Level, Amount, and Area/Height values as necessary. 

For more information on how to create new calibration levels, refer to 
the next section. 
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Adding Default Calibration Levels 
To determine unknown component amounts, TotalChrom compares the 
component's response (peak area or height) to the response of a known amount of 
the same component in a single standard sample. To improve the accuracy, you 
can choose to inject more than one standard sample, where each sample contains 
the same component but in different amounts. These varying samples are called 
calibration levels.  

The response produced by the component at each calibration level, plotted against 
the level amount, defines the points on which the component's calibration curve is 
based. 

Some notes about calibration levels: 

• You can only add calibration levels with the Avg Calibration Factor and Use 
Curve calibration types. 

• A component can have up to 100 calibration levels, but the level names for 
all components in a standard sample must be the same. 

• Use unique level names for different levels. 

• Ensure that two different levels do not have the same amount unless the 
component is an internal standard component. 

 To add new calibration levels: 

1. Choose Avg Calibration Factor or Use Curve as the Calibration Type. 

2. Under Response, select whether to use Area or Height. 

3. Enter a level name or number in the first empty cell in the Level column. 

The level name must be between 2 and 40 characters. 

4. Enter a value in the first empty cell in the Amt. column. 

You do not need to enter an amount of more than zero when you set 
defaults. Do this only when you add components to the list. 

The value displayed in the Area/Height column is grayed-out because it is not 
relevant for default components. 

TotalChrom adds a new row to the table after you complete the columns 
for the current level. 

5. Repeat Steps 2 to 4 to add additional levels. 
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Setting User Value and LIMS Defaults 
You can use the User Values/LIMS tab to:  

• Specify a number of default constants associated with a default component 
type. 

• Set up a default for SQL*LIMS reporting (if you have Connect).  

You can specify default constants and then use these values in custom 
expressions, which you create in the Report Format Editor. For example, you can 
multiply the peak area or the peak concentration (or other value) by a constant 
factor for each individual component. You are more likely, however, to enter 
constants as you add each component, rather than entering them as defaults. 

 To set default user values for components: 

1. Select the User Values/LIMS tab of the Component Defaults dialog box. 

 

2. In the User Label text box, enter a label that associates the default values 
with a component. 

3. In the User Values text boxes, enter the default values that you want to 
use. 

4. Select Send Results For This Component To LIMS if you want the 
default to be to send the information for this component to SQL*LIMS. 
For information, refer to the Connect documentation. 
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Adding and Editing Components 
You add and edit components in the Components dialog box. The New 
Component and Edit Component commands in the Components menu both open 
the Components dialog box. The difference between the two commands is in the 
initial ‘mode’ of the dialog box: 

• When you choose New Component, the dialog box is ready to accept your 
input of a new component (add mode) 

• When you choose Edit Component, the dialog box is ready for you to select 
an existing component to edit (edit mode) 

Whichever command you use, once the Components dialog box is open you can 
both add and edit without having to close and reopen the dialog box to change the 
mode. 

• To switch from editing to adding, choose the New Component command 
button. 

• To switch from adding to editing, select a component to edit from the list. 

You can also open the Components dialog box in edit mode by double-clicking a 
component name in the Component List window. This both opens the window 
and preselects the component that you want to edit. 

For detailed information on the specific parameters contained in the Components 
dialog box, refer to “Understanding Component Parameters” on page 8-9. 
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The following is the general procedure for adding and editing component 
information. 

 To add or edit component information: 

1. Choose New Component or Edit Component from the Components menu 
to open the Components dialog box.  

 

There are three tabs in the Components dialog box: 

 Identification ⎯ Select this tab to set parameters for component 
identification. The options on this tab change depending on the peak type 
you select. 

 Calibration ⎯ Select this tab to set the calibration parameters you want 
to use. 

 User Values/LIMS ⎯ Select this tab to specify constants to use in 
calculations. You can also use this tab to tag components for SQL*LIMS 
reporting (if you have Connect). 

2. You can use the Next and Previous buttons to scroll through the list of 
components that are already in the method. 

3. To delete the currently selected component from the component list, 
choose Delete Component. 
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4. Make any changes to the values in the Components dialog box, and then 
do any of the following: 

• To save your work and close the dialog box, choose OK. 

• To save your work without closing the dialog box, choose Apply. 

• To close the dialog box and discard your changes since the last time 
you chose Apply, choose Cancel. 

The following sections describe how to complete each tab of the Components 
dialog box. 

Adding a Component 
If you are adding a large number of components whose parameters are the same, 
you might want to customize the component defaults before starting this 
procedure. For more information, refer to “Setting Component Defaults” on 
page 8-20. 

 To prepare to add a new component: 

• Do one of the following: 

• Choose New Component from the Components menu to open the 
Components dialog box in add mode. 

• Choose the New Component command button on the Identification 
tab of the Components dialog box. 

Entering Component Identification Information 
When adding components, the first step is to complete the component 
identification information. You can add the following types of components: 

• Single peak components 

• Named group components 

• Timed group components 

Note the following about component types: 

• Any peak component you add to the component list in a method can also act 
as a reference component or internal standard. 

• You must have identified the single peak or timed group components before 
you can create a named group. The members of a named group do not need to 
be located contiguously in the chromatogram: they can appear anywhere. 

• Peaks need not be identified to be included in a timed group. 
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 To add a peak component to the component list: 

1. Select the Identification tab of the Components dialog box and select 
Peak as the component type. 

 

2. In the Name text box, enter a name for the component. 

3. In the Retention Time text box, enter the expected retention time for the 
component. 

4. In the Absolute Window text box, enter the size of the absolute search 
window you want to use on either side of the expected retention time. 

5. In the Relative Window text box, enter a percentage of the expected 
retention time you want to add onto either side of the absolute search 
window. 

6. Select Find Largest Peak In Window if you want TotalChrom to identify 
the largest peak (based on height, not area) as the component rather than 
the one closest to the expected retention time. 

7. Do one of the following: 

• To use the current component as a retention reference for other 
components in the method, select This Component Is A Retention 
Reference. 

• To use another component in the current method as a reference, 
select a retention reference from the Reference list. 

• Select <no reference> in the Reference list if this component needs 
no retention reference. 

8. If the method specifies internal standard calibration, do one of the 
following: 

• To use the current component as an internal standard for other 
components in the method, select This Component Is An Internal 
Standard. 

• To use another component as an internal standard component, select 
one from the Internal Standard list. 

If you are performing an internal standard calibration, you must select an 
internal standard. 
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9. To use this component as the reference for calculating RRT, select the 
corresponding check box. 

You will be prompted to confirm any change that you make. 

The state of this check box for each component reflects what you entered 
for RRT reference in the Global Information dialog box (or what you set 
here last time): 

• If you designated this method to use the first peak as the RRT 
reference, then this check box will not be selected for any 
component. 

If you designated this method to use a specific component as the RRT 
reference, then this check box will be selected when you select that 
component. 

 To add a named group to the component list: 

1. Select the Identification tab of the Components dialog box and select 
Named Group as the Component Type. 

 

2. In the Name text box, enter a name for this group. 

3. Select the components you want to include in the named group from the 
Group Members box. 

The list includes all peak and timed group components contained in the 
open method. To select multiple components, hold down the Ctrl key 
and then click on each name. 

4. From the Internal Standard list, select the component you want to use as 
the internal standard. 

This list consists of all components in the open method that have already 
been designated as internal standards. 

 To add a timed group to the component list: 

1. Select the Identification tab of the Components dialog box and select 
Timed Group as the Component Type. 

  

2. In the Name text box, enter the name you want to use for this timed 
group. 
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3. In the Start Time text box, enter the starting time you want to use. 

TotalChrom only includes in the group those peaks whose crests occur 
after this time. 

4. In the End Time text box, enter the ending time you want to use. 

TotalChrom only includes in the group those peaks whose crests occur 
before this time. 

5. From the Reference list, select the component you want to use as a 
reference component. 

If you specify a reference component, TotalChrom adjusts the actual start 
and end times used to define the group based on the actual retention time 
of the reference peak in each run. 

6. If necessary, select the name of a component you want to use as an 
internal standard from the Internal Standard list. 

Setting Calibration Parameters 
Calibration values affect how TotalChrom calculates component amounts. You 
can choose among the following types of calibration for components:  

• Using a constant calibration factor 

• Calculating an average calibration factor 

• Using the calibration curve of another component (calibration reference) 

• Solving the component's calibration curve 

The procedures for setting up each calibration type follow. This section also 
provides instructions for working with calibration levels. 

If you select Use Calibration Factor, TotalChrom divides the component's 
response by the calibration factor to obtain an amount. 
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 To calibrate using a constant calibration factor: 

1. Select the Calibration tab of the Components dialog box.  

2. Select Use Calibration Factor as the Calibration Type. 

 

3. Enter a calibration factor value in the Cal Factor text box. 

4. Under Response, select whether to use Area or Height. 

If you select Average Calibration Factor as the calibration type, TotalChrom 
averages the slope at each calibration point on the curve and uses this average as a 
single calibration factor. TotalChrom does not perform a linear regression on the 
data. Because this calculation requires that the intercept of the curve pass through 
the origin, the Origin options are not available when you add new components or 
edit existing components. 

The slope at each calibration point referred to above is either a response-to-
amount ratio (for external standards), or response ratio-to-amount ratio (for 
internal standards) for each replicate. 
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 To calibrate using an average calibration factor: 

1. Select the Calibration tab of the Components dialog box. 

2. Select Avg Calibration Factor as the Calibration Type. 

 

3. Under Response, select whether to use Area or Height. 

The last column of the table changes to Area or Height, depending on the 
option you choose. 

4. Edit the Level, Amt, and Area or Height values as necessary. 

For more information on levels, refer to “Working with Calibration 
Levels” on page 8-37. 

You can perform a calibration by using the calibration of another component. 
TotalChrom calculates the amount for the component based on the calibration 
curve of the other component. This type of calibration is called calibrating by 
reference. The calibration reference component, in this case, can be any 
component: it does not have to be one previously defined as a reference peak. 

 To calibrate using a reference component: 

1. Select the Calibration tab of the Components dialog box.  

2. Select Calibrate By Reference as the Calibration Type. 

 

3. Select a component to use as a reference from the Cal Reference list. 
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 To calibrate using a calibration curve: 

1. Select the Calibration tab of the Components dialog box. 

2. Select Use Curve as the Calibration Type. 

 

3. Under Response, select whether to use Area or Height. 

The last column of the table changes to Area or Height depending on the 
option you choose. 

4. Select the Curve Fit Type you want to use from the list. 

Depending on the calibration curve type, the minimum number of levels 
required are as follows: 

• Point-To-Point:  1 

• 1st Order Polynomial:  2 (or 1 if you include the origin) 

• 2nd Order Polynomial: 3 (or 2 if you include the origin) 

• 3rd Order Polynomial:  4 (or 3 if you include the origin) 

5. Select the Scaling factor you want to use from the list. 

For definitions of the options, refer to “Selecting Fit Parameters” on 
page 8-16. 

6. Select the Weighting factor you want to use from the list. 

For definitions of the options, refer to “Selecting Fit Parameters” on 
page 8-16. 

7. Under Origin Treatment, select Include or Force as the origin option if 
required. 

Include origin adds point 0,0 to the calibration (zero amount to zero 
response). Force origin prevents any offset, forcing the curve to go 
through the point of origin. 

Leave both options deselected to omit the origin from the calibration. 

8. Edit the Level, Amount, and Area/Height values as necessary. 

For more information on how to create new calibration levels, refer to 
“Working with Calibration Levels” on page 8-37. 
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Working with Calibration Levels 
If you did not build calibration levels in the Component Defaults dialog box, or if 
you need additional levels, you can add new levels in the Components dialog box. 

To determine unknown component amounts, TotalChrom compares the 
component's response (peak area or height) to the response of a known amount of 
the same component in a single standard sample. To improve the accuracy, you 
can choose to inject more than one standard sample, where each sample contains 
the same component but in different amounts. These varying samples are called 
calibration levels.  

The response produced by the component at each calibration level, plotted against 
the level amount, defines the points on which the component's calibration curve is 
based. 

Some notes about calibration levels: 

• You can add calibration levels only with the Avg Calibration Factor and Use 
Curve calibration types. 

• A component can have up to 100 calibration levels, but the level names for 
all components in a standard sample must be the same. 

• Use unique level names for different levels. 

• Ensure that two different levels have different amounts unless the component 
is an internal standard component. 

You can also revise an existing calibration level, or delete it from the list if it no 
longer applies to a specific method or component. If you are using named or 
timed groups, these actions apply to a group of components. 

 To add a calibration level: 

1. Choose Avg Calibration Factor or Use Curve as the Calibration Type. 

 

2. Under Response, select Area or Height as the option you want to edit. 

3. Enter a level name or number in the first empty cell in the Level column. 

The level name must be between 2 and 40 characters. 
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4. Enter a value in the first empty cell in the Amt. column. 

TotalChrom adds a new row to the table after you complete the columns 
for the current level. 

The value displayed in the Area/Height column is grayed-out because it is not 
relevant for default components. 

5. Repeat Steps 2 to 4 to add additional levels. 

 To change an existing calibration level: 

1. In the table showing the levels, select the cell that contains the parameter 
you want to change 

2. Edit the parameters as necessary. 

If you change level entries that contain any replicates, TotalChrom will 
delete the replicates. 

 To delete a calibration level: 

1. Click inside the row you want to delete. 

2. Press the Delete key. 

Setting User Values and LIMS Options 
You can use the User Values/LIMS tab to: 

• Specify a number of constants associated with the component 

• Set up SQL*LIMS reporting for the component (if you have Connect) 

You can specify constants and then use these values in custom expressions, which 
you create in the Report Format Editor. For example, you can multiply the peak 
area or the peak concentration (or other value) by a constant factor for each 
individual component. 

If you are using Connect, you can also use this tab to specify whether to send the 
results for the component to LIMS. 

 To set user values for the component: 

1. Select the User Values/LIMS tab in the Components dialog box. 

2. In the User Label text box, type a label that associates the values with the 
component. 

3. In the User Values text boxes, type the constants that you want to use. 

4. Select Send Results For This Component To LIMS if you want to send 
the information for this component to SQL*LIMS. For information, refer 
to the Connect documentation. 



Adding and Editing Components 

Developing Calibration Parameters in the Method 8-39 

Editing a Component 
The procedure for editing a component is the same as that for adding a new 
component, except that you choose an existing component instead of entering a 
new name. 

 To edit component information: 

1. Do one of the following: 

• Choose Edit Components from the Components menu. 

• Double-click on the component name to open the Components 
dialog box. 

2. Use the mouse or the Next and Previous command buttons to select the 
component that you want to edit from the list in the dialog box. 

3. Edit the component parameters as necessary. 

For specific procedures, refer to “Adding a Component” on page 8-30. 
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Loading and Merging Components From Files 
When you build a method, you can use the component list from another method, 
text file, or result file, and edit the component information as necessary for the 
current method. To use the components from another file, you choose the Load 
and Merge commands in the Components menu. 

Load — TotalChrom replaces the existing components in the component list with 
the components from the file. 

Merge — TotalChrom intersperses, by retention time, the existing components in 
the component list with the components from the file. 

To use the Text File commands, you must first generate an ASCII text file. Each 
line of the text file represents a component that you want added to the list, and 
each line must have the following format: 

"<name>", <time> [, <abs> [, <rel>]] 

Two examples are: 

"Aldrin", 8.6, 5, 0.1 

"Dieldrin", 13.15, 6, 0.1 

where <name> is the component name, and <time> is the expected time for the 
component. You must specify both of these values, and you must enclose the 
name in quotes. The remaining two values, representing the size for the absolute 
search window and the size for the relative search window, are optional. You 
must separate all values on a line by commas. 

The information in the component default file supplies all other values, including 
the search window values, if they are not defined in the text file. 

 To load components from a text, result, or method file: 

1. Do one of the following: 

• Choose Load/Text File or Load/Result File from the Components 
menu to open the file selection dialog box for the specified type of 
file. Skip to Step 5. 

• Choose Load/Method File from the Components menu to open the 
Load From Method File dialog box. Continue with Step 2. 

2. Leave Copy Levels From Method File selected if you want to copy 
calibration levels. 

3. Leave Copy Replicates From Method File selected if you want to copy 
replicate injection information. 

4. Choose OK to open the file selection dialog box showing method files. 
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5. Select the file whose component list you want to load into the current 
method file, and then choose OK. 

The component information contained in the selected file appears in the 
component list. The new information overwrites existing data in the 
component list. 

The procedure for merging components is similar to loading, including the option 
to include calibration information from method files. 

 To merge components from a result, text, or method file: 

1. Choose Merge/Text File, Merge/Result File, or Merge/Method File from 
the Components menu. 

2. Select the file with the component information you want to merge, 
including the levels, and replicates from the calibration section of the 
method if you are merging a method file. 

3. Choose OK. 
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Deleting Components 
You can delete a component from the component list by using the Delete 
command or the Delete key. 

 To delete a component from the component list: 

1. In the Component List window, select the component you want to delete. 

2. Choose Delete Component from the Components menu. 

The selected component and its related information is deleted, and the 
Component List window changes to show information on the next 
component. 

 To delete all components, levels, and replicates: 

• Choose Delete All Components from the Components menu. 

After asking you to confirm the command, TotalChrom deletes all 
components from the component list for this method file. 
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Changing Parameters for Multiple Components 
Simultaneously 

The following commands in the Components menu allow you to make changes 
simultaneously to multiple components: 

Change Component Info ⎯ Changes the search window and reference peak 
information for a range of components. 

Change Calibration Info ⎯ Changes parameters for a range of components. 

The changes apply to the range of components and parameters that you specify in 
each dialog box. You specify the component range by using the index numbers 
for each component, which appear next to the entry in the component list. 

 To change component information for a range of components: 

1. Choose Change Component Info from the Components menu to open the 
Change Component Information dialog box. 

 

2. To redefine the search window size, select the Absolute Window option, 
and enter a new value (in seconds) in the text box. 

3. To redefine the relative window size as a percentage of the expected 
retention time, select the Relative Window option, and enter a new value 
in the text box 

4. To change the peak identification, select the Peak Identification option. 
Select Find Largest Peak if you do want to identify the largest peak 
(based on height, not area) in the search window as the component. 

5. To change the reference component, select the Reference Component 
option, and then choose a name from the list. Choose <no reference> to 
remove an existing reference component. 
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6. To change the internal standard component, select the ISTD Component 
option, and then choose a component name from the list. 

7. In the First Component text box, enter the index number of the first 
component in the range that you want to change. 

8. In the Last Component text box, enter the index number of the last 
component in the range that you want to change. 

9. Choose OK. 

TotalChrom updates the component list to reflect the changes you 
specified. 

The Change Calibration Info command in the Components menu allows you to 
change the calibration data for more than one component. For example, you can 
change all components to use peak height instead of peak area. 

 To change calibration parameters for a range of components: 

1. Choose Change Calibration Info from the Components menu to open the 
Change Calibration Information dialog box. 

 

2. To change the calibration type, select Change Calibration Type and 
select an option. 

For detailed information on each of the options, refer to “Setting 
Calibration Parameters” on page 8-33. 

3. To change the peak response you want to use for calibration, select 
Change Response and select Area or Height. 

4. To change the origin option, select Change Origin and select Include 
Origin, Force Origin or neither (to reset a previous origin option). 
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5. To change the plot scaling, select Change Scaling and select an option 
from the list. 

6. To change the regression weighting, select Change Weighting and select 
an option from the list. 

7. To change the curve fit type, select Change Curve and select an option 
from the list. 

8. In the First Component text box, enter the first index number in the range 
of components that you want to change. 

9. In the Last Component text box, enter the last index number in the range 
of components that you want to change. 

10. Choose OK. 

TotalChrom updates the component list to reflect the changes you 
specified. 
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Performing a Manual Calibration  
The Calibrate command in the Components menu lets you use response values 
from one or more result files to update the calibration information in a method 
file. The procedure consists of: 

• Selecting one or more result files 

• Selecting a calibration level for each result file 

• Selecting the calibration type for each combination of result files and 
calibration levels 

• Performing the calibration 

To perform a manual calibration, you must have a component list and calibration 
levels associated with each component in the list. You also need to verify that the 
calibration parameters for each component are correct before you perform a 
manual calibration. 

When you manually calibrate a method, you create calibration replicates. A 
replicate is a repetitive analysis of the same calibration standard for a particular 
calibration level. Since it is a unique analysis, you can use replicates to average 
calibrations. 

 To perform a manual calibration: 

1. Choose Calibrate from the Components menu to open the Manual 
Calibration dialog box. 

 

2. Choose Add to select the appropriate result file. 
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3. Select a level in the Level list box. 

4. Select Replace or Average as the Calibration Type. 

 Replace — Replaces the existing replicates with the new replicates. 

Average — Averages the existing calibration replicates with the new 
replicates. 

5. Repeat Steps 2 through 4 to include more files. 

6. To identify peaks in the result file before calibration, select Identify 
Peaks Before Calibrating. 

Select this option if you want TotalChrom to identify peaks based on changes 
you have made in the method. Only select this option if you know that the 
current version of the method will identify the peaks in the result file 
correctly. 

7. Choose OK. 

 To change an entry in the Filename/Level/Cal Type list: 

1. Select the entry you want to change in the Filename/Level/Cal Type list. 

2. Select a new filename, level, or calibration mode. 

3. Choose Change. 

4. Choose OK. 

 To delete an entry from the Filename/Level/Cal Type list: 

1. Select the entry you want to delete in the Filename/Level/Cal Type list. 

2. Choose Delete. 

3. Choose OK. 

Excluding and Deleting Replicates  
Replicate data are stored in the method. The calibration table in the Components 
dialog box displays the average response for each level; the Replicates dialog box 
shows the individual values that make up the average. Once you create a replicate, 
you can either exclude it from the current calibration or delete it altogether. 

 To work with the replicate list: 

1. Choose Edit Component from the Components menu or double-click the 
component name in the Component List to open Components dialog box. 

2. Select the Calibration tab to view the level settings for the selected 
component. 
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3. Open the Replicates dialog box by double-clicking any level that is 
marked with an asterisk or by clicking the Replicates button. 

 

4. Select the replicate you want to act on by clicking its row number. 

Use Ctrl-Click and Shift-Click to select multiple replicates. 

5. To exclude a replicate from the list, choose Exclude. 

Replicates that you exclude are shown in red on this list. The points that 
represent replicates will appear in a different color on the calibration 
curve for that component. TotalChrom excludes these replicates from the 
analysis (and the plot), but the replicates still exist in the result file. 

You cannot exclude all replicates or delete the last replicate if all other 
replicates are excluded. To remove all calibration data from a level, you 
must delete all replicates or delete the level itself. The next topic describes 
how this can be done for all components and all levels simultaneously using 
the /c command line parameter. 

6. To include a replicate that you have excluded, choose Include. 

7. To delete a replicate from the list, choose Delete. 

Points associated with replicates will be removed from the calibration 
curve. 

8. Choose OK to return to the Components dialog box. 
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Deleting All Calibration Replicates 
You can delete all calibration replicates from a method in one operation by 
running the Method Editor from the command line, typically by setting it up as a 
user program in the Sequence Editor. 

You will need to use the following information to fill in the Program Information 
dialog box: 

Program Name — MethEdit.exe 

Command Line —”filename.mth” /c 

This will delete every replicate for every component in the method. 

Refer to Chapter 11 for complete information and instructions on how to include a 
user program in a sequence. 
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Chapter 9 
Building a Report Format 

 

This chapter explains how to use the Report Format Editor to build a report format 
file. This file controls which parameters are included in the printed report that follows 
data analysis. 

You can use TC Publisher to produce highly customized reports. Refer to the TC 
Publisher Help file for instructional information. 

To learn about: Go to page: 

Using the Report Format Editor........................................................................9-2 

Creating Title, Header, and Footer Text ...........................................................9-5 

Editing Report Columns....................................................................................9-6 

Creating a Custom Expression ........................................................................9-10 

Editing Report Format Options.......................................................................9-13 

Printing Report Format Files...........................................................................9-17 
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Using the Report Format Editor 
After TotalChrom analyzes a raw data file, it saves the analysis as a result (.rst) file 
and reports the results of that analysis using the format file(s) listed in the sequence 
file. If you have identified additional report format files in the processing section of 
the method, you can generate up to six different secondary reports. If you do not 
include the name of a report format file in the sequence or method, TotalChrom will 
not print a report. 

In addition to specifying which information you want to include from the data 
analysis, the report format file also defines how the information appears on the page. 

You can also use a report format file to format information for use in other 
applications. For example, you can create a file for importing results to SQL*LIMS, 
and you can save a report as a comma-separated ASCII file. 

Menus and Commands 
The Report Format Editor window is available by choosing Report Format from the 
Navigator Build menu. It includes the following menus and commands: 

File Menu 
Allows you to create, open, and save files; enter and review documentation about a 
report format; print report formats; and, exit the program to return to the Navigator. 

User Notes Menu 

Lets you create header, footer, and title text for the report. 

Report Menu 

Lets you select the columns that you want to have in the report including custom 
expressions that generate values in a column. 

Edit Menu 

Lets you move and delete columns. 

Options Command 

Lets you specify a variety of reporting options such as the size of the system header 
and the components to include. 
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General Procedure for Creating a Report Format 
The following is the general procedure for creating a report format. Specific 
procedures for the tasks referenced in this procedure are provided later in this 
chapter. 

You can also create a new report format by editing an existing report file and 
renaming it with the Save As command. 

 To create a new report format file: 

1. Do one of the following: 

• In the Navigator, choose Report Format from the Build menu. 

The Startup dialog box appears: 

 

Select one of the displayed options and choose OK to open the Report 
Format Editor window. 

• If the Report Format Editor is already open, choose New from the File 
menu. 

The name <untitled> appears in the title bar of the Report Format Editor 
window, and TotalChrom displays the default format. Your defaults may 
look different from those shown if the default file has been modified. 



Using the Report Format Editor 

9-4  

 

Whenever you change an untitled or existing report format, the word 
MODIFIED appears in the status bar at the bottom of the window. It disappears 
after you save the modifications. 

2. If you wish, change the default title and create a report header and footer. 
Refer to “Creating Title, Header, and Footer Text” on page 9-5. 

3. Set up the columns you want to use for this report. Refer to “Editing Report 
Columns” on page 9-6 and “Creating a Custom Expression” on page 9-10. 

4. When you are finished developing the report format, choose Save from the 
File menu. 

The Documentation dialog box opens. 

5. Complete the Description tab in the Documentation dialog box and choose OK. 

For a discussion about entering descriptive information about a file, refer to 
Chapter 2, “TotalChrom Basics.” 

The TotalChrom File Save As dialog box opens. 

6. Enter a name for the report format in the File Name text box and choose Save. 

The dialog box closes, and the new report format name appears in the title bar. 

7. When you are finished working in the Report Format Editor, choose Exit 
from the File menu. 
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Creating Title, Header, and Footer Text 
The commands in the User Notes menu enable you to create report title, header and 
footer text in a report format. 

 To create a report title: 

1. Choose Title from the User Notes menu to open the Report Format Title 
dialog box. 

 

2. Enter the title you want to use for this report and choose OK. 

When you choose OK, the dialog box closes and the title for this report 
format file appears at the top of the report. 

After you have created a report title, you can click the title area to reopen the 
Title dialog box. 

The steps to create header and footer text are nearly identical, and they have been 
combined into a single procedure. 

 To create header or footer text: 

1. Choose Header from the User Notes menu to open the Header dialog box. 

OR 

Choose Footer from the User Notes menu to open the Footer dialog box. 

The following shows the Header dialog box. However, except for the title, 
the two dialog boxes look and function the same way. 
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2. Enter the text you want to appear as the report header or footer in the text 
area of the dialog box and choose OK. 

When you come to the end of a line, press Ctrl+M to start a new line. You 
can enter up to 512 characters. To delete all existing text, choose Delete. 

When you choose OK, the report header or footer appears in the report 
window. 

After you have created a report header or footer, you do not need to choose 
the command to edit the header or footer: just click anywhere in the header 
or footer text in the Report Format Editor window to open the corresponding 
dialog box. 

Editing Report Columns 
The Report menu in the Report Format Editor displays a list of the types of columns 
you can include in a report. For an explanation of each type of column, refer to the 
Glossary. 

The Report menu also includes the Custom Expression command. Custom Expression 
is a special type of data column that allows you to include mathematical operations 
within a column. Refer to “Creating a Custom Expression” on page 9-10. 

Choosing any of the column types from the Report menu, or clicking the column name 
in the report itself, opens the Column Information dialog box, which is described in the 
procedures that follow. You can edit the column information, including the name, and 
place the columns wherever you want them to appear in the report. 

You can also create blank columns in a report by choosing this command in the Report 
menu. The Blank Column dialog box is the same as the Column Information dialog 
box, except that it inserts a blank space between columns, or it adds space in the 
margin if you make it the first or last column on the page. 

Adding and Deleting Columns 
The default report format file shipped with TotalChrom includes the following 
columns: 

 
You can add new columns or delete report columns as desired. 
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 To add a report column: 

1. Choose Report to display the available column types. 

 

2. Choose one of the column types listed in the menu (except Custom 
Expression). 

The Column Information dialog box appears. The word “<none>” appears 
next to Current Column until you add this column to the report. Once the 
column is added, you can click on the column name to open this dialog box, 
rather than choose the name from the Report menu. 

 

3. Enter a column number in the Column Number text box. 

This establishes the location of this column relative to other columns on the 
page. For a column type that is not currently in the report, the default value 
is the next available column number. For a column type that already appears 
in the report, the default is the existing column number. 

If you assign the new column the same number as an existing column, 
TotalChrom automatically shifts the columns to insert it. 

4. Enter a number to specify the Column Width in characters. 
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5. If Digits is available, type the number of digits you want to display after the 
decimal point. 

6. Enter text for the top line of the column name in the Column Label text box. 

A column label can consist of one or two lines of alphanumeric characters. 
The Column Label text box is the upper line. 

If the column label exceeds the number of characters in the Column Width text 
box, the column will expand to the label width.  

7. Enter text for the bottom line of the column name in the Second Label text 
box. 

The default format uses the second line for units. 

8. Select Calculate Total For This Column to include a column total. 

This option is only available for columns that have numeric values. 

9. Choose Insert/Add.  

The new column appears in the report format.  

There are two ways to delete a column from a report format: from the Column 
Information dialog box, or by using the Delete Column command in the Edit menu. 

 To delete a column: 

• Click on the column you want to delete and choose Delete in the Column 
Information dialog box. 

OR 

 Choose Delete Column from the Edit menu to open the Delete Column 
dialog box, enter the number of the column that you want to delete, and 
choose OK. 

Replacing/Editing Column Information 
Use the Replace command to modify the information that appears for any column in a 
report format file. 

 To edit existing column information: 

1. Click on the column that you want to change to open the Column 
Information dialog box. 

2. Edit the information as necessary but do not change the column number or 
you will move the column. 

3. Choose Replace 
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Moving Columns 
You can change the position of columns in a report format file in two ways: by using 
the Move Column command in the Edit menu, or the Move button in the Column 
Information dialog box. 

 To move a column: 

1. Click on the column you want to move to open the Column Information 
dialog box. 

2. In the Column Number text box, enter the new column number. 

3. Choose Move to close the dialog box and reposition the columns. 

OR 

1. Choose Move Column from the Edit menu to open the Move Column dialog 
box. 

 

2. Enter the number of the column you want to move in the Which Column To 
Move text box, and enter the number where you want the column to appear 
in the New Column Position text box. 

3. Choose OK to close the dialog box and move the column to the new 
location. 
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Creating a Custom Expression 
Custom Expressions let you include information that is the result of a calculation that 
is performed when the report is generated. 

For example, you must use custom expressions to calculate scaled percentage values. 
To obtain scaled values, the largest peak is assigned a value of 100% (or some other 
percentage) and percentage values for other peaks are scaled proportionately. You 
can use the following expressions: 

Scaled area: #PA/#MA*100 

Scaled height: #PH/#MH*100 

Scaled amount: #AA/#MC*100 

In these expressions, #PA, #PH, and #AA represent peak area, peak height, and 
adjusted amount, respectively; #MA, #MH, and #MC represent the maximum peak 
area, maximum peak height, and maximum adjusted amount, respectively. 

Creating a custom expression is much like building a mathematical expression, except 
that you use the data values and operators provided in the Custom Expression Editor: 

• Data values can be numbers or predefined values such as Area Percent and 
Sample Volume. 

• Operators can be arithmetic, exponential or logarithmic. 

• Calculations can be binary (performed with two values) or multi-level. 

Use US conventions for all number formats in the Custom Expression Editor. For 
example, although a Windows system may be set up to use German number formats, 
such as using a comma to designate a decimal point, the Custom Expression Editor 
only accepts a period as a decimal point. 

When a calculation is invalid (for example, division by zero), a dashed line appears 
in the report instead of a numeric value. 

After you build the calculation for an expression, you specify column parameters in 
the Custom Expression column information dialog box. This dialog box is identical to 
the column information dialog box that is used for all other report columns. Once you 
create a custom expression, it can be edited, moved or deleted just like any other 
report column. 

Predefined Custom Expression Data Values 
When you develop a custom expression, you select from a list of predefined data 
values. 

Most of the items refer to individual peak values (such as #PA for Peak Area); others 
refer to the entire run (such as #TA for Total Area). 
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Predefined values for the items with the phrase (from Suit) are available only if 
Suitability has been run on the data before this report is generated: 

Values for #SA Lambda Max; #SP Peak Purity Index; #SR Absorbance Ratio are 
available only if they are present in the result file. Additionally, for #SP the LC235 
must have been set to AUTO mode for spectra. 

 To create a custom expression: 

1. Choose Custom Expression from the Report menu to open the Custom 
Expression Editor dialog box. 

 
The list box on the left shows the types of the data that are available for 
calculations. 

2. Enter the desired expression in the Custom Expression text box. 

You can enter the expression either by choosing items from the Available 
Column Values and Available Operations lists or by typing the values and 
operations directly into the Custom Expression text box. To use constants as 
values, type the desired constants directly into the Custom Expression text 
box. 

Most terms in the Available Column Values list are defined in the Glossary, 
which is available in this manual and in Help. 

3. Choose OK when the expression is complete. 

The Custom Expression Editor dialog box closes and the Custom Expression 
dialog box appears. 
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4. Enter the column number where you want the expression to appear. 

5. Enter the other parameters for this column. 

6. Choose Insert/Add. 

The label you assigned to the custom expression appears at the top of the 
column. When TotalChrom generates a report based on this format file, the 
result of that expression will appear in the column. 

When you click on this column in the window, the Custom Expression 
Editor dialog box appears, followed by the Custom Expression dialog box. 

Creating Additional Custom Expressions 
Data from an existing custom expression column is always used as a basis (or 
template) for creating additional custom expressions. This enables you to derive new 
custom expressions from existing custom expressions quickly without having to re-
enter data. 

When there is only one custom expression in the report, its data are always used as a 
template for creating another custom expression. But when there is more than one 
custom expression, you must select the specific custom expression whose data you 
want to use. You can either: 

• Click on the desired custom expression. 

OR 

• Select Custom Expression from the Report menu to open the Duplicate Columns 
dialog box. Choose the custom expression column whose data you want to use 
and select OK. 

Whichever method you choose, the Custom Expression Editor dialog box appears. It 
is already filled in with expression data. Use the procedure described in “Creating a 
Custom Expression” to build the custom expression. 
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Editing Report Format Options 
The Options command in the Report Format Editor opens a dialog box that contains a 
variety of options that relate to the information you want to include in the report. 

 To edit report format options: 

1. Choose Options to display the Report Format Options dialog box. 

 

2. Select the size of the System Header you want to include in the report. 

The system header contains summary information about the data analysis; it 
is not merely a label (like the user-entered report header). The following 
table shows which data is included in Small, Medium, and Large report 
headers. 

Item Small Medium Large 

Software Version number  x x x 

Process Number x x x 

Operator name x x x 

Sample Name x x x 

Instrument Name and Channel x x x 

Date (and time) of report x x x 

Data Acquisition Time/Date x x x 
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Item Small Medium Large 

Sequence File name and Cycle # x x x 

Rack/Vial number x x x 

Sample Amount and Dilution Factor x x x 

Result File x x x 

Sample number   x x 

Internal Standard Amount  x x 

Study name   x x 

Autosampler name   x x 

Interface serial #   x x 

A/D mV Range  x x 

Delay time  x x 

End time  x x 

Sampling rate  x x 

Sample Volume  x x 

Area reject  x x 

Instrument method file  x x 

Processing method file  x x 

Calibration method file  x x 

Raw Data File  x x 

Report Format File  x x 

Noise and Area Threshold   x 

Instrument notes from the method   x 

Method processing parameters   x 

Additional sequence sample values    x 

Total number of peaks detected   x 
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A process number is included in every standard report header generated  
(i.e., produced from an RPT file) when a raw file is processed starting with 
peak detection. A process number is a unique number specific to the analysis 
server and execution of Client/Server Analyze that created the report. If a 
method specifies a number of different reports then, when a file is analyzed 
with that method, the set of resulting reports all contain the same number, 
but that number is different each time the method is used to process data. 

Since the process number only appears when processing starts with peak 
detection it will be printed on a line by itself, just below Software Version, 
with the caption Process Number. The first time a report is generated the 
Analyze software sets the process number to an initial value of one (1). 

3. Select the Instrument Control Parameters check box to include a summary of 
the instrument conditions used by a LINK-controlled instrument in the 
report. 

4. Select any Report Body Options you want to use. To print only the system 
header information in the report, deselect Print Main Report Body and go to 
step 5. 

Refer to the Status bar for a description of each Report Body Option. Certain 
options are further described below. 

• If you choose to include named or timed groups in the body of the 
report, then the individual members of the group will not be reported. 
The group amount will be based on the calibration of the group as a 
whole. Conversely, if groups have been defined but are not included in 
the report body, the individual components and/or peaks will be 
reported based on their individual calibrations. 

• If you select Missing Components, Missing Named Groups, or Missing 
Timed Groups, the peak index and quantities will be zero because no 
peaks will be found. The rows will contain zeroes and will use the ex-
pected retention time. 

5. Enter a value for Area Reject to represent the minimum peak area that you 
want included in the report. 

This value is used for report generation only. 

6. Select any Miscellaneous Options you want to use. Refer to the Status bar 
for a description of each option. Certain options are further described below. 

• If you select either Expand Named Groups or Expand Timed Groups, 
TotalChrom will include a supplementary report following the main 
report. This report includes the individual component and/or peak 
results. These results are always based on the individual calibration of 



Editing Report Format Options 

9-16  

the group members. For timed group members, this may be one of the 
options for calibrating unidentified peaks. 

 If you want the individual members of a group to use the overall group 
calibration, select the Calibrate By Reference option for the individual 
components in the method file, and identify the group itself as their 
calibration reference. 

• If you select Print Baseline Timed Event Table and the method is set so 
that events track reference peaks, then both method time and adjusted 
time will be included in the report. 

• Select Create ASCII Delimited File if you want to create a file that 
contains a version of the report that is readable by another application. 

 These files are saved with the file extensions .TX0 through .TX6 in the 
same directory as the result files. TX0 is the base report, and TX1 
through TX6 are the optional reports from the processing section of the 
method. The report name is taken from the name of the result (.RST) file. 

• Select Create AIA Metafile to create a special data file in the standard 
format defined by the Analytical Data Exchange Protocol for 
Chromatographic Data (ASTM E 1947-98) to transfer chromatography 
data between data systems. 

 These files are saved with the .CDF file extensions. 

• Select Create SQL*LIMS File to create a special data file that can be 
exported to SQL*LIMS. 

These files are saved with the .PRC file extensions. 

• Select Formfeed Between Reports to start any optional report specified 
in the method on a new page. Otherwise, the optional report will 
immediately follow the primary report on the same page. 

7. If you selected Print Replot With Report to print a plot on the same page as 
the report, enter a value in the Replot Size text box to indicate the height of 
the chromatogram replot on the page. 

Other parameters needed for the replot, such as the axis labels, are supplied 
from the method used to process the run. 

8. Choose OK. 



Printing Report Format Files 

Building a Report Format 9-17 

Printing Report Format Files 
The Print command in the File menu lets you print a copy of the current report format 
file, optionally with its audit trail information. This output lists the contents of the 
report format file; it does not print an example of the report format like the one you 
see in the Report Format Editor window. 
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 Chapter 10 
Editing Methods and 
Results Graphically 

 

This chapter explains how to create an optimal data processing method for an analysis 
by manipulating a typical chromatogram in the Graphic Method Editor. It also 
explains how to optimize the results for a single analysis by using the Reprocess 
Results function. 

To learn about: Go to page: 

Optimizing Data Analyses With Graphic Editing Applications .....................10-2 

Graphic Method Editing Versus Reprocessing Results ..................................10-3 

Using the Graphic Method Editor ...................................................................10-4 

Using Reprocess Results...............................................................................10-10 

Changing Display Options ............................................................................10-13 

Setting Processing Parameters ......................................................................10-20 

Working with Components ...........................................................................10-34 

Displaying and Printing Information ............................................................10-49 
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Optimizing Data Analyses With Graphic Editing Applications 
Method parameters such as integration thresholds, timed events, and component 
retention times determine how TotalChrom analyzes raw data. When you vary these 
parameters, you can dramatically affect the outcome of an analysis. However, when 
you first create a method in the Method Editor, it is difficult to estimate what values 
will provide the best data analysis. Sometimes, you need to perform an analysis 
before you can verify the results. 

TotalChrom provides two applications that you can use to optimize the analysis 
graphically and interactively. 

Graphic Method Editor 
Use this application to test and change the method by viewing and manipulating the 
chromatographic display of raw data after a run. When you view the data in graphic 
form, you can determine if TotalChrom is detecting peaks correctly, placing baselines 
properly, and if expected retention times and search windows for components are 
identifying peaks accurately. If you discover that the analysis is inadequate or wrong, 
you can change the method parameters while viewing the chromatogram and see the 
effects of the change immediately. 

Reprocess Results 
Use this application to change a result file and view the outcome instantaneously in 
order to find the optimal parameters for a particular analysis. You can use Reprocess 
Results to fine-tune parameters for a specific run even after you have optimized the 
parameters in a method to produce satisfactory analyses in the Graphic Method 
Editor. The primary difference between Reprocess Results and the Graphic Method 
Editor is that with Reprocess Results, you only change the result file, not the method. 
The “method” you are modifying in Reprocess Results is not the method file itself but 
a copy embedded in the result file when TotalChrom generated it. 
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Graphic Method Editing Versus Reprocessing Results 
To edit a method in the Graphic Method Editor, you specify a raw data file 
representing a chromatogram of the analysis you want to optimize. TotalChrom 
processes the raw data with the method and displays the chromatogram, showing the 
resulting integration and peak identification.  

You can change the parameters in the processing and calibration sections of the 
method until the parameters produce the results you want. At this point, you can save 
the optimized analysis of the raw data in a result file and save the modified method 
file under the same name or give it a new name. With the Graphic Method Editor, 
you can also edit instrument timed events graphically, but these events have no effect 
on the data being reprocessed. 

When you reprocess results, however, TotalChrom draws a chromatogram based on 
the result file you select and the raw data file that TotalChrom analyzed to produce 
the result file. Again, you can test different parameters to view the results. When you 
produce an optimal analysis of the raw data, you can save the new results in the result 
file or save them as a new file. Thus, the goal of reprocessing results is to improve the 
results of a single analysis. When you close the Reprocess Results window after 
changing the result file, TotalChrom asks if you want to save the modified result file 
because you are not saving changes to the method itself. 

The first two sections of this chapter explain how to open and get started with the 
Graphic Method Editor and Reprocess Results applications. The rest of the chapter 
explains how to perform the different tasks. With the exception of calibration and 
component tasks in the Graphic Method Editor, the procedures for both applications 
are identical. Thus, the common tasks are combined and most figures use the Graphic 
Method Editor as a representative example. 



Using the Graphic Method Editor 

10-4  

Using the Graphic Method Editor 
You can open the Graphic Method Editor from either the Navigator or the Method 
Editor. 

 To open the Graphic Method Editor:  

1. Do one of the following: 

• In the Navigator, click on the Graphic Edit button or choose Graphic 
Edit from the Build menu. 

  
• In the Method Editor, choose Graphic Editor from the Other menu. 

The Graphic Method Editor window opens. The TotalChrom File Open 
dialog box appears in the foreground, prompting you to select a raw data 
file. 

2. Locate and select the name of the raw data file that you want to edit and 
choose Open. 

TotalChrom performs peak detection, integration, and component 
identification on the raw data using the method named in the file header. 
Then TotalChrom displays the chromatogram. 

In addition to opening raw files by selecting them one at a time, you can access a 
group of related raw files by opening the index (IDX) file in which they are 
referenced. 
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 To use an index file to open raw files: 

1. In the TotalChrom File Open dialog box, select IDX Files (*.idx) from the 
Files Of Type list then select an index file. 

The first raw file in the index file is loaded, analyzed, and a chromatogram is 
displayed using the method that is associated with the raw file. 

2. To move through the raw files in the index file you selected, use the 
Previous Data File and Next Data File commands on the File menu. 

The method that is loaded with the first raw file does not change as you move 
through the raw files, even if subsequent files were analyzed with a different 
method. 

3. To load a different method, use the Open command on the File menu. 

The procedures in this chapter assume that you selected the Autoscale Plots By 
Default option in the Configuration Editor. If you deselected this option when you 
configured your system, the Rescale Plot dialog box appears whenever you open a 
new data file. For information on how to use this dialog box, see “Changing the Plot 
Display” on page 10-14. 
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Understanding the Graphic Method Editor Window 
By default, the Graphic Method Editor shows a working chromatogram in the main 
work area of the window, and a reference chromatogram above it. 

 

You can toggle the display of the reference chromatogram by choosing Reference 
Chromatogram from the Display menu. To hide the reference chromatogram as the 
default setting, deselect Show Reference Chromatogram in the Plot Options dialog 
box of the Configuration Editor before you open the Graphic Method Editor window. 

File Menu 
Lets you load and print other methods and data files; specify a report format file; 
enter and review documentation about a method; and copy and save the plot image 
for use in other applications. 

Process Menu 
Lets you edit instrument timed events and baseline timed events; optimize parameters 
such as noise and area thresholds; and manually integrate peaks by redrawing the 
baseline. 

Calibration Menu 
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Lets you perform component tasks such as creating or merging component lists from 
peak lists; change component information and build or edit named and timed groups; 
display and revise search windows; and update calibration information. 

Display Menu 
Lets you control the characteristics of the display, including the plot scale and 
whether items such as the report header, peak report, or reference chromatogram 
appear on the screen. 

Other Menu 
Closes the Graphic Method Editor and opens the Method Editor with the current 
method loaded; and lets you start the optional LC spectral analysis application. 

Status Bar 
The status bar appears at the bottom of the window. This area shows the raw data file 
name, the coordinates of the mouse cursor along the X and Y-axes, and how many 
points there are in the chromatogram. In addition, the status bar displays Help for the 
currently selected command and whether or not you have modified the file. 
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Loading Files in the Graphic Method Editor 
You primarily work with two types of files in the Graphic Method Editor: raw data 
files and method files. You can also specify a report format file to use for printed 
output. 

After you load a raw data file, that file name appears in the status bar, and the name 
of the method used to process the data appears in the title bar. You can either: 

• Change the method used to process the current raw data file by opening a new 
method file. 

• Use the same method to evaluate different raw data files. 

• Save the method or result data as a new file, leaving the current files intact. 

To maintain the current view and retain the same scaling parameters, choose 
Preserve View from the File menu before loading a raw data file.  

 To load a raw data file: 

1. Choose New Data File from the File menu to open the TotalChrom File 
Open dialog box.  

2. Locate and select the raw data file that you want to open. 

You can select an index file instead as described under “Using the Graphic 
Method Editor” starting on page 10- 4. 

3. Select the Load Data File Method check box to load the method that is 
associated with the new data file.  

If you do not select this, TotalChrom uses the method that is currently 
loaded in the Graphic Method Editor. 

4. Choose Open. 

TotalChrom performs peak detection, integration, and component 
identification. TotalChrom then displays the chromatogram for the file you 
selected. 

 To load a different method file: 

1. Choose Open from the File menu to open the TotalChrom File Open dialog 
box. 

2. Locate and select the method file that you want to open and choose Open. 

The title bar changes to show the method name that you selected. 
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 To specify a new report format file: 

1. Choose New Report Format from the File menu to open the TotalChrom File 
Open dialog box. 

2. Locate and select a report format file and choose Open. 

The report format file that you specify primarily determines which printing format 
TotalChrom uses for output. Some aspects of the report format, such as the type and 
order of the data columns, affect how the Peak Report appears when you display 
report information above the chromatogram. 

For information on how to use the reporting features in the Graphic Method Editor, 
refer to the sections, “
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Displaying and Printing Information” on page 10-49 and “Printing a Report or Replot” 
on page 10-51. 

Saving Files in Graphic Method Editor 
When you work in the Graphic Method Editor, you can save a modified method and 
you can save the optimized analysis of raw data in a result file. 

• To save a method, either choose Save from the File menu to save the method 
with the same name, or choose Save As to rename it. 

• To save a result file, either choose Save Result File As to rename it, or choose 
Save Result File With Time Stamp to use the original name with a time stamp 
added. This provides a type of chronological versioning capability. 

If the method you use in Graphic Method Editor has auditing enabled, then 
auditing is also enabled for result files created from it; the Audit Trail dialog box 
will be displayed when you save the result file. 
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Using Reprocess Results 
To reprocess the data from a single run to improve the results of a single analysis, use 
the Reprocess Results application. The majority of the commands are the same as 
those in the Graphic Method Editor, and you can see the effect of changing the 
parameters that were used to process the data immediately. You can save the results 
in the existing result file, or save them as a new file.  

When you save the results, you do not change parameters in the method. 

 To open the Reprocess Results window: 

1. In the Navigator, click on the Results button or choose Results from the 
Reprocess menu. 

 

The Reprocess Results window opens. The TotalChrom File Open dialog 
box appears in the foreground, prompting you to choose a result file. 

2. Locate and select the result file you want to edit and choose Open. 

TotalChrom opens the raw data file associated with the selected result file 
and processes it using the copy of the method embedded in the result file. 
Therefore, the results displayed are identical to the information in the 
selected result file. 

Instead of opening result files by selecting them one at a time, you can access a group 
of related result files by opening the index (IDX) file in which they are referenced. 

 To use an index file to open result files: 

1. In the TotalChrom File Open dialog box, select IDX Files (*.idx) from the 
Files Of Type list then select an index file. 

TotalChrom opens the raw data file associated with the first result file in the 
index file and processes it using the copy of the method embedded in the 
result file. 

2. To move through the result files in the index file you selected, use the 
Previous File and Next File commands on the File menu. 
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Understanding the Reprocess Results Window 
By default, Reprocess Results shows a working chromatogram in the main work area 
of the window, and a reference chromatogram above it. 

 

You can toggle the display of the reference chromatogram by choosing Reference 
Chromatogram from the Display menu. To hide the reference chromatogram as the 
default setting, deselect Show Reference Chromatogram in the Plot Options dialog 
box of the Configuration Editor before you open the Reprocess Results window. 

The Reprocess Results window contains the following menus and commands: 

File Menu 
Lets you load, save result files; print report, plot or method parameters; enter and 
review documentation about a result file; and copy and save the plot image for use in 
other applications. 

Process Menu 
Lets you edit instrument timed events and baseline timed events; optimize processing 
parameters such as noise and area thresholds; and manually integrate peaks by 
redrawing the baseline. 

Components Menu 
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Lets you identify peaks manually and display search windows. 

Display Menu 

Lets you control display characteristics including the plot scale and whether the 
report header, peak report, or reference chromatogram appear on the screen. 

Other Menu 
Closes Reprocess Results and opens the optional LC spectral analysis application. 

Status Bar 
The status bar at the window bottom shows the raw data file name; the cursor X and 
Y coordinates; the number of points in the chromatogram; Help for the currently 
selected command; and whether or not you have modified the file. 

Loading Files in Reprocess Results 
You usually work with result files in Reprocess Results. However, you can also select 
another report format file for reports and replots. TotalChrom uses the selected report 
format file to determine the format for printed output. TotalChrom also uses some 
aspects of the format to display the Peak Report information above the chromatogram 

When you open the result file, TotalChrom also opens the corresponding raw data file 
in order to plot the chromatogram. Although you can modify method parameters in 
Reprocess Results, you are only modifying a copy of the method embedded in the 
result file, not the method itself. If you save the changes you make to a result file in 
Reprocess Results, that new file will contain the modified method parameters 

To maintain the current view and the current scaling parameters, choose Preserve 
View from the File menu before choosing Open. 

 To open a new result file in the Reprocess Results window: 

1. Choose Open from the File menu to open the File Open dialog box. 

2. Locate and select the result file that you want to open and choose Open. 

You can select an index file instead as described under “Using Reprocess 
Results” starting on page 10-10). 

TotalChrom opens the selected result file and the associated raw data file. 
TotalChrom performs peak detection, integration, and component 
identification using the method parameters embedded in the result file, and 
finally displays the processed chromatogram. 
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 To specify a new report format file: 

1. Choose New Report Format from the File menu. 

2. Locate and select a report format file and choose Open. 

To learn how to use Reprocess reporting features, refer to “
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Displaying and Printing Information” and “Printing a Report or Replot” on 
pages 10-49, 51. 

Saving Files in Reprocess Results 
When you work in Reprocess Results, you can save modified result data with three 
commands on the File menu: 

• To overwrite the original result file with the modified results, choose Save. 

• To save the modified results in a new file with the original name with a time 
stamp added, choose Save With Time Stamp. This provides a type of 
chronological versioning capability. 

• To rename the modified result file, choose Save As. 

If a method that is referenced in a result file has auditing enabled, then auditing is 
also enabled for result file that was created from it; the Audit Trail dialog box will be 
displayed when you save the result file. 
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Changing Display Options 
Display menu commands let you change how chromatographic data appears as well as 
other attributes of the Graphic Method Editor and Reprocess Results windows. You can: 

• Display report information above the chromatogram to review the peak report or 
report header, select another report format file, or print a report 

• Use raw data points or bunched points to display the chromatogram  

• Show or hide the reference chromatogram 

• Display the entire chromatogram, if you have expanded it 

• Redefine the plot scale by entering specific values 

• Expand both chromatograms together by expanding the reference chromatogram 

The following sections explain how to perform each task. For information on how to 
use the report commands, see “Displaying and Printing Information” on page 10-49. 

Changing the Plot Display 
You can choose to display the chromatogram as raw data points, raw and bunched 
data points, or as line segments. 

 To change the display of the plot: 

• Choose Raw Points, Raw Points With Bunching, or Lines from the Display 
menu. 

Changing the Plot Scale 
The Rescale Plot command in the Display menu lets you change the parameters that 
affect which part of the run (the chromatographic data) you see in the main window. 
These parameters include starting and ending times, the offset, and the full scale 
values. 

 To edit the scaling parameters: 

1. Choose Rescale Plot from the Display menu. 
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2. In the Start Time text box, enter the time you want at the start of the plot 
window. 

The start time must be the same as or greater than the delay time for the start 
of data acquisition. This time must also be less than the total run time for the 
chromatogram. 

3. In the End Time text box, enter the time you want at the end of the plot 
window. 

The end time must be later than the start time, and be less than the total run 
time for the chromatogram. 

4. In the Offset text box, enter the offset value that you want to appear at the 
bottom of the plot window. 

The plot always appears above the actual bottom of the window to allow 
enough room for component names.  

5. In the Full Scale text box, enter a value to specify the height of the plot 
window. 

The millivolt value assigned to the top of the plot window is equal to the full 
scale value plus the offset value. A data point that has a voltage value equal 
to the sum of the offset and full scale is plotted at the top of the window. A 
data point with a value equal to the offset voltage is plotted at the bottom of 
the window. 

6. Choose OK to redraw the plot using the new values. 

 To redraw the plot at the default scaling: 

• Choose Entire Chromatogram from the Display menu. 

TotalChrom redisplays the plot in its entirety, showing the full time span and 
recalculating the full scale and offset values, based on the maximum and 
minimum data values in the file. 

Expanding Chromatograms 
By default, TotalChrom displays the chromatogram and shows the complete run with 
the largest peak set to full scale. You can quickly expand and reduce the plot display 
by using the mouse to rescale the plot manually. You can also redefine scaling 
parameters in the Rescale Plot dialog box, as shown in “Changing the Plot Scale.” 
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To retain the plot scale that you defined for more than one file using either the mouse 
or the Rescale Plot command, choose Preserve View from the File menu before 
opening another file. 

 To expand the chromatogram using the mouse: 

1. Position the mouse cursor where you want the starting point of the 
expansion to be. 

2. Drag to select the part of the working chromatogram you want to enlarge. 
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3. Release the mouse button. 

The working chromatogram expands, and TotalChrom highlights the visible 
portion in the reference chromatogram. 

 

The left and right sides of the selection rectangle are equivalent to the 
starting and ending times in the Rescale Plot dialog box. The height and 
bottom position of the selection rectangle are equivalent to the full scale and 
offset values in the Rescale Plot dialog box.  

 To return the chromatogram to a previous level of expansion: 

• Position the mouse anywhere on the chromatogram and click the right button 
one or more times until the plot appears at the level of expansion you want. 

To immediately return the plot to the default view, choose Entire 
Chromatogram from the Display menu. 

When you select a portion of the working chromatogram to expand it, TotalChrom 
does not normally expand the reference chromatogram. The Expand Reference 
Chromatogram command enables you to expand both chromatograms simultaneously. 
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 To expand both reference and working chromatograms simultaneously: 

1. Choose Expand Reference Chromatogram from the Display menu. 

2. In the reference chromatogram, select the part of the plot you want to 
enlarge.  

TotalChrom redraws both plots to show the part of the run you selected. The 
following figure shows both chromatograms expanded. 

 

 To reduce just the reference chromatogram: 

• Click the right mouse button inside the reference chromatogram. 

TotalChrom restores the reference chromatogram to the previous scaling; the 
working chromatogram maintains its current level of expansion. 

 To reduce both reference and working chromatograms: 

1. Click the right mouse button inside the working chromatogram.  

TotalChrom restores both plots to the previous scaling. 

If you click the right mouse button inside the reference chromatogram after 
you start to reduce the view in the working chromatogram, an update 
message appears. 

2. Choose Yes and click the right mouse again to continue reducing the view. 
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Manipulating the Reference Chromatogram 
If you have not expanded the reference chromatogram, TotalChrom displays visible 
portion of the working chromatogram as a selection rectangle in the reference 
chromatogram. You can manipulate this selection rectangle to change which part of 
the plot appears in the working chromatogram window. 

 To display a different part of the chromatogram: 

1. Move the mouse cursor over the selection rectangle in the reference 
chromatogram.  

The mouse cursor changes to a cross. 

2. Drag the outline of the selection rectangle to the part of the chromatogram 
you want to view. 

3. Release the mouse button. 

TotalChrom displays the selected part of the reference chromatogram in the 
working chromatogram. 

In addition to changing which part of the chromatogram appears in the working area, 
you can also change the size and proportions of the selection rectangle in the 
reference chromatogram. 

 To change the size of the displayed region: 

1. Move the mouse cursor to an edge of the selection rectangle in the reference 
chromatogram.  

The mouse cursor changes to a double-headed arrow. 

2. Drag the selected edge until the rectangle is the size you want. 

3. Release the mouse button. 

Hiding or Showing the Reference Chromatogram 
By default, TotalChrom displays the reference chromatogram above the working 
chromatogram in the Graphic Method Editor (or Reprocess Results) window. You 
use the Reference Chromatogram command as a toggle to hide or show the reference 
chromatogram.  

 To hide or show the reference chromatogram: 

1. Choose Reference Chromatogram from the Display menu to deselect the 
command. 

TotalChrom redraws the working chromatogram to fill the entire window. 

2. Choose Reference Chromatogram again to show the reference 
chromatogram. 
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To hide the reference chromatogram as the default, or to change how much space it 
occupies as a percentage of the total window area, deselect Show Reference 
Chromatogram or change its size in the Plot Options dialog box in the Configuration 
Editor. The change takes effect the next time you open the Graphic Method Editor or 
Reprocess Results. For more information, refer to Chapter 3. 

Setting Processing Parameters 
Most of the commands in the Process menu affect peak detection and integration. For 
detailed information on the basic concepts, terminology, and effects of setting these 
parameters, refer to Chapter 7. 

The following sections explain how to set processing parameters in the Graphic 
Method Editor and Reprocess Results and see their effects on a completed run. 
Except for the instrument events command, which appears only in the Graphic 
Method Editor, the processing tasks are identical for both applications. 

Setting Baseline Timed Events 
Baseline timed events affect how TotalChrom detects and integrates peaks during a 
run. Therefore, you can use them to help maintain consistent results when peak and 
baseline noise characteristics change. 

You can set baseline timed events in the processing section of the method in the 
Graphic Method Editor. You can also set baseline timed events in the Reprocess 
Results window; however, the events set there apply to a single file only and not to 
the method as a whole. In either case, the procedures are identical. 
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 To set baseline timed events: 

1. Choose Baseline Events from the Process menu to open the baseline timed 
events display. 

 

The menu bar changes to show the following commands: 

Delete Events — Lets you delete one or more baseline timed events from 
the chromatogram.  

Reprocess — Reprocesses the raw data file using the new baseline events. 

Return — Closes the baseline timed events display. 

2. From the Events list, select the baseline timed event that you want to add. 

For technical information about these events, refer to the sections, “How 
Timed Events Affect Peak Detection” and “How Timed Events Affect 
Integration” in Chapter 18. 

3. If the event requires a value, choose one from the Value list. 

4. On the chromatogram, click where you want the event to occur. 
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When using user forced peak events (UF), the event occurs at the point where you 
click the mouse pointer. It does not automatically create the event on the baseline. 
For additional information, refer to Retention Time and User Forced Peak Events in 
Chapter 18.  

We strongly recommend using the Manual Reintegration procedure to add UF events 
to a method. 

The event appears at the specified point on the plot. 

 

If you make a mistake, you can delete the event and try again. Alternatively, 
you can set the exact time at which you want the event to occur in the 
Baseline Timed Events tab (Process Menu) in the Method Editor. 

5. Choose Reprocess or Return to implement the change. 

 To delete a baseline timed event: 

1. Choose Baseline Events from the Process menu to open the baseline timed 
events display. 

2. Choose Delete Events to open the Delete Timed Events dialog box. 

 

3. Select one or more events to delete and choose OK. 
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TotalChrom deletes the events from the list and the chromatogram. 

 

 To reprocess peak data after adding or deleting baseline timed events: 

1. Choose Reprocess. 

TotalChrom reprocesses the raw data by performing peak detection, 
integration, component identification, and quantitation, using the current 
method settings. 

2. Choose Return to close the baseline timed events display. 
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Setting Noise and Area Thresholds 
To ensure that TotalChrom detects small peaks, but does not interpret baseline noise 
as peaks, you need to calculate the baseline noise and set noise and area thresholds to 
ignore the baseline noise.  

The Noise/Area Threshold command in the Process menu lets you change the settings 
that exist in the method, and view the result of the changes immediately. 

 To change the noise and area thresholds used in a method:  

1. Choose Noise/Area Threshold from the Process menu.  

The status bar message prompts you to outline the portion of the baseline 
that you want to use for calculating a new threshold level. 

2. In the working chromatogram, drag to select the part of the baseline that you 
want to analyze. 

TotalChrom only uses the starting and ending times of your selection, not 
the height.  

 

3. Release the mouse button. 

The Noise/Area Threshold dialog box opens, and TotalChrom draws the 
baseline drift and RMS baseline noise levels for the selected section. 

 

The Noise/Area Thresholds dialog box has the following information and 
options: 
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Baseline Drift ⎯ The calculated drift (slope) for the best fit. 

Baseline Intercept ⎯ The calculated intercept (at time = 0 minutes) for the 
best fit. 

RMS Baseline Noise ⎯ The calculated noise value (root-mean squared) for 
the best fit. 

Current NT ⎯ The current noise threshold level. 

Current AT ⎯ The current area threshold level. 

Suggested NT ⎯ The suggested optimum noise threshold. 

Suggested AT ⎯ The suggested optimum area threshold. 

4. Make any changes to the values in the Suggested NT and Suggested AT text 
boxes and choose OK. 

TotalChrom reprocesses the data and redraws the results of the integration 
based on the new noise and/or area threshold levels. 
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Setting a New Sampling Rate or Bunching Factor 
When you develop a method, you need to determine how much data to collect to 
achieve the most accurate quantitation. The Sampling Rate/Bunching Factor 
command in the Process menu helps optimize peak detection by: 

• Measuring the peak width to determine the right sampling rate for future analyses 

• Setting the best bunching factor to reprocess files that already exist. 

Because the sampling rate is the rate at which TotalChrom collects data, you cannot 
change it for an existing file. If you enter a new value for sampling rate in Graphic 
Method Editor, TotalChrom does not reprocess the raw data for the current session. 
However, TotalChrom saves the new value in the method and uses it in future 
analyses.  

You cannot enter a new sampling rate in Reprocess Results because you are 
modifying a stored data file, not the method. 

 To set a new sampling rate or bunching factor: 

1. Choose Sampling Rate/Bunching Factor from the Process menu. 

The status bar message prompts you to outline the narrowest peak to use for 
the calculation. 

2. Drag to outline the narrowest peak in the chromatogram. This is the same 
action you would perform to expand the working chromatogram to show just 
that peak. 

You do not need to select the entire peak because TotalChrom only uses the 
starting and ending times of the region that you select. 

 



Setting Processing Parameters 

Editing Methods and Results Graphically 10-29 

When you release the mouse button, the Sampling Rate/Bunching Factor 
dialog box appears. 

 

The dialog box has the following information and options: 

Peak Width (s) ⎯ The width of the peak, in seconds, that you just selected. 

Peak Width (pts) ⎯ The width of the peak, in data points, that you just 
selected. 

Old Sampling Rate (pts/s) ⎯ The sampling rate currently set in the 
instrument section of the method. 

Old Bunching Factor (pts) ⎯ The bunching factor currently set in the 
processing section of the method. 

Sampling Rate ⎯ The recommended new sampling rate. This option is 
only available in the Graphic Method Editor. 

Bunching Factor ⎯ The recommended new bunching factor. 

Note that you can enter values other than the one that TotalChrom 
recommends, but you can only enter a sampling rate or a bunching factor, 
not both. If the recommended sampling rate is higher than that used to 
collect the current data file, then you might not be able to achieve optimal 
results for all peaks in the current file.  

3. Do one of the following: 

• Leave Bunching Factor selected and then enter a new value. 

• Select Sampling Rate and enter a new value. 
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If your power line frequency is 60 Hz, you must enter a sampling rate as follows: 

• for single- and dual-channel acquisition, a rate that is evenly divisible  
into 100. 

 For example: 10 pts/s is acceptable as entered; however, TotalChrom 
changes 12 pts/s to 12.5 pts/s. 

If your power line frequency is 50 Hz, you must enter a sampling rate as follows: 

• for single-channel acquisition, a rate that is evenly divisible into 50. 

• for dual-channel acquisition, a rate that is evenly divisible into 25. 

If necessary, TotalChrom will change your entry for sampling rate to conform to 
this requirement. This is done to prevent the excessive baseline noise that may be 
produced with certain detector grounding configurations with older, generic 
interfaces. 

4. Choose OK. 

TotalChrom reprocesses the data and redraws the chromatogram using the 
new values. 

Changing Peak Separation and Exponential Skim Criteria 
Peak separation indicates whether a peak is fully resolved from the peaks on either 
side of it, or if it partially overlaps one or both of the other peaks. TotalChrom uses 
two criteria to determine if peaks are separated: width ratio and valley-to-peak ratio. 

TotalChrom uses three criteria to define whether or not to use an exponential skim 
line to calculate the area of peaks eluting on the trailing edge of a parent peak: peak 
height ratio, adjusted height ratio, and valley height ratio. 

The Peak Separation/Expo Skim command in the Process menu lets you set and 
modify each of these parameters. For more information on each of these options, refer 
to Chapter 7. 

Modify these values with caution. If you change these parameters without fully 
understanding the potential consequences, you might obtain invalid results. 
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 To change the peak separation and exponential skim criteria for a peak: 

1. Choose Peak Separation/Expo Skim from the Process menu to open the Peak 
Separation/Expo Skim dialog box. 

 

2. Make any changes to the values for the Peak Separation Criteria. 

A peak must meet both of the following criteria to be considered separated:  

Width Ratio — The ratio of the distance between two peaks to the width of 
the base of the second peak. If the actual value of this ratio for two peaks is 
greater than the value set here, TotalChrom considers the peaks separated. 
Otherwise, TotalChrom marks them as overlapped. 

Valley-To-Peak Ratio — The ratio of the height of the valley between the 
peaks to the height of the smaller peak. If the actual value of this ratio for 
two peaks is less than or equal to the value set here, TotalChrom considers 
the peaks to be separated. Otherwise TotalChrom marks them as overlapped. 

This information determines how TotalChrom draws the baseline beneath 
the peaks. The baseline codes in a report indicate the baseline used for each 
peak. 

3. Make any changes to the values for the Exponential Skim Criteria.  

All peaks must meet all following three criteria to be skimmed. If any of the 
peaks does not meet these criteria, TotalChrom uses a vertical dropline to 
separate the peaks. 

Peak Height Ratio —The ratio of the baseline-corrected height of the 
parent peak to the baseline-corrected height of the child peak. The actual 
value of this ratio must be greater than the value set here for the child peak 
to be skimmed off the parent. To disable exponential skimming throughout 
the run, you can set this parameter to its maximum value.  

Adjusted Height Ratio — The ratio of the height of the parent peak above 
its start point to the height of the child peak above the same point. The actual 
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value of this ratio must be greater than the value set here for the child peak 
to be skimmed off the parent. 

Valley Height Ratio — The ratio of the baseline-corrected height of the 
child peak to the height of the valley between the parent and child peaks 
above the baseline. The actual value of this ratio must be less than the value 
set here for the child peak to be skimmed off the parent. 

4. Choose OK. 

TotalChrom reprocesses the data file and changes the chromatogram display 
to reflect the new values. 

Drawing the Baseline Manually 
The Manual Integration command in the Process menu allows you to set timed events 
that indicate the baseline that you want to use beneath specific peaks. 

These manual integration timed events become part of the method, just like ordinary 
baseline timed events, and TotalChrom does not erase them if you reprocess the data 
later with the same method. The UF events override the normal peak detection 
process.  

If you manually draw in a baseline for a peak that TotalChrom did not previously 
detect, TotalChrom integrates the peak. However, if you draw a segment of the 
baseline underneath a cluster of peaks, TotalChrom will end the current cluster and 
draw new peaks as directed by the timed events. 

 To redraw a baseline: 

1. Toggle Manual Integration from the Process menu. 

The status bar message at the bottom of the window prompts you to draw a 
baseline under a new or existing peak. 

2. To draw a new baseline, drag the mouse from the required baseline starting 
point to the ending point. 

As you drag, TotalChrom creates a line between the starting point and the 
current mouse location.  
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When you release the mouse button, the TotalChrom draws the new baseline 
on the plot and adds the +UF and −UF timed events to the chromatogram. 

 

You can underline more than one peak at a time, and include peaks that were 
not marked previously by baselines. If you mark peaks that do not have 
baselines, TotalChrom adds the new peaks to the peak list. TotalChrom 
reprocesses the data through peak detection and integration, and redraws the 
plot.  

To start (or end) a baseline at the exact cursor location, hold the Shift key while 
pressing (or releasing) the mouse button. Otherwise, the start or end point will 
be the raw data value on the Y axis that corresponds to the cursor time position.  

 To delete a baseline: 

• Choose Baseline Events and delete the +UF and −UF timed events with the 
Delete Events command. 

OR 

• Right click between the +UF and -UF events and choose Delete Baseline 
from the pop-up menu. If you have more than one baseline, TotalChrom will 
delete the baseline closest to the cursor. 

Setting Instrument Timed Events (Graphic Method Editor Only) 
The Instrument Events command in the Process menu of the Graphic Method Editor 
lets you set a variety of instrument timed events, depending on the instrument you are 
accessing. These events, however, do not affect the current data file because they 
occur only during data acquisition. For 900 Series Interfaces, you can turn relays on 
and off, and instruct the interface to read rack and vial information from an attached 
autosampler. For LINK-controlled instruments, the events you can use depend on the 
type of instrument and its configuration. 
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 To set instrument timed events: 

1. In the Graphic Method Editor, choose Instrument Events from the Process 
menu to open the Instrument Timed Events display. 

 

The menu bar changes to show the following commands:  

Delete Events — Lets you delete one or more instrument timed events from 
the method. 

Reprocess — Reprocesses the raw data file. You do not need to use this 
command here because instrument timed events cannot affect data 
processing. 

Return — Closes the instrument timed events display and returns to the 
Graphic Method Editor.  

The instrument timed events available for the current instrument appear in 
the list. For some events, such as relays, you use the Value text box to enter 
the required values. 

2. From the Events list, select the timed event that you want to add. 

3. If the event requires a value, choose one in the Value list. 

4. On the chromatogram, click where you want this event to occur. 

The event appears at the specified point on the plot. If you make a mistake, 
you can delete the event and click again. To set a more precise time, enter 
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the exact time when you want the event to occur in the Instrument Timed 
Events dialog box in the Method Editor. 

5. Repeat Steps 2 through 4 to add other events. 

Add an OFF condition for every relay event you turn ON, because 
TotalChrom does not reset relays at the end of the run. 

 

6. Choose Return to close the timed events display. 

 To delete an instrument timed event: 

1.  Choose Instrument Events from the Process menu to open the instrument 
timed events display. 

2. Choose Delete Events to open the Delete Events dialog box. 

 

3. Select the events you want to delete and choose OK. 

TotalChrom removes the events from the list and the plot. 
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Working with Components 
This section describes the different procedures for components tasks for the Graphic 
Method Editor and Reprocess Results. Since you modify the actual method with the 
Graphic Method Editor, there are more component-specific commands in that 
application. 

Using the Calibration Commands in the Graphic Method Editor  
The commands in the Calibration menu in the Graphic Method Editor allow you to 
establish, or revise, the component information in the calibration section of the 
method. This part of the method defines which peaks TotalChrom identifies and as 
what component. You can add, delete, or change components, create or modify 
groups, change search windows, and modify other calibration characteristics. 

Creating a Component List From a Peak List 
During the peak detection phase of data analysis, TotalChrom assigns a sequential 
number to each detected peak. This list is referred to as the peak list. The component 
list, in contrast, is the list you create in the method that identifies each peak as a 
specific component. 

The Load From Peak List and Merge From Peak List commands in the Calibration 
menu let you add components to the method from the current peak list. 

 To create a component list from a peak list: 

• Choose Load From Peak List from the Calibration menu. 

TotalChrom adds a component to the list for every unidentified peak in the 
chromatogram. Component names take the form peak (n), where (n) is the 
index number of the peak. 

You can use the Load From Peak List command even if a component list 
already exists. TotalChrom retains in the list any existing components that 
are matched with peaks and deletes any component that is not matched with 
a peak. Previously unidentified peaks will be added to the component list as 
described above. 

The Merge From Peak List command, in contrast, retains all existing 
components whether they are matched to peaks or not. It adds a new 
component for each previously unidentified peak. 

 To merge a peak list with the component list: 

• Choose Merge From Peak List from the Calibration menu. 

TotalChrom retains all current components whether the components are 
identified with a peak or not. TotalChrom then adds a component name to 
the list for every unidentified peak in the chromatogram. These component 
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names take the form peak (n), where (n) is the index number of the peak. 
TotalChrom bases the index number on the order that it occurs in the run. 
The new component names appear on the chromatogram. 

When you merge or load from component lists, TotalChrom creates default 
component names. You can use the Edit Components command to enter new 
names. 

 To review and revise component names: 

1. Choose Edit Components from the Calibration menu to open the Edit 
Components dialog box. 

 

2. In the Name box, rename each component as necessary.  

3. Choose Next or Prev to process the change and to select the next or previous 
name in the list. 

4. Choose Return when you are done. 
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Editing Component Information 
The Edit Components command in the Calibration menu of the Graphic Method 
Editor lets you: 

• Assign a component name to a previously unidentified peak 

• Change the association between peaks and components (re-identify peaks) 

• Update the calibration level and amount for a component 

• Define or specify components as reference components or internal standards  

• Define and modify single peak, named group, and timed groups components 

• Display or change search windows 

 To open the Edit Components dialog box: 

• Choose Edit Components from the Calibration menu to open the Edit 
Components dialog box. 

 

The dialog box appears on the right side of the window and a reduced view 
of the plot appears on the left. The menu bar changes to display the 
following commands: 

Type menu ⎯ Lets you select the type of component to add or edit. 
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Re-Identify command ⎯ Re-identifies peaks after you change component 
information. 

Return command ⎯ Closes the Edit Components dialog box and restores 
the main Graphic Method Editor window. 

Adding and Editing Single Peak Components 
The following procedures explain how to identify a previously unidentified peak by 
creating a new component and how to change information for an existing component. 
If you want to change which peak a component is assigned to, refer to “Re-
Identifying Peaks” on page 10-39. 

 To add or edit a single peak component: 

1. Choose Edit Components from the Calibration menu. 

The Edit Components dialog box appears and the plot display changes to 
reflect component names, retention times, and search windows. The first 
peak in the plot, which TotalChrom may or may not have identified as a 
component, has a dotted rectangle around it to indicate that it is the currently 
selected peak. Choose Next and Prev in the dialog box to select the next or 
previous peak. 

2. Click the peak that you want to identify as a new component or choose the 
Next button until that peak is outlined. 

If the peak has already been identified as a component, the component 
information appears in the Edit Components dialog box. Otherwise, the 
Name text box is blank and the other parameters have default values. 

3. In the Name text box, enter the new name you want to assign to this peak. 

The name you assign appears on the plot after you complete the remaining 
entries for the component and choose Next or Prev. To cancel a pending 
entry of a new component, click on another peak in the plot. 

4. Do one of the following: 

• To specify that this component act as a reference peak for other 
components, select the Ref. check box. 

• To specify that an existing reference component act as a reference for 
this component, select the component from the Reference list. This 
option is only available if you deselect the Ref check box. 

5. Do one of the following: 

• To specify that this component act as an internal standard for other 
components, select the ISTD check box.  
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• To specify that an existing internal standard component act as an 
internal standard reference for this component, select the name from the 
ISTD list. This option is only available if you deselect the ISTD check 
box. 

6. To change the size of the search window, enter a value in the Absolute 
Window and Relative Window text boxes. 

The total search window is the sum of the absolute and relative windows, 
which TotalChrom applies to either side of the current retention time of the 
component. 

The relative window is a percentage of the expected retention time of the 
component. Changes are in increments of tenths of a second for the absolute 
window and tenths of a percent for the relative window. The search window 
marker (⏐⎯⏐)for the selected peak changes dynamically as you alter these 
values. The example below shows the original search window on the left, 
and a reduced absolute window on the right. 

 

7. To identify the largest peak eluting within the search window as the 
component, select Find Largest Peak In Window. 

This option selects the largest peak as the designated component. If you 
deselect this option, TotalChrom identifies the peak closest to the expected 
retention time in the window as the component. 

8. If you do not want to recalibrate the component, skip to Step 13. To calibrate 
the component, continue with Step 9. 

9. Select Update Calibration. 

The Level and Amount text boxes and the Calibration Type settings become 
enabled. This option only updates the calibration for the component you are 
currently working with. To update all components, use the Calibrate 
command in the Calibration menu.  

10. In the Level field, do one of the following: 

• To select from existing calibration levels, enter the name of the level or 
select it from the list. 

• To create a new calibration level, enter the new level name in the Level 
text box.  

11. In the Amount text box, enter the standard amount of the component. 
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12. Under Calibration Type, select Average or Replace. 

Average — Adds an entry to the calibration replicate list for this component 
in the current method.  

Replace — Deletes all calibration replicates in the current method and 
replaces them with one replicate for the current data file. 

This option also applies to retention time replicate information. 

13. Choose Reset RT if you are editing an existing component and want to set 
the expected retention time to the actual value in the current data file. For a 
new component, this will already be true. TotalChrom deletes any existing 
retention time replicate information. 

14. Choose Next or Prev to implement the changes and move to the next or 
previous component in the list. 

15. Choose Return to close the Edit Components dialog box.  

Component names for peaks that are close to each other might not appear on the 
plot. Expand the plot to see all component names. 

Re-Identifying Peaks 
You can re-identify the peaks displayed in the Graphic Method Editor in two ways: 

• By using the Re-Identify command 

• By explicitly assigning a component name to a selected peak 

When you Choose the Re-Identify command, TotalChrom runs the peak identification 
stage of data analysis and incorporates any changes you have made to the component 
parameters, such as search window sizes or reference peak assignments. You can then 
review the new peak identities by selecting each peak in turn. 

 To assign or move a component name to a peak: 

1. Choose Edit Components from the Calibration menu. 

2. In the plot window, click the peak that you want to re-identify. 

3. From the Name list, select the name of the component you want to assign to 
this peak. 

4. Make any changes to the other component options. 

5. Choose Next, Prev, or Return to implement the changes.  

If you try to assign a component name to a peak that is already identified as 
another component, an error message appears. 
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If you do not want to delete the old component, you must first re-assign that 
component to an unidentified peak. You cannot designate a component as 
“unassigned.” 

6. Choose Return to close the Edit Components dialog box. 

Creating and Editing Named and Timed Groups 
In TotalChrom, you can identify a group of peaks as a single component for the 
purposes of calibration and reporting.  

A named group consists of two or more single peak components that are grouped 
together in order to be reported as a single entity. Before you can assign a component 
to a named group, you must first identify the peak as a component. Members of a 
named group can appear anywhere in the chromatogram: they do not have to be 
located contiguously. A single peak component can be a member of more than one 
named group. If you wish, you may calibrate the components in a named group 
individually and report the results for individual components. 

A timed group is a group of contiguous peaks whose retention times fall within a time 
window, which you define. TotalChrom can include a peak in a timed group even if 
the peak is not identified as a component. In both named and timed groups, each peak 
is detected and integrated individually. TotalChrom calibrates the group 
independently of its members’ calibrations: the group area and height are the sum of 
the individual peak areas and heights. 

For more information on developing a component list in the method, refer to 
Chapter 8. 

The procedure for creating and editing these groups in the Graphic Method Editor is 
similar to that for single peak components. 
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 To create a named group: 

1. Choose Edit Components from the Calibration menu. 

The Edit Components dialog box appears and shows the options for single 
peak components. 

2. Choose Named Group from the Type menu. 

The dialog box changes to reflect the options for named groups. 

 

If the method has any existing named groups, the name of the first group 
appears in the Name text box. The Group Members list then contains a list of 
all components in the method with the group members selected in the list 
and on the plot. 

3. Choose New in the Edit Components dialog box to create a new named group. 

The words New Group appear in the Name text box. 

4. In the Name text box, enter a name for the new group. 

Selecting a group name from the list of names in the Name text box actually 
changes the name of the group to the selected name.  It will not select the group. 
To select a group, use the Next and Prev buttons. 

5. To calibrate the group using an internal standard, select a name from the 
ISTD list. 
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6. In the Group Members list, click each component that you want to include in 
the group. 

As you select each component, TotalChrom highlights its associated peak in 
the chromatogram. 

7. To calibrate the group with the current data file, select Update Calibration. 

The Level and Amount text boxes and the Calibration Type settings become 
enabled. 

8. In the Level text box, either enter the name of the calibration level 
represented by the data file, or select a level from the list. 

9. In the Amount text box, enter the sum of the standard amounts for each of 
the member components of the group. 

10. Select Average or Replace under Calibration Type. 

Average — Adds an entry to the calibration replicate list for the component 
in the current method.  

Replace — Deletes all calibration replicates for the current component in 
the current method and replaces them with one replicate for the current data 
file. 

For a new component, Average and Replace act in the same way because 
there is no current calibration information. 

11. Choose Next or Prev to implement the change and move to the next group. 

12.  When you are done creating named groups, choose Return to close the Edit 
Components dialog box. 

 To edit a named group: 

1. Choose Edit Components from the Calibration menu. 

The Edit Components dialog box appears and shows the options for single 
peak components. 

2. Choose Named Group from the Type menu. 

The name of the first group appears in the Name text box followed by a list 
of all components in the method with the group members selected in the list 
and on the plot. 

3.  In the Group Members list box, click each component that you want to 
include in or delete from the group. 

4. Choose Next or Prev to implement the change and move to the next group. 

5.  When you are done creating named groups, choose Return to close the Edit 
Components dialog box. 
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 To create and edit a timed group: 

1. With the Edit Components dialog box open, choose Timed Group from the 
Type menu. 

The Edit Components dialog box changes to reflect the options for timed 
groups. 

If the method has any existing timed groups, the name of the first timed 
group appears in the Name text box, and the values for other options are 
displayed. The search (time) window for the group appears in the plot 
window. 

2. Choose New to create a new timed group. 

A group window marker that spans the entire run appears in the plot 
window. You define the size of this window by entering the Group Start and 
End Times. The following example shows a new timed group window. 
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3. In the Name field, enter a name for the new group component. 

Selecting a group name from the list of names in the Name text box actually 
changes the name of the group to the selected name.  It will not select the group. 
To select a group, use the Next and Prev buttons. 

4. To use a time reference peak, select a name from the Reference list. 

5. To calibrate the group using an internal standard, select a name from the 
ISTD list. 

6. Enter or edit the Group Start Time. 

The group window marker changes dynamically as you adjust the time. 

7. Enter or edit the Group End Time. 

8. To calibrate the component, select Update Calibration. 

The Level and Amount text boxes and the Calibration Type settings become 
enabled. 

9. In the Level text box, enter the name of a calibration level, or select a level 
from the list. 

10. In the Amount text box, enter the sum of the standard amounts for each of 
the member components of the group. 

11. Select Average or Replace under Calibration Type. 

Average — Adds an entry to the calibration replicate list for the component 
in the current method.  

Replace — Deletes all calibration replicates for the current component in 
the current method and replaces them with one replicate for the current data 
file. 

For a new component, Average and Replace act in the same way because 
there is no current calibration information. 

12. Choose Next or Prev to implement the change and move to the next timed 
group. 

The name for the timed group appears beneath the chromatogram at the 
midpoint of the timed group marker.  
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You can select the timed group component by selecting anywhere on the timed 
group window marker. 

13. When you are done creating timed groups, choose Return to close the dialog 
box. 

Displaying Search Windows 
To identify a peak as the correct component in a run, you define a search window, 
which is a time tolerance before and after the expected retention time for the 
component. This enables TotalChrom to identify components despite small variations 
in retention time from run to run. 

The Show Windows command in the Calibration menu displays the search window 
for each single peak component that is defined in the method. This allows you to 
check for any component identification problems caused by incorrect search 
windows. The Show Windows command is a toggle so you choose the command 
again to hide the search windows. 

 

 To hide all search windows for single peak components: 

• Deselect the Show Windows command from the Calibration menu. 

TotalChrom hides all search windows from the working chromatogram. 
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Because timed groups do not use search windows, the Show Windows command 
does not display the window for timed groups. Instead, timed groups have a group 
marker based on time that defines which peaks are part of the group. You can view 
timed group windows by entering starting and ending times in the Edit Component 
dialog box, as described in “Creating and Editing Named and Timed Groups.” 

For more information on how TotalChrom uses search windows to identify peaks, 
refer to Chapter 8. 

Updating Calibration Information 
The Calibrate command in the Calibration menu lets you use the results from the 
current data file to update the calibration information for a specified level in the 
current method. This applies to every component in the method. To update calibration 
for individual components, use the Update Calibration check box in the Edit 
Components dialog box. 

 To update calibration information: 

1. Choose Calibrate from the Calibration menu to open the Calibrate dialog 
box. 

 

2. In the Calibration Level list, select the appropriate calibration level for the 
current data file from the list of levels defined in the current method. 

3. Select either Average or Replace under Mode. 

Average — Adds a new replicate to the existing replicate list at the specified 
level for each component in the current method file.  

Replace — Deletes all replicates in the current method file at the specified 
level and replaces them with one replicate for the current data file. 

Using the Components Commands in Reprocess Results 
The only component operations you can perform in Reprocess Results are identifying 
peaks manually and displaying search windows. 

Identifying Peaks Manually 
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The Manual Identification command in the Reprocess Results window lets you 
override normal component identification and directly assign component names to 
peaks in the result file. 

 To identify a peak manually: 

1. Choose Manual Identification from the Components menu. 

The window changes to display the Manual Identification list and the 
Reassign button above the working chromatogram. 

 

2. Click the peak that you want to rename. 

If this peak has already been identified as a component, the name appears in 
the text box. 

3. Select a component name from the list. 

4. Choose Reassign to give the selected peak a new name. 

The new component name appears beneath the selected peak. TotalChrom 
also removes the new component name from any peak to which it was 
assigned previously. 

5. Repeat Steps 2 through 4 to identify another peak. 
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6. When you finish identifying peaks, choose Return to restore the main 
Reprocess Results window. 

Displaying Search Windows 
To identify a peak in a run as the correct component, you define a search window, 
which is a time tolerance before and after the expected retention time for the 
component. This window allows TotalChrom to identify components despite small 
variations in retention time from run to run. 

The Show Windows command in the Components menu displays the search window 
for each single peak component defined in the method. You can use the display to 
check if incorrect search windows are causing any component identification 
problems. The Show Windows command acts as a toggle, so you choose it again to 
hide the search windows.  

Timed groups do not use a search window, but instead have their own time window 
defined. Therefore, the Shows Windows command does not display timed-group 
windows. 

 To show the search windows: 

1. Choose Show Windows from the Components menu.  

A check mark appears next to the command and TotalChrom adds search 
windows to the working chromatogram. 

2. To remove the search windows, choose the Show Windows command again. 

For more information on how TotalChrom uses search windows to identify peaks, 
refer to Chapter 8.  
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Displaying and Printing Information 
The Report Header and Peak Report commands in the Display menu let you view the 
contents of each report on screen. 

These commands display the report in a format different than when it is printed. The 
Peak Report command displays the information for each peak detected in the run, 
including component identification and quantitation. If the selected report format 
contains the options to include named and timed groups in a printed report, then those 
are displayed in the list instead of their constituent peaks. Peak Report lets you 
quickly review the results for any peak that is not part of a group by clicking on that 
peak in the plot. The Peak Report list then scrolls to highlight the data for that peak. 

 To display report information: 

• Choose Peak Report or Report Header from the Display menu. 

 

The report information for the current run is displayed above the 
chromatogram (replacing the reference chromatogram, if present) in the 
format defined by the currently specified report format file. 

The menu bar also changes to include the following menu and command: 

Report menu — Lets you alternate between viewing report contents and header 
information; select another report format; and print full reports and replots. 

Return command — Removes the report information and returns to the main 
application window. 
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 To view report header information: 

1. Choose Report Header from the Display or Report menu. 

The report header appears in a scrollable window. You can scroll through 
the window to view additional information in the header. 

2. To switch to the Peak Report list from this view, choose Peak Report from 
the Report menu.  

3. Choose Return to remove the report information and return to the main 
application window. 

 To view the report information for detected peaks: 

1. Choose Peak Report from the Display or Report menu. 

The report information display shows the results for all detected peaks. The 
data columns in the window are those defined in the report format associated 
with the data file (or selected using the New Report Format command). 

 

The example above shows the default report format. For information on 
report data and formats, refer to Chapter 9. 

2. In the chromatogram, click on the peak for which you want to review 
information. 

TotalChrom highlights the line for that peak in the report. 

3. To sort the display on something other than Peak#, click a different column 
header. 

 To change the report format file: 

1. Choose New Report Format from the Report menu to open the TotalChrom 
File Open dialog box. 

2. Locate and select the report format file you want to use and choose Open. 

The report information display changes according to the new format you 
select. 
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Printing a Report or Replot 
You can print a report or replot from either the main application window or from the 
report information display. You can select to print the report and replot that would be 
printed at the end of a run, or you can print the plot as currently displayed. 

 To print a copy of the current report or replot: 

1. Do one of the following: 

• In the Graphic Method Editor or Reprocess Results window, choose 
Print Report from the File menu. 

• In the report information display, choose Print Report from the Report 
menu. 

The Print Options dialog box appears. 

 

2. Do one or more of the following: 

• To print the report, select Report. 

• To print the complete plot that is defined by the replot parameters in the 
method, select Annotated Replot. 

• To print a copy of the current plot as it is scaled on the screen, select 
Current View. 

3. If you are printing the current view, choose Portrait or Landscape. 

Portrait — Orients the image on the page so that the time axis is parallel to 
the width of the page. 

Landscape — Orients the image on the page so that the time axis is parallel 
to the length of the page. 

4. Choose OK. 

5. Make any changes to the option in the second Print dialog box and choose 
OK. 



Displaying and Printing Information 

10-54  

Printing Method Information 
The Print Method command in the File menu offers the same printing options as the 
Method Editor: you can print the instrument, processing, and calibration parameters. 

 To print a copy of the parameters in the method: 

1. Choose Print Method from the File menu to open the Print Options dialog box. 

 

2. Select the method parameters that you want to print and choose OK. 

The Print dialog box appears. 

3. Make any changes to the options and choose OK. 
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Using Images in Other Applications 
The Copy to Clipboard command in the File menu lets you use a copy of the 
chromatogram image in another Windows application. 

 To copy the current chromatogram to the Clipboard: 

• Choose either Copy To Clipboard/Color or Copy To Clipboard/B/W from 
the File menu. 

TotalChrom captures the screen image of the working chromatogram and 
copies it to the Windows Clipboard. The image is either a color or 
monochrome bitmap. 

You can now copy the screen image from the Clipboard into another 
program or a file.  

A color bitmap requires many times more memory than a monochrome bitmap. 

The Save As MetaFile command in the File menu lets you copy an image of the 
screen to a Windows metafile. 

 To save the current chromatogram as a Windows metafile: 

• Choose Save As MetaFile from the File menu, then name the file.  

The image in the file will be a color image. 
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Chapter 11 
Building a Sequence 

 

This chapter explains the function of a sequence and describes how to use the 
Sequence Editor to build and edit sequence files. 

 

To learn about: Go to page: 
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How a Sequence Works 
A sequence controls the acquisition and analysis of chromatographic data produced 
by a series of injections in TotalChrom. 

TotalChrom displays sequence information in a spreadsheet format, which consists of 
one or more columns and rows. Columns are the vertical elements of the spreadsheet 
and rows are the horizontal elements. 

The columns contain the parameters that control the acquisition, processing, and 
reporting of the data. 

A row can either specify an analysis or specify an application that TotalChrom will 
run. A row that specifies an analysis is also referred to as a cycle. Each cycle contains 
all the information TotalChrom needs to acquire and analyze data produced by one 
(or possibly two) injections. With some instruments, cycles may contain information 
that controls two simultaneous injections. These are called dual injections. 

A cycle can specify a calibration or an analysis of an unknown sample. If the cycle 
specifies a calibration, TotalChrom uses the data from that run to update the 
calibration data in the method. If the cycle indicates the analysis of an unknown 
sample, TotalChrom processes the data from the run (using the previously calibrated 
method) to generate quantitative results. 

How TotalChrom Uses A Sequence 
A sequence enables TotalChrom to acquire data by providing all the information the 
program needs for a series of injections. You can collect and analyze data 
automatically by using an autosampler, which can be connected to either a 900 Series 
Interface or a LINK Interface. 

Refer to the manual for your 900 Series Interface for information on connecting 
autosamplers to achieve various degrees of automation. 

When you set up an instrument to run a sequence, TotalChrom downloads the 
parameters from the instrument section of the method (or methods) to the interface 
you are using. Without these parameters, the interface cannot begin to acquire data, 
nor can a LINK-controlled instrument be run. TotalChrom uses the remaining 
parameters from the sequence and its referenced methods when it uploads the data 
acquired from each run from the interface and processes it. 
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The Information in a Sequence 
A sequence file contains two types of information, also referred to as parameters:  

• Values that identify a particular analytical sample, also known as sample 
parameters. 

• Information that affects how TotalChrom processes and stores data from a 
sample, also known as processing parameters. 

The main distinction between the two types of parameters is that some can have 
different values for the two channels (A and B); others must have the same 
values for both channels. To indicate this, the columns in the Sequence Editor 
spreadsheet are color coded: yellow columns must have the same value; blue 
columns can have different values. 

For the special case of a dual-injection sequence, all parameters can differ for the two 
channels, except the (instrument) method. 

For a description of the columns in the Sequence spreadsheet, see page 11-6. 
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Using the Sequence Editor 
You use the Sequence Editor to create new sequences and to modify existing 
sequences. 

You can create new sequences by: 

• Building a new sequence using a template. 

• Building a new sequence vial by vial. 

• Building a new sequence from an existing sequence file by editing  
and renaming it. 

• Building a new sequence from a text file. 

• Building a new sequence from a SQL*LIMS worklist  
(if you have Connect; refer to the Connect documentation for information). 

You can modify existing sequences by changing, adding, or deleting data. 

Menus and Commands in the Sequence Editor 
You can choose commands from the Sequence Editor menu bar, from a shortcut 
menu that you display whenever you want it, or from the toolbar. 

The Sequence Editor contains the following menus. 

File Menu 
Allows you to create, open, save, and print sequence files; preview a sequence file 
before you print it; enter and review documentation about a sequence; and exit the 
Sequence Editor. 

Edit Menu 
Lets you edit rows in your sequence file, such as by cutting, copying, pasting, and 
deleting them. You can also copy and paste blocks of cells, and you can paste data 
from and copy data into external spreadsheet applications. 

Change Menu 
Lets you change values in your sequence file, such as filling rows with repeating or 
incrementing values. You can also browse for file names; change global parameters; 
create sample notes; and include program information. 



 Using the Sequence Editor 

Building a Sequence 11-5  

Build Menu 
Lets you append (add) new cycles to the current sequence; append cycles based on a 
template; and append another sequence file to the current sequence. The Build menu 
also contains commands that let you create a sequence by loading, appending, or 
merging a text file. 

Format Menu 
Lets you hide and unhide columns; adjust column width; synchronize column width 
for channels A and B; and select a font for the spreadsheet. 

Actions Menu 
Lets you switch to Setup; reprocess data in the sequence (using the Batch 
Reprocessing program); and switch to the Method Editor to change the method 
parameters referenced in the current sequence. 

View Menu 
Lets you display or hide the Sequence Editor toolbar and Edit Bar. 

The Status Bar at the bottom of the window displays important information about the 
sequence and Help messages for each command and toolbar button that you select. 
You cannot hide the Sequence Editor Status Bar. The Status Bar also displays the 
word Modified if you change any part of the current sequence. 

The Sequence Spreadsheet 
TotalChrom displays sequence information in spreadsheet format. Channel A and 
Channel B appear in separate windows. When an instrument is capable of collecting 
only a single channel of data, only one spreadsheet appears. The spreadsheet window 
has the following features: 
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Edit Bar — Displays the full contents of the currently selected cell. You can move 
the cursor to the edit bar and enter text there. Text that you enter in the edit bar is 
mirrored in the cell and vice versa. You cannot use the edit bar to edit cells that 
contain a drop-down list. 

Column Label — Identifies the type of information in all cells in the column. 
Column labels are displayed as headers across the top of the spreadsheet. Columns 
are explained in “Columns in the Spreadsheet.” 

Row Numbers — Always the first column in a spreadsheet. Because a spreadsheet 
can contain more rows than are visible in the window, row numbers help you find 
your location in the spreadsheet. 

Cell — A box at the intersection of a row and a column. A cell contains one item of 
data: a text string, an integer, or a real number. All the cells in a given column contain 
the same type of data. A cell that is not applicable in the context of the current row is 
shown in black. 

View Tab — Displays the columns that are associated with the tab. 

Columns in the Spreadsheet 
A sequence spreadsheet consists of the columns listed in this section. Columns that 
must have the same value for both channels appear with a yellow background. 
Columns that can have different values for each channel have a blue background. For 
a dual injection sequence, the (instrument) method column is the only yellow column.  

If the TotalChrom applications manager has designated columns as read-only they 
will appear with a gray background indicating that they are unavailable for editing. 

Type — Defines the nature of a row, which can be an analysis, a calibration, an 
external program, or a cleanup. A description of each type follows this list. 

Study Name — The name of the analytical study. 

Name — The name of the sample. 

Note — Displays an “X” when text, program, or serial dilution information has been 
entered for a row. 

Number (Sample Number) — The identification number of the sample. 

Site (Injection Site) — Whether the autosampler will inject into the front or back 
injector (for LINK-controlled GCs only). 

Rack — The rack number of the vial used for the injection when Varian or 
Micromeritics autosamplers are used. 

Vial — The vial number for the sample. 
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Method — If you select One Per Row in the Global Parameters dialog box, 
TotalChrom will use the same method for the instrument, processing, and calibration 
parameters. If you select Multiple Per Row, the following columns appear instead of 
Method: 

Inst Method (Instrument Method) ⎯ The method containing the instrument 
parameters. 

Proc Method (Processing Method) — The method containing the processing 
parameters. 

Calib Method (Calibration Method) — The method containing component and 
calibration parameters. 

Rpt Fmt File (Report Format File) — The report format file for the first report to 
be printed for a row. (You can specify additional optional reports in the processing 
part of the method.) 

Data File — If you select Same Name in the Global Parameters dialog box, 
TotalChrom applies the same base name to both the raw and result files. If you select 
Separate Names, the following columns appear instead of Data File: 

Raw Data File — The file containing the raw data. 

Result File — The file containing the analysis results. 

When the sequence is run, TotalChrom appends a unique suffix to the base name 
to name the data file(s). 

Calib Rpt (Calibration Report) — Whether a calibration report will be printed and, 
if so, the amount of detail that it will include. 

Cal Level — The name of the calibration level. 

Update RT (Retention Times) — Whether the calibration is set to update peak 
retention data or to retain the initial data. 

Sample Amt ⎯ The actual amount of the sample injected, excluding the amount of 
internal standards. Based on settings in the (calibration) method, this value can be 
used as a correction for calibration standards and/or to convert unknown samples to 
concentration units. 

Int Std Amt (Internal Standard Amount) ⎯ The total amount of internal standard 
component(s) in the sample. 

Sample Vol (Sample Volume) ⎯ The actual volume injected. 

Dil Factor (Dilution Factor) ⎯ The value that accounts for the diluents or aliquots 
used in preparing the sample. 

Multiplier ⎯ The value by which TotalChrom multiplies raw component amounts to 
get the adjusted amount. 
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Divisor ⎯ The value by which TotalChrom divides raw component amounts to get 
the adjusted amount. 

Addend ⎯ The value TotalChrom adds to raw component amounts to get the 
adjusted amount. A negative value is valid. 

Norm Factor (Normalization Factor) ⎯ The normalization factor used in reporting 
normalized amounts and normalized areas. 

Baseline (Baseline File) ⎯ The data file (usually derived from a blank sample run) 
that is subtracted from the raw data file to generate the modified file. 

Modified (Modified File) ⎯ The file containing the modified raw data. 

Printer ⎯ The printer to be used for printing reports. See your application manager 
for information about default and other printers. 

Plotter ⎯ The plotter to be used for printing replots (if specified in the method). See 
your application manager for information about default and other printers. 

Sample ID (LIMS) ⎯ A read-only column that uniquely identifies the sample within 
the SQL*LIMS system. 

Task ID (LIMS) ⎯ Uniquely identifies a SQL*LIMS test to be run on the sample. 

User 1 through User 10 — Ten columns available for any user-defined purpose. 

Type Column Entries 
Each cell in the Type column must contain an entry that either determines how 
TotalChrom analyzes data or specifies that TotalChrom run a special procedure. 

Among the Type column entries are Bracketed Calibration cycle types. They involve 
using standards both before and after a group of samples to derive the calibration 
information used to quantify the samples. A single sequence can contain several 
brackets (sets of calibration standards with intervening samples). 

TotalChrom prevents you from entering conflicting calibration types. For example, if 
you select Cal:Grand Avg, all other calibration types are removed from the list of 
selections. 

You select an entry for the Type column from the following options: 

 

Sample ⎯ Indicates an unknown sample to be analyzed. Your application manager 
might define additional names that function in the same way as Sample. 
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Cal:Average — Represents a calibration run. TotalChrom will add the results to the 
replicate information for the specified calibration level in the calibration section of 
the method. The resulting calibration will be the average of all the replicates. 

Cal:Replace — Represents a calibration run. TotalChrom will replace the results of 
all previous calibration data for the components at the specified calibration level. 
TotalChrom erases stored calibration replicates. 

Cal:Bracket-Overlapped — A type of bracketed calibration in which the final set of 
calibrations for one group of samples also acts as the first set for the next group. 

Cal:Bracket-NonOverlapped — A type of bracketed calibration in which each 
group of samples uses its own set of calibrations. Standards are duplicated between 
sample groups. 

Cal:Grand Avg — Averages all occurrences of each calibration level in the 
sequence and uses that average to process and report all samples. 

Program — Lets you run a user program in the sequence. Refer to “Including a User 
Program in a Sequence” on page 11-46. 

Serial Dilution — Used with the LC Series 200 Autosampler Serial Dilution 
function. For more information, refer to Appendix D, “Serial Dilution.” 

Blank, Spike, Std Check, Ctrl Sample, Precision, Suitability — Other names for 
Sample that indicate an unknown sample to be analyzed. (Your application manager 
might define other additional names for Sample.) 

Clnup-Shutdn — Causes the instrument portion of the method to be run. However, 
no injection is made, and no raw data file is created. If there are multiple method 
columns, you can only assign the name of a method in the instrument method column. 

GPCCal:Average and GPCCAL:Replace — Used with the optional TurboSEC 
application. In TotalChrom, these function like sample types. See the TurboSEC 
documentation for more information. 

General Procedure for Building a Sequence 
The following is the general procedure for creating a new sequence. Specific 
procedures for the dialog boxes referenced in this procedure are provided later in this 
chapter. 

You can also create a new sequence by editing an existing sequence file and 
renaming it with the Save As command. 
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 To create a new sequence: 

1. Do one of the following: 

• In the Navigator, choose Sequence from the Build menu or click the 
Sequence button, select Create New Sequence in the Startup dialog box, 
and choose OK. (Your application manager may have disabled the 
display of the Startup dialog box.) 

• If the Sequence Editor is already open, choose New from the File menu. 

2. Complete the dialog boxes that are displayed: Global Parameters and either 
Sequence Template or Append New Cycles or Sequence Worklist. 
Instructions for completing these dialog boxes appear later in this chapter. 
(Instructions for the Sequence Worklist dialog box are in the Connect 
documentation.) 

3. When the spreadsheet windows for Channels A and B open, you can edit 
data and change the appearance of the spreadsheet. Refer to “Editing the 
Sequence Spreadsheet” on page 11-27. 

 

4. When you are finished developing the sequence, choose Save from the File 
menu. 

The Documentation dialog box opens. 
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5. Complete the Description tab in the Documentation dialog box and choose 
OK. 

For a discussion about entering descriptive information about a file, refer to 
Chapter 2, “TotalChrom Basics.” 

The TotalChrom File Save As dialog box opens. 

6. Enter a name for the sequence in the File Name text box and choose Save. 

The dialog box closes, and the new sequence name appears in the title bar. 

7. When you are finished working in the Sequence Editor, choose Exit from 
the File menu. 

Alternatively, you can choose from the Actions menu to go directly to 
another application. 

Defining Global Parameters 
Whenever you create a new sequence, you enter information in the Global Parameters 
dialog box. You also use this dialog box to change global parameters for an existing 
sequence. 

There are two tabs in the Global Parameters dialog box: Build Parameters and 
Configuration. Each is described in a separate procedure. 

 To enter build parameters for a new sequence: 

1. When you choose Create New Sequence from the Startup dialog box or New 
from the File menu, the Global Parameters dialog box opens.  

 

2. If you want to assign an instrument for this sequence now, select from the 
Instrument list or click the ... button and select from the Instrument Selection 
dialog box. 



Defining Global Parameters 

11-12  

3. If your instrument contains trays, select the LC autosampler tray that you 
want to use for this sequence. 

4. If the instrument selected in the Instrument drop-down list has a 
TurboMatrix associated with it, select from the Sampling drop-down list the 
type of injection (Manual, Autosampler, or TurboMatrix) the sequence will 
use. 

5. Select From Template or Vial By Vial as the Build option that you want to 
use. If you have Connect, you can build a sequence by worklist. Refer to 
your Connect documentation for information. 

 To enter configuration parameters: 

1. On the Configuration tab, set the Injection Type to Single or Dual to match 
the instrument and type of analysis. 

Do not confuse dual injection with dual channel. The former refers to the 
injection of two different samples simultaneously, whereas the latter refers 
to the use of two detectors to monitor the separation of a single sample. 

2. Under Methods, select One Per Row or Multiple Per Row. 

When you select One Per Row, there will be one method column labeled 
Method. The method name that you enter will be used for acquisition, 
analysis, and component information. 

When you select Multiple Per Row, there will be three method columns 
labeled Instrument, Process, and Calibration. This allows you to use a 
different method for acquisition, analysis, and component information. 

3. Under Raw Data And Result Files, select Same Name or Separate Names. 

When you select Same Name, the same base name will be used for both raw 
and result data files. 

When you select Separate Name, you may use different base names for the 
raw and result data files. 

4. Choose OK. 

When you are building a new sequence, TotalChrom opens the next dialog 
box: 

• If you selected From Template on the Build Parameters tab, TotalChrom 
opens the Sequence Template dialog box. For dual injection sequences, 
you must complete the Sequence Template dialog box for both 
channels. Refer to “Building a Sequence by Template” on page 11-13.  

• If you selected Vial by Vial on the Build Parameters tab, TotalChrom 
opens the Append New Cycles dialog box. Refer to “Building a 
Sequence Vial by Vial” on page 11-17. 



 Building a Sequence by Template 

Building a Sequence 11-13  

• If you select By Worklist on the Build Parameters tab, TotalChrom 
opens the Sequence Worklist dialog box. Refer to the Connect 
documentation for information. 

Building a Sequence by Template 
Using a template simplifies the process of creating a routine sequence. The template 
lets you define a structure of calibrations and samples in a single operation. The 
template holds no sample-specific information such as sample name; you must 
provide that information in the spreadsheet. 

The Sequence Template dialog box opens when you build a new sequence and select 
From Template as the Build option in the Global Parameters dialog box. You also use 
this dialog box when you use a template to add samples to an existing sequence with 
the Append New Template command. 

 

 To enter Sequence Template information: 

1. If you want to identify the analysis being performed in the optional Study 
text box, enter any combination of alphanumeric characters. 

2. In the Method text box, enter or select the name of the Method that you want 
to use for Channel A. 

3. Enter a Base File Name for Channel A. 

You can include the full data path here, add it in the spreadsheet after you 
complete this dialog box, or enter or change it during setup. The base file 
name itself may contain 80 characters.  
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Do not end a base file name with a number since it will be treated like a cycle 
number.  If you must enter a number, then follow it with a legal separator (for 
example, hyphen – or underscore_ ). Do not use a period ( . ).  

TotalChrom creates a result file (.RST) for every raw data file (.RAW). The 
base name you enter here is used to name these files, along with a three-digit 
cycle number (starting at 001) that TotalChrom appends to them. If you run 
a sequence more than once, TotalChrom appends a timestamp to file names 
when necessary to keep them unique. 

Your application manager may have set up your system to append a 
timestamp to all files. 

4. If this is a dual-channel sequence, repeat steps 2 and 3 for Channel B. 

The method you enter for Channel A determines the instrument parameters 
that are used for both channels because these must be the same. If you enter 
a different method for Channel B, TotalChrom uses only the processing and 
calibration parameters from that method for Channel B. 

5. If you want to run calibration standards to calibrate the method, select 
Include Calibration Standards under Calibration. 

This option is only available if the method you specify includes calibration 
information. If you select Include Calibration Standards, the other options in 
the group box are available. 

TotalChrom will create a row for each calibration level that is defined in the 
method, and the first rows entered in the sequence will be calibration levels. 
Additional rows will be entered in the sequence based on your entries in the 
# Samples Between Calibrations and Number of Samples text boxes. 

For example, if you have four calibration levels and 12 samples, and you 
indicate that you want four samples between calibrations, the calibration 
standards will appear in the rows 1 to 4, 9 to 12, and 17 to 20. 

6. From the First Injection list, select the type of calibration that you want to 
use. 

This defines the type of calibration that TotalChrom will perform on the first 
injection of each standard level within a set of standards in the sequence. 

 

 Cal:Replace — This replaces existing calibration data in the method with 
new data from the run. 
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 Cal:Average — This averages the new calibration data with the existing 
data in the method. 

 Cal:Bracket-Overlapped — A type of bracketed calibration in which the 
final set of calibrations for one group of samples also acts as the first set of 
calibrations for the next group. 

 Cal:Bracket Non-Overlapped — A type of bracketed calibration in which 
each group of samples is analyzed with its own set of calibrations. Standards 
are duplicated between sample groups. 

 The bracketed calibration types involve using standards both before and 
after a group of samples to derive the calibration information used to 
quantify the samples. A single sequence can contain several brackets (sets of 
calibration standards with intervening samples). 

 Cal:Grand Avg — Averages all occurrences of each calibration level in the 
sequence and uses that average to process and report all samples. 

7. In the # Injections Per Calibration text box, enter the number of injections 
that you want to include for each calibration in the sequence. 

8. If you want TotalChrom to enter sample numbers for calibration rows, select 
Assign Sample Numbers To Calibrations. 

9. If you selected Replace or Average as the First Injection type and are 
making more than one injection per calibration, select from these same 
options for Replicate Injections. 

This defines how TotalChrom will handle the replicate injections for each 
standard level within each set of calibration standards. 

10. Enter a number in the # Samples Between Calibrations text box to define 
where the calibration standards appear in the sequence. 

When calibration cycles are to be inserted, TotalChrom enters a row for each 
calibration level defined in the method. 

11. Under Samples, enter a Sample Number Pattern.  

The sample number pattern is an alphanumeric entry that defines the basic 
form of the sample number. Use # characters to indicate the position and 
length of a numeric string within the sample number. Numeric digits can be 
located anywhere in the sample number. The following are valid patterns: 

ABC# 
##ABC2 
##### 
ABC####XYZ 
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Use only one set of pound signs. A pattern such as ABC##DEF## will give 
sample numbers of the form ABC01DEF## because only the first set of # 
characters is replaced by a number. 

12. In the Starting Number text box, enter the value that you want to become the 
first number in the sample number pattern. 

This number will be increased by an increment of one for each new sample 
in the sequence. 

13. In the Number Of Samples text box, enter the total number of samples to be 
analyzed in the sequence. 

TotalChrom uses this value, along with the entry from # Samples Between 
Calibrations, to determine where to insert sets of calibration cycles in the 
sequence. 

14. Enter a number in the # Injections Per Sample text box to indicate how many 
injections to include for each sample in the sequence. 

15. Under Autosampler, enter the Initial Vial Number for the first sample or 
calibration standard in the sequence. 

TotalChrom increases the number for subsequent samples. Replicates use the 
same vial number. 

16. If you are using an autosampler that can access vials randomly, select the 
option All Calibrations From One Vial Set to use the same set of vial 
numbers for all calibration sets. 

17. If you are using a LINK-controlled GC autosampler, select the Injection 
Site, which is either the front or the rear inlet (or injector). 

18. Choose OK. 

19. If the sequence is a dual injection, complete the Sequence Template dialog 
box for Channel B. 

When you complete the sequence template, TotalChrom builds the sequence. To edit 
the sequence, refer to “Editing the Sequence Spreadsheet” on page 11-27. 



 Building a Sequence Vial by Vial 

Building a Sequence 11-17  

Building a Sequence Vial by Vial 
You can build a sequence by individually defining each sample to be analyzed. This 
is referred to as building the sequence “vial by vial.” Because only one sample is 
added at a time, you can include sample-specific information. 

The Append New Cycles dialog box opens when you build a new sequence and select 
Vial By Vial as the Build option in the Global Parameters dialog box. You also use 
this dialog box when you add cycles to an existing sequence with the Append New 
Cycles command.  

 

There are four tabs in the Append New Cycles dialog box. Each is described in a 
separate procedure. 

Identification ⎯ For sample data and the instrument method 

Files ⎯ For processing and data parameters 

Quantitation ⎯ For sample values 

Calibration ⎯ For auto-calibration parameters (available only for calibration cycles) 
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The Append New Cycles dialog box contains the following command buttons: 

Add ⎯ Applies data to the sequence and leaves the dialog box open 

Add + Close ⎯ Applies data to the sequence and closes the dialog box 

Close ⎯ Cancels the Append New Cycles dialog box without applying data entered 
since the last “Add” 

Identifying the Sample 
You complete the Identification tab in the Append New Cycles dialog box to specify 
sample data and the instrument method to be used in a sequence. The Identification 
tab differs for single and dual injection sequences; refer to the procedure for the 
appropriate type of sequence. 

Do not confuse dual injection with dual channel. The former involves the injection of 
two different samples simultaneously, whereas the latter involves the use of two 
detectors to monitor the separation of a single sample.  

 To enter identification information for a single-injection sequence: 

1. On the Identification tab of the Append New Cycles dialog box, select an 
entry for the Type field from the list. 
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2. If the sample is to be injected more than once, enter the number of cycles in 
the # Of Cycles text box. 

When you are creating a new sequence, start by adding data for the first 
injection cycle (Cycle #1). As you add each cycle, TotalChrom assigns it a 
three-digit cycle number, starting at 001, and increases the sample number 
by increments of one. The cycle number is added to the base names of the 
raw data and result files that are created during data acquisition. 

3. In the Name text box, enter the name of the sample to be injected. 

4. In the Number Pattern text box, enter an alphanumeric pattern to define the 
basic form of the sample number. 

Use # characters to indicate the position and length of a numeric string 
within the sample number. Numeric digits can be located anywhere in the 
sample number. The following are valid patterns: 

ABC#2 
##ABC 
##### 
ABC####XYZ 

Use only one set of pound signs. A pattern such as ABC##DEF## will give 
sample numbers of the form ABC01DEF## because only the first set of # 
characters is replaced by a number. 

5. In the Actual Number text box, enter the value that you want TotalChrom to 
use in the sample number. The default value is the next available number, 
and it will be increased by an increment of one for each new sample in the 
sequence. 

6. In the Study text box, enter the name of the study to which this sample 
belongs. 

7. In the Vial text box, enter the vial number from which you want a LINK-
controlled autosampler to take the injection. If you do not have a LINK-
controlled autosampler, this number is informational only. The default value 
is the next available number, and it will be increased by an increment of one 
each time you choose Add. 

8. If necessary, change the number in the Rack text box. 

9. If you are using a LINK-controlled GC, select the appropriate Injection Site. 

10. In the (Instrument) Method text box, enter or select the name of the method 
file (that contains the instrument parameters) that you want to use. 

This information is required, but you can enter the name of a method that 
does not yet exist as long as the path exists and you create the method before 
you run the sequence. 
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 To enter identification information for a dual-injection sequence: 

For a dual-injection sequence, you may enter different parameters for each 
channel. 

1. On the Identification tab of the Append New Cycles dialog box, select an 
entry for the Type field. 

 

The type that you select will be used for both channels. If you want to 
specify different types for each channel, you can edit the spreadsheet later. If 
you use a type that is not a sample or a calibration type, it must appear for 
both channels. 

2. If the sample is to be injected more than once, enter the number of cycles in 
the # Of Cycles text box. 

When you are creating a new sequence, start by adding data for the first 
injection cycle (Cycle #1). As you add each cycle, TotalChrom assigns it a 
three-digit cycle number, starting at 001, and increases the sample number 
by increments of one. The cycle number is added to the base names of the 
raw data and result files that are created during data acquisition. 

3. In the (Instrument) Method text box, enter or select the name of the method 
file (that contains the instrument parameters) that you want to use. 

You can enter the name of a method that does not yet exist as long as you 
create it before you run the sequence. 

4. Select Channel A or Channel B. 
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5. In the Name text box, enter the name of the sample to be injected. 

6. In the Number Pattern text box, enter an alphanumeric pattern to define the 
basic form of the sample number. 

Use # characters to indicate the position and length of a numeric string 
within the sample number. Numeric digits can be located anywhere in the 
sample number. The following are valid patterns: 

ABC#2 
##ABC 
##### 
ABC####XYZ 

Use only one set of pound signs. A pattern such as ABC##DEF## will give 
sample numbers of the form ABC01DEF## because only the first set of # 
characters are incremented. 

7. In the Actual Number text box, enter the value that you want TotalChrom to 
use in the sample number. The default value is the next available number, 
and it will be increased by an increment of one each time you choose Add. 

8. In the Study text box, enter the name of the study to which this sample 
belongs. 

9. In the Vial text box, enter the vial number from which you want a LINK-
controlled autosampler to take the injection. If you do not have a LINK-
controlled autosampler, this number is informational only. The default value 
is the next available number, and it will be increased by an increment of one 
each time you choose Add. 

10. If necessary, change the number in the Rack text box. 

11. Repeat steps 5 through 10 for the other channel. 
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Specifying File Information 
You complete the Files tab in the Append New Cycles dialog box to define 
processing and data parameters. 

 To enter file information: 

1. On the Files tab of the Append New Cycles dialog box, select Channel A or 
Channel B. 

 

2. In the Processing and Calibration Method text boxes, enter or select the 
name of the method(s) that contains the parameters that you want to use. 

You can enter the name of a method that does not yet exist as long as the 
path exists and you create the method before you run the sequence. 

If you selected One Per Row in the Global Parameters dialog box, these text 
boxes will not be available. 

3. In the Report Format File text box, enter or select the name of the report 
format file that you want to use with this cycle. 

4. In the Raw Data File and Result File text boxes, enter or select the individual 
base data file names that you want to use for raw and result files. 

OR 

If you selected Same Name in the Global Parameters dialog box, enter or 
select the base data file name that you want to use for both files in the Data 
Files text box. 
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You can include the full data path here, add it in the spreadsheet after you 
complete this dialog box, or enter or change it during setup. The base file 
name itself may contain 80 characters. 

TotalChrom creates a result file (.RST) for every raw data file (.RAW). The 
base name(s) you enter here are used to name these files, along with a three-
digit cycle number (starting at 001) that TotalChrom appends to them. If you 
run a sequence more than once, TotalChrom appends a timestamp to file 
names when necessary to keep them unique. 

Your application manager may have set up your system to append a 
timestamp to all files. 

5. Optionally, enter or select the Baseline File that you want subtracted from 
the raw data collected from this cycle. 

6. If you specified a Baseline file name, enter the name of the Modified Data 
File to be generated. 

TotalChrom creates a modified file by subtracting the baseline file from the 
raw data file (for this cycle). If you create a modified data file, TotalChrom 
analyzes the data in this file rather than that in the original raw data file. 

You can collect a data file and use it for baseline subtraction in the same 
sequence. For the first injection, enter a file name in the Data File column and 
leave the Baseline File column empty. For the second and subsequent injections, 
specify the Data File file name as the Baseline File. 

7. If you want to change the current output port settings for this sample, select 
new ports from the Report Device and Plot Device lists. 

8. If necessary, repeat this procedure for the second channel. 
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Specifying Quantitation Values 
You complete the Quantitation tab in the Append New Cycles dialog box to set the 
parameters that relate to sample amounts. On this tab, you also set the conversion 
factors that TotalChrom uses to calculate adjusted component amounts from raw 
amounts. 

 To enter quantitation information: 

1. Select the Quantitation tab of the Append New Cycles dialog box and select 
Channel A or Channel B. 

For a single-injection sequence, an asterisk (*) next to a column indicates 
that the value will be entered for both Channels. 

 

2. In the Sample Amount text box, enter the actual amount of sample injected 
(excluding the amount of any internal standards used). 

Based on settings in the method, this value can be used for correcting calibration 
standards and for converting unknown samples to concentration units. 

• When sample amount is used for correcting calibration standards, you 
must use the same units as those used for component amounts in the 
calibration section of the method. TotalChrom calculates the correction 
factor as: 

actual sample amount
expected sample amount
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where the actual sample amount is the Amount entry in the sequence, 
and expected sample amount is the sum of the component amounts in 
the calibration section of the method. Each component amount in the 
method is multiplied by this factor to correct for any difference between 
the actual and expected amounts. 

• When sample amount is used to convert unknown samples to 
concentration units, it acts as a divisor. 

3. In the ISTD Amount text box, enter the amount of internal standard that is 
being added to the sample or calibration standard. 

The units must be the same as those used for the ISTD component amounts 
in the calibration section of the method. If you want to use the same ISTD 
amount(s) specified in the calibration section of the method, use the default 
value of 1.0. 

4. In the Sample Volume text box, enter the actual volume injected. 

This value affects quantitation only; it does not control the amount of sample 
injected. 

5. In the Dilution Factor text box, enter the amount that represents the dilution 
factor used in the sample before injection. 

Use 1 as the dilution factor if the sample is not diluted or if you do not want 
to make this correction. Raw amounts are multiplied by this value to get 
adjusted amounts. 

6. In the Multiplier text box, enter a value by which to multiply raw component 
amounts to get adjusted amounts. 

7. In the Divisor text box, enter a value by which to divide raw component 
amounts to get adjusted amounts. 

8. In the Addend text box, enter a value to add to raw component amounts to 
get adjusted amounts. 

9. In the Norm Factor text box, enter the value that you want to use for the 
normalization factor. 

This represents the normalization percentage if you want to report results as 
normalized concentrations. 

10. If necessary, repeat this procedure to set the sample values for the second 
channel. 
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Specifying Calibration Parameters 
You complete the Calibration tab of the Append New Cycles dialog box only if you 
selected one of the calibration options from the Type list on the Identification tab. 

 To enter calibration information: 

1. Select the Calibration tab of the Append New Cycles dialog box and select 
Channel A or Channel B. 

 

2. Select a Calibration Level. 

The choices come from the calibration method indicated on the Files tab. 

3. Select the Calib Report Length option that you want to use: 

Short — Provides a summary of the current calibration status for each 
component. 

Long — Includes the amount and response data for components in the run. 

None — Provides no calibration report. 
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4. Select an option from the Update RTs (Retention Times) list: 

Yes — Updates the expected retention times for components in the method 
using the actual retention times obtained during the calibration run. 

No — Does not update the expected retention times for components in the 
method. 

The list in the Update RT column of the spreadsheet has a third option 
(Replace), but because you do not use this option repeatedly in a sequence, it 
is not included in the Append New Cycles dialog box. 

Replace — Replaces all retention time replicates at all levels with the actual 
values from the current cycle. This is equivalent to choosing the Reset RT 
button in the Graphic Method Editor. 

5. If necessary, repeat this procedure for the second channel. 

Editing the Sequence Spreadsheet 
When you edit a sequence spreadsheet, you change existing data. By using 
commands from the Edit, Change, Build, and Format menus, you can: 

• Format spreadsheet views. 

• Change the appearance of the spreadsheet by altering the width of columns and 
by changing the font. 

• Edit the data in individual spreadsheet cells or in selected groups of cells. 

• Edit spreadsheet rows by moving, copying, inserting, appending, and deleting 
them. 

• Edit the values in individual columns, or in selected groups of columns. 

• Create notes about your samples. 

• Edit the global parameters of a spreadsheet to change its basic structure. 

• Append new cycles to the spreadsheet. 

Editing Basics 
You can use several methods to assist you when editing a spreadsheet: 

• To edit the value in an individual cell, select the cell and type directly into it. 

• To open a shortcut menu of commonly used commands, click the right mouse 
button in a selected element. 
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• To specify changes that you want to make to spreadsheet elements, use the 
Change Values command. 

• To edit the values in spreadsheet columns, use the Fill, Renumber Files, and Path 
commands: 

The Sample Fill-In command ensures that sample information for replicate injections 
is the same. 

The Fill Down command copies the contents of a selected cell to all cells in the same 
column below it. 

The Renumber Files command renumbers the base data file name in multiple 
columns. 

The Path command changes the path that is associated with method and/or data files. 

The Smart Fill command increments sample numbers, vial values, and the cycle 
numbers that are associated with data file names in a single column. 

When one or more cells in the Data, Raw Data File, or Result File column are 
selected you can use the Edit Token String command (in the Change or context 
menu) to create a file name based on tokens or to edit the existing tokenized file 
name.  See Chapter 2 for details on using the Token Editor dialog. 

Formatting Spreadsheet Views 
You select which columns to display by clicking the view tabs at the bottom of each 
spreadsheet. You can display a different view for each channel, but the available 
views and their contents are the same for both channels. 

As installed, the General view includes most of the available columns, and the 
remaining views are groupings of logically related columns. 

You can change the contents of views with the Hide/Unhide command, and you can 
create, rename and delete views with other commands on the Format menu. 

Hiding and Unhiding Columns 
The Hide/Unhide Columns command lets you select which columns to display in a 
spreadsheet view. Columns that are hidden or unhidden are always the same for 
Channels A and B. 
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 To hide and unhide spreadsheet columns: 

1. Choose the Hide/Unhide Columns command from the Format menu or from 
the toolbar. 

 

2. Select the column names that you want to hide or unhide and move them to 
the other list by clicking the appropriate arrow button. 

3. Choose OK to close the dialog box and redisplay the spreadsheets. 

TotalChrom will save information about which columns are displayed. 

To use the shortcut menu, follow one of these steps: 

• To hide columns immediately, select the columns that you want to hide and 
choose the Hide Column command from the shortcut menu. 

• To unhide columns, you need not select any columns. Choose the Unhide 
Column command from the shortcut menu and follow the procedure for using the 
Hide/Unhide Columns dialog box. 

Formatting View Tabs 
You can create new views, and you can rename and delete any view except General. 

 To create a new view tab: 

1. Position the cursor on the tab to the left of where you want the new tab to 
appear. 
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2. Choose New View from the Format menu. 

 

3. Enter a name for the view, then choose OK to display the Hide/Unhide 
Columns dialog box. 

4. Select the column names that you want to include in the view, and move 
them to the other list by clicking the appropriate arrow button. 

5. Choose OK. 

 To rename a view tab: 

1. Select the tab that you want to rename. 

2. Choose Rename View from the Format menu. 

 

3. Enter a new name, then choose OK. 

 To delete a view tab: 

1. Select the tab that you want to delete. 

2. Choose Delete View from the Format menu. 

Changing the Appearance of a Spreadsheet 
You can customize the appearance of a spreadsheet by: 

• Changing column widths 

• Synchronizing column widths for both channels 

• Changing the font used in the spreadsheet 
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Changing Column Widths 
You can format your spreadsheet by increasing or decreasing the width of columns 
with the mouse. You can also use the Column Width command to change the width 
of columns. 

 To change column width with the mouse: 

1. Position the cursor over the right border of the column header whose size 
you want to change; it will become a sizing cursor. 

2. Drag the cell border to the right or left to increase or decrease its size. All 
other columns retain their size. 

If you want to apply changed column widths to the other channel, choose the 
Synchronize Column Widths command from the Format menu. 

If you use the Column Width command, you can select either the number of 
characters you want columns to contain or you can configure the width to correspond 
with the longest entry in each column. 

 To change column width with the Column Width command: 

1. Select the columns that you want to resize. 

2. Choose Column Width from the Format menu or the shortcut menu. 

 

3. If you want the selected columns to contain a specific number of characters, 
enter a value between 1 and 255 in the Column Width text box. 

TotalChrom limits the number of characters that you may use in many 
columns, but you may make such columns wider if you wish. 

Or, if you want the column widths to correspond to the longest entry in each 
column, select the Fit To Contents check box. This selection overrides any 
value in the Column Width text box. 

4. If you want the column widths to be the same for both channels, select the 
Set Other Channel To The Same Width check box. 

5. Choose OK. 
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Synchronizing Column Widths 
The Synchronize Column Widths command lets you set all column widths in the 
inactive channel window to the same width as their corresponding columns in the 
active channel. You might want to synchronize column widths after you change them 
in one channel of your spreadsheet. 

 To synchronize the width of spreadsheet columns in both channels: 

1. Select the spreadsheet that contains the desired column widths. 

2. Choose the Synchronize Column Widths command on the Format menu. 

Changing the Font 
The Font command on the Format menu allows you to change the font, type style, 
and size of the text in the sequence spreadsheet. You may use any fonts installed on 
your computer. 

1. Choose Font from the Format menu. 

2. Select the font, style, and font size that you want to use. 

3. Choose OK. 

Editing Individual Cells 
You can change the contents of spreadsheet cells individually or in groups. 

Each cell in the spreadsheet is one of the following types: 

• Cells that you type into directly 

• Cells that contain a list  

• Cells that require a file name 

Editing Cells Directly 
Certain columns contain cells that you can edit directly by selecting and typing 
required information. 

 To edit cell contents directly: 

1. Select the cell that you want to change.  

2. In the cell or in the Edit Bar, type the value that you want the cell to contain. 

Your edits are mirrored in both the cell and the Edit Bar, although the Edit 
Bar can show more of your text unless you have increased the column width 
for the current cell. 
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Editing Cells with a Drop-Down List 
Certain columns contain cells that you can edit by selecting from a list. 

 To edit a cell that contains a drop-down list: 

1. Select the cell that you want to change; the list appears.  

2. Scroll to the option that you want and select it. 

Editing Cells That Require a File Name 
Certain columns contain cells that you can edit by selecting a file name from a file 
selection dialog box. You can also select the cell that you want to change and type the 
file name directly in the cell or in the Edit Bar. 

 To select a file name from the file selection dialog box: 

1. Display the TotalChrom File-Select dialog box by using one of these 
methods: 

• Double-click the cell. 

• Select the cell by clicking the right mouse button. Then choose Browse 
from the shortcut menu. 

• Select the cell by clicking the left mouse button. Then choose Browse 
from the Change menu. 

2. Locate and select the file name that you want to use for the selected cell. 

Editing Cells by Copying and Pasting 
You can copy data from any cell or group of contiguous cells and paste that data 
elsewhere in the spreadsheet. You can also paste that data into an external 
spreadsheet application. 

 To copy and paste data: 

1. Select the block of data that you want to copy. 

2. Choose Copy from the Edit menu. 

3. Identify the paste location by selecting the upper-leftmost cell. 

4. Choose Paste. 

Each cell in a pasted block must pass a validation check for format, such as 
length or numeric range. If any single cell fails validation, the entire paste 
operation is canceled and all cells remain unchanged. The basic rules of 
validation for pasting are: 

• Alphanumeric cells such as Sample Name can accept from any cell, 
within length constraints. 
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• Numeric cells such as ISTD Amount can only accept numbers within 
the allowed range. 

• Cells with enumerated lists, such as Type, can only accept strings that 
match one of the allowed entries exactly, except for case. 

• Method cells, which require a path, will accept a string. If the string 
does not include a valid path, the default path will be added. 

Changing the Values in Multiple Cells 
You can save time by changing the contents of multiple spreadsheet cells in one 
operation by using the Change Values command. 

 To change the values in multiple cells at one time: 

1. Select the cells that you want to edit. 

2. Choose the Change Values command from the Change menu or the shortcut 
menu.  

The Change Values dialog box has a data entry field for each cell you 
selected. In the following example, cells in the columns Study, Method, Rpt 
Fmt File, and ISTD Amt are selected. 

 

3. If you change your mind about the rows to which a change should apply, 
change the value for Starting Row and/or Ending Row. 

4. If the columns you selected are all blue and you want both channels to 
reflect your changes, select the Apply To Other Channel Also check box. 
When an asterisk (*) appears to the left of a column name, it is a “yellow” 
column: changes you make to it will always be entered into both channels. 

5. For each column type, enter or select the value that you want each cell to 
contain. 

Note that this operation applies only to the cells you have selected. It puts 
the exact value you enter in the dialog box into each of the selected cells of 
that column type. 
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Editing Rows 
Use commands from the Edit menu or the shortcut menu to perform the following 
edits to spreadsheet rows: 

• Moving rows 

• Copying rows 

• Inserting rows 

• Appending a row (Edit menu only) 

• Deleting rows 

These functions encompass the entire row, including hidden columns. 

Moving Rows 
To move rows in a spreadsheet, you use the Cut and Paste commands from the Edit 
menu or the shortcut menu. 

When you move rows, TotalChrom cuts and pastes them in both the Channel A and 
Channel B spreadsheets simultaneously. 

 To move spreadsheet rows: 

1. Select the rows that you want to move. 

2. Choose Cut. 

3. Select the row above which you want to insert the rows. 

If you do not select a row, TotalChrom appends the rows that you cut to the 
end of the spreadsheet. If you select the last row, TotalChrom gives you the 
option to insert or append. 

4. Choose Paste. 

You may paste the same selection as many times as needed while it remains 
on the clipboard. 

5. Check that the values in the rows that you have moved and the rows that 
follow are correct in their new context. You can use the Smart Fill command 
to increment values in the Number, Vial, and Data File columns if necessary. 
See “Editing Column Values” on page 11-37. 

Copying Rows 
To duplicate existing rows, you use the Copy and Paste commands from the Edit 
menu or the shortcut menu. The Copy and Cut commands are available  

When you copy rows, TotalChrom copies them in both the Channel A and Channel B 
spreadsheets simultaneously. 
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 To copy spreadsheet rows: 

1. Select the rows that you want to copy. 

2. Choose Copy. 

3. Select the row above which you want to insert the copied rows. 

If you do not select a row, TotalChrom appends the rows that you copied to 
the end of the spreadsheet. If you select the last row, TotalChrom gives you 
the option to insert or append. 

4. Choose Paste. 

You may paste the same selection as many times as needed while it remains 
on the clipboard. 

5. Check that the values in the rows that you have copied and the rows that 
follow are correct in their new context. You can use the Smart Fill command 
to increment values in the Number, Vial, and Data File columns if necessary. 
See “Editing Column Values” on page 11-37. 

Inserting Rows 
To insert new rows identical to rows you select, you use the Insert command from the 
Edit menu or the shortcut menu. The new rows are inserted above the rows you 
select. 

When you insert rows, TotalChrom inserts them in both the Channel A and Channel 
B spreadsheets simultaneously. 

 To insert new rows in the spreadsheet: 

1. Select the rows that you want to duplicate. 

2. Choose Insert. 

3. Check that the values in the rows that you have inserted and the rows that 
follow are correct. You can use the Smart Fill command to increment values 
in the Number, Vial, and Data File columns if necessary. See “Editing 
Column Values” on page 11-37. 
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Appending a Row 
When you append a row, TotalChrom adds it to the end of both the Channel A and 
Channel B spreadsheets simultaneously. 

 To append a row to the end of the spreadsheet: 

1. With your cursor anywhere in the Channel A or Channel B spreadsheet, 
choose Append from the Edit menu. 

TotalChrom appends a new row to the bottom of the spreadsheet. The new 
row will contain the same data as the last non-program row in the 
spreadsheet, with numeric data incremented for vial, sample number, raw 
file, result file, and modified file. 

2. Check that the values in the appended row are correct. You can use the 
Smart Fill command to increment values in the Number, Vial, and Data File 
columns if necessary. See “Editing Column Values.” 

For information about appending new cycles to a spreadsheet, refer to “Appending 
New Cycles to a Sequence” on page 11-48. For information about appending cycles 
to a sequence from a text file, refer to “Appending Sequence Information from a Text 
File” on page 11-57. 

Deleting Rows 
When you delete rows, TotalChrom deletes them from both the Channel A and 
Channel B spreadsheets simultaneously. 

 To delete spreadsheet rows: 

1. Select the rows that you want to delete. 

2. Press the Delete key or choose the Delete command from the Edit menu or 
the shortcut menu. 

3. Check that the values in remaining rows are correct in the new context. You 
can use the Smart Fill command to increment values in the Number, Vial, 
and Data File columns if necessary. See “Editing Column Values” below. 

Pasting Data from an External Spreadsheet Application 
You can create sequence data in an external spreadsheet application then paste that 
data into a sequence. You can paste in every column in a row, or only certain 
columns. 

You can reverse the process and copy visible, contiguous sequence spreadsheet data 
for pasting into an external spreadsheet application. 
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 To paste data from an external spreadsheet application: 

1. In the external application, create the data then copy them to the Windows 
clipboard. 

2. In the sequence, display the columns that correspond to the data to be pasted. 

If the columns do not match the incoming data, validation is likely to fail. 

3. Identify the paste location by selecting the cell that is the upper leftmost in 
the block. 

4. Choose Paste. 

Each cell in a pasted block must pass a validation check for format, such as 
length or numeric range. If any single cell fails validation, the entire paste 
operation is canceled and all cells remain unchanged. The basic rules of 
validation for pasting are: 

• Alphanumeric cells such as Sample Name can accept from any cell, 
within length constraints. 

• Numeric cells such as ISTD Amount can only accept numbers within 
the allowed range. 

• Cells with enumerated lists, such as Type, can only accept strings that 
match one of the allowed entries exactly, except for case. 

• Method cells, which require a path, will accept a string. If the string 
does not include a valid path, the default path will be added. 

Editing Column Values 
You use the Fill, Renumber Files, and Path commands from the Change menu or the 
shortcut menu to edit column values: 

Smart Fill ⎯ Increments the sample and vial values and data file names in a single 
column. 

Renumber Files ⎯ Renumbers the base data file name selectively in multiple 
columns. 

Fill Down ⎯ Duplicates the value in a selected cell to all cells in the rows below it 

Sample Fill-In ⎯ Ensures that sample information for replicate injections is the 
same 

Path  ⎯ Changes the path that is associated with method and/or data files. 

Using Smart Fill to Increment Sample Numbers 
Many editing operations apply only to the cell you have selected. After you insert, 
copy, move, or delete rows in a spreadsheet, it is a good practice to check the 
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accuracy of values in other rows. For example, if you change a sample number, the 
values in the remaining Number cells retain their original values.  

You use the Smart Fill command to increment sample numbers in the same column. 

 To increment sample numbers: 

1. If this is a dual-injection sequence, select all or part of the Number column 
in the channel for which you want to make changes. 

For a single-injection sequence, changes will apply to both channels. 

2. Select the Smart Fill command from the Change menu or the shortcut menu. 

 

3. If you change your mind about the rows to which a change should apply, 
change the value for the Starting Row and/or Ending Row. 

4. If necessary, change the entry in the Sample Number Pattern text box. 

The sample number pattern is an alphanumeric entry that defines the basic 
form of the sample number. Use # characters to indicate the position and 
length of a numeric string within the sample number. Numeric digits can be 
located anywhere in the sample number. The following are valid patterns: 

ABC# 
##ABC2 
##### 
ABC####XYZ 

Use only one set of pound signs. A pattern such as ABC##DEF## will give 
sample numbers of the form ABC01DEF## because only the first set of # 
characters is replaced by a number. 

5. If you want the numbering to change, enter the new value in the Starting 
Number text box. 

6. If you want the sample numbers to correspond to the vial numbers in this 
sequence, click the Synchronize With Vial Numbers check box.  
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When the same vial number appears several times, the same Sample Number 
will be used in each case. This applies to all occurrences of a given vial 
number, not just in adjacent rows. 

7. If you want to assign sample numbers to calibration rows, select the Assign 
Sample Numbers To Calibrations check box.  

If you do not check this box, sample numbers for all calibration rows will 
remain as they appeared before you used the Smart Fill command. 

8. Choose OK. 

Using Smart Fill to Increment Vial Numbers 
Many editing operations apply only to the cell you have selected. After you insert, 
copy, move, or delete rows in a spreadsheet, it is a good practice to check the 
accuracy of values in other rows. For example, if you change a vial number, the 
values in the remaining Vial cells retain their original values.  

You use the Smart Fill command to increment vial numbers in the same column. 

 To increment vial numbers: 

1. If this is a dual-injection sequence, select all or part of the Vial column in 
the channel for which you want to make changes. 

For a single-injection sequence, changes will apply to both channels. 

2. Select the Smart Fill command from the Change menu or the shortcut menu. 

 

3. If you change your mind about the rows to which a change should apply, 
change the value for the Starting Row and/or Ending Row. 

4. Enter a new Initial Vial Number. 

5. If you want the renumbered vials to be synchronized with current vial 
numbers, select the Maintain Replicates check box. 

The Maintain Replicates option ensures that rows that previously specified 
the same vial number still do so after renumbering even if they are not 
adjacent. 
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6. If there are calibration samples in the sequence and you want to use the same 
vial number for each occurrence of a particular calibration level, select the 
All Calibrations From One Vial Set check box. The vial number associated 
with the first occurrence of a level will be used wherever that level appears. 

7. Choose OK. 

Using Smart Fill to Rename Data Files 
Many editing operations apply only to the cell you have selected. After you insert, 
copy, move, or delete rows in a spreadsheet, it is a good practice to check the 
accuracy of values in other rows. 

You use the Smart Fill command to rename data files in the same column. 

 To rename data files: 

1. Select all or part of the data files columns (Raw, Result, Data, or Modified) 
in the channel for which you want to make changes. 

2. Select the Smart Fill command from the Change menu or the shortcut menu. 

 

3. If you change your mind about the rows to which a change should apply, 
change the value for the Starting Row and/or Ending Row. 

4. If necessary, enter or select the full path name of the directory in which to 
store (or search for) these files in the Directory text box. 

You need not enter a path name, and in normal usage, you might not want 
to. When you use a sequence to acquire data, you can specify the directory 
in which to store the data in the Setup dialog box (in the Navigator). This 
lets you specify a different destination for the data each time you run the 
sequence without having to modify the sequence.  

5. In the Base File Name text box, enter the base file name that you want to use 
when building the file names. 

If you leave the text box blank, TotalChrom will use the current base file 
name. Base file names may contain 80 characters. 



Editing the Sequence Spreadsheet 

11-42  

6. If you want to change the beginning file number, and therefore, successive 
file numbers, enter your changed value in the Starting Number text box. 

7. Choose OK. 

Using Renumber Files to Renumber Base Data File Names 
The Renumber Files command allows you to renumber either a range or all base data 
file names in a sequence, of one or multiple file types (raw, result, and/or modified), 
for all or only specific base names. 

Renumber files is similar to using Smart Fill to rename data files. The differences are: 

• Renumber Files affects only the numeric portion of the file name. 

• Renumber Files can operate on multiple file types (raw, result, modified). 

• Renumber Files can apply to only a specific base name rather than to all base 
names in the selected range. 

The default entries in the Renumber Files dialog box reflect what you select in the 
spreadsheet before you choose the command. You can edit these defaults as 
necessary. 

 To renumber data files: 

1. If you want to renumber specific rows or columns, select them then choose 
the Renumber Files command. 

The Renumber Files dialog box appears. 

 

2. To change the default rows, edit the values for Starting and/or Ending Row. 

If you did not select specific rows, the default values include the entire 
sequence. 
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3. If you want the new numbering to apply to the other channel, select the 
Apply To Other Channel Also check box. 

4. Enter the number you want for the new starting number. 

5. Select an option to indicate whether you want to renumber all base names or 
a specific base name only. 

6. If you are renumbering a specific base name, enter that name in the text box. 

If you selected a subset of rows, the name from the first selected row is 
provided as the default. 

If you enter a base name that does not exist, an error message will be 
displayed. (You must use Smart Fill to change a base name.) 

7. Select the check box for each file type that you want to renumber. 

Any data file types that are included in your selection are checked by 
default. 

8. Choose OK. 

Using Fill Down to Duplicate a Cell Value 
The Fill Down command provides a quick way to fill a column, from a designated 
cell downward, with the same value. You may perform this operation for any column 
in the spreadsheet, but you must begin by selecting an individual cell. 

The spreadsheet contains several columns that are likely to contain a constant value 
over a range of injections: Study, Sample Volume, the Method file columns (Method, 
Inst Method, Proc Method, and Calib Method), and the columns that contain 
conversion factors. 

For the Number, Vial, and Data File columns, consider using the Smart Fill command 
instead of Fill Down because when you use the latter, incorrect values that might 
invalidate the sequence can be introduced. 

The Fill Down command has a special action in the Notes column of the spreadsheet: 
if you select a cell in a Program row, the Program information is copied to all other 
Program rows in the spreadsheet. If you select a cell that is in any non-program row, 
the Sample Note is copied to all other non-Program rows in the spreadsheet. 

 To insert a repeating value in an entire column: 

1. Select a cell whose value you want to copy to all cells below it in the current 
column.  

2. Select Fill Down from the Change menu or the shortcut menu. 
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Using Sample Fill-In for Replicate Injections 
The Sample Fill-In command ensures that sample information for replicate injections 
is the same. 

The two options are Vial Number and Sample Number. If you select Vial Number, all 
sample information for cycles with the same vial number is changed to match the first 
cycle with that number. If you select Sample Number, it changes all sample 
information for cycles with the same sample numbers to match the first cycle with 
that sample number. 

Because the Sample Fill-In function involves comparing each sequence row against 
every other row, the time required for it to be completed increases geometrically with 
the number of rows. 

 To set sample information for replicate injections: 

1. Choose the Sample Fill-In command from the Change menu or the shortcut 
menu. 

 

2. Select Vial Number or Sample Number. 

3. Choose OK. 

Changing Paths 
The Path command allows you to change the path associated with all or specific 
method and/or data files. 

The default entries in the Change Path dialog box reflect what you select in the 
spreadsheet before you choose the command. You can edit these defaults as 
necessary. 

 To change paths: 

1. If you want to change the path(s) in specific rows or columns, select them 
then choose the Path command. 

The Change Path dialog box appears. 
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2. To change the default rows, edit the values for Starting Row and/or Ending 
Row. 

If you did not select specific rows, the default values include the entire 
sequence. 

3. To change the default paths, edit the entry for Path To Change. 

If you selected a single cell, the existing path is displayed. Otherwise, an 
asterisk (*) is displayed to represent all cells in the range of rows. 

4. Enter or select a new path for the file(s). 

5. Select the check box for each file type whose path you want to change. 

Any method and data columns that are included in your selection are 
checked by default. 

If you selected Same Name in the Global Parameters dialog box, a single 
checkbox labeled Data is available for both raw and result files. 

6. Choose OK. 

Creating Notes About Your Samples 
You may enter information about each non-program cycle in the spreadsheet by using 
the Sample Note command. 

 To create a sample note: 

1. Double-click a Note cell to open the Sample Note dialog box. 

OR 

Click anywhere in the row for which you want to add a note, and then 
choose Sample Note from the Change menu or the shortcut menu. You can 
enter different notes for each channel. 
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2. Enter a text note, pressing Ctrl+M to start a new line. 

3. Choose OK. An “X” appears in the Note column to indicate that a note 
exists. 

Including a User Program in a Sequence 
To include a user program in a sequence, you select Program as the cycle type, and 
then complete the Program Information dialog box. For specific information about 
running System Suitability, Fit Analysis, or Summary as a user program, see the 
corresponding chapter in this manual. Contact your application manager for 
information about your access to programs. 

When you designate a program in one channel for a single-injection sequence, 
TotalChrom adds the same program to the second channel. You can specify different 
programs for each channel only in dual-injection sequences. 

Real-Time programs will be run by Acquire when that cycle is reached during 
sequence execution. These programs are run in a manner that is synchronized with 
Analyze. That is, the program will not run until the previous row has been completed 
and processed, if processing is taking place. A Real-Time program does not run when 
a sequence or an index file is reprocessed. 

Process-Time programs are also run in a manner synchronized with Analyze. The 
difference between a Process-Time program and a Real-Time program is that the 
Process-Time program is also run when a sequence or index file is reprocessed. 

Programs used to process data should be identified as Process programs, while 
programs that interact with an instrument (for example, to switch sample streams or 
columns) should be specified as Real-Time programs. 

When you reprocess, only the Process-Time programs are run. 
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 To include a user program in a sequence: 

1. In the Type cell of the row for which you want to include a user program, 
select Program from the list. 

The Program Information dialog box opens, and TotalChrom disables all 
columns for the Program row except Type, Name, and Note. 

 

2. Select the program name. 

If you have unlimited access to programs, you may type in a program name. 
You must include the complete path so that TotalChrom can find the 
program. You can enter a program name that does not yet exist as long as 
you create it before you run the sequence. 

3. In the Command Line text box, enter any text that you want to pass to the 
user program. 

A command can contain no more than 256 characters. Make sure that the 
sum of the path, program name, and command line arguments (including 
expanded tokens) are within this limit. 

When TotalChrom runs a user program, it adds the command line by taking 
the specified information and by providing file name substitution for the 
following variables: 

$RAW — Full path and file name of the last raw data file 

$RST ⎯ Full path and file name of the last result file 

$MET ⎯ Full path and file name of the instrument method 

$SEQ ⎯ Full path and file name of the sequence file 

$IDX — Full path and file name of the index file 

$AIA — Full path and file name of the AIA metafile 
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If you must include the name of an explicit file rather than one of the tokens 
listed above, you must enclose the name in quotation marks. 

If TotalChrom is running in a networked environment and the command line 
must include the name of an explicit file, use the UNC name instead of a mapped 
share name. 

4. Choose OK. An “X” appears in the Note column to indicate that user 
program information exists for this row, and the program name is displayed 
in the Name column. 

Including a Serial Dilution Program in a Sequence 
You can include an LC Series 200 Autosampler Serial Dilution program in a 
TotalChrom sequence by selecting the Serial Dilution cycle type and specifying a 
Serial Dilution file. 

 To include a Serial Dilution program in a sequence: 

1. In the Type cell of the row for which you want to include a serial dilution 
program, select Serial Dilution from the List. 

The Serial Dilution dialog box opens, and TotalChrom disables all columns 
for the Serial Dilution row except Type, Name, and Note. 

 

2. Enter or select the Serial Dilution Method name. 

If you enter the name, you must include the complete path so that 
TotalChrom can find it. If you select the name, TotalChrom inserts the path. 

3. Choose OK. An “X” appears in the Note column to indicate that serial 
dilution information exists for this row. 

Appending New Cycles to a Sequence 
You can append new cycles to a sequence by using the Append commands on the 
Build menu: 

Append New Cycles ⎯ Lets you append cycles that include sample-specific 
information. After you choose the Append New Cycles command, you complete the 
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Append New Cycles dialog box like you would for a new sequence. This procedure is 
described in “Building a Sequence Vial By Vial.” 

Append New Template ⎯ Lets you append a structure of calibrations and samples 
in a single operation. After you choose the Append New Template command, you 
complete the Sequence Template dialog box like you would for a new sequence. This 
procedure is described in “Building a Sequence by Template.” 

Append Sequence File ⎯ Lets you append the cycles from another sequence that is 
designed to use the same instrument. After you choose the Append Sequence File 
command, you select a sequence from the File Select dialog box. 

You can also append cycles to a sequence from a text file. See “Appending Sequence 
Information from a Text File” on page 11-57. 

You can append a single row to a sequence by selecting the Append command from 
the Edit menu. See “Appending a Row” on page 11-37. 

Editing Global Parameters 
To change the basic structure of an existing sequence, use the Global Parameters 
command on the Change menu. 

When you change global parameters, the integrity of a sequence can be affected. 
Make sure that the values in the sequence are compatible with any new instrument 
configurations you assign when you change global parameters. 

Because global parameters define the fundamental characteristics of a sequence, 
changing them for an existing sequence can have a serious impact. For example, 
certain vial number entries that are valid for a Series 900 Interface will be invalid if 
you change the instrument type to an AutoSystem GC with a built-in autosampler. 
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Changing Environments From Within the Sequence Editor 
The commands in the Actions menu allow you to switch directly to other functions in 
TotalChrom without having to go through the Navigator. You can: 

• Switch to Setup to acquire data using the sequence. 

• Reprocess data from the sequence file using the Batch Reprocessing function. 

• Switch to the Method Editor to revise parameters associated with this sequence. 

Switching to Setup 
The Set Up command in the Actions menu allows you to switch to the Setup dialog 
box and begin acquiring data using the current sequence without having to return to 
the Navigator. 

 To switch to Set Up from the Sequence Editor: 

• Choose Setup from the Actions menu. 

If you have changed the current sequence file, the Save As dialog box 
appears. You can save the changes to the current file or create a new 
sequence file. 

The Setup dialog box opens, displaying the currently selected instrument and 
the appropriate sequence file. Refer to Chapter 12, “Acquiring and Viewing 
Data,” for information. 

Switching to Batch Reprocessing 
The Batch command in the Actions menu allows you to reprocess the data files that 
are referenced in the sequence. 

 To switch from the Sequence Editor to Batch Reprocessing: 

• Choose Batch from the Actions menu. 

If you have changed the current sequence file, the Save As dialog box 
appears. You can save the changes to the current file or create a new 
sequence file. 

The From Sequence dialog box opens. For information on how to use the 
options in Batch Reprocessing, refer to Chapter 15, “Reprocessing Files in 
Batch.” 

Editing Method Files for the Current Sequence 
Although you can identify the methods whose instrument, processing, and calibration 
parameters you want to use for a given sequence, you cannot change those parameters 
from the Sequence Editor. You must return to the Method Editor.  
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The Method Edit command in the Actions menu lets you switch to the Method Editor 
without going through the Navigator. 

 To switch to the Method Editor: 

1. Choose Method Edit in the Actions menu. 

If you have changed the current sequence file, the Save As dialog box 
appears. You can save the changes to the current file or create a new 
sequence file. 

 

2. Enter the number of the sequence row that contains the name of the 
method(s) that you want to edit. 

3. Choose Channel A or Channel B. 

4. Choose whether you want to edit the Instrument, Processing, or Calibration 
method for the specified row and channel. 

If your spreadsheet has a single method column, any option you select will 
open the same file. 

5. Choose OK. 

The Sequence Editor window closes and the Method Editor opens and 
displays the method you identified. 

6. Edit the method parameters as necessary. 

Refer to Chapters 6, 7, and 8 for information about developing instrument, 
processing, and calibration parameters in the method. 

7. Choose Save on the File menu to save the revised method. 

8. To return to the Sequence Editor window, choose Sequence Editor from the 
Other menu in the Method Editor. 
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Building a Sequence from a Text File 
You can load, append, or merge the information from an ASCII text file to build a 
sequence. 

• Loading a text file lets you use it as the source for an entire sequence.  

• Appending a text file lets you append sequence information from a text file to the 
end of a sequence file. 

• Merging information from an ASCII text file lets you merge it into the cycles of 
a sequence. In this case, the text file provides missing parameters in the sequence 
and overwrites existing parameters. 

You can create an ASCII text file with sequence parameters by using any text editor 
or word processor that can convert its files to ASCII text. You can also create a text 
file automatically by using certain laboratory information management system, such 
as SQL*LIMS. 

Text File Format 
You can import a text file into a sequence, but it must be formatted in a precise file 
format in order for TotalChrom to recognize it. The file format is as follows: 

First Line — The first line of the text file must contain only the number of cycles 
defined in the text file and nothing else. 

Second Line — The second line of the text file contains a series of identifiers, 
separated by commas, that specify which parameters are included in the text file and 
the order in which they will appear. The identifiers are listed in the table that follows 
this discussion. 

You can list some, or all, of the identifiers on the second line. Enter only the 
identifiers that represent the parameters you plan to put in the file. Following is an 
example of the second line in a text file: 
STUDY-A,SAMPLE-A,NUMBER-A,INST,RAW-A,RESULT-A,PROC-A,SAMP-A 

If you omit identifiers, and the text file is intended to create a whole sequence or 
append cycles, the Sequence Editor will enter default values for parameters 
corresponding to the missing identifiers. 

Third and all subsequent lines — Each of these lines represents a different cycle. 
They contain parameters corresponding to the identifiers listed on line 2. No other 
parameters are allowed. 

Here is an example of line 2 followed by a row of parameters to illustrate how the 
parameters must correspond to the identifiers: 
TYPE-A,SAMPLE-A,AMOUNT-A,INST,RAW-A,RESULT-A,PROC-A,SAMP-A 
"Sample","HERBICIDE",2,"PEST","HERB001","HERB001","PEST","PEST" 
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A file must contain at least as many cycles as specified in line 1. If there are more, 
they will be ignored.  

The following table lists the identifiers that you use when you import a text file into a 
sequence, their corresponding parameters, and whether each identifier must appear as 
a number or text. 

You must enter the identifiers exactly as shown in the table including capitalization. 
Otherwise, TotalChrom will not be able to import the file.  

For single-channel runs using Channel B, you must use the "-A" identifiers for 
sample information. If you use the"-B" identifiers, the sequence will not be built 
properly. The "-B" identifiers are used only with processing parameters in dual-
channel runs and with sample parameters in dual-injection runs. 

Identifier Type Corresponding Parameter 

TYPE-A Text Type for Channel A 

TYPE-B Text Type for Channel B 

STUDY-A Text Study name for Channel A 

STUDY-B Text Study name for Channel B 

SAMPLE-A Text Sample name for Channel A 

SAMPLE-B Text Sample name for Channel B 

NUMBER-A Text Sample number for Channel A 

NUMBER-B Text Sample number for Channel B 

SITE-A Text Injection site for Channel A 

SITE-B Text Injection site for Channel B 

VIAL-A Number Vial for Channel A 

VIAL-B Number Vial for Channel B 

RACK-A Number Rack for Channel A 

RACK-B Number Rack for Channel B 

AMOUNT-A Number Actual sample amount for Channel A 

AMOUNT-B Number Actual sample amount for Channel B 

ISTD-A Number Actual internal standard amount for Channel A 

ISTD-B Number Actual internal standard amount for Channel B 
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Identifier Type Corresponding Parameter 

VOLUME-A Number Actual sample volume for Channel A 

VOLUME-B Number Actual sample volume for Channel B 

DIL-A Number Dilution factor for Channel A 

DIL-B Number Dilution factor for Channel B 

MULT-A Number Multiplier for Channel A 

MULT-B Number Multiplier for Channel B 

DIV-A Number Divisor for Channel A 

DIV-B Number Divisor for Channel B 

ADD-A Number Addend for Channel A 

ADD-B Number Addend for Channel B 

INST Text Instrument method 

OUTPUT-A Text Printer and plotter device for Channel A 

OUTPUT-B Text Printer and plotter device for Channel B 

PRINTER-A Text Printer device for Channel A 

PRINTER-B Text Printer device for Channel B 

PLOTTER-A Text Plotter device for Channel A 

PLOTTER-B Text Plotter device for Channel B 

RAW-A Text Raw data file name for Channel A 

RAW-B Text Raw data file name for Channel B 

RESULT-A Text Result file name for Channel A 

RESULT-B Text Result file name for Channel B 

PROC-A Text Processing method for Channel A 

PROC-B Text Processing method for Channel B 

SAMP-A Text Calibration method for Channel A 

SAMP-B Text Calibration method for Channel B 

RPT-A Text Report format file name for Channel A 

RPT-B Text Report format file name for Channel B 
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Identifier Type Corresponding Parameter 

BLANK-A Text Baseline file name for Channel A 

BLANK-B Text Baseline file name for Channel B 

MOD-A Text Modified data file name for Channel A 

MOD-B Text Modified data file name for Channel B 

CAL-A Text Calibration report for Channel A 

CAL-B Text Calibration report for Channel B 

LEVEL-A Text Calibration level for Channel A 

LEVEL-B Text Calibration level for Channel B 

UPDATE-A Text Update retention times for Channel A  

UPDATE-B Text Update retention times for Channel B 

NORM-A Number Normalization factor for Channel A 

NORM-B Number Normalization factor for Channel B 

SAMPID_A Text SQL*LIMS Sample ID for Channel A 

SAMPID_B Text SQL*LIMS Sample ID for Channel B 

TASKID_A Text SQL*LIMS Task ID for Channel A 

TASKID_B Text SQL*LIMS Task ID for Channel B 

USER1-A Text First user-defined value for Channel A 

USER1-B Text First user-defined value for Channel B 

USER2-A Text Second user-defined value for Channel A 

USER2-B Text Second user-defined value for Channel B 

USER3-A Text Third user-defined value for Channel A 

USER3-B Text Third user-defined value for Channel B 

USER4-A Text Fourth user-defined value for Channel A 

USER4-B Text Fourth user-defined value for Channel B 

USER5-A Text Fifth user-defined value for Channel A 

USER5-B Text Fifth user-defined value for Channel B 

USER6-A Text Sixth user-defined value for Channel A 
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Identifier Type Corresponding Parameter 

USER6-B Text Sixth user-defined value for Channel B 

USER7-A Text Seventh user-defined value for Channel A 

USER7-B Text Seventh user-defined value for Channel B 

USER8-A Text Eighth user-defined value for Channel A 

USER8-B Text Eighth user-defined value for Channel B 

USER9-A Text Ninth user-defined value for Channel A 

USER9-B Text Ninth user-defined value for Channel B 

USER10-A Text Tenth user-defined value for Channel A 

USER10-B Text Tenth user-defined value for Channel B 

Following are the syntax rules for listing the parameters in a cycle: 

• They are listed in the order indicated by line 2. 

• They are separated by commas. Spaces after commas are allowed, but not 
required. 

• When a cycle does not have a value to correspond to a parameter identified on 
line 2, use two commas in succession to indicate its position. You may use blank 
spaces between the commas, but they are not required. If the position of the 
missing parameter is at either end of the line, a second comma is not required. If 
the missing parameter is numeric, the system will enter 0 in the sequence. If the 
missing parameter is text, a blank will be entered. 

• Text parameters must be enclosed in quotes. If a text parameter includes a quote, 
such as “DIET LITE” STUDY, use additional quotes around the quoted portion: 

 """DIET LITE"" STUDY" 

• Do not enclose number parameters in quotes. 

• Omitting quotes from text parameters, or enclosing numeric parameters in 
quotes, will not generate an error message: a default value (or a blank for text 
parameters) will be used instead. 
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• The only permitted values for “Type-A” and “Type-B” are any of the types that 
you can select in the Sequence Editor. 

Invalid combinations of Types, within a single channel or between channels, 
will produce an error when the text file is loaded. 

If you omit the Type parameter, TotalChrom will use a Sample type, 
regardless of any other parameters that you include (such as calibration level 
name). 

The following is an example of a properly formatted text file. 
3 
TYPE-A,SAMPLE-A,AMOUNT-A,VOLUME-A,INST,RAW-A,RESULT-A,PROC-A,SAMP-A 
"Sample","WASTEWATER",5,2,"WATER","POND001","POND001","WATER","WATER" 
"Sample","WASTEWATER",1,1,"WATER","POND002","POND002","WATER","WATER" 
"Sample","WASTEWATER",1,1,"WATER","POND003","POND003","WATER","WATER" 

Loading a Text File into a Sequence 
You use the Load Text File command on the Build menu to transfer the information 
from an existing text file to create a sequence file. 

 To load sequence information from a text file: 

1. Choose Load Text File from the Build menu. 

2. Select the text file that you want to open and click Open. 

The information from the text file becomes a sequence file. If the text file 
does not match the parameters in the sequence file, you get a message that 
says: No Field Identifiers Were Specified or Unknown Field Identifier. 

Another error is Invalid Type In Text File. This means that you have either 
misspelled a Type parameter or have used an invalid combination of Types. 
You need to fix the text file before TotalChrom can generate a sequence. 

Appending Sequence Information from a Text File 
You use the Append Text File command on the Build menu to append sequence 
information from a text file to the end of a sequence file. 

 To append information from a text file: 

1. Open the sequence file that you want to change. 

2. Choose Append Text File from the Build menu. 

3. Enter or select a text file name and choose Open. 

This appends sequence information from the selected text file to the current 
sequence file. 
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Merging Sequence Information from a Text File 
The Merge Text File command on the Build menu merges sequence information from 
a text file with the current information in a sequence file.  

If the two files have different values for the same parameter, the text file value will 
overwrite the sequence file value. 

When you merge a text file with a sequence, any parameters in a given cycle of the 
text file will overwrite those of the same type in the corresponding cycle of the 
sequence. For example, if a cycle in the sequence specifies DEFAULT as the method 
file, and the corresponding cycle in the text file specifies SOLVENT as the method 
file, SOLVENT will overwrite DEFAULT. 

If the text file contains a blank parameter (with commas to mark its place), a blank 
value or 0 will overwrite the corresponding value in the sequence. Certain numeric 
sequence parameters (amount, ISTD amount, multiplier, divisor, and dilution factor) 
are not allowed to be 0, so you must edit the sequence to correct these invalid entries. 

 To merge information from a text file: 

1. Open the sequence file that you want to change. 

2. Choose Merge Text File on the Build menu. 

3. Enter or select a text file name and choose Open. 

This merges sequence information from the selected text file with the current 
sequence file. 

Using a Text File from the Command Line 
You can run the Sequence Editor and specify a fully qualified text file name on the 
command line. 

When you build a new sequence from the command line, the text file name is used to 
name the sequence. When you merge or append a text file, the text file name must 
match the fully qualified name of an existing sequence. CAM locks are asserted on 
existing sequence files the same way they are when you run the Sequence Editor from 
TotalChrom. 

You can include switches on the command line to indicate how text should be 
incorporated into a sequence. If there are no switches on the command line, the /B 
switch is assumed. 

/B build new sequence based on the input text file 
/M merge input text file into existing sequence file of the same name 
/A append input text file to existing sequence file of the same name 
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You can add the quiet mode switch, /Q, so that the Sequence Editor does not open 
during this process. When you use the /Q switch, you must add the /B, /M, or /A 
switch. When you use the /Q switch, you cannot build a dual-injection sequence or 
select an autosampler tray. 

When you use the /Q switch, you may provide instrument information for the 
sequence file by adding the following line after all the cycle records in a text file. 

[UserData] 
Instrument=<target instrument key> 

The instrument entry must be the instrument key, not the instrument name. This value 
will overwrite the instrument key in the sequence file when you merge or append a 
text file to it. 

Using Index Files 
As TotalChrom acquires data from a series of runs, it creates a record of those runs in 
the form of an index file (with the extension .IDX). The information in an index file is 
basically the same as in a sequence, but with one important difference: the index file 
contains the actual name of each file collected, whereas a sequence file contains only 
the base file name and the cycle number. The actual file name may be more than a 
combination of these two parts, however, because if that name already exists at the 
time of the run, a timestamp will be added to create a unique file name. 

Because you can modify completed rows during data acquisition, you cannot use the 
sequence file as documentation for a series of runs. Only the index file represents a 
true picture of what occurred during a sequence run. 

TotalChrom does not add file names to the index file until the run is complete, so the 
index file that is generated from a sequence that has not run to completion will 
contain fewer rows than the sequence. 

You can view index files in the Sequence Editor, but you cannot edit them. However, 
you can save an index file as a new sequence file with the Save As command. 

 To view an index file: 

1. Choose Open from the File menu. 

2. Select IDX Files from the List Files Of Type list. 

3 In the File Name text box, enter or select the name of the index file that you 
want to edit. 

4 Choose Open. 

You can print the index file by choosing Print from the File menu. 
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Printing Sequence Information 
The Print command on the File menu allows you to select from a variety of printing 
options and print the information in a sequence. Two print-related dialog boxes will 
appear, one for sequence options and one for standard Windows printing options. 

 To print the information from a sequence: 

1. Choose Print from the File menu to open the Print Options dialog box. 

 

2. Under Options, select the check boxes for the print options you want: 

• To print every column in all cycles in the entire sequence for both 
channels, select Full Detail. All Channel A and Channel B selections 
will be disabled. 

• To start a new page for each type of information, select Form Feed 
Between Sections. 

• To include every column in the printout, select Print Hidden Columns. 
When this is not selected, the printout includes only the visible columns. 

• To print a history of changes made to an audited file, select Audit Trail. 

3. For each channel, select the check boxes for the options that you want to 
include in the printout, then choose OK. 

4. Make any changes in the Print dialog box, and then choose OK. 
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Chapter 12 
Acquiring and Viewing Data 

 

This chapter explains how to use TotalChrom to acquire and view data from your 
chromatographs.  

To learn about: Go to page: 
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Setting Up Data Acquisition 
Acquiring data, in brief, consists of: 

• Receiving analog or digital signals from one or more chromatographic detectors 
through an interface. 

• Converting these signals to digital data, if necessary. 

• Displaying the data as a real-time plot, if desired. 

• Storing the data for analysis. 

Once you set up and initialize an instrument, you control data acquisition by using the 
commands in the Navigator Run menu. You can view the data in real-time as it is 
generated and view detailed information about the instruments and interfaces.  

TotalChrom acquires data based on the instructions contained in a method file 
(*.mth), which you download from the computer to the interface memory using the 
Setup function. The Quick Start setup type uses a basic, default method file, whereas 
the Method and Sequence types use more sophisticated, pre-defined method files. 
You need to set these method parameters before you can acquire data. 

This section explains  

• How to choose a setup type,  

• How to set parameters appropriate for each different type, and  

• How to build a Quick Method or Vial List, if necessary, for your setup. 

Choosing a Setup Type 
You can set up an instrument in three different ways depending on the analytical task 
you need to perform. These three options are available in the Setup Instrument dialog 
that appears when you select an instrument and click the Setup button. The choices in 
the Setup Instrument dialog box will differ depending on the type you select. 

 

Quick Start 
If you do not have an appropriate method available, you can use TotalChrom’s Quick 
Start feature, which lets you specify the essential instrument conditions and data 
handling parameters during the setup process. Since a Quick Start method contains 
only the very basic parameters, the result from a Quick Start analysis will be a simple 
default report showing peak retention times and area/height normalized percentage 



 Setting Up Data Acquisition 

Acquiring and Viewing Data 12-3 

values. The methods you create using Quick Start will not contain the information 
that is required for component identification or calibration. 

This option is helpful when you are first starting to use the system, if you are 
performing a “survey” run on a type of sample that you have not analyzed before, or 
when you are developing instrument settings for an analysis. 

Method 
If you already have an appropriate method and have only a small number of samples 
to analyze, you can use the Method setup option. This provides all of the flexibility 
available in a TotalChrom method to process data. For example, you can customize 
report formats and include component names and amounts that are calculated using 
internal or external standard calibration. For detailed information on building 
methods, refer to Chapters 5 through 8. 

Sequence 
If you need to analyze a large number of samples, or want to automate routine 
analyses, the best choice is to set up your instrument using the Sequence option. The 
sequence provides all of the information TotalChrom needs to acquire and analyze 
data from a complete set of samples. The sequence can: 

• Define when to carry out calibrations. 

• Include unique descriptive and quantitative parameters for each sample. 

• Specify different methods for different samples. 

• Include instructions to run an application program at a specific point in the 
analytical process. 

For detailed information on building sequences, refer to Chapter 11, “Building a 
Sequence.” Once you decide which Setup option is appropriate for the current 
analysis, you can start the setup procedure. 
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Using Quick Start 
 To use the Quick Start setup type to acquire data: 

1. If you are setting up an LC and the interface status is Released, choose Take 
Control from the Run menu. 

2. Select an instrument in the instrument selection panel and click the Setup 
button to open the Setup Instrument dialog box for that instrument. 

 

3. Select Quick Start as the Setup Type. 

 

4. In the Raw file path and Result file path text box, enter or select the path 
where you want to store your data files. 

The check box relating to paths is hidden (not merely disabled) for all users. 
The raw and result paths are initially filled with your default paths.  
Allowable changes to the contents of these fields (via typing or folder 
button) depend on the permissions set in System Configuration. 
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5. In the Base File Name text box, enter a file name or set a tokenized name by 
clicking the ‘…’ button. 

The default Base File Name is typically set in System Configuration.  
Allowable changes to the contents of these fields (via typing or folder 
button) depend on the permissions set in System Configuration. Your 
application manager may have set up Default base names in System 
Configuration. 

Do not end a base file name with a number since it will be treated like a cycle 
number.  If you must use a number, then use a legal separator (for example, 
hyphen – or underscore_ ). Do not use a period ( . ).  

TotalChrom will automatically append a three-digit run or cycle number to 
this base file name to create the data file names. If the file name already 
exists in the path, TotalChrom will append a date/time stamp to the file 
name: the four-digit year, two-digit month, two-digit day, two-digit hour (in 
24-hour style — “14” = 2 pm), two-digit minute, and two-digit second. 

6. Build and save a Quick Method and, if necessary, a Vial List as explained in 
“Using Quick Method” on page 12-15 and “Building a Vial List” on 
page 12-16. 

7. Select Suppress Processing if you do not want to process the data 
immediately after it is collected. 

This automatically suppresses the data analysis process, including the 
printing of reports and plots, and the creation of a result file. 

You may want to select Suppress Processing if you plan to use your 
computer for another task and do not want to be interrupted by data 
processing at the end of each run. Since data processing is a compute-
intensive task, it can cause your computer to be unresponsive for several 
seconds as the various data analysis functions are carried out. 

You can use Batch Reprocessing later to obtain results from the analyses. 

8. Select Suppress Reports/Plots if you do not want to print a report and plot. 

Otherwise, a report and plot will automatically print at the end of a run. 

9. Choose OK in the Setup Instrument dialog box to initialize the instrument. 
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Using a Method 
 To use the Method setup type to acquire data: 

1. If you are setting up an LC and the interface status is Released, choose Take 
Control from the Run menu. 

2. Select an instrument in the instrument selection panel and click the Setup 
button to open the Setup Instrument dialog box for that instrument. 

 

3. Select Method as the Setup Type. 

 

4. In the Method text box, enter or select the name of a method file. 

1. In the Raw file path and Result file path text box, enter or select the path 
where you want to store your data files. 

The check box relating to paths is hidden (not merely disabled) for all users. 
The raw and result paths are initially filled with your default paths.  
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Allowable changes to the contents of these fields (via typing or folder 
button) depend on the permissions set in System Configuration. 

6. In the Base File Name text box, enter a file name or set a tokenized name by 
clicking the ‘…’ button. 

The default Base File Name is typically set in System Configuration.  
Allowable changes to the contents of these fields (via typing or folder 
button) depend on the permissions set in System Configuration. Your 
application manager may have set up Default base names in System 
Configuration. 

Do not end a base file name with a number since it will be treated like a cycle 
number.  If you must use a number, then use a legal separator (for example, 
hyphen – or underscore_ ). Do not use a period ( . ).  

TotalChrom will automatically append a three-digit run or cycle number to 
this base file name to create the data file names. If the file name already 
exists in the path, TotalChrom will append a date/time stamp to the file 
name: the four-digit year, two-digit month, two-digit day, two-digit hour (in 
24-hour style — “14” = 2 pm), two-digit minute, and two-digit second. 

Your application manager may have set up your system to automatically 
append a date/time stamp to all files. 

7. Enter the Starting File Number you want to be appended to the base file 
name for the first run. 

If necessary, TotalChrom will add leading zeros to your entry to generate the 
three-digit cycle number. For example, the entry 2 will become 002.  

Subsequent runs will use the same file name with the appended number 
incremented for each run. 

8. If necessary, edit the Method or build a Vial List as explained in “Using 
Quick Method” on page 12-15 and “Building a Vial List” on page 12-16. 

9. Select Start Run When Ready to start the run as soon as the instrument is 
ready. 

You use this option when you want a LINK-controlled autosampler to begin 
its first injection of the new setup as soon as the instrument reaches the 
Ready state. If the sample vials are not in the autosampler yet, you may issue 
the Start Run command later. 

10. Select Single Run Data Buffering if you do not want to store data from 
multiple runs in the interface. 

This forces single run data buffering even when there is enough space to 
store multiple runs. 
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If Single Run Data Buffering is not selected, the interface memory will be 
divided into segments large enough to store the data from a single run. This 
enables the interface to acquire data from multiple runs even if the Navigator 
window is closed or the computer is turned off. For details, refer to 
Appendix A, “How Interfaces Collect Data.” 

11. Select Suppress Processing if you do not want to process the data 
immediately after it is collected. 

This automatically suppresses the data analysis process, including the 
printing of reports and plots, and the creation of a result file. 

You may want to select Suppress Processing if you plan to use your 
computer for another task and do not want to be interrupted by data 
processing at the end of each run. Since data processing is a compute-
intensive task, it can cause your computer to be unresponsive for several 
seconds as the various data analysis functions are carried out. 

If you suppress processing, you can use Batch Reprocessing later to obtain 
results from the analyses. 

12. Select Suppress Reports/Plots if you do not want to print a report and plot. 

If you do not select this option, TotalChrom will automatically print a report 
and plot at the end of a run. 

13. To run a program after TotalChrom downloads the method to the interface, 
select Run A User Program After Setup. Enter or select the name (including 
the path) of the program you want to run. 

14. Choose OK in the Setup Instrument dialog box to initialize the instrument. 

Using a Sequence 
When you set up a sequence for any instrument other than one with a LINK-
controlled autosampler, a tab for Post Sequence Options is added to the Setup 
Instrument dialog box. You use this tab to define what will happen when the 
sequence ends. The two tabs are described in separate procedures. 

 To use the Sequence setup type to acquire data: 

1. If you are setting up an LC and the interface status is Released, choose Take 
Control from the Run menu. 

2. Select an instrument in the instrument selection panel and click the Setup 
button to open the Setup Instrument dialog box for that instrument. 
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3. Select Sequence as the Setup Type, then enter or select the name of the 
sequence file. 

 

The name of the first method to be downloaded appears in the Method text 
box, and the first and last rows in the sequence are shown in the Starting and 
Ending Row text boxes. 

4. For a sequence setup the Raw and Result file path fields are disabled and 
blank. 

• If the path specified in the sequence you selected is the path that you 
want to use, do not select the “Store data in above paths (or sub-
directories) in preference to sequence paths.” The path entry will not be 
used in this case. 

• To override the path that is defined in the sequence you selected, enter 
a different path in the Raw and Result file paths text boxes and select 
the “Store data in above paths (or subdirectories) in preference to 
sequence paths.” 

For example, if the path in the sequence is C:\TC\MARY, and you enter 
C:\TC\JOHN in the Setup Instrument dialog, then the files will be stored 
in C:\TC\JOHN. 
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However, if the path in the sequence specifies a subdirectory of the 
default path that you enter here, then that subdirectory will be used. For 
example, if the path in the sequence is C:\TC\JOHN\DATA, and you 
enter C:\TC\JOHN in the Setup Instrument dialog, then the files will be 
stored in C:\TC\JOHN\DATA. 

• If the sequence you selected does not specify a path, enter the path you 
want in the Raw and Result files path text box. The state of the “Store 
data in above paths (or subdirectories) in preference to sequence paths” 
check box is irrelevant in this case. 
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• If you are constrained to use default paths or a subdirectory then the 
“Store data in above paths (or subdirectories) in preference to sequence 
paths” check box is always checked and disabled. 

 
Any path typed into the constrained field(s) must be on the default path 
tree.  Entering an invalid path produces an error message when you 
leave the field or click on a button. 

If you click the file folder button associated with a constrained field 
then the displayed dialog box only allows selection of directories in 
your default path tree. 
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5. In the Starting Row text box, you may change the row number with which 
you want to begin the sequence operation. 

This may be an analysis cycle or a user program to be run. 

6. In the Ending Row text box, you may change the sequence row number with 
which you want to end the sequence operation. 

This specifies the last row of the sequence that will be run. If you are using a 
LINK-controlled autosampler, TotalChrom will stop acquiring data at this 
point. If you are using a LINK without a controlled autosampler, or a 900 
Series Interface, you may continue to collect data from runs by using manual 
injections. However, the sample information for all subsequent injections 
will come from this last row, and TotalChrom will build all file names for 
the data from the last row’s file name. 

7. Select Start Run When Ready to start the run as soon as the instrument is 
ready. 

You use this option when you want a LINK-controlled autosampler to begin 
its first injection of the new setup as soon as the instrument reaches the 
Ready state. If the sample vials are not in the autosampler yet, you may issue 
the Start Run command later. 

8. Select Single Run Data Buffering if you do not want to store data from 
multiple runs in the interface. 

If Single Run Data Buffering is not selected, the interface memory will be 
divided into segments large enough to store the data from a single run. This 
enables the interface to acquire data from multiple runs even if the Navigator 
window is closed or the computer is turned off. For more details, refer to 
Appendix A, “How Interfaces Collect Data.” 

9. Select Suppress Processing if you do not want to process the data 
immediately after it is collected. 

This automatically suppresses the data analysis process, including the 
printing of reports and plots, and the creation of a result file. 

You may want to select Suppress Processing if you plan to use your 
computer for another task and do not want to be interrupted by data 
processing at the end of each run. Since data processing is a compute-
intensive task, it can cause your computer to be unresponsive for several 
seconds as the various data analysis functions are carried out. 

If you suppress processing, you can use Batch Reprocessing later to obtain 
results from the analyses. 

10. Select Suppress Reports/Plots if you do not want to print a report and plot. 
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If you do not select this option, TotalChrom will automatically print a report 
and plot at the end of a run. 

12. To run a program after TotalChrom downloads the method to the interface, 
select Run A User Program After Setup. Enter or select the name (including 
the path) of the program you want to run. 

13. If after a run finishes you want the channel reset with a particular method or 
other options, set Post Sequence Options as described in the following 
procedure. 

14. Choose OK in the Setup Instrument dialog box to initialize the instrument. 

 To set Post Sequence Options: 

1. Click on the Post Sequence Options tab in the Setup Instrument dialog box. 

 

2. Select a Post Sequence Action. 

• Selecting Clear Setup will leave the instrument uninitialized at the end 
of the sequence. No other options in the Post Sequence Options tab will 
be available. This is the only action available for a bracketed sequence. 

• Selecting Use Last Active Method From The Sequence will leave the 
instrument set up with the last-used method. No other options in the 
Post Sequence Options tab will be available. 
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• Selecting Set Up With Specified Parameters will enable other options in 
the Post Sequence Options tab. 

• Selecting Use Options from Configuration enables the use of the 
settings defined for the instrument in Configuration 

3. In the Method text box, enter or select the name of the method file to be set 
up when the sequence is completed. 

4. In the Data Path text box, enter or select the path where you want to store 
post sequence data files. 

5. In the Base File Name text box, enter a file name or set a tokenized name by 
clicking the ‘…’ button. 

The default Base File Name is typically set in System Configuration.  
Allowable changes to the contents of these fields (via typing or folder 
button) depend on the permissions set in System Configuration. Your 
application manager may have set up Default base names in System 
Configuration. 

Your application manager may have set up your system to automatically 
append a date/time stamp to all files. 

6. Enter the Starting File Number you want to be appended to the base file 
name for the first post sequence run. 

If necessary, TotalChrom will add leading zeros to your entry to generate the 
three-digit cycle number. For example, the entry 2 will become 002. 

7. Select Single Run Data Buffering if you do not want to store data from 
multiple post sequence runs in the interface. 

If Single Run Data Buffering is not selected, the interface memory will be 
divided into segments large enough to store the data from a single run. This 
enables the interface to acquire data from multiple runs even if the Navigator 
window is closed or the computer is turned off. For more details, refer to 
Appendix A, “How Interfaces Collect Data.” 

8. Select Suppress Processing if you do not want to process the data for post 
sequence runs immediately after they are collected. 

This automatically suppresses the data analysis process, including the 
printing of reports and plots, and the creation of a result file. 

You may want to select Suppress Processing if you plan to use your 
computer for another task and do not want to be interrupted by data 
processing at the end of each run. Since data processing is a computer-
intensive task, it can cause your computer to be unresponsive for several 
seconds as the various data analysis functions are carried out. 
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If you suppress processing, you can use Batch Reprocessing later to obtain 
results from the analyses. 

9. Select Suppress Reports/Plots if you do not want to print a report and plot 
for post sequence runs. 

If you do not select this option, TotalChrom will automatically print a report 
and plot at the end of a run. 

10. Choose OK in the Setup Instrument dialog box to initialize the instrument. 

Using Quick Method 
The Quick Method button in the Setup Instrument dialog box opens a limited version 
of the Method Editor. Use this editor to build a method when you use the Quick Start 
Setup type. You can access only the instrument and processing parameters (except the 
instrument name); you cannot access calibration parameters. The Quick Method name 
is the base file name you enter in the Setup Instrument dialog box (plus the .MTH 
extension). 

For a detailed explanation of the Method Editor commands that are available from 
Setup, refer to Chapters 6 and 7. 

When you use the Quick Method Editor with Quick Start, default values are provided 
for all parameters. You need to alter these values so that they are appropriate for 
your analysis. 

If you set up an instrument using the Method option, you can also use Quick Method 
to modify an existing method. 

 To use the Quick Method editor: 

1. Click the Quick Method button. 

 

The applicable dialog boxes open in succession. 

2.  In each dialog box, select the options and enter values that are appropriate 
for the analysis you are performing and choose OK.  
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When you close the last dialog box, the Quick Method Editor summary 
screen appears showing the principal parameters you set. 

 

3. Choose Save from the File menu to save the new method. 

4. Choose Exit from the File menu to return to the Setup Instrument dialog box 
in the Navigator. 

Although you can switch to other applications when the Quick Method Editor 
window is open, do not try to re-access the Navigator until you close the Quick 
Method editor. 

Building a Vial List 
If you are setting up a LINK-controlled instrument with an autosampler, you must 
specify the samples to be injected by building a vial list through the Setup Instrument 
dialog box. You can build a vial list for any instrument, although it is only required if 
you are using a controlled autosampler. The Vial List button opens a limited version 
of the Sequence Editor. Use this editor to build a sequence when you use the Quick 
Start Setup type or to edit a sequence when you use the Sequence Setup type. 

In addition to entering vial numbers for a LINK-controlled autosampler, you can also 
enter the sample name, number, rack number (if applicable), and injection site (if you 
are using a LINK-controlled GC).  

The limited version of the sequence spreadsheet also has columns for Sample 
Amount, ISTD Amount, Sample Volume, and Dilution Factor. However, these are 
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not used in a normal Quick Start setup because the Quick Method only performs an 
area percent calculation. If you are setting up a standard TotalChrom method, these 
parameters will be used if the method includes calibration information. If an 
instrument has no autosampler and the user does not create a vial list, TotalChrom 
automatically creates a one-row sequence when the user chooses OK in the Setup 
Instrument dialog box.  

The files generated by a vial list include cycle numbers that are appended to the base 
file name. These cycle numbers increase automatically by an increment of one, such 
as TEST001, TEST002, TEST003, etc.  

For a detailed explanation of Sequence Editor commands, refer to Chapter 11, 
“Building a Sequence.” 

 To build a vial list: 

1. Click the Vial List button. 

 

This opens the Vial List and Sequence Information windows.  
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2. If you are using a LINK-controlled LC autosampler, or you want to generate 
a vial list for dual simultaneous injections on the same instrument, choose 
Global Parameters from the Change menu.  

Otherwise continue with step 4. The Global Parameters dialog box opens. 

 

3. If you are using a LINK-controlled LC autosampler, select the tray type 
installed in the autosampler from the Tray drop-down list on the Build 
Parameters tab. 

To generate a vial list for dual simultaneous injections, select Dual as the 
injection type on the Configuration tab and choose OK. 

4. Select the first cell in the Vial column in the spreadsheet. 

5. Enter the vial number for the first sample to be analyzed. 

6. Continue entering vial numbers for each row to be included in the current set 
of runs.  

Add, delete, and move rows as necessary using the commands in the Edit 
menu. 

7. Choose Save from the File menu to save your changes. 

The vial list is saved as a sequence using the base file name you entered in 
the Setup Instrument dialog box plus the .SEQ extension. 

8. Close the Vial List window to return to the Setup Instrument dialog box. 
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Controlling Data Acquisition 
You control data acquisition by using the commands in the Navigator Run menu, 
which appears as both a drop-down menu in the menu bar and as a pop-up menu from 
the Run button. The procedures for using the Run commands are fundamentally the 
same for both menus, but the dialog boxes displayed depend on how you choose the 
command.  

• If you choose the command from the menu bar, you must then select the 
instrument you want to control.  

• If you click the Run button, the command affects the instrument currently 
selected in the Navigator.  

The procedures appearing later in this section to explain specific Run commands 
assume you are using the Run button’s pop-up menu. 

The Run menu includes commands that affect single runs as well as an entire 
sequence. It also includes commands that affect the status of 900 Series Interfaces 
and LINK-controlled instruments.  

You may also control data acquisition from within the Real-Time Plot window. This 
enables you to perform an action while simultaneously viewing the incoming data for 
the instrument you select. For more information on viewing the real-time data, refer 
to “Viewing Real-Time Plots” on page 12-26. 

 To choose a Run command for the active instrument: 

1. Select the instrument from the instrument selection panel in the Navigator. 

2. Click the Run button in the Navigator. 

This displays the Run menu. 

 

3. Choose the Run command you want to use. 

The CMD line in the Status box displays an indication that processing of the 
command is taking place.  
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 To choose a Run command for one or more instruments: 

1. Select the required command from the drop-down Run menu in the 
Navigator.  

A dialog box appears listing the available instruments. The instruments that 
are available depend on which command you selected from the menu. 

You may select multiple instruments from the Primary list only. 

2. Select the instrument(s) to which you want to send the command. 

3. Choose OK. 

The CMD line in the Status box displays an indication that processing of the 
command is taking place.  

Starting Data Acquisition 
The precise action of the Start Run command depends on the instrument 
configuration. You must choose Start Run if you are using a LINK-controlled 
autosampler. This tells the autosampler when to start the injection process for the first 
sample of a sequence. For other configurations, each run can be initiated by a device 
that is external to TotalChrom (such as a standalone autosampler or by pressing the 
chromatograph run button). 

LINK-Controlled Autosamplers 
If you are using a LINK-controlled autosampler, you may want to set up the 
instrument before you have finished preparing the samples and placing them in the 
autosampler. This allows the instrument to equilibrate. If you did not select the option 
Start Run When Ready in the Setup Instrument dialog box, the instrument will remain 
in the Ready state until you choose Start Run.  

Alternatively, if you have everything already prepared, you can check Start Run 
When Ready in the Setup Instrument dialog box, and the Start Run command will be 
issued automatically as soon as all parts of the instrument become ready. 

900 Series Interfaces 
For a 900 Series Interface, the Start Run command causes the interface to begin 
collecting data immediately. Normally, you will only want the interface to begin 
collecting data when a sample has been injected at the chromatograph. Therefore, the 
usual procedure is to use a relay from the chromatograph or autosampler to trigger the 
start input on the 900 Series Interface rather than choose the Start Run command 
from within TotalChrom. 
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LINK-Controlled LC Pump Modules Without Autosamplers 
If you are using a LINK-controlled LC pump module without an associated 
autosampler, the Start Run command will begin the pump program starting with the 
equilibration step. If the pump is off when you choose Start Run, the pump will first 
be turned on. The normal procedure is to inject the sample and press the run button 
on the pump, which will in turn send a message to TotalChrom via the LINK that the 
run has started. 

LINK-Controlled GCs Without Autosamplers 
The Start Run command will begin the GC’s program run starting with the 
equilibration step. Alternatively, if you make an injection at the GC and then press its 
run button, TotalChrom will receive a message via the LINK that the run has started. 

 To start data acquisition for the selected instrument: 

• After you have completed the Setup procedure, click the Run button in the 
Navigator and choose Start Run. 

The immediate effect of choosing Start Run will depend on your instrument 
configuration as described above. 

At this point, you may want to view instrument information in the Details 
window or open the Real-Time Plot window to wait for the run to start (if it 
has not already) and watch TotalChrom plot the data. Refer to “Viewing 
Real-Time Plots” on page 12-26 and “Viewing Data Acquisition 
Information” on page 12-33. 

You may also send the Start Run command to a LINK-controlled instrument 
when it is not ready. It will start as soon as it is ready. 

Stopping a Run 
You can stop data acquisition by choosing the Stop Run command. This command is 
only available when a run is in progress. When you stop a run, TotalChrom retains 
the data that has been collected up to that point, analyzes it, and prints a report and 
plot based on the data collected (unless you suppressed processing or the printing of a 
report and plot). 

 To stop a run for the selected instrument: 

• Click the Run button in the Navigator and choose Stop Run from the pop-up 
menu. 

Canceling a Run 
The Cancel Run command in the Run menu resets the interface to start the run again 
and discards all data collected up to that point. 
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 To cancel a run for the selected instrument: 

• Click the Run button in the Navigator and choose Cancel Run from the pop-
up menu. 

When you cancel a run, the interface (both the 900 Series and LINK) will go to the 
Not Ready state. This allows you to correct whatever problem caused you to cancel 
the run and then restart the instrument. 

To restart an instrument with a LINK-controlled autosampler, simply choose the Start 
Run command. For a LINK-controlled instrument with manual injection, starting the 
next run will automatically restart the instrument and data acquisition. 

To restart an instrument connected to a 900 Series Interface, press and hold the Stop 
button on the front of the interface and press the Start button simultaneously. This 
will set the 900 Series Interface back to the Ready state, and you can start the run in 
the usual way. 

Pausing and Resuming Data Acquisition 
You can temporarily halt a sequence by choosing Pause Sequence in the Run menu. 
Since Pause Sequence stops data acquisition after the current injection cycle, it is 
only effective in a multi-injection sequence. 

 To pause a sequence: 

• Click the Run button in the Navigator and choose Pause Sequence from the 
pop-up menu to halt data acquisition at the end of the current run (if one is in 
progress). 

 To resume a paused sequence: 

1. Click the Run button and choose Resume Sequence. 

The Resume Sequence dialog box appears, showing the name of the 
sequence file in use. 

2. Select Start Next Run When Ready to start the run as soon as the instrument 
is ready. 

Normally, you will want to select this option only if you are using an 
instrument configured with a LINK-controlled autosampler. 

3. In the Starting Row text box, you may enter the row with which you want to 
resume data acquisition. 
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If the sequence includes bracketed calibrations, you will not be able to alter the 
starting row and ending row entries. In order to obtain valid results, a sequence 
of this type must be run in its entirety, without modification. You can pause a 
bracketed calibration sequence, but it can only be resumed from the point at 
which it was paused. 

4. In the Ending Row text box, you may enter the row with which you want to 
end data acquisition. 

5. Choose OK to resume the sequence. 

Clearing the Setup 
You can stop a sequence and clear the setup from the interface or LINK by choosing 
Clear Setup in the Run menu. 

 To clear the setup: 

1. Click the Run button and choose Clear Setup. 

A confirmation dialog box appears. 

2. Choose OK. 

Starting and Stopping the Pump 
If you are using an LC, the Stop Pump command in the Run menu stops the pump. 
The pump will start automatically when you start the instrument. You can also start 
and stop the pump from the Hands On dialog box, which is accessible through the 
Hands On button in the Navigator. Refer to Chapter 13, “Working with Instruments 
Interactively.” 

 To stop the pump on an LC: 

• Choose Stop Pump from the Run menu. 

You can designate how long a pump can remain ready without being used in the 
Pump dialog box in the Method Editor. If it stays idle longer than this Ready 
Time, it will automatically stop. 

Releasing Control of an Instrument 
You can choose the Release Control command in the Run menu to release an 
instrument from TotalChrom control. If you release the instrument during a run, the 
run is canceled. 

In some cases, you can release an instrument from control by TotalChrom to change a 
setting using the instrument’s keyboard, and then re-establish control by TotalChrom. 
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 To release control of an instrument: 

• In the Navigator, click the Run button and choose Release Control from the 
pop-up menu. 

Taking Control of an Instrument 
The Take Control command in the Run menu allows you to take control of an 
instrument if its current status is Released.  

 To take control of an instrument: 

• In the Navigator, click the Run button and choose Take Control from the 
pop-up menu. 

Re-establishing Communication with an Instrument 
TotalChrom can lose communication with an instrument for a variety of reasons, 
including by request. Refer to “Breaking Communication with an Instrument.” The 
Attach command allows you to re-establish communication. 

 To re-establish communication: 

• In the Navigator, click the Run button and choose Attach from the pop-up 
menu. 

TotalChrom attempts to re-establish communication with the instrument. If 
communication is established, the interface status changes from Detached to 
some other state depending on what state it was in previously and what 
caused it to become detached. 

Breaking Communication with an Instrument 
If you want to break communication with an instrument, you use the Detach 
command in the Run menu. There are two principal reasons for breaking 
communication with an instrument: 

• An error has occurred 

• You do not want the Navigator to upload or process data while you perform 
another task  

Choosing Detach prevents TotalChrom from spending time attempting to 
communicate with the instrument. Breaking communications between TotalChrom 
and an interface generally does not interfere with any data acquisition task that the 
interface is performing. The one exception to this is if the interface is being run in 
single-run data buffering mode because the run may produce more data than the 
interface can store. In this situation, breaking communication between TotalChrom 
and the interface will eventually cause an “Overflow” or “Wrapped” error state when 
the interface memory fills up.  
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 To break communication between TotalChrom and an instrument: 

• Click the Run button and choose Detach from the pop-up menu. 

TotalChrom will no longer be able to receive information from, or give 
information to, the selected instrument.  

Instrument Errors 
Failures of communication between TotalChrom and an instrument could possibly 
occur at any time. The two most likely situations when a problem will be detected are 
when you open the Navigator window or when you set up an instrument. 

A list of the errors that have occurred since the Navigator was started is shown in the 
Instrument Errors window. By default, this window is displayed whenever a new 
error occurs (you can change this default from the Instrument Errors pop-up menu). 
You can open the window at any time by choosing Error Messages from the View 
menu. 

A list of all errors that have occurred since the last time the list was cleared is 
maintained in INSTRUMENT ERRORS.LOG in the user's directory 
(Config\Users\<username>) in the TotalChrom path. 

When you set up a sequence, each method specified in the sequence must be checked 
to see if it is valid for the selected instrument. Errors detected during this process are 
saved in a file in the user's directory under the name VERIFY.LOG. The information 
in this file is also displayed in the Setup Problems window so you can quickly see the 
reason the setup failed. You will be unable to complete the setup until you have 
corrected the problems described in the Setup Problems window. 

Using the Instrument Errors Pop-Up Menu 
You can access a pop-up menu in the Instrument Errors window by clicking the right 
mouse button. The menu includes commands to keep a separate log file, print errors, 
delete past errors, and to toggle the display of new errors as they occur. If you do not 
view new errors as they occur, a message in the status bar indicates the number of 
new errors. 
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Viewing Real-Time Plots 
The Real-Time Plot button, and its associated command in the View menu, lets you 
view a real-time plot of the data as it is acquired by an interface for each instrument 
that is performing a run. Each real-time plot appears in its own window in the Real-
Time Plot application. 

As with other features, clicking on the Real-Time Plot button displays the plot for the 
instrument currently selected in the Navigator. Choosing the command from the drop-
down menu opens the Real-Time Plot window, in which you select the instrument 
from a list of those available. This does not change the instrument that is selected in 
the Navigator. 

 To open the Real-Time Plot window: 

• In the Navigator, select the instrument for which you want to view the real-
time plot and click the Real-Time Plot button. 

  OR 

Choose Real-Time Plot from the View menu. 

The Real-Time Plot window opens. 

 

The Real-Time Plot window includes the following menus and commands: 
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Instrument Menu 
Displays a list of instruments currently configured on your system. Choosing Select 
opens the Select Instrument dialog box. 

 

Choosing an instrument name from the Instrument menu or Select Instrument dialog 
box opens another window, which has the instrument name in the title bar. If the 
instrument is set up for dual-channel data acquisition, the window will appear divided 
in two for Channels A and B. If the instrument is currently acquiring data, 
TotalChrom will plot that data; if it is not acquiring data, just the plot axes will 
appear. If the instrument is not set up, the plot window shows the status of the 
instrument. 

Options Menu 
Lets you change the plot scale for the active window by entering new values for the 
X-axis and Y-axis. You can also zoom in on the plot to view the data in more detail. 
If you are using a dual-channel instrument, you can scale the plot for each channel 
independently. 

Run Menu 
Lets you perform some of the same functions as the Run menu in the Navigator. In 
addition, the Start Monitor command lets you view the detector signal without 
starting a true run. The Stop Monitor command stops the monitoring process. 

Details Command 
Opens the Details window, which shows instrument conditions during the run. 
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Viewing Multiple Real-Time Plots 
You can open a window to display the real-time plot for any instrument on your 
system that is currently set up. Each plot appears in its own window. The commands 
in the Options, Run, and Window menus, as well as the Details command, affect only 
the active plot. Clicking in a plot window or choosing one of the instruments from the 
Window menu makes that the active plot; it does not change which instrument is 
selected in the Navigator. 

 To view multiple real-time plots: 

1. Choose an instrument name from the Instrument menu to view the real-time 
plot for that instrument. 

A new window opens in the Real-Time Plot window. 

2. Continue choosing instrument names from the Instrument menu until all the 
real-time plots you want to view are open. 

 To close a real-time plot window: 

• Close the window of the plot you want to close by clicking the close box in 
the upper-right corner of the window. Do not choose Exit from the 
Instrument menu or double-click the Control menu box in the Real-Time 
Plot window. This will close the main window (not the individual plot 
window) and return you to the Navigator. 

Rescaling a Plot 
The Rescale command in the Options menu of the Real-Time Plot window lets you 
change the scaling parameters of the plot while data are being collected.  The initial 
parameters come from the instrument section of the method. Changing the parameters 
in the Rescale dialog box does not change the parameters in the method. 
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 To change the scaling parameters in the real-time plot: 

1. Choose Rescale from the Options menu. 

The Rescale dialog box opens. If you are using a single-channel instrument, 
only the parameters for that channel are available. 

 

2. Under Voltage Axis, enter new values for Offset and Scale if you want to 
change the Y-axis scale of the real-time plot. 

• Offset value — Specifies the voltage corresponding to the bottom of 
the plot window. The default when you open the window is the value 
you set in the Real-Time Plot dialog box in the method. 

• Full-Scale value — Specifies the vertical size of the real-time plot. The 
default when you open the window is the value you set in the Real-Time 
Plot dialog box in the method. 

3. Under Time Axis, define the part of the run you want to view by entering a 
starting and ending time in the Plot From and Plot To text boxes, 
respectively. 

4. In the Number Of Pages text box, enter how many screen widths (“pages”) 
you want the full plot to be displayed across. 

The amount of the plot displayed on each screen page is, therefore, equal to 
the full plot time divided by the number of pages. When the plot has filled a 
screen page, the window is cleared and the next page begins to be plotted. 
To redisplay data from a previous screen page, you can rescale the plot. 
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Zooming In on the Real-Time Plot 
The Zoom In and Zoom Out commands in the Options menu of the Real-Time Plot 
window let you enlarge and reduce the y axis of the real-time plot as the data points 
are being collected. If you are using a dual-channel instrument, you can change the 
views independently for each channel. 

The Zoom In command halves the full-scale value, thereby enlarging the plotted 
peaks. You can enlarge the view up to a full-scale value of 0.01 mV. The Zoom Out 
command doubles the full-scale value, thereby reducing the size of the plotted peaks. 
The Zoom commands do not change the plot offset value or the time axis scale. 

Changing the Plot Origin 
The Autozero command in the Options menu of the Real-Time Plot window changes 
the offset value for Channel A and/or Channel B so that the current data point is 
plotted at 5% above the X-axis. The height of the plot window remains unchanged. 

Do not choose this command while a peak is eluting or the remainder of the peak will 
be clipped at the X-axis. 

 To autozero the plot origin for a real-time plot: 

• Choose Autozero A from the Options menu. 

The plot changes by adjusting the offset so that the current detection signal 
level is visible just above the X-axis. You can choose the command for 
Channel B if you are using a dual-channel instrument. 

Controlling a Run from the Real-Time Plot Window 
The Run menu in the Real-Time Plot window is similar to the one in the Navigator. 
The differences are that this Run menu lets you control a run while viewing the data 
being plotted (for one or more instruments); you cannot take or release control of an 
instrument, but you can use monitor mode to view the detector signal without starting 
a true run. Refer to the next section, “Using Monitor Mode.” 

For specific information on how to use the commands in the Run menu (except Start 
Monitor), refer to “Controlling Data Acquisition” on page 12-19. 

Using Monitor Mode 
The Start Monitor command in the Run menu of the Real-Time Plot window lets you 
view the detector signal coming from an instrument without actually engaging in a 
run. All of the Options commands are available during monitor-mode plotting. 
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 To view the detector signal without starting a run: 

1. Choose Start Monitor from the Run menu. 

The signal from the instrument is plotted on the screen. If you are viewing 
the plot for a 900 Series Interface, the interface switches to sampling mode. 
The initial scaling of the monitor plot uses the real-time plot parameters 
from the active method. 

During monitor mode, the Details window will display the current elapsed 
time as usual, but the plot will not stop when the elapsed time reaches the 
Run Time set in the active method. 

2. Choose Stop Monitor to stop plotting the detector signal and to restore the 
instrument to its previous state. 

Although the data points acquired during monitor mode are not saved in a raw 
data file on disk, they are stored in the interface memory. If the interface memory 
is segmented (set up for multiple runs to be stored), it is possible for the active 
memory segment to fill up during monitor mode. If this occurs, monitor mode 
will stop automatically. 
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Viewing Data and Instrument Information 
The Details button and command in the Navigator open a window that lets you see 
the run information and instrument status for each instrument. The Details menu 
command in the Real-Time Plot window opens the same window. 

The information that appears in the Details window varies depending on the type of 
instrument. TotalChrom updates the information as necessary to reflect the current 
state of the instrument. You can open only one Details window at a time. 

There are three commands in the Details window: 

Select command — Opens the Select Instrument dialog box. 

Next command ⎯ Displays information about the next active instrument. 

Previous command ⎯ Displays information about the previous active instrument. 

Text appearing in black on your screen represents information that is changing 
dynamically as the instrument status changes. Text appearing in gray represents 
information that does not apply to this setup. 

 To view detailed status and run information: 

• In the Navigator, click the Details button to open the Details window for the 
currently selected instrument or choose Details from the View menu. 

  OR 

Choose Details in the Real-Time Plot window. 

The Details window opens, showing the status of the currently selected 
instrument. The contents of the Details screen are different for 900 Series 
Interfaces, LINK-controlled GCs, and LINK-Controlled LCs. 
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Viewing Data Acquisition Information  
The information that appears in the Details window is grouped into several 
categories. The following categories are common to all instrument types. 

Sample Information 

Sample Name ⎯ Name of the sample as specified in the sequence file. For dual 
injection analyses, there will be separate names for Channels A and B. 

Sample Number ⎯ Number of the sample as specified in the sequence file. For dual 
injection analyses, there will be separate numbers for Channels A and B. 

Raw Data File Ch A (Ch B, or both) ⎯ The full name of the current raw data file 
(for each active channel). 

Sequence Information 

Sequence File ⎯ Name and path of the current sequence file. 

Starting Row ⎯ The first row of the sequence that is going to be run.  

Ending Row ⎯ The last row of the sequence to be run. 

Curr Seq Row ⎯ The position of the current run in the sequence. 

Vial — The vial number associated with the current (or next) run. If this is unknown, 
a “-” will appear. For a dual-injection run, the two vial numbers (if known) appear. 

Analysis Information 

Instrument Method ⎯ The name of the current method used for instrument control. 

Run Time ⎯ The total length of time the current cycle is to run. 
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Delay Time ⎯ The amount of time between the start of the run and when data will 
be analyzed. 

Sampling Rate ⎯ The number of data points acquired per second.  

Process Current Run ⎯ Indicates whether the current run will be processed, or 
saved but not processed. 

Interface Information 

Segments Used ⎯ How many runs for which data are backlogged in the interface. 

Segments Free ⎯ Approximately how many runs for which data can still be stored 
in the interface memory. 

Total Runs ⎯ Total number of runs completed for this instrument since the start of 
the initial run. This does not include data in the interface that have not been uploaded 
to TotalChrom. 

Viewing Detailed Instrument Information 
The status boxes of the Details window display information about the state of the 
instrument. Although the Details window for all instruments contains the Current 
status box, the items within this status box vary depending upon the instrument. In 
addition, some status boxes exist only for certain instruments.  

Current 
The following items appear in the Current status box for all instrument types: 

I/F Status ⎯ Status of the interface. This is the same message that appears 
on the I/F line of the Status box in the Navigator. For more information, 
refer to “Understanding Status Messages” on page 12-37. 

Elapsed Time ⎯ The amount of time, in minutes, that the current cycle has 
been running. 

The following item appears in the Current status box only for a 900 Series Interface: 

Ch A/B Voltage ⎯ Current signal level for that channel. 

The following items appear in the Current status box only for a LINK-controlled GC: 

Aux — Current flow/pressure. 

Carr A/B — Current carrier flow/pressure. 

Inj. A/B — Current injector temperature. 

Oven Temp ⎯ Current oven temperature. 

Program Time ⎯ Length of time to run the oven program. 
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The following items appear in the Current status box only for a LINK-controlled LC: 

Flow — Current (actual) pump flow rate in mL/min or µL/min. 

% ABCD — The current percentage of each solvent. 

Pressure — The current pump pressure. A negative value for pump pressure 
indicates that the pump pressure calibration is incorrect. Refer to the 
operator’s manual for your specific pump for information on how to correct 
this problem. 

λA/B — The current monitoring wavelength of the detector (for Channels A 
and B).  

Program (GC only) 
You can select to display a table or a graph of a program in the Program status box.   

The program selections include the oven program and each configured programmable 
zone. While you can display only one program as a table, you can select several 
programs to include in a graph. (The vertical bar in the graph moves to display the 
current elapsed time.) 

Zones (GC only) 
The setpoint (Init Set) for all zones might change during a run if you have set any 
timed events. The column will indicate Ready, Not Ready, Alarm, or N/A. 

Injector Temp 

Init Set ⎯ Setpoint temperatures for injectors A and B. 

Actual ⎯ Current (actual) temperatures of injectors A and B. 

Ready ⎯ Whether or not the injector is ready. 

Detector Temp 

Init Set ⎯ Setpoint temperature for detectors A and B. 

Actual ⎯ Current temperature of the detectors A and B. 

Ready ⎯ Whether or not the temperature zone is ready. 

Carrier Pressure/Flow 

Init Set ⎯The initial carrier setpoint for channels A and B. 

Actual ⎯The current (actual) carrier pressure/flow of channels A and B. 

Units — Units configured for the carrier. 

Ready ⎯Whether or not the carrier zone is ready. 
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Detector Flow 

Init Set ⎯The setpoint detector flow (two flows can be associated with each 
detector). 

Actual ⎯The current (actual) detector flow of detectors A and B. 

Ready ⎯Whether or not the detector flow zone is ready. 

Auxiliary Pressure/Flow 

Init Set ⎯The initial setpoint pressure/flow for auxiliary zones 1 through 4. 
The actual value might differ from the Init value due to timed events. 

Actual ⎯The current (actual) pressure/flow of auxiliary zones 1 through 4. 

Units — Units configured for the carrier. 

Ready ⎯Whether or not the pressure/flow is ready for the auxiliary zones. 

Split Flow 

Init Set — The setpoint displayed as either flow or ratio depending on 
which mode you are using. The actual value might differ from the Init value 
due to timed events. 

Actual ⎯ The current (actual) flow. 

Ready ⎯ Whether or not the split flow zone is ready. 

Pump Program (LC only) 

Time — The duration of the pump program step in minutes. 

Flow — The solvent flow rate during the pump program step in mL/min. 

%A — The percentage of solvent A at the end of the pump program step. 

%B — The percentage of solvent B at the end of the pump program step. 

%C — The percentage of solvent C at the end of the pump program step. 

%D — The percentage of solvent D at the end of the pump program step. 

Curve — The type of curve used for the pump program step. 

Pump Status — Current state of the pump (ON or OFF). 

Pump Time — During a run, the elapsed time into the current pump 
program step. Outside a run, the length of time the pump has been ready 
(equilibrated). 
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Understanding Status Messages 
Use the Status command in the Navigator to view the general status of all instruments 
currently configured on your system. 

 To view the status of all instruments on your system: 

1. In the Navigator, choose Status from the View menu or click the Status 
button. 

The Instrument Status window opens, listing each instrument configured on 
your system, its location, and its current status. 

 

2. To toggle the display of running files, click the right mouse button to access 
the pop-up menu. 

The other columns in the Instrument Status window are as follows: 

Bklg (Backlogged) Runs ⎯ Identifies how many runs have been completed 
for which the data has not been transferred from the interface to 
TotalChrom. 

Seq Row ⎯ The current sequence row number. This is the run in progress 
or, if the instrument is ready, the next run.  

Sample Name — The sample name for the sequence row. 

Bound User — The name of the user to whom the instrument is bound. 

Elapsed Time ⎯ The amount of time, in minutes, that the current cycle has 
been running. 

Prog (Program) Time — The length of time that the instrument program 
will run. 
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 To view the status of the currently selected instrument: 

• The Status box in the Navigator reflects up to six types of information 
depending on the instrument configuration. 

 

First line — The status of the active instrument. 

Second line (ACQ) — The status of data acquisition. 

Third line (I/F) — The status of the active interface. 

Fourth line (CMD) — The run command currently in effect. 

Fifth line — The LINK-controlled instrument status, such as the pump 
status for an LC. 

Sixth line — The status of the LINK-controlled autosampler. 

Lines five and six will not appear for a 900 Series Interface. Line six will not 
appear if there is no LINK-controlled autosampler. 

What the Status Messages Mean 
This information changes continuously as you acquire and analyze data, report the 
results, modify methods and sequences, and perform other actions that affect the 
instrument or interface. 

The color of the text that appears in the Status box changes based on the status of the 
run and the instrument.  

Green — Indicates that the instrument is ready to start a run (acquire data). 

Blue — Indicates that the interface is active (a run is in progress, or the interface is 
uploading data to TotalChrom). 

Red — Shows that the instrument is not ready to collect data because it is not 
connected, it has no method, or it has been paused.  

The following are explanations of the status messages that appear in the Status box. 
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Global Status (Line 1) 

Active — The interface is collecting data from a current run or it is in monitor mode. 

Detached — Not currently communicating with the instrument, possibly due to 
communication errors. 

Initializing — TotalChrom is retrieving initial status information for the instrument. 

In Reconfig — This instrument is reconfiguring such as updating an IPM. 

No Method — The instrument is turned on and connected to the computer but is not 
set up. 

Post-Run — Post-run activity is in progress or a LINK-controlled autosampler is 
cleaning up after the previous injection. 

Pre-Run — A LINK-controlled autosampler is preparing the next injection. 

Ready — The interface is ready to collect data and is waiting for the run to start. 

Seq Done — An automated LINK-controlled analysis is complete. The instrument 
must be initialized again for any future analyses. 

Seq Paused — The user has paused the current sequence by choosing Pause, Modify 
Downloaded Method, or Modify Active Sequence.  

Setting Up — The instrument is being initialized with acquisition information. 

System Re-config — Navigator is carrying out a system reconfiguration. 

User Pgm — A user program from a sequence is running synchronized with 
instrument operation. 

Host Not Found — Navigator could not communicate with the acquisition server for 
this instrument. 

Unknown Inst — The instrument is unknown to the Acquire Client server. 

No License — No license is available for the instrument. 

Not Yet Online — The instrument is being initialized 

Port Comm Error — The Acquire Client server is unable to communicate with the 
port  

Cancelled — The last run on the instrument was cancelled. 

Starting — The instrument is waiting to start a run. 

Ser. Dil. — The instrument is performing a serial dilution (Series 200 LC only). 

Monitor — The instrument is in Monitor mode. 

Not Ready — The instrument is not ready. 
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Acquisition-Related Messages (Line 2) 

Backlogged — Data from one or more completed runs still reside in the interface. 

Monitor — The instrument is running in monitor mode from the Real-Time Plot 
window. 

No Data — No data is available from the interface. 

Other Data — Acquire is collecting other data (e.g. spectra, instrument run log). 

Sampling — A run is in progress and the interface is collecting data. 

Interface-Related Messages (Line 3) 

Canceling — The instrument is in the process of responding to a Cancel Run 
command. 

Injected — A LINK-controlled autosampler has made an injection and TotalChrom 
is waiting to receive the first data points from the run. This can occur when a slow 
sampling rate (a few points per second) is used. 

Inst NRDY — The instrument is not yet ready to perform the run because it is not 
equilibrated at the set conditions. 

Monitor — The instrument is running in monitor mode from the Real-Time Plot 
window. 

Not Ready — The interface is not ready to accept data. 

Other Data — Acquire is collecting other data (e.g. spectra, instrument run log) 

Overflow — The run has produced more data than the interface can store. This can 
only occur if the interface has been set up in single-run data buffering and the 
interface is detached or if the Navigator is closed during data collection. TotalChrom 
will automatically stop the run when this occurs. 

Ovrflw Wrp — A combination of the two previous situations. This can occur if the 
Navigator is closed while the interface is in the Wrapped state. 

Pre-Run — A LINK-controlled autosampler is preparing the next injection. 

Post-Run — A LINK-controlled autosampler is cleaning up after the previous 
injection. 

Ready — The interface is ready to collect data and is waiting for the run to start. 

Released — TotalChrom does not have control of the instrument. 

Sampling — A run is in progress and the interface is collecting data. 

Ser. Dil — The instrument is performing a serial dilution (200 Series LC only) 
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Started — A Start Run command has been given but the run has not yet started. This 
will occur if the Start Run command is given before a LINK-controlled instrument is 
ready. 

Wrapped — The run has produced more data than the interface can store. Some data 
have already been uploaded from the interface and TotalChrom is using that part of 
memory to store new data. This can only occur when the interface has been set up in 
single-run data buffering and the Navigator is open. No data is lost in this situation 
and the run can continue. 

Command Messages (Line 4) 

None — No command is currently being processed. 

Attaching — TotalChrom is attaching to the instrument. 

Detaching — TotalChrom is detaching the instrument. 

Seizing — The instrument is being seized for control by TotalChrom (Links only). 

Releasing — The instrument is being released from control by TotalChrom (Links 
only). 

Setting Up — The instrument is setting up. 

Pausing — The current sequence is being paused. 

Unpausing — The current sequence is being unpaused at current row. 

Resuming — The current sequence is being resumed from the specified row. 

Clearing Setup — The current setup is being cleared. 

Starting Run — A run is starting on the instrument. 

Cancelling Run — The current run is being canceled and the data is being discarded. 

Stopping Run — The current run is stopping and the data is being saved. 

Starting Monitor — The instrument is starting in monitor mode.  

Stopping Monitor — Monitor mode is stopping on the instrument. 

Stopping Pump — The pump is being stopped (LC only). 

Binding — The instrument is being bound to the user. 

Unbinding — The instrument is being unbound from a user. 
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Instrument Messages (Line 5) 
This line displays the status of LINK-controlled GC’s or of the pump for LINK-
controlled LC systems. 

For a LINK-Controlled GC: 

Equil — The GC is equilibrating. 

Hold — The GC temperature program is in a hold state. 

Not Ready — The GC is not ready. 

Off — The GC is off. 

Oven Off — The GC oven is off. 

Pre-Run — The GC is executing the pre-run events. 

Run — The GC run is in progress. 

Ready — The GC is ready. 

During the oven temperature program, the current program step appears. 
These are: Initial (temp), Ramp 1, Hold 1, Ramp 2, Hold 2, Ramp 3, Hold 3, 
Cool. 

For a LINK-Controlled LC: 

Equil — The pump is equilibrating. 

Hold — The pump is in a Hold state. 

During the solvent gradient program, the current step number appears.  

Not Ready — The pump is not ready. 

Off — The pump is off. 

Pmin — The pump has shut down because it did not exceed the Pmin value 
set in the method. 

Pmax — The pump has shut down because it exceeded the Pmax value set 
in the method. 

Ready — The pump has finished equilibrating. 

Startup — The pump is starting and has not yet exceeded the Pmin value 
set in the method. 
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Autosampler Messages (Line 6) 
This line displays the status of an autosampler. 

For a LINK-Controlled GC Autosampler: 

Clean — The autosampler is performing a cleaning cycle. 

Priority — The autosampler is running a priority vial. 

Ready — The autosampler is ready. 

RUN — The GC run is in progress. 

Sampling — The autosampler is performing its sampling procedure. 

For a LINK-Controlled LC Autosampler: 

Adjust — The autosampler is adjusting the position of the needle in the 
valve. 

Decode — The autosampler is decoding the current tray number. 

Flush — The autosampler is performing a flush cycle. 

No Vial — There is no vial at the requested sampling position. 

Not Ready — The autosampler is not ready. 

Off — The autosampler is off. 

Ready — The autosampler is ready. 

Sampling — The autosampler is withdrawing a sample from a vial 
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Chapter 13 
Working with Instruments 

Interactively 
 

This chapter explains how to use the Hands On and Modify functions in TotalChrom 
to work interactively with instruments before, during, or after a run. 

To learn about: Go to page: 

Using Hands On..............................................................................................13-2 

Setting Relays for a 900 Series Interface ........................................................13-3 

Setting Zone Setpoints and Valves for a GC ..................................................13-5 

Setting LC Parameters ....................................................................................13-5 

Modifying a Downloaded Method................................................................13-13 

Modifying a Sequence During a Run............................................................13-16 

785 Detector Wavelength Calibration...........................................................13-19 
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Using Hands On 
The Hands On button and Hands On command in the Instrument menu let you control 
certain instrument settings after you have set up an instrument.  The actual parameters 
available depend on the type of instrument that is selected and whether or not a run is 
in progress. The Hands On button and command are not available until you set up 
and bind an instrument. 

As with most other functions in TotalChrom, clicking the Hands On button in the 
Navigator opens the dialog box for the instrument that is currently selected in the 
instrument selection panel. In contrast, selecting the Hands On command from the 
menu bar lets you select the instrument to which it applies afterwards. 

The changes made to the Hands On dialog boxes during a run are NOT made to the 
method stored in the raw file. 

The icon that appears in the Hands On button in the Navigator changes based on the 
instrument that is selected. The first icon shown below represents a 900 Series 
Interface. The second icon represents a LINK-controlled gas chromatograph, and the 
third icon (showing a schematic drawing of a pump) represents a LINK-controlled 
liquid chromatograph. 
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Setting Relays for a 900 Series Interface 
With a 900 Series Interface, the Hands On dialog box contains a series of relay 
options, which you can turn on or off. It also has an option to read the rack and/or 
vial number from an autosampler if one is attached. You may access Hands On for a 
900 Series Interface when it is in the Ready state. 

 To change relay settings for a 900 Series Interface: 

1. Select the interface in the Instrument panel, then click the Hands On button 
in the Navigator. 

 OR 

Choose Hands On from the Instrument menu, then select the interface. 

The Interface Hands On dialog box appears showing the current relay 
settings. When you first set up a method, all relays are set to OFF as the 
default setting. 

 

When the Interface Hands On dialog box appears, the status message for the 
interface will change from Ready to NRDY (Not Ready) in the Status box in 
the Navigator. It will change back to Ready when you close the dialog box. 

2. Select the relays you want to turn on by clicking the ON buttons. 

3. Choose Set Relays to implement the settings. 

4. Choose Close if you do not need to read rack and/or vial numbers. 

You must choose Set Relays before choosing Close in order to change 
settings. 
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 To read rack and/or vial numbers from an autosampler: 

• Choose Read RVP to have TotalChrom read the rack and vial numbers. 

This command tests the connection to the autosampler only. The rack and/or 
vial numbers that appear in the dialog box are not stored. 
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Setting Zone Setpoints and Valves for a GC 
If you are controlling a gas chromatograph, you can set the oven temperature, 
autozero the detector, and turn valves (or relays) on and off. The instrument type and 
its current run status determine which Hands On parameters are accessible. 

 To set controls for a gas chromatograph: 

1. Select the GC in the Instrument panel, then click the Hands On button in the 
Navigator. 

 OR 

Choose Hands On from the Instrument menu, then select the GC. 

The GC Hands On dialog box appears, showing the current zone setpoints 
and valve settings. 

 

2. In the Zones Setpoints text boxes, enter the temperature and flow setpoints 
for this GC, and choose Set Zones to implement the settings. 

3. Choose Autozero, if desired. 

4. In the Valves area of the dialog box, select the valves you want to switch by 
clicking the ON or OFF button as appropriate, and choose Set Valves to 
implement the settings. 
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5. Choose Close. 

You must choose Set Zones, Set Valves, or Autozero before choosing Close 
in order to change settings. 
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Setting LC Parameters 
If you are using a LINK-controlled LC system, the Hands On command enables you 
to change a variety of instrument parameters for the different modules. Most of these 
settings are only available when a run is not in progress. 

LC Hands On is available after the LC instrument is set up and the hardware  
(e.g., pump, autosampler, and detector) is ready for pre-run startup.  For example, 
purging the pump, autozero (A/Z) the detector and flushing the autosampler.  

LC Hands On is not available during the actual run (analysis) and it is disabled at 
the end of a running sequence. 

 To set parameters for an LC: 

1. Select the LC in the Instrument panel, then click the Hands On button in the 
Navigator. 

  OR 

Choose Hands On from the Instrument menu, then select the LC. 

The LC Hands On dialog box appears. The tabs and settings available 
depend on the type of equipment you are using. Each tab is described 
separately below. 



Setting LC Parameters 

13-8  

Pump Actions 
You can control pump actions from the Pump tab in the LC Hands On dialog box. You 
can change any of the available values, then activate them by choosing Set Pump. You 
can start and stop the pump at any time with the Start Pump/Stop Pump command. 

The LC Hands On pump parameters displayed are the previous runs’ settings (the 
composition currently in the column). They are displayed until a new run is started, 
then the new runs’ parameters are displayed. 

 

 To perform pump actions: 

1. To change the flow, enter a different value in the New text box. 

The current pressure appears below the flow rate. 

2 To change the solvent composition, enter new percentages for solvents A, B, 
or C. 

Only solvent A will be available for a binary solvent pump. 

By changing the solvent composition in Hands On, you are modifying step 0 of 
the solvent program directly at the pump. If you want the pump to return to the 
active method conditions when you exit Hands On, you must repeat the Setup 
procedure. 

3. To change program settings, select one of the following options. 

Continue — Resumes the solvent gradient from hold. 

Hold — Holds the solvent composition at the current state. 

Advance — Advances the solvent program to the next step. 

Reset — Resets the solvent composition to the initial conditions. 
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The Program options are only available if you have a 200Q/410 pump 
configured for the instrument. 

4. To close one or more relay(s) for two seconds, make the appropriate 
selection(s) under Active Relays.  

E1 and E2 are not available for all instruments. 

5. To activate new pump parameters, choose Set Pump. 

6. To start/stop the pump, choose Start Pump/Stop Pump. 

Purging a Pump 
You can purge an LC system pump remotely from the Purge tab in the LC Hands On 
dialog box. You can change the setpoint, then activate it by choosing Set Pump. You 
can start and stop the pump at any time with the Start Pump/Stop Pump command. 

 

The information on the right side of the tab reflects current pump conditions, 
including the purge flow rate and the solvents being used. 

 To purge a pump: 

1. To change the purge flow rate and/or the purge solvent being used, select the 
solvent option you want to use and enter a value in the Flow text box. 

The Current Method option purges the pump using the solvent composition 
specified in the equilibration step of the active method. 

2. To activate new pump conditions, choose Set Pump. 

As the flow rate and solvent percentage change, the results are reflected on 
the right side of the dialog box. 

3. To start/stop the pump, choose Start Pump/Stop Pump. 
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Detector Actions 
The Detector tab of the LC Hands On dialog box varies depending on which detector 
you are using. 

Autozero is available during a non-spectral collecting run on the Series 200 DAD.  
However, if you autozero during data collection, the data collection pauses resulting 
in a retention time shift of later eluting peaks. 

 To perform detector actions: 

You can change the wavelength, then activate it by choosing Set Detector. You 
can use the Lamp and Autozero commands at any time. 

 

1. To change the wavelength to be monitored for Channel A and/or B, enter 
new values in the New text boxes next to Wavelength A and/or Wavelength 
B then choose Set Detector. 

The Absorbance fields for Channels A and B show you the detector output 
at the current wavelength. 

2. To turn the D2 (deuterium) or W (tungsten) detector lamp off/on, choose the 
corresponding command. 

3. To set the detector signal back to zero, choose Autozero. 
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 To perform 785 detector actions: 

 

• To set the detector signal back to zero, choose Autozero. 

Autosampler Actions 
The following is the Autosampler tab of the LC Hands On dialog box. You can use 
the Flush Autosampler command at any time. 

For an autosampler equipped with a Peltier tray, you can change the temperature, then 
activate it by choosing Set Temp. You can enable/disable the Peltier tray at any time 
with the Turn Peltier On/Turn Peltier Off command. 
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 To perform autosampler actions: 

1. To have the autosampler perform a flush cycle, choose Flush Autosampler. 

2. To have the autosampler reset the sampling needle to the correct position 
when a sample is introduced into the sampling valve, choose Adjust Needle. 

3. To change the temperature of a Peltier tray, enter a different value in the 
New text box then choose Set Temp to activate the setting. 

4. To enable/disable Peltier tray temperature control, choose Turn Peltier 
On/Turn Peltier Off. 
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Modifying a Downloaded Method 
The Modify/Downloaded Method command in the TotalChrom Navigator lets you 
change method parameters in any method that has been downloaded as part of the 
setup. The Downloaded Method command is available from the Modify button and 
from the Instrument menu once you set up and bind an instrument. 

 

Clicking the Modify button, or choosing the Modify command from the Instrument 
menu, displays a pop-up menu with two commands: Downloaded Method and Active 
Sequence. See page 13-16 for information on modifying an active sequence. 

If you have multiple instruments set up and bound, Modify/Downloaded Method 
works like other functions in TotalChrom: the button applies to the instrument 
currently selected in the Navigator. Choosing the command from the menu lets you 
select which instrument you want to use afterward. 

When a single method has been downloaded, it is by definition the active method — 
the one that is being used in the current run — and the Method Editor opens when 
you choose the Downloaded Method command. When multiple methods have been 
downloaded, TotalChrom lists them for you to select from when you choose the 
command. One will be identified as the active method. 

For LC instruments, you do not have the option to modify the active method, only 
subsequent runs that use the same method. 

For GC instruments, if you change the mode during a current run (e.g., from Flow to 
Velocity) it will not change the GC until the next run. 

The commands and options available in the Method Editor depend on the type of 
instrument you are using and whether the method is active or not. When you modify 
the active method, the term Modify Active is displayed in the title bar of the Method 
Editor. 

When you modify a method that is not active, you can modify any parameter except 
the instrument name. When you modify the active method, the instrument parameters 
that you can modify are limited to those that can be downloaded during a run. 

When you finish editing the method, TotalChrom downloads it to the interface so that 
the modified version will be present during the run in which the method is used. 
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 To modify a downloaded method: 

1. If the instrument is not bound, choose Bind from the Instrument menu then 
select the instrument that you want to bind. 

2. Select the instrument in the Instrument panel, then click the Modify button 
in the Navigator and choose Downloaded Method. 

  OR 

Choose Modify/Downloaded Method from the Instrument menu, then select 
the instrument. 

3. If the setup contains more than one method, select the one you want to 
modify from the list and choose OK. 

The method is displayed in the Method Editor window. If it is the active 
method, the term Modify Active is displayed in the title bar of the window. 
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Although you can switch to other applications when you are modifying a downloaded 
method, you cannot re-access the Navigator until you close the Modify Active/Method 
Editor window. 

4. In the Method Editor, choose from the Instrument, Process, and Components 
menus to modify the parameters associated with those menus. 

5. Save your changes after modifying the method. 

Notice that the Save As command is not available because you cannot save 
the changes as a new method. 

6. Close the Method Editor window to return to the Navigator. 

The Status box will display different messages, based on the instrument you 
are using. While are you modifying the method, the instrument state will be 
“Paused.” 
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Modifying a Sequence During a Run 
The Modify/Active Sequence command in the Navigator lets you change sequence 
information while a run is in progress. The Active Sequence command is available 
from the Modify button and from the Instrument menu once you set up and bind an 
instrument. 

Modify/Active Sequence pauses the current sequence and opens a limited version of 
the Sequence Editor. TotalChrom does not resume the sequence until after you have 
finished editing it. 

If you have multiple instruments set up and bound, Modify/Active Sequence works 
like other functions in TotalChrom: the button applies to the instrument currently 
selected in the Navigator. Choosing the command from the menu lets you select 
which instrument you want to use afterward. 

If you change the sequence either before or after a run, the interface will change to 
Not Ready until you finish editing the sequence. You can edit the rows representing 
future or past runs and append or insert as many rows as you wish. Changes affect 
only future injections. 

Because you can modify completed rows, you cannot use the sequence file as 
documentation for a series of runs. Only the index file represents a true picture of 
what occurred during a sequence run. 

The Modify/Active Sequence command is not available if the setup sequence 
includes bracketed calibrations. To ensure that you obtain valid results, you need to 
run a sequence of this type in its entirety, without modifications. 

 To modify the active sequence: 

1. If the instrument is not bound, choose Bind from the Instrument menu then 
select the instrument that you want to bind. 

2. Select the instrument in the Instrument panel, then click the Modify button 
in the Navigator and choose Active Sequence. 

  OR 

Choose Modify/Active Sequence from the Instrument menu, then select the 
instrument. 
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The Sequence Editor window opens. The sequence file name appears in the 
title bar, and the instrument name appears in the status bar. 

 

Although you can switch to other applications when you are modifying a 
sequence, you cannot re-access the Navigator until you close the Sequence 
Editor window. 

3. Edit the sequence as necessary. 

For information on Sequence Editor commands, refer to Chapter 11. 

4. Choose Save from the File menu to save your changes. 

These will be applied to the runs that have not yet been executed. 

5. Close the Sequence Editor window to return to the Navigator. 

The Resume Sequence dialog box appears. 

 

6. Select Start Next Run When Ready if you want to start the run as soon as the 
instrument is ready. 
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Normally, you will want to select this option only if you are using an 
instrument configured with a LINK-controlled autosampler. 

7. Change the Starting Row and Ending Row numbers if they are not correct. 

The default starting row will be the first row that has not yet been run. The 
default ending row will be the ending row originally specified in the Setup 
dialog box. If you have added rows to the sequence, you must update the 
ending row number to include those rows in the run. 

8. Choose OK. 

The messages that appear in the Status box of the Navigator reflect the 
changing instrument status as the new sequence information is downloaded 
and implemented for subsequent runs. 
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785 Detector Wavelength Calibration 
You must periodically perform a wavelength calibration procedure before you set up 
a 785 detector for data acquisition. 

A holmium oxide filter must be installed for the wavelength calibration process. 

 To check wavelength calibration: 

1. Choose Bind from the Instrument menu, then select the instrument that you 
want to bind. 

2. Choose Wavelength Calibration from the Navigator Instrument menu to 
open the Wavelength Calibration dialog box. 

 

3. Choose Start to initiate the calibration process. 

The progress of the calibration is shown below the instrument name, and a 
plot of the sample data is drawn in the bottom half of the screen. When the 
calibration is complete, TotalChrom prints a plot of the sample data. 

4. Choose Close. 

Remove the holmium oxide filter before beginning data acquisition. 
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Chapter 14 
Displaying Chromatograms 

 

This chapter explains how to use the Chromatograms application in TotalChrom. A 
chromatogram, or plot, is the graphical representation of chromatographic data that is 
displayed when you use this application. The terms chromatogram and plot are used 
interchangeably throughout this guide. 

To learn about: Go to page: 

Using the Chromatograms Application...........................................................14-2 

Controlling the Appearance of Chromatogram Windows...............................14-7 

Displaying Information in Chromatograms ..................................................14-11 

Adding and Editing Chromatogram Labels ..................................................14-16 

Aligning Peaks in Two Chromatograms .......................................................14-20 

Calculating a New Chromatogram................................................................14-28 
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Using the Chromatograms Application 
The Chromatograms application allows you to display and examine multiple raw and 
result data files at one time. After you display the chromatograms, you can perform 
the following functions to analyze and compare the results of this data. 

• Print a copy of the chromatogram or file summary data on the selected data files. 

• Copy a chromatogram to the clipboard for use in another application. 

• Stack, cascade, or tile open chromatogram files. 

• Compare two or more chromatograms by overlaying them in the same window. 

• Expand, or zoom, selected parts of a single chromatogram and expand two or 
more chromatograms simultaneously. 

• Change the low and high voltage values. 

• Show or hide various features such as title bars, axis labels, coordinates, 
component names, and peak retention times. 

• Add time labels and create custom labels. 

• Align the chromatograms in a variety of ways to eliminate the effects of small 
differences in chromatographic conditions. 

• Create a new raw data file by performing a mathematical calculation on two 
existing files. 

 To open the Chromatograms application: 

1. In the Navigator, choose Chromatograms from the Display menu or choose 
the Chromatograms button. 

 

2. In the Chromatograms window, choose Open from the File menu, select the 
files you want to work with, then choose Open. 

 To close one chromatogram: 

1. In the Chromatograms window, select the chromatogram that you want to 
close.  

2. Choose Close from the File menu or click the Close box on the 
chromatogram window. 
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 To close all chromatograms: 

• Choose Close All from the File menu. 

 To close the Chromatograms application: 

• Choose Exit from the File menu or click the Close box. 

Menus and Commands 
The Chromatograms application includes the following menus and commands. 

File Menu 
Allows you to open, replace, close, save, print, and copy one or more chromatograms 
for use in other applications. This menu also provides access to the most recently 
used raw and result files. It allows you to exit the Chromatograms program and return 
to the Navigator. 

Operation Menu 
Lets you create a new chromatogram by performing a mathematical calculation on 
two existing chromatograms. You can then edit the way that the new chromatogram 
is generated. 

Options Menu 
Lets you change the scale of one or more chromatograms; create a 3-D view of 
chromatograms in overlaid mode; expand all chromatograms simultaneously by 
expanding one; and show or hide mouse coordinates, title bars, axis labels, baselines, 
component names, and retention times. 

Window Menu 
Allows you to automatically size displayed chromatograms; overlay two or more 
chromatograms; stack, cascade, and tile open windows; and arrange icons. 

View Menu 
Allows you to switch from window to window. 

Status Bar 
At the bottom of the window, the status bar displays the file name and path of the 
active chromatogram, the starting and ending times of the run, and the offset and 
scale. You can substitute the X and Y coordinates of the mouse cursor for Start and 
End times if you choose Show Coordinates from the Options menu.  
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Using the Chromatogram Pop-up Menu 
After you open one or more chromatogram files, you can access additional commands 
by clicking the right mouse button in any chromatogram. 

The Chromatogram pop-up menu lets you add labels to chromatograms and perform 
other tasks. Your access to pop-up menu commands will vary depending on the type 
of file you have open and the way in which chromatograms appear.  

Command:  Action: 

Undo Reverses a previous scaling or alignment action. 

Set Chromatogram Pen Sets the width, style, and color of the plot lines. 

Set Background Color Sets the background color of a chromatogram. 

Add Label Adds labels to chromatograms. 

Set Start Time Allows you to set markers for the starting time of 
peaks in chromatograms. 

Set End Time Allows you to set markers for the ending time of peaks 
in chromatograms.  

Set Low Voltage Allows you to set low voltage values in 
chromatograms. 

Set High Voltage Allows you to set the high voltage in chromatograms. 

Shift Time Allows you to shift the time period that you have 
configured in chromatograms. 

Shift Voltage Allows you to shift the voltage range that you have 
configured in chromatograms. 

Scale Time From Origin Changes the time scale such that the end times in two 
chromatograms match each other. 

Scale Voltage From 
Origin 

Changes the voltage scale such that the end voltages in 
two chromatograms match each other. 

Scale Time Changes the time scale of a target chromatogram to 
align the start and end times with a reference plot. 

Scale Voltage Changes the voltage scale of a target chromatogram to 
align low and high points with a reference plot. 

Clear Removes all starting and ending times and low and 
high voltage values added to a chromatogram. This 
command applies to one chromatogram at a time.  
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Opening Chromatogram Files 
You can open multiple raw and result data files during the same session by using the 
Open command on the File menu. 

A raw data file is always necessary to plot a chromatogram because that is where the 
data points are stored. When you open a result file, TotalChrom uses the associated 
raw data file to plot the chromatogram. Result files enable you to display peak 
baselines, peak retention times, and component names. 

When you open files, TotalChrom displays each chromatogram in the colors that are 
specified in Configuration. Each file will open in its own window. 

 To open one or more files: 

1. Choose Open from the File menu. 

2. To open raw data files, select the files that you want to open in the Multiple 
File Open dialog box, then choose Open. 

3. To open individual result files, select Result Files (*.rst) in the Files Of Type 
list, select the files that you want to work with, and choose Open. 

Replacing a File With Another File 
The Replace command lets you replace an open file with another file. The new file 
assumes the same scaling and position in the window as the file that you replace. 
Replacing files can be helpful if you want to compare a series of files against a 
standard file. 

 To replace one file with another: 

1. Select the file that you want to replace.  

2. Choose Replace from the File menu. 

3. In the File Open dialog box, select the file that you want to open in place of 
the current file. 

4. Choose Open. 
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Printing Chromatograms and Their Scaling Information 
The Print command lets you print a copy of the chromatograms for all open files. 
Chromatograms will be printed in stack mode. You can choose whether a summary of 
the start time, end time, and the low voltage and high voltage values for each 
chromatogram is printed. 

 To print an overlay view: 

1. Select the Overlay View window before you choose the Print command. 

2. Choose Print from the File menu. 

 

3. Select Print overlay in the Print dialog box and choose OK. 
Only the contents of this overlay window will be printed. 

Using Images in Other Applications 
The Copy To Clipboard command on the File menu allows you to copy a 
chromatogram and its scaling information for use in any Windows application that 
accepts black and white or color bitmapped files. 

 To copy a chromatogram to the clipboard: 

1. Select the chromatogram that you want to copy.  

2. Choose either Copy To Clipboard/B/W or Copy To Clipboard/Color from 
the File menu. 
You can then paste the image into any Windows application that accepts 
black and white or color bitmapped files. 

The Save As MetaFile command in the File menu lets you copy an image of the 
screen to a Windows metafile. 

 To save the current chromatogram as a Windows metafile: 

• Choose Save As MetaFile from the File menu, then name the file. 
The image in the file will be a color image. 
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Controlling the Appearance of Chromatogram Windows 
Because you can have multiple chromatograms open at the same time, you might 
want to change the way in which they appear in the Chromatograms window. 

Stacking, Cascading, and Tiling Chromatograms 
You use the following commands on the Window menu to control how 
chromatograms appear on your screen.  

Stack —  Stacks chromatograms horizontally across the window. Each window is 
displayed at the full screen width, but you can view a limited number of 
chromatograms at a time depending on the resolution of your monitor. TotalChrom 
automatically sets the appearance to Stack when you open 11 or more files in a single 
operation. 

Cascade — Arranges the windows so that they cascade from the upper-left to the 
lower-right corner of the screen. 

Tile Horizontally — Displays windows horizontally across the screen. The first three 
files will appear at full-screen width as in stacked mode. If you have more than three 
files open, TotalChrom will divide the screen into two or more columns, always 
making the X-axis longer than or equal to the Y-axis. 

Tile Vertically — Displays up to three chromatograms at full window height, side by 
side. If more than three files are open, the window is divided into two or more rows 
of equal width, which makes the Y-axis longer than or equal to the X-axis. 

Automatically Sizing Chromatograms 
The Auto Size command on the Window menu automatically resizes each window 
when you change the size of the Chromatograms window or when you open or close 
a new file. The Auto Size command functions as a toggle that you turn on or off: it is 
selected by default and has a check mark next to it. 

If you deselect Auto Size, the individual windows do not change when you enlarge or 
reduce the Chromatograms window. If you open a new file with Auto Size off, the 
new window will appear on top of the existing windows instead of being stacked, 
tiled, or cascaded. 

Displaying Chromatograms in Overlay View 
When you choose the Overlay command on the Window menu, two or more open 
chromatogram files will appear in the same window. Overlaying chromatograms 
enables you to compare their similarities and differences. Because overlaid 
chromatograms use the same set of axes, you distinguish them by their colors, which 
you control through the Configuration function in the Navigator.  
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In the overlay window, one chromatogram will appear in front of the others: you can 
change the chromatogram that appears in front by selecting the window that you want 
to be the topmost, or active, chromatogram in the overlay window. 

The topmost, active chromatogram determines which axis labels appear. If you select 
Show Baselines, Show Retention Times, or Show Components from the Options 
menu (when you open one or more result files), the retention times that appear will be 
those for the topmost chromatogram. 

The Overlay command functions as a toggle: when you select it, a check mark will 
appear next to it and all open chromatograms will appear in a new window. All single 
plots will remain open, and the chromatogram that was selected when you chose 
Overlay will be topmost in the overlay window. If you open another file after you 
select Overlay, that file will appear both in its own window and in the overlay 
window. 

 To overlay chromatograms: 

• Open the chromatogram files that you want to overlay and choose Overlay 
from the Window menu.  

 

Viewing Chromatograms Three Dimensionally 
The 3-D Preview command on the Options menu lets you create a three-dimensional 
effect in an overlay window by rotating and elevating chromatograms. Viewing 
overlaid chromatograms three dimensionally makes them visually more distinct and 
can enable you to better evaluate the differences between two or more similar plots.  
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The 3-D Preview command is available only for an overlay window. 

 To change the rotation and elevation of chromatograms in overlay mode: 

1. Choose Overlay on the Window menu. 

2. Choose 3-D Preview on the Options menu.  

• The chromatogram that is displayed in the 3-D Preview dialog box is an 
example and does not duplicate the overlaid chromatograms. However, 
the overlay will reflect your three-dimensional changes after you close 
the 3-D Preview dialog box. 

 

3.  Move the slider under Rotate Around The X-Axis to change the amount by 
which the chromatograms are shifted to the right from each other.  
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4. Move the slider under Rotate Around the Y-Axis to change the degree of 
rotation for the chromatograms.  

The image in the dialog box changes concurrently. You can shift all 
chromatograms up to 45 degrees.  

 

5. When the 3-D effect suits your needs, choose OK. 

If you want to cancel the changes you have made, choose Reset. 

If you want to remove all rotation, choose Default. 

Hidden Lines 
The Suppress ‘Hidden Lines’ check box in the 3-D Preview dialog box lets you view 
a 3-D overlay with either the topmost plot covering other plots or with all plots 
equally visible. The effect will appear both onscreen and in printed output. 

Select this check box to make the most recently opened plot opaque. Only other plot 
lines’ areas that are outside the frontmost plot’s area are visible. 

Deselect this check box to make the most recently opened plot transparent so that all 
areas of all plots in the overlay window are visible. 
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Displaying Information in Chromatograms 
The following commands on the Options menu allow you to control what types of 
information appear in each window. Instructions for using these commands follow 
this list. 

Command: Action 

Rescale Lets you change the start time, end time, offset, and full 
scale by a specific amount for multiple files at one time 
instead of by changing them individually within each 
window.  

Expand All Plots Expands the display of individual chromatograms or 
expands all chromatograms simultaneously by the same 
amount.  

Show Coordinates Shows and hides the coordinates of the cursor in the 
active chromatogram. This command does not apply to 
overlaid chromatograms.  

Show Title Bars  Shows and hides the title bars of all open 
chromatograms.  

Show Axes Shows and hides the X and Y axes coordinates of all 
open chromatograms.  

Show Baselines For result files, displays and hides the baselines for each 
chromatogram.  

Show Components  For result files, displays and hides the component names 
for each chromatogram.  

Show Retention Times For result files, displays and hides the peak retention 
times for each chromatogram.  

Expanding Chromatograms 
You can expand, or zoom, the display of individual chromatograms or expand all 
chromatograms simultaneously by the same amount by using the Expand All Plots 
command on the Options menu. This command works whether your windows are 
cascaded, stacked, or tiled. TotalChrom does not save expansions when you exit the 
application. You can also use the Rescale command on the Options menu to change 
the scaling factor and plot offset. Refer to “Rescaling Chromatogram Values” on 
page 14-13. 
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 To expand an individual chromatogram: 

1. If more than one chromatogram is open in the Chromatograms window, 
deselect Expand All Plots on the Options menu. 

2. Highlight the part of the chromatogram that you want to expand. 

TotalChrom redraws the chromatogram at the expanded scale. 

3. If you want to further expand the chromatogram, repeat step 2. 

 To expand all open chromatograms: 

1. Select Expand All Plots on the Options menu. This command functions as a 
toggle: it is selected by default and has a check mark next to it.  

2. Select an area to expand in one of the chromatograms. 

When you release the mouse button, TotalChrom expands all open 
chromatograms. 

3. Repeat step 2 to further expand all chromatograms. 

 To return a chromatogram to its previous level of expansion: 

1. To reduce only one chromatogram, deselect Expand All Plots on the Options 
menu.  

2. Click the right mouse button anywhere in the chromatogram that you want to 
return to a previous level of expansion. 

3. Choose Undo on the Chromatogram pop-up menu. 

4. Right-click and then choose Undo as many times as needed to further reduce 
the expansion. 

When you can no longer reduce the expansion, the Undo command becomes 
disabled. 

 To return multiple chromatograms to their previous level of expansion: 

1. Select Expand All Plots on the Options menu.  

2. Click the right mouse button in any open chromatogram. 

3. Choose Undo on the Chromatogram pop-up menu. 

4. Right-click and choose Undo as many times as needed to further reduce the 
expansion. 

When you can no longer reduce the expansion, the Undo command becomes 
disabled. If you have previously expanded any chromatograms with Expand 
All Plots deselected, some plots will reach their original level of expansion 
before others. 
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Rescaling Chromatogram Values 
The Rescale command on the Options menu lets you change the starting and ending 
times and the offset and full scale values by a specific amount for all open 
chromatograms except those displayed in overlay view.  

 To rescale the values for multiple chromatograms: 

1. Choose Rescale on the Options menu.  

TotalChrom opens the Rescale dialog box, which contains the file name, 
starting and ending times, and the offset and full scale values for all open 
files except overlays.  

 

2. Enter new values (in minutes) in the Start Time and/or End Time columns to 
define the X-axis scale of the chromatogram. 

These values determine which part of the chromatogram (and hence, the run) 
you will see in the window.  

3. In the Offset column, enter the minimum value that you want to use as the 
offset in the Y-axis. 

The offset is the signal level that appears at the bottom of the chromatogram 
window as the Y-axis minimum. The Y-axis maximum value is equal to the 
offset plus the full scale value. 

4. In the Full Scale column, select the cell for the file that you want to change, 
and enter the desired height (in mV) of the chromatogram. 

The Autoscale button sets the X-axis scale to the full run time and the Y-axis 
scale such that the largest peak is full scale. 

The Defaults button sets the X-axis scale back to the full run time and the Y-
axis scale back to the real-time plot parameters in the method. 

5. Choose OK. 
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Showing and Hiding Coordinates 
The default display in the status bar shows the Start and End times for each 
chromatogram. However, you can change these fields to show the exact position of 
the mouse cursor on the X-axis and Y-axis (in minutes and mV, respectively) as you 
move around in the window. 

 To show the coordinates of the mouse cursor: 

• Choose Show Coordinates from the Options menu.  

The coordinates appear in the status bar. The numbers change dynamically 
as you move the mouse in the selected window. 

Showing and Hiding Title Bars 
If more than two chromatograms are open, you might want to hide the title bars to 
enlarge the chromatograms. When you hide the title bars, you can distinguish the 
active chromatogram by their color and by the file name that appears in the status bar. 

 To hide the title bars of all chromatograms: 

• Choose Show Title Bars from the Options menu to deselect it.  

TotalChrom removes the title bars from all open windows and redraws the 
chromatograms slightly larger than before. 

To show the title bars, choose the command again. 

Showing and Hiding Axis Labels 
For some operations, you must have the axis labels displayed in each chromatogram. 
When you do not need this feature, you can hide the axis labels. 

 To hide axis labels for all open chromatograms: 

• Choose Show Axes from the Options menu to deselect it.  

TotalChrom redraws the display without axis labels.  

To redisplay axis labels, choose Show Axes. 

Showing and Hiding Baselines, Component Names, and Peak 
Retention Times 

If you display chromatograms based on result files (rather than raw data files), you 
have the option of displaying or hiding the baselines, component names, and peak 
retention times for each chromatogram. The first time you run Chromatograms after 
installing TotalChrom, it displays the baselines for result files. To hide baselines, 
deselect Show Baselines on the Options menu. 
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To show component names or retention times, however, you must choose Show 
Components or Show Retention Times. Thereafter, the settings you choose for all 
three features will stay in effect until you change them.  

Each of these commands acts as a toggle: to show or hide any of these attributes, 
select or deselect the command on the Options menu. 
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Adding and Editing Chromatogram Labels 

One of the tasks that you can perform through the Chromatogram pop-up menu is the 
adding of labels. After you create a label, you can move it, edit its text and 
appearance, move it to the top of a stack of labels, and link or unlink the label to data 
in the chromatogram. 

Adding Labels to Chromatograms 
You can add labels to chromatograms by using the Add Label command on the 
Chromatogram pop-up menu. After you create a label that shows the time into a data 
acquisition run, you can customize it by entering text that you want the label to 
contain. You can move labels, delete them, set the font, and set the text colors. 

 To add a label to a chromatogram: 

1. Open the chromatogram file in which you want to add labels. Files of this 
type have the extension .raw or .rst.  

2. Click the right mouse button where you want a label to appear. The 
Chromatogram pop-up menu appears. 

3.  Select Add Label. A label will appear that displays the time into the run for 
the position of the cursor in the chromatogram. 

4.  To accept the label, press Enter. If you want to delete the label after you 
accept it, right-click in it and choose Delete. 

Editing Chromatogram Labels 
After you create a label, you can move it with the mouse, edit its text, delete it, define 
colors, and set the font and other characteristics by using the Labels pop-up menu. 

Using the Labels Pop-up Menu 
When you right-click in a label, the Labels pop-up menu opens:  
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The Labels pop-up menu has the following commands: 

Command: Action: 

Delete Deletes a selected label.  

Edit Text Redisplays the label in an edit box allowing you to enter 
any text.  

Set Text Color Displays the standard color selection dialog box 
allowing you to select a color for the label text and 
border.  

Set Font Displays a dialog box that allows you to select typeface, 
style, size, and an angle of rotation.  

Move To Top When labels overlap, this causes the currently selected 
label to move to the top of a stack of labels.  

Link Position To Data When you select this option, the label will keep the 
same relative position in terms of the time and intensity 
axes. When you do not select it, the label maintains the 
same absolute position in the window when you rescale 
the chromatogram.  

Moving a Label 
In addition to the tasks that you can perform through the Labels pop-up menu, you 
can move a label by using the mouse. 

 To move a label: 

• Select the label that you want to move and use the mouse to drag it to 
another position in the chromatogram.  

If the label displays time into the run, that value will change relative to the 
position of the label. 

Deleting a Label 

 To delete a label:  

1. Click the right mouse button in the label that you want to delete. 

2. Choose Delete from the Labels pop-up menu. 

Editing Label Text 
When you create a label, TotalChrom inserts a time-into-run value by default. You 
can create custom labels by editing the text. You can also restore the time-into-run 
value in a label whose text you have edited previously. 
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 To edit the text in a label: 

1. Click the right mouse button in the label whose text you want to edit. 

2. Choose Edit Text from the Labels pop-up menu. The label will become a 
text box.  

3. Type the text that you want the label to contain.  

4. Press Enter to accept changes. 

You can restore the time-into-run value at any time by deleting your 
replacement text. 

 To restore the time-into-run value:  

1. Right-click in the label whose time-into-run value you want to restore. 

2. Choose Edit Text from the Labels pop-up menu. The label will become a 
text box. 

3. Press the Delete key to remove the existing text. 

4. Press Enter to accept the change. The time-into-run value will be restored, 
reflecting the current position of the label. 

Setting the Text Color 
If you want to define custom colors, refer to your Microsoft Paint documentation. 

 To set the text color: 

1. Click the right mouse button in the label whose text color you want to set. 

2. Choose Set Text Color from the Labels pop-up menu. 

3. In the Color dialog box, select one of the Basic Colors or choose the Define 
Custom Colors selection box.  

4. Choose OK. 

Setting the Font 
The Set Font command on the Labels pop-up menu allows you to select the font, 
style, size, effects, color, script, and the angle of rotation for a label. 

Some fonts cannot be rotated. If you choose a font that cannot be rotated, the sample 
in the Font dialog box will move but will not rotate. Choose a different font if you 
want to rotate a label. 
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 To set the font and other attributes: 

1. Click the right mouse button in the label whose font or other characteristics 
you want to edit. 

2. Choose the Set Font command from the Labels pop-up menu.  

3. In the Font dialog box, select the font and other attributes that you want the 
label to contain. 

If you want to change the angle of rotation, move the slider at the bottom of 
the Font dialog box. The angle of the label will be displayed under Sample. 
You can rotate the angle between -90 degrees and +90 degrees. 

4. Choose OK. 

Moving a Label to the Top of a Stack 
Labels can become hidden behind other labels when multiple labels occur at or near 
the same location. When you want to see a hidden label, you can move it to the top of 
a stack of labels with the Move To Top command on the Labels pop-up menu. 

 To move a label to the top of a stack: 

1. Click the right mouse button in the label that you want to move to the top of 
a stack of labels. 

2. Choose Move To Top from the Labels pop-up menu. 

Linking and Unlinking Labels to Data 
When you choose the Link Position To Data option, a label will keep the same 
position in terms of the time and intensity axes when you scale the chromatogram. 
When you deselect this option, the label maintains its same absolute position in the 
window. 

When you create a label, it is linked to data by default. 

 To link and unlink the position of a label to data: 

1. Click the right mouse button in the label that you want to link or unlink. 

2. Choose Link Position To Data from the Labels pop-up menu to toggle 
between linking and unlinking the position of the label to data appearing in 
the chromatogram.  

A check mark will appear next to this command when you select it. 
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Aligning Peaks in Two Chromatograms 

Use the commands on the Chromatogram pop-up menu to shift or resize one 
chromatogram to align selected peaks, baselines, or other points with those on 
another chromatogram. You can then compare chromatographic data in the two plots. 
The procedures in this section explain how you align peaks by time and voltage. 

The first chromatogram, or reference chromatogram, is the one to which you want to 
align peaks. The second chromatogram, or target chromatogram, is the one in which 
peaks will be shifted. 

Aligning Peaks By Time 
You can align peaks by time using three procedures:  

• Shifting the time scale. 

• Scaling the time from origin. 

• Scaling time by using two time points as constants. 

Before you can shift the time scale or scale time from origin, you must set the end 
time in the two chromatograms to be aligned. Before you can scale time, you must set 
the start and end times in the two chromatograms that you want to compare. 

 To set start and end times: 

1. In the reference chromatogram, right-click where you want the end time to 
appear and choose Set End Time on the Chromatogram pop-up menu.  

A dotted vertical line appears through the point you selected. 

2. In the reference chromatogram, right-click where you want the start time to 
appear and choose Set Start Time.  

A dotted vertical line appears through the point you selected. 

3. In the target chromatogram, right-click where you want the end time to 
appear and choose Set End Time. 

A dotted vertical line appears through the point you selected. 

4. In the target chromatogram, right-click where you want the start time to 
appear and choose Set Start Time. 

A dotted vertical line appears through the point you selected. 
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 To return to the original chromatogram view: 

• To return to the original chromatogram view, right-click in the reference 
chromatogram and then choose Clear.  

You can also choose the Defaults button through the Rescale command on 
the Options menu to restore the chromatograms to their default settings.  

Shifting the Time Scale 
The Shift Time command shifts the time of one chromatogram relative to another. 
You select a point on each chromatogram that you want to be at the same position on 
the X-axis. For example, if you know that two peaks appearing at different retention 
times represent the same component, you can shift one to cause both to appear at the 
same time. 

 To align peaks by shifting the start time on the X-axis: 

1. Set an end time in both chromatograms. 
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2. Right-click in the target chromatogram and choose Shift Time.  

The peak in the target chromatogram is shifted along the X-axis to align with 
the peak in the reference chromatogram. 

 

Scaling the Time From Origin 
The Scale Time From Origin command on the Chromatogram pop-up menu rescales 
the X-axis of the target chromatogram relative to a reference chromatogram. You 
align the peaks by holding the origin (start time) constant and compressing or 
expanding the X-axis of the target chromatogram in order that the selected peak 
aligns with the peak in the reference chromatogram. 

 To align peaks by scaling time from origin: 

1. Set an end time in both chromatograms. 

2. Right-click in the target chromatogram and choose Scale Time From Origin.  

The X-axis in the target chromatogram is scaled such that the peak in the 
target chromatogram aligns with the peak in the reference chromatogram. 

Scaling the Time using Two Time Points 
The Scale Time command rescales the X-axis of a chromatogram you want to scale 
and shifts it relative to a reference chromatogram. You select two points on each 
chromatogram that you want to appear at the same positions on the X-axis. The start 
and end times of the target chromatogram will be adjusted such that the marked 
points align with the marked points on the reference chromatogram. 
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 To align peaks by scaling time: 

1. Set a start and end time in both chromatograms. 

 

2. Right-click in the target chromatogram and choose Scale Time. 

The peak in the target chromatogram is scaled such that it aligns with the 
peak in the reference chromatogram. 
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Aligning Peaks by Voltage 
You can align peaks by voltage using three procedures:  

• Shifting the voltage scale. 

• Scaling the voltage from origin. 

• Scaling the chromatogram by matching baselines. 

Before you can shift the voltage scale or the voltage from origin, you must set the 
high voltage value in the two chromatograms to be aligned. Before you can scale 
voltage, you must set the low voltage and high voltage values in the two 
chromatograms that you want to compare. 

 To set low voltage and high voltage values: 

1. In the reference chromatogram, right-click where you want the high voltage 
value to appear and choose Set High Voltage on the Chromatogram pop-up 
menu.  

A dotted horizontal line appears through the point you selected. 

2. In the reference chromatogram, right-click where you want the low voltage 
to appear and choose Set Low Voltage.  

A dotted horizontal line appears through the point you selected. 

3. In the target chromatogram, right-click where you want the high voltage to 
appear and choose Set High Voltage. 

A dotted horizontal line appears through the point you selected. 

4. In the target chromatogram, right-click where you want the Low Voltage to 
appear and choose Set Low Voltage. 

A dotted horizontal line appears through the point you selected. 
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 To return to the original chromatogram view: 

• To return to the original chromatogram view, right-click in the reference 
chromatogram and then choose Clear. 

You can also choose the Defaults button through the Rescale command on 
the Options menu to restore the chromatograms to their default settings. 

Shifting the Voltage Scale 
The Shift Voltage command on the Chromatogram pop-up menu shifts the voltage 
range of one chromatogram relative to another chromatogram. You select a point on 
each chromatogram that must be at the same position on the Y-axis. For example, this 
lets you compensate for different baseline signal levels between two chromatograms. 

 To align peaks by shifting the voltage: 

1. Set a high voltage in both chromatograms. 

2. Right-click in the target chromatogram and choose Shift Voltage.  

The target chromatogram is shifted such that the high voltage aligns with the 
high voltage in the reference chromatogram. 
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Scaling the Voltage From Origin 
The Scale Voltage From Origin command on the Chromatogram pop-up menu 
rescales the Y-axis of the target chromatogram relative to a reference chromatogram.  

 To align peaks by scaling voltage from origin: 

1. Set a high voltage in both chromatograms. 

2. Right-click in the target chromatogram and choose Scale Voltage From 
Origin.  

The target chromatogram is scaled such that the low and high voltage values 
align with the low voltage and high voltage values in the reference 
chromatogram. 

Scaling the Voltage Using Two Points 
To scale voltage using two points, you mark baselines and peak crest points on each 
chromatogram, and TotalChrom rescales the aligned chromatogram such that the 
baseline points and peak crests are at equivalent positions on the Y-axis. 

The Scale Voltage command on the Chromatogram pop-up menu allows you to match 
the baselines of two chromatograms. It affects the Y-axis by changing the low voltage 
of the target chromatogram. Because you are actually changing the low voltage and 
full-scale values for the aligned chromatogram, you can also perform this task 
through the Rescale command on the Options menu. 
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 To align peaks by scaling voltage: 

1. Set a low and high voltage in both chromatograms. 

 

2. Right-click in the target chromatogram and choose Scale Voltage. 

The target chromatogram is scaled such that the low and high voltage align 
with the reference chromatogram. 
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Calculating a New Chromatogram 
The New Calculation Plot command on the Operation menu enables you to create a 
new chromatogram by performing a mathematical operation on two chromatograms. 
You can add, subtract, or divide the data from two raw data files to create a new data 
file. 

After completing the calculation, TotalChrom plots the results in a new window. You 
can save the data resulting from the calculation in a new raw data file and use it like 
any other raw data file in TotalChrom. This data file, which is called the modified 
data file, uses the method parameters associated with the first file. This includes the 
sampling rate and voltage range. 

 To create a new chromatogram from two existing chromatograms: 

1. Open the two files that you want to use to create a new chromatogram. 

2. Choose New Calculation Plot from the Operation menu.  

The Calculation Plot Properties dialog box appears. 

 

3. Select the name of the raw data file that you want to use in the calculation 
from the Plot 1 list. 

If you have aligned this chromatogram with another one by using one of the 
commands on the Alignment menu, the starting and ending times resulting 
from this alignment will appear in the Start Time and End Time text boxes. 

4. Select the operation that you want to perform to create the modified data file. 

Plus — Adds the data in Plots 1 and 2  

Minus — Subtracts the data in Plot 2 from that in Plot 1 

Divide — Divides the data in Plot 1 by that in Plot 2 
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5. From the Plot 2 list, select the name of the second file that you want to 
include in the calculation. 

6. In the Start Time text boxes for each file, enter the time at which you want 
the chromatogram to begin. 

This defines the starting point for the new data. If you enter a start time for 
Plot 1 that is greater (later) than the original start time, the preceding data 
will not be included in the calculation. 

7. In the End Time text boxes for each file, enter the time at which you want 
the chromatogram to end. 

This defines the ending point for the new raw data file. If you enter an 
ending time for Plot 1 that is less than the original ending time, TotalChrom 
does not use the data after the new ending time in the calculation. 

8. Select a Baseline Adjustment option. 

This is a correction factor that is applied to each data point to ensure that 
minimum values are not negative values because TotalChrom cannot process 
values below zero. Baseline Adjustment affects only the new data. 

Automatically Calculate — Causes TotalChrom to calculate the baseline 
offset in order that no negative data point values are generated. 

Set — Lets you enter the amount by which to offset the baseline. If the 
amount you enter is not sufficient to eliminate data point values of less than 
1, TotalChrom applies an additional offset in order that all values are greater 
than zero. The allowed range is -1.0e+100 to 1.0e+100. 

9. Select one of the options under Normalization For Second Plot. 

These define how you want to scale Plot 2 before you perform the 
calculation. TotalChrom uses the following equation to generate each new 
raw data point: 

( )R P operator P M O B= − +×1 2    

where 

R is the resultant data value 

P1 is the first plot data value 

P2 is the second plot data value 

M is the multiplier applied to the second plot 

O is the offset applied to the second plot  

B is the baseline adjustment applied to the calculated plot.  
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The Normalization option you select determines how the values for M and O 
are calculated. These options are: 

None ⎯ The operation is performed with no normalization applied to the 
second plot: the raw data values are used from both plots (for example, M 
and O are equal to 1 and 0, respectively). 

From Data — The offset and multiplier are derived from the minimum and 
maximum values in the two raw data files. Changes in the actual display 
have no effect on the calculation. 

( )
( )

( )

M max min
max min

 min  M x min

1

2

1 2

=
−
−

= −O

 

From Display — The offset and multiplier are calculated in the same way 
as From Data except that the maximum and minimum values used are those 
from the displayed data range only; they are the maximum and minimum 
values that occur in the raw data files between the Start Time and End Time 
set in the dialog box. 

From Scaling — The multiplier and offset values are calculated from the 
screen display as follows: 

( )

M Scale
Scale

O Offset M x Offset

1

2

1  2

=

= −

 

Manual — Lets you set the values for the multiplier and offset. 

10. If you select Manual as the Normalization option, enter the values that you 
want to use for the Multiplier and Offset. 

Offset — This controls the vertical position of a chromatogram in the 
window, and is the amount that the bottom of the window is offset from the 
0 (zero) point on the Y-axis of the window. 

Multiplier — This is the factor by which the data values in plot 2 are 
multiplied before the addition, subtraction, or division operation.  

11. Choose OK. 

TotalChrom calculates the results and displays the new chromatogram in a 
separate window. The operation performed is reflected in the title bar by a +, 
-, or / sign between the file names. If you save this as a new raw data file, 
that name appears in the title bar and you can process the data in the same 
way as any other raw data file. 
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Editing Calculated Parameters  
After you create a new chromatogram using the New Calculation Plot command, the 
Edit Calculation Plot command on the Operation menu becomes available. To edit the 
new chromatogram, make sure that both source chromatogram files are open. If you 
want to use another file for plot 1 or plot 2, you must open this file. 

 To edit a newly calculated chromatogram: 

1. Make the new chromatogram active by clicking inside it. 

2. Choose Edit Calculation Plot on the Operation menu.  

The Edit Calculation Plot dialog box appears, reflecting the values you 
entered to create this chromatogram. 

3. Change whichever parameters are necessary, including the plots you are 
using, to achieve the results that you want to see in the new chromatogram. 

4. Choose OK. 

TotalChrom recalculates the information and displays the modified 
calculated chromatogram.  

Saving the New Chromatogram 
If you have created a new chromatogram by using the New Calculation Plot 
command, the default title of that chromatogram reflects the two file names and 
operation. To save the chromatogram as a new raw data file, you use the Save As 
command.  

 To save a new calculation chromatogram under a new name: 

1. Select the chromatogram that you want to rename. 

2. Choose Save As from the File menu. 

Enter any information in the Description tab of the Documentation dialog 
box. The Save As dialog box opens next, showing the temporary file name 
and directory in the File Name text box. 

3. Enter a new file name, changing directories if necessary. 

4. Choose Save to save the file. 
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ACF  See average calibration factor 
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converting to raw amounts  18-76 
definition  8-5, 8-14 
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prohibited  17-9 
solving for  17-11 
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area threshold  10-26, 18-9, 18-15 
area threshold timed event  18-16 
ASCII text files  See text files 
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Attach command  12-24 
audit trail  2-8, 2-10 
Auto Size command  14-7 
auto-calibration reports  18-61—18-67 
autosampler 

configuring  3-6 
parameters 

for gas chromatographs  6-12 
for liquid chromatographs  6-21 

status messages  12-43 
autoscaling  3-20 
Autozero A/B command  12-30 
auto-zero plot offset  7-15 
average calibration factor  8-24, 8-35, 18-56, 
   18-59 

B 
backlogged data  A-8 
base data file names, renumbering  11-42 
Base File Name command  15-8 
baseline  See also baselines 

penetrations  18-24, 18-26 
resolution, improving  18-23 
subtraction  18-3, 18-5 
timed events 

adding  7-8 
deleting  10-24 
entering  7-6 
overview  7-6, 18-15, 18-32 
setting  10-22 

Baseline Events  68 
Baseline Events command  10-23, 10-24 
Baseline Timed Events command  7-6, 7-8 
baseline to point timed event  18-34 
baselines  See also baseline 

adjusting preliminary  18-24 
hiding or showing  14-14 
horizontal backward  18-38 
horizontal forward  18-36 
indicating for peaks  10-32 
preliminary, establishing  18-24 
printing  7-14 
redrawing manually  10-32 
theoretical, repositioning  18-35 

valley-to-valley  18-33 
Batch command  11-50, 15-3 
batch reprocessing 

overview  15-2 
steps  15-3 
versus single-file reprocessing  15-4 

BF  See bunching factor timed event 
bipolar interfaces, testing  C-4 
BL  See baseline to point timed event 
blank column in reports  9-6, 16-17 
build parameters, entering  11-11 
bunching factor 

overview  18-6 
setting  10-28 

bunching factor timed event  18-15 

C 
Calibrate command  8-46, 10-48 
calibrating by reference  8-35 
calibrating components  8-9, 8-35 
calibration 

amounts, correcting  8-6, 11-24 
automatic  18-55 
by average calibration factors  18-59 
commands, overview  10-36 
components, controlling  10-36 
curve labels, changing  17-7 
curves 

changing display of  17-6 
changing fit parameters  17-8 
computing, overview  18-56 
creating  8-16 
defining  8-37 
defining scaling limits for  17-6 
displaying information about  17-11 
fitting and weighting  17-9 
from regressive calculations  18-58 
overview  17-5, 18-47 
plotting  17-2 

data 
copying  17-17 
printing and plotting  17-16, 17-18 

defaults, setting  8-23 
external standard  8-5 
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external vs internal standard  18-49—18-53 
internal standard  8-5, 8-14 
levels 

adding  8-26, 8-37 
changing  8-38 
definition  8-26 
deleting  8-38 
guidelines  8-26, 8-37 
internal standard  18-52 
overview  8-37, 18-46 

parameters 
changing for a range of components  8-44 
curve fit type  8-16, 17-9 
definition  5-2, 8-2 
editing global  8-7 
entering  8-2 
regression weighting  17-10 
reject outliers  8-5 
replace versus average  18-55 
scaling  8-17 
setting  8-33 
types  8-2 
weighting  8-17 

replicates 
definition  8-46 
deleting/excluding  8-47, 8-49 

report, example  18-61 
standard, options  8-5 
types  8-15, 8-33, 10-41 
updating  8-46, 10-48 
within a sequence  11-9 

calibration curve fit  8-36 
calibration curve parameters  8-25, 8-36 
calibration of components, overview  18-46 
Calibration/Plotting (Calplot) application  See  
   Fit Analysis 
Cancel Run command  12-21 
carrier parameters  6-15 
CB  See common baseline timed event 
cell values, duplicating  11-43, 17-15 
CFG  See configuration file 
Change Calibration Info command  8-43 
Change Component Info command  8-43 
Change Password command  4-2 
Change Scaling command  17-8 

Change Values command  11-34 
chapter summary  1-8 
child peaks, definition  18-28 
chromatograms  See also plot 

adding labels to  14-4, 14-16 
appearance of  14-7 
background color of  14-4 
calculating new  14-28 
changing rotation and elevation of  14-9 
closing  14-2 
color of lines within  14-4 
comparing  14-20, 14-24 
coordinates of  14-14 
copying  14-6 
default display parameters for  10-17 
definition  14-1 
displaying  10-21 
displaying axis labels in  14-14 
displaying based on result files  14-14 
displaying hidden lines in  14-10 
editing  14-31 
expanding  10-19, 14-11, 14-12 
hiding and showing title bars  14-14 
hiding or displaying  10-21 
manipulating  10-21 
overlaying  14-7, 14-8 
printing  14-6 
reducing  10-20 
reference  10-6, 14-20 
rescaling the values in  14-13 
restoring original  14-21, 14-25 
reverting to previous expansion level  10-19 
saving  14-31 
shifting time scales of  14-21 
sizing automatically  14-7 
target  14-20 
truncated, cause of  18-5 
viewing three-dimensionally  14-8 
working with  7-13, 10-6 

Chromatograms 
menus and commands  14-3 
overview  14-2 
pop-up menu  14-4 

Chromatograms command  14-2 
chromatographic method, definition  5-2 
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Clear command  14-4, 15-13 
Clear Setup command  12-23 
cluster, definition  18-14 
clusters, peak  18-24 
color, chromatogram 

of background  14-4 
of label  14-17 
of lines  14-4 
of text  14-18 

Colors command  3-18 
colors, setting for screens and plots  3-18 
Column Width command  11-31 
columns, report  see report format and summary 
report format editor 
columns, sequence spreadsheet 

duplicating values in  11-43 
hiding and displaying  11-29 
inserting repeating value in  11-43 
width  11-31, 11-32 

common baseline timed event  18-32 
component  See also components 

amounts 
calculating  8-15, 8-33 
calculating adjusted amounts  18-77 
calculating initial  18-70—18-75 
calculating with constant calibration  
   factors  18-75 
calibrating with reference calibrations  18-75 
converting ratios to  18-76 
converting volume-adjusted  18-76 
correcting  18-53 
correcting calibrated  8-6 
determining unknown  8-37 

defaults, customizing  8-20 
identification 

defaults, entering  8-22 
definition  18-4, 18-45 
optimizing  18-45 
overriding  10-49 

information 
adding/editing  8-29 
changing  8-43 

list, in suitability method  B-12 
 
lists 

adding a peak component to  8-31 
adding named group to  8-32 
adding timed group to  8-32 
creating  10-36 
creating/editing manually  16-9 
definition  10-36 
editing  16-10 
loading  16-7 

names 
form of  10-36 
hiding or showing  14-14 

parameters, overview  8-2, 8-9 
quantitation, definition  18-4 
types, overview  8-30 
values, user-definable  8-19 

Component List command  17-4 
Component List window  5-3, 5-4, 8-9 
components  See also component 

adding  8-28, 8-30 
assigning names to peaks  10-49 
calibrating 

by reference  8-15, 8-35, 18-56 
definition  18-4 
overview  18-46, 18-49 

changing several simultaneously  8-43 
deleting  8-42 
editing  8-28, 8-39, 10-38 
identifying  8-30 
loading 

from files  8-40 
in component lists  16-9 

matching peak(s)  8-9 
merging  8-40, 8-41, 16-10 
selecting multiple  8-32 
setting identification defaults  8-22 

Configuration Editor 
menus  3-3 
opening  3-2 

configuration file  A-4 
configuration information, printing  3-25 
configuration parameters  11-12 
configuration, saving  3-14 
Configure command  3-4, 3-10 
constant calibration factors  8-23, 8-34, 18-75 
Control Options command  6-2, 6-11 
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control options parameters, setting  6-11 
conventions used in manual  1-11 
Convert application, overview  19-1 
coordinates, showing and hiding  14-14 
Copy command  17-14 
Copy To Clipboard command 

in Chromatograms  14-6 
in Fit Analysis  17-17 
in Graphic Method Editor/Reprocess  
   Results  10-55 

Create ASCII File command  19-2 
CSV file extension  16-24 
curve fit types  17-9 
Curve Info command  17-11 
curves, calibration  18-70 
custom expressions 

definition  9-10, 16-19 
multiple  9-12, 16-22 

customized component defaults  8-20 
cycles 

appending  11-48 
definition  11-2 

D 
data 

acquisition 
controlling, overview  12-19 
effect of breaking communication  12-24 
pausing and resuming  12-22 
port, choosing  3-9 
setting up, overview  12-2 
starting  12-20, 12-21 
stopping  12-21 
viewing run information for  12-32 
with 785 Detector  13-19 
with Method  12-3, 12-6 
with Quick Start  12-2, 12-4 
with Sequence  12-3, 12-8 

analysis 
definition  18-2 
icons  18-3 
overview  18-3—18-4 
parameters  18-2 

collection 

by interfaces  A-2 
determining length of  A-8 
setting channel(s) for  6-6 

compression  A-10 
expected retention time, updating  18-55 
points, calculating collected  6-7 
recalibrating  15-4 
reprocessing  10-25, 15-4, 15-8 
storage  6-7, 12-31 
validation  C-2 

Data Channels command  6-2, 6-6, 6-8 
Data File command  15-10 
data files 

renaming  11-41 
renumbering  11-42 

Data List command  17-12 
Data List spreadsheet 

overview  17-12 
default component information, setting  8-20 
Defaults command  8-20, 8-21 
delayed time data collection, programming  6-7 
Delete All Components command  8-42 
Delete Column  9-8 
Delete Column command  16-18 
Delete command  14-17 
Delete Component command  8-42 
Delete Events command  10-23, 10-24, 10-34 
Delete View command  11-30 
delta modulation  A-10 
derivatization programs  6-38 
descriptive file information  2-8 
Detach command  12-24 
Details command  12-27, 12-28 
Details window  12-32 
detector signals, viewing  12-30 
detector, GC 

adjusting after setup  13-5 
setting parameters  6-19 

detector, LC 
adjusting after setup  13-10 
setting parameters  6-30 

Dilution command  6-42 
dilution programs  6-38, 6-40 
Disconnect command  3-15 
downloaded method, modifying  13-13 
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downloading parameters, overview  A-6 
dropline integration  18-27 
dual injection versus dual channel  11-18 
dual-channel instrument processing parameters  7-2 
dual-injection sequence sample identification  11-20 

E 
E  See end peak timed event 
Edit Calculation Plot command  14-31 
Edit Component command  8-28 
Edit Component List command  16-10 
Edit Components command  10-37, 10-38, 10-39, 
10-41, 10-43, 10-44 
Edit File List command  16-4, 16-8 
Edit Format command  16-3 
Edit List command  B-12 
Edit or Add Component command  8-9 
Edit Text command  14-17, 14-18 
electronic signature  2-13 
Electronic Signature  141 
end peak timed event  18-40 
Entire Chromatogram command  10-19 
equations 

adjusted amounts  18-77 
adjusted internal standard amount  18-54, 18-69 
adjusting expected retention times  8-14 
amount ratios, converting to raw amounts  18-76 
amount scaling  18-57 
average calibration factors  18-59 
calibration factor  18-66 
capacity factor  B-23 
collected data points  6-7 
confidence limits test  18-63 
correcting component amounts  18-53 
correlation coefficient  18-64 
exponential skim  18-31 
external standard calibration factors  18-59 
first order (linear) curve  18-72 
gain error  C-20 
generating new raw data point  14-29 
initial component amount  18-75 
internal standard calibration factors  18-60 
k' value  8-5 

least squares approximation from regression 
calculation  18-58 
linearity errors  C-20 
normalization for 900 Series interface  A-3 
offset and multiplier  14-30 
outlier test  18-66 
point-to-point curve fit, initial amount  18-72 
regression calculation  18-58 
relative retention  B-25 
relative retention value  8-5 
resolution  B-24 
sampling rates for 900 Series interface  A-3 
search window, total size of  8-13 
second order (quadratic) curve fit  18-72 
signal-to-noise ratio  B-25 
system efficiency  B-22, B-23 
tailing factor  B-23 
third order (cubic) curve fit  18-73 
volume-adjusted amounts, converting to raw 
amounts  18-76 

error messages 
insufficient calibration information  17-4 
Invalid Type In Text File  11-57 
IVM, reported by  C-18 
log file for  12-25 
No Field Identifiers Were Specified  11-57 
Overflow  12-24 
Unknown Field Identifier  11-57 
Wrapped  12-24 

Error Messages command  12-25 
events  See timed events 
examples 

actual peak start point, finding  18-11 
area thresholds  18-15 
baseline adjusted at start of cluster  18-26 
baseline penetrated by chromatogram valley  
18-24 
bunched data points, too few  18-7 
calibration level names  18-47 
correcting component amounts  18-53 
distance between peaks exceeds noise 
threshold  18-8 
external standard calibration curve  18-49 
internal standard calibration curve  18-51 
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internal standard calibration, multiple  
   levels  18-52 
method parameters for testing unipolar 
interface  C-10 
peak after SM event is run  18-23 
peak before SM event is run  18-23 
peak detection timed event, effect of  18-17 
peak shoulders, detecting  18-13 
peak top, confirming potential  18-12 
relationship of area threshold to peak  
   detection  18-9 
relationship of noise threshold to peak 
detection  18-8, 18-10 
single validation run text file  C-17 
Suitability report  B-4, B-7 
summary report  16-12 
synchronized program  7-18 
text file format  11-57 
timed events 

effect of -I and +I  18-21 
effect of -N and +N  18-18 
retention time and user forced peak  18-22 

unrepresented components  18-48 
validation report  C-15 

Expand All Plots command  14-11, 14-12 
Expand Reference Chromatogram command  10-20 
exponential skim 

calculating  18-31 
criteria, listed  10-30, 18-28 
forcing  18-42 
overview  18-28—18-31 
preventing  18-42 
requirements  10-31 
timed event  18-42 

external standard 
calibration  17-8, 18-49 
definition  8-5 

F 
file formats 

for Lotus 1-2-3  16-24 
for Microsoft Excel  16-24 

File Open dialog  34 
File Open dialog box  2-3 

File Select dialog box  2-3 
File/Level/Type list  8-47 
files  See also text files 

converting into alternate formats  19-5 
converting to ASCII text  19-2 
entering descriptive information in  2-8 
reprocessing  15-3 

Fill Down command  11-43, 17-15 
Fit Analysis 

automating as user program  17-18 
menus and commands  17-4 
overview  17-2 

fit parameters 
overview  17-8 
selecting  8-16 

flush cycle, activating by autosampler  13-12 
Foley-Dorsey  B-23 
font attributes  14-18 
font, changing in sequence  11-32 
Fonts command  3-17 
fonts, selecting  3-17 
footer, report  9-5, 16-16 
For Amount command  17-11 
For Response command  17-12 
From Base Name command  16-4 
From Sequence command  16-4, 16-6 

G 
gain errors  C-20 
gas chromatograph 

autosampler parameters  6-12 
carrier parameters  6-15 
configuration options, setting  3-11 
controls, adjusting after setup  13-5 
oven coolants  6-13 
oven temperature  6-13, 6-14 
status, viewing detailed  12-32 
valves  6-18 

global calibration parameters 
editing  8-7 
options  8-5 
overview  8-4 

Global Information command  8-7 
Global Parameters command  11-49, 12-18 
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global parameters in sequence 
defining  11-11 
editing  11-49 
effect of changing  11-49 

global status messages  12-39 
Graphic Edit command  10-4 
Graphic Method Editor 

calibration commands  10-36 
file types in  10-8 
menus and commands  10-6 
overview  5-2, 10-2 
window  10-4 

Group Detail tab  20-101 
Group Table  97 

H 
Hands On command  13-2, 13-3, 13-5, 13-7 
Hands On overview  13-2 
header tab  20-106 
header, report  9-5, 10-52, 16-16 
Help system  1-12 
HF  See horizontal baseline forward timed event 
Hide/Unhide Columns command  11-28 
horizontal baseline backward timed event  18-38 
horizontal baseline forward timed event  18-36 
HR  See horizontal baseline backward timed event 

I 
I  See peak end detection timed event 
icons 

data analysis  18-3 
Hands On  13-2 

identification of components, optimizing  18-45 
identifiers in text file  11-53 
identifying components  8-30 
IDX  See index files 
Import command  5-9 
index file 

loading raw files from  10-4 
loading result files from  10-11 
overview  15-4 
reprocessing  15-4 
versus sequence file  15-4 

viewing  11-59 
Insert command  17-14 
instrument  See also instruments 

disconnecting  3-15 
errors  12-25 
parameters 

adjusting after setup  13-7 
definition  5-2 
downloading  A-6 
entering  6-2 

personality modules  A-4 
settings, adjusting after setup  13-2 
status messages  12-42 
timed events 

deleting  10-35 
setting  6-36, 10-33 

Instrument Configuration command  3-2, 3-9 
Instrument Event Properties  20-74 
Instrument Events command  10-33, 10-34, 10-35 
Instrument Status window  12-37 
instruments  See also instrument 

breaking communication with  12-24 
configuration options for  A-4 
configuring  3-4—3-8 
controlling when released  12-24 
re-establishing communication with  12-24 
releasing control of  12-23 
selecting  2-15 
viewing detailed information about  12-34 
viewing detailed status of  12-32 

Integration command  7-4 
integration parameters  7-4 
interface 

function of  A-2 
memory types  A-7 
performance validating for 900 Series  
   interface  C-2 
status messages  12-40 

Interface Validation Module 
calculations, overview  C-19 
error conditions in  C-18 
gain errors in  C-20 
installing  C-3 
IVM file extension  C-17 
IVM.EXE file  C-3 
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IVM.MTH file  C-2 
IVM.RPT file  C-2 
IVM.SEQ file  C-2, C-12 
linearity errors in  C-20 
overview  C-2 
preparing methods with  C-6 
report sample  C-16 
running tests in  C-14 
sequences, setting up  C-12—C-13 
standard deviation gain errors  C-22 
test methods  C-10 
test plots  C-19 
text report file  C-2 
validation procedures  C-6 
validation specifications  C-17 

internal standard 
amounts 

correcting  18-54, 18-69 
overview  18-52 

calibration  8-5, 17-8, 18-50 
components, defining  8-14 

IPMs  See instrument personality modules 
ISTD  See internal standard 
IVM  See Interface Validation Module 

L 
labels 

absolute positioning of  14-19 
adding  14-4, 14-16 
configuring  7-13, 14-16, 14-18 
deleting  14-17 
displaying hidden  14-19 
editing  14-16, 14-17 
linking to data  14-19 
moving  14-17 
rotating  14-19 

Labels command  17-7 
levels, adding calibration  8-37 
library file (LIB)  A-4 
Limits command  17-6 
LIMS options 

defaults, setting  8-27 
setting  8-38 

linear least-squares regression analysis  C-19 

linearity error  C-20 
Lines command  10-16 
LINK  See also 600 Series LINK Interface 
LINK configuration 

options, setting  3-11 
resetting  3-15 

Link Position To Data command  14-17, 14-19 
LINK-controlled autosamplers 

acquiring data with  12-20 
restarting  12-22 
setting up  12-16 

LINK-controlled GC, setting detector parameters  
   for  6-19 
LINK-controlled instruments, channel options for  6-6 
LINK-controlled LC pump module without 
autosampler, acquiring data with  12-21 
LINK-controlled LC, adjusting instrument 
parameters  13-7 
liquid chromatograph 

autosampler parameters, setting  6-21 
configuration options, setting  3-13 
control options, setting  6-20 
detector parameters, setting  6-30 
pump parameters, changing graphically  6-27 
status, viewing detailed  12-32 

List Window Properties  20-40 
LLS  See linear least-squares regression analysis 
LM  See locate maximum timed event 
Load From Method command  16-9 
Load From Peak List command  10-36 
Load From Result File command  16-9 
Load Text File command  11-57 
Load/Method File command  8-40 
loading components from files  8-40 
local reprocessing controls  15-12 
locate maximum timed event  18-22 
low voltage, changing  14-26 

M 
M  See manual integration timed event 
Main Toolbar, review and approve  20-17 
Manual Identification command  10-49 
Manual Integration command  10-32 
manual integration timed event  18-42 
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manually drawn baselines  10-32 
mathematical operations in reports  9-10, 16-19 
memory segmentation in interfaces  A-7 
menu bar  20-17 
Merge command  8-40 
Merge From Method command  16-10 
Merge From Peak List command  10-36 
Merge From Result File command  16-10 
Merge Text File command  11-58 
merging components from files  8-40 
messages, status  See status messages 
method 

acquiring data with  12-6 
creating  5-6 
definition  5-2, 18-2 
modifying downloaded  13-13 
modifying with Quick Method  12-15 
preparing IVM  C-6—C-12 
printing  5-8 
referenced in sequence, opening  5-7 
reviewing parameters  5-7 
suitability 

creating new  B-9 
modifying  B-11 
reusing  B-11 

Method Edit command  11-51 
Method Editor 

commands  5-5 
menus  5-5 
overview  5-2 
windows  5-3 

Method Summary window  5-3 
Modify/Active Sequence command  13-16 
Modify/Downloaded Method command  13-13 
monitor mode  12-30 
mouse cursor coordinates  14-14 
Move Column command  9-9, 16-19 
Move command  15-12 
Move To Top command  14-17, 14-19 

N 
N  See negative peak detection timed event 
Name command  6-2, 6-3 
Named Group command  10-43, 10-44 

named group components 
adding to component list  8-32 
creating and editing  10-43, 10-44 
definition  10-42 
setting defaults for new  8-23 

Navigator 
buttons and commands  4-4 
tasks, overview of  4-7 
window  4-3 

needle, reset by autosampler  13-12 
negative amount values  18-74 
negative peak detection timed event  18-18 
New Calculation Plot command  14-28, 14-31 
New Component command  8-28, 8-30 
New Data File command  10-8 
New Fit command  17-9 
New Report Format command  10-52 
New View command  11-30 
Next command  12-32 
Next Component command  17-4 
noise threshold  10-26, 18-8, 18-15 
noise threshold timed event  18-16 
Noise/Area Threshold command  10-26 
Notes command  6-2, 6-4, 6-5 
NT  See noise threshold timed event 
numbers, reading rack and vial  13-4 

O 
offsets, preventing  8-36 
Open Format command  16-11 
Opt 1 tab  20-109 
Optional Reports command  7-9 
Options dialog  20-27 

Initial Scaling  20-28 
Peaks/Components  20-30 

origin 
changing for real-time plot  12-30 
treatment options  8-19 

outlier test  18-65 
oven temperature, setting  6-14, 13-5 
Overflow error message  12-24 
overlapped peaks  18-14 
overlapped search windows  18-45 
Overlay command  14-7, 14-8 
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Overlay display  20-52 
over-sampling, compensating for  18-6 

P 
P  See peak detection timed event 
parent peaks, definition  18-28 
passwords  4-2 
Paste command  17-14 
Path command  11-44 
Path Select dialog box  2-4 
paths, configuring preset  3-21 
Pause command  15-12, 15-13 
Pause Sequence command  12-22 
peak 

areas 
adjusting  18-27 
determining, overview  18-26 

clusters  18-14, 18-24 
components 

adding  8-31, 10-39 
editing  10-39 
setting as default type  8-22 

detection 
allowing and inhibiting  18-20—18-21 
definition  18-3 
disabling and enabling  18-16 
optimizing  18-16 
overview  18-11 
parameters  7-4, 18-6 
procedures  18-6—18-23 
relationship to timed events  18-15 

height ratio, definition  18-28 
heights, calculating  18-44 
integration parameters  7-4 
integration, definition  18-3 
list, definition  10-36 
retention times 

calculating  18-44 
compensating for shifts in  8-13 
hiding or showing  14-14 

separation criteria 
changing  10-30 
definition  10-30 
overview  18-14 

width for acquired data  6-7 
peak detection timed event  18-16 
peak end detection timed event  18-20 
Peak or Component Properties  78 
Peak Report command  10-51, 10-52 
Peak Separation/Expo Skim command  10-30, 10-31 
Peak Table  20-92 
peaks 

aligning 
by scaling time  14-22 
by scaling voltage  14-26 
overview  14-20 
scaling time from origin  14-22 
scaling voltage from origin  14-26 
shifting time axis  14-20, 14-21 
shifting voltage axis  14-24 
shifting voltage scale  14-25 

child and parent  18-28 
creating and editing timed groups of  10-45 
detecting and integrating  10-22 
finding end of  18-13 
forcing daughter  18-22 
identifying  10-39, 10-49 
identifying as correct run component  10-47 
integrating  18-24—18-26 
locating top of  18-12 
merging list with component list  10-36 
naming unidentified  10-36 
optimum number of  18-6 
overlapped  18-14 
preventing undetected  18-38 
quantifying unidentified  18-78 
re-identifying  10-41 
relationship to search window  8-13 
selecting for identification  10-36 
separated  10-31, 18-14 
shifting  14-20 

Peltier Tray temperature  6-23 
plot  See also chromatograms 

display, changing  10-16 
labels, changing  17-7 
options, configuring  3-20 
origins, changing  12-30 
parameters, changing  12-28 
redrawing  10-17 



  

xii  

rescaling  10-16 
scale 

absolute  7-16 
methods of calculating  17-6 

settings for reports  7-11 
Plot command  3-20 
Plot Settings dialog box  7-11 
Plot Title Properties  20-65 
plot window  42, 45 
Plot Window Properties  20-59 
point index, definition  18-6 
point-to-point fit  18-70 
Post sequence options  12-13 
Post sequence Options  3-8 
post-analysis programs, definition  18-4 
preliminary baselines, adjusting  18-24 
Preserve View command  10-8, 10-13 
Previous command  12-32 
Previous Component command  17-4 
Print Method command  10-54 
Print Options  20-31 
Print Report command  10-53 
Print Summary command  5-8 
Printed Reports  20-12 
printing 

audit trail  2-12 
calibration data  17-16 
chromatograms  14-6 
configuration information  3-25 
method information  5-8, 10-54 
options for plots  3-20, 7-12 
options for reports  9-13 
replots  10-53 
report format file content  9-17 
reports  10-53 
run logs  6-7 
selecting optional reports for  7-9 
sequence information  11-60 
suitability method and reports  B-18 
summary report  16-4, 16-11, 16-25 
summary report format file content  16-24 

PRN file extension  16-24 
Process dialog box  7-2, 7-8, 7-9 
Process Number  9-15 
processing parameters 

definition  5-2 
entering in method  7-2 
for dual-channel instruments  7-2 
overview  7-2 
setting  10-22 

Process-Time programs  11-46 
program parameters  13-8 
Program Selection dialog box  2-5 
programs  See user programs 
Project Directory  3-23 
property inspector  20-25 
pump 

parameters 
adjusting after setup  13-8 
changing  6-27 
setting configuration  6-23 
setting control  6-26 

programs 
creating  6-24 
deleting or duplicating steps in  6-29, 6-30 

purging  13-9 
solvent gradient programs, creating  6-24 
starting and stopping  12-23 

purging pumps  13-9 

Q 
quantitating 

component parameters  8-9 
unidentified peaks  18-78 

quantitation units parameter, definition  8-4 
quantitation, overview  18-68 
Quick Method  12-15 
quick paths  3-21 
Quick Start 

acquiring data with  12-4 
overview  12-2 
reprocessing data acquired with  15-4 

R 
ratios 

adjusted height  18-29 
amount  8-5 
peak height, definition  18-28 
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response  8-5 
valley height  18-30 
valley-to-peak  18-14 
width  18-14 

raw data files, loading  10-8 
Raw Points command  10-16 
Raw Points with Bunching command  10-16 
Read RVP command  13-4 
reagent values  6-38 
real-time plot 

changing origin of  12-30 
parameters, setting  6-10 
rescaling  12-28 
setting scale  6-10 
viewing  12-26 
viewing multiple  12-28 

Real-Time Plot command  12-26 
Real-Time Plot Scale command  6-2, 6-10 
Real-Time Plot window 

menus and commands  12-26 
opening  12-26 

Real-Time programs  11-46 
reference calibration factors  18-75 
reference chromatogram 

hiding or showing  10-21 
manipulating  10-21 
reducing  10-20 
resizing  10-21 

Reference Chromatogram command  10-6 
reference components 

calibrating by  8-24, 8-35 
overview  8-13 

regression calculations  17-9, 18-58 
Re-Identify command  10-39, 10-41 
relative scaling  7-14 
relative window  10-40 
relay 

events  10-35 
parameters  13-9 
settings, adjusting after setup  13-3 

Release Control command  12-23 
Rename View command  11-30 
Renumber Files command  11-42 
Replace command  14-5 
replicate injections  11-44 

replicate, definition  18-46 
replicates  8-5, 8-47, 8-49 
replot 

generation step in data analysis  18-4 
parameters, editing  7-12 
printing  10-53 
suppressing  7-12 

Replot command  7-12 
report format   see also summary report format 
editor; TurboRGEN 

designing 
columns  9-6 
custom expressions in  9-10 
general procedure  9-3 
headers and footers  9-5 
Report Format Editor, overview  9-2 
selecting AIA metafile  9-16 
selecting ASCII text file output  9-16 
selecting options to include  9-13 
selecting SQL*LIMS files  9-16 
title  9-5 

printing content of file  9-17 
selecting for output 

in Graphic Method Editor  10-9, 10-52 
in Method Editor  7-9 
in Sequence Editor  11-7 

Report Format Editor, overview  9-2 
Report Format Editor, process number  9-15 
report generation, step in data analysis  18-4 
Report Header command  10-51, 10-52 
Report Properties  20-89 
report status  20-6 
Report tab  20-105 
Report window  20-44 
Report Window  20-87 
report, auto calibration  18-61—18-67 
reported retention time  18-13 
Reprocess command  10-23, 10-34 
Reprocess Results 

function  10-11 
loading files  10-13 
opening  10-11 
overview  10-2, 10-13 

reprocessing, batch 
controlling files during  15-12 
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definition  15-1 
index or sequence files  15-4 

Rescale  115 
Rescale command  12-28, 12-29, 14-11, 14-13,  
   14-21, 14-25 
Rescale Plot command  10-16 
Reset LINK command  3-15 
Reset Run Counters command  3-15 
response 

methods of plotting  17-8 
options, overview  8-16 
ratios, definition  8-5, 8-14 
values 

definition  17-6 
solving for  17-11 

result file list 
for Suitability calculations 

building  B-16 
editing  B-17 
printing  B-18 

for Summary report 
creating by base file name  16-4 
creating from sequence file  16-6 
creating or editing manually  16-8 
overview  16-4 

result files 
definition  18-2 
summarizing in report  16-2 

results, sending to SQL*LIMS  8-19 
Resume command  15-13 
Resume Sequence command  12-22 
retention time  8-14, 14-15, 18-13 
retention time data, updating  18-55 
retention time timed event  18-22 
Return command  10-23, 10-34, 10-39, 10-51, 10-
52 
Review and Approve levels  20-10 
Review command  5-7 
RST  See result files 
RT  See retention time timed event 
Run counters 

resetting  3-15 
resetting all  3-15 

run logs  6-7 
runs 

canceling  12-21 
canceling reprocessing  15-13 
stopping  12-21 

S 
S  See start new peak timed event 
sample 

identifying in sequence  11-18 
notes  11-45 
numbers 

defining  11-15, 11-19, 11-21 
incrementing  11-38 

volume parameter, definition  8-5 
Sample Fill-In  11-44 
Sample Note command  11-45 
sampling needle, adjusting  13-12 
sampling rate, setting  6-7, 6-8, 10-28 
Sampling Rate/Bunching Factor command  10-28 
Save As MetaFile command 

in Chromatograms  14-6 
in Graphic Method Editor/Reprocess  
     Results  10-55 

Scale Time command  14-4, 14-22, 14-23 
Scale Time From Origin command  14-4, 14-22 
Scale Voltage command  14-4, 14-26, 14-27 
Scale Voltage From Origin command  14-4, 14-26 
scaled amount values, reversing  18-75 
scaling 

alternative amount, overview  18-57 
factors  17-8 
options  8-17 
parameters  6-10, 7-11, 12-29 
relative  7-14 

SD gain error  C-21 
search window 

calculating total size  8-13 
definition  8-13, 10-47, 10-50 
displaying  10-50 
hiding  10-47 
overlapping a  8-13 
overlapping, overview  18-45 
setting up  8-13 

segmented memory, creating  A-7 
Select command  12-32 
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sequence 
acquiring data with  12-8 
building by template  11-13 
building vial by vial  11-17 
calibration parameters  11-26 
calibration types  11-14 
configuration settings  11-11 
creating  11-9, 11-10 
defining each sample  11-17 
editing method from  11-51 
IVM  C-12 
modifying during a run  13-16 
overview  11-2 
parameters 

file information for  11-22 
overview  11-3 
quantitation values for  11-24 

reprocessing  15-4 
spreadsheet 

appearance of  11-30 
changing font  11-32 
changing method/data paths  11-44 
color codes  11-3, 11-6 
column width  11-31 
columns, hide/unhide  11-28 
columns, list of  11-6 
copying and pasting in  11-33, 11-37 
editing  11-27, 11-32, 11-35 
editing multiple cells  11-34 
entering file names in  11-33 
format  11-5 
rows  11-35 
Type column  11-8 
views  11-28, 11-29 

Sequence command  11-10, 15-4 
Sequence Editor 

commands and menus  11-4 
overview  11-4 

Sequence Information window  12-17 
serial dilution program, including in sequence  11-
48 
Set Background Color command  14-4 
Set Chromatogram Pen command  14-4 
Set End Time command  14-4, 14-20 
Set Font command  14-17, 14-18, 14-19 

Set High Voltage command  14-4, 14-24 
Set Low Voltage command  14-4, 14-24 
Set Start Time command  14-4, 14-20 
Set Text Color command  14-17, 14-18 
Set Up command  11-50 
Setup function  12-2 
Setup Problems window  12-25 
Shift Time command  14-4, 14-22 
Shift Voltage command  14-4, 14-25 
Show Axes command  14-11, 14-14 
Show Baselines command  14-8, 14-11, 14-14 
Show Components command  14-8, 14-11, 14-15 
Show Coordinates command  14-3, 14-11, 14-14 
Show Reference Chromatogram command  10-22 
Show Retention Times command  14-8, 14-11, 14-15 
Show Title Bars command  14-11, 14-14 
Show Windows command  10-47, 10-50 
Show/Hide Dialog  20-38 
Sign Toolbar  20-43 
signature table  20-14 
single-injection sequence sample identification  11-
18 
skims 

exponential  18-42 
tangential  18-42 

SM  See smooth peak ends timed event 
Smart Fill command  11-38—11-42 
smooth peak ends timed event  18-23 
solvent gradient program, creating  6-24 
solvents 

adjusting composition after setup  13-8 
labeling  6-24 

specifications, 900 Series interface  C-17 
SQL*LIMS, sending results to  8-19 
Stack command  14-7 
Stacked display  20-51 
Start Monitor command  12-30, 12-31 
start new peak timed event  18-41 
Start Run command  12-20, 12-21, 12-22 
Startup dialog box  2-2 
Static Overlay Plot  53 
Static Stacked Plot  53 
Status command  4-4, 12-37 
status messages 

acquisition  12-40 
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autosampler  12-43 
displaying  12-37, 12-38 
global  12-39 
instrument  12-42 
interface  12-40 

Status Tab  20-108 
Stop Monitor command  12-31 
Stop Pump command  12-23 
Stop Run command  12-21 
SUI  See System Suitability files 
Suitability  See System Suitability 
Suitability command  B-8 
summary 

reports, including historical IVM data in  C-17 
Summary  See also summary report format editor 

menus and commands  16-3 
overview  16-2 
report 

definition/example  16-12 
including in a sequence  16-25 
printing  16-4, 16-11 
selecting components for  16-4, 16-6, 16-9 
selecting format for  16-11 
selecting result files for  16-4, 16-6, 16-8 

window  16-3 
Summary Properties  20-133 
summary report format editor  See also Summary 

menus and commands  16-13 
overview  16-12 
report format 

custom expressions in  16-19 
designing columns  16-16 
general procedure  16-13 
headers and footers  16-16 
printing content of file  16-24 
printing options  16-23 
selecting ASCII text file output  16-24 
title  16-15 

Synchronize Column Widths command  11-32 
synchronized programs  7-16 
System Suitability 

calculations  B-22 
commands and menus  B-8 
files  B-11 
method 

creating  B-9 
developing component lists for  B-12 
modifying  B-11 
using an existing  B-11 

opening  B-8 
options, defining  B-13 
overview  B-3 
parameters used in testing  B-2 
printing method and reports  B-18 
reports  B-4 
result file list, creating for  B-16 
running automatically  B-20 
testing, definition  B-2 
window  B-8 

T 
T  See tangential skim timed event 
Take Control command  12-24 
tangential skim timed event  18-42 
tangential skims  18-27, 18-42 
target chromatograms  14-20 
TCR file  20-6 
TCR File Warning  20-32 
TCSTRUCTURE.HLP file  19-3 
template 

appending to sequence  11-49 
building a sequence by  11-13 
for instrument notes  6-4, 6-5 
selecting for report  7-9 

tests, running validation  C-14 
text files 

building sequence from  11-52 
commands for loading components  8-40 
converting files to  19-2 
creating comma-delimited  B-14 
creating from report  9-16, 16-24 
example validation run  C-17 
format for sequence  11-52 
loading sequence information from  11-57, 11-58 
merging sequence information from  11-58 

three-dimensional chromatograms  14-8 
thresholds  10-26, 18-8, 18-9, 18-15, 18-16 
Tile Horizontally command  14-7 
Tile Vertically command  14-7 
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time 
delaying between run start and data 
     analysis  6-9 
scaling  14-22 
shifting scale  14-21 
start/stop  14-13 

time from origin, scaling  14-22 
time slice, definition  A-2 
timed events 

adding  7-8 
adding or editing  6-36 
changing time or value of  6-37 
deleting  6-37, 7-8 
deleting baseline  10-24 
deleting instrument  10-35 
descriptions  7-6 
editing  7-8 
printing  7-14 
programming  6-36 
selecting  7-6 
setting baseline  10-22 
setting instrument  10-33 
types 

area threshold  18-15, 18-16 
baseline to point  18-34 
bunching factor  18-15 
common baseline  18-32 
end peak  18-40 
exponential skim  18-42 
horizontal baseline backward  18-38 
horizontal baseline forward  18-36 
locate maximum  18-22 
manual integration  18-42 
negative peak detection  18-18 
noise threshold  18-15, 18-16 
peak detection  18-16 
peak end detection  18-20 
retention time  18-22 
smooth peak ends  18-23 
start new peak  18-41 
tangential skim  18-42 
user forced peak  10-24, 18-22 
valley-to-valley baselines  18-33 

Timed Group command  10-45 
timed group components 

adding to component list  8-32 
creating and editing  10-45 
defaults  8-23 
definition  8-12, 10-42 
displaying  10-47 

time-into-run values  14-17, 14-18 
title bars, hiding and showing  14-14 
Title command  16-15 
title, report  9-5, 16-15 
Tokenized file names  2-6 
TotalChrom 

capabilities  1-3—1-7 
starting  4-1 
overview  1-2 

troubleshooting 
instrument-related errors  12-25 
validation runs  C-18 

Type menu command  10-38 

U 
UF  See user forced peak timed event, See user 
forced peak timed event 
Undo command  14-4 
unidentified peak quantitation parameter  8-6 
unipolar interfaces, testing  C-4 
unsegmented memory, overview  A-7 
user forced peak timed event  10-24, 18-22 
User Label Properties  71 
user options, configuring  3-17—3-25 
user program 

in a method  7-16 
in a sequence  11-46 
Process-Time programs  11-46 
quiet mode  7-18 
Real-Time programs  11-46 
running Fit Analysis as  17-18 
running Suitability as  B-20 
running Summary as  16-25 

user programs  5-5, 7-3 
User Programs command  7-16 
user values, setting  8-38 
user-definable component values  8-19 



  

xviii  

V 
V  See valley-to-valley baselines timed event 
validation 

performance parameters  C-2 
procedures  C-6 
reports, example  C-15 
specifications  C-17 
tests, running  C-14 

valley height ratio  18-30 
valley-to-peak ratio  18-14 
valley-to-valley baselines timed event  18-33 
valves 

adjusting for GC after setup  13-5 
initial values for  6-18 

vertical scaling  7-14 
vial list 

building  12-17 
overview  12-16 

Vial List window  12-17 
vial numbers, incrementing  11-40 
views of sequence  11-28, 11-29 
void time, definition  B-13 
voltage 

range, shifting  14-4 
scaling  14-26 

voltages, changing in chromatograms  14-13 
volume units parameter, definition  8-4 

W 
wavelength calibration for 785 detector  13-19 
weighting factor 

definition  8-17 
in calculation  18-64 
selecting  17-9 

width ratio, definition  18-14 
window  See search window 
Wrapped error message  12-24 

X 
X  See exponential skim timed event 

Z 
zone 

parameters, setting  6-14 
setpoints  6-13 

zoom box  54 
Zoom In A/B command  12-30 
Zoom Out A/B command  12-30 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 




